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 1 Introduction



1 Introduction SigmaPlot makes it easier for you to present your findings accurately using precise, publication-quality graphs, data analysis and presentation tools. SigmaPlot offers numerous scientific options such as automatic error bars, regression lines, confidence intervals, axis breaks, technical axis scales, non-linear curve fitting and a data worksheet for powerful data handling. SigmaPlot 9.0 is a state-of-the-art technical graphing program designed for the Windows platform. It is certified for Windows 98, Windows NT, Windows 2000, Microsoft Office 98, 2000, and Windows XP. SigmaPlot 9.0 is specifically designed to aid in documenting and publishing research, specializing in the graphical presentation of results. Creating and editing graphs is easy. Just click a Graph toolbar button, pick your data with the Graph Wizard, and you can create a graph in seconds. You can also use templates to apply favorite graphs again and again. SigmaPlot also includes a powerful nonlinear curve fitter, a huge scientific data worksheet that accommodates large data sets, summary statistics, a mathematical transform language and much more. OLE2 technology is fully supported. You can annotate graphs with the Microsoft Word Equation Editor, edit your graphs directly inside Word or PowerPoint, or plot your data with an Excel spreadsheet right inside SigmaPlot.



SigmaPlot at a Glance Graph Types and Styles



SigmaPlot’s selectable Graph Type determines the structure of your graph. SigmaPlot provides many different types of two- and three-dimensional Cartesian (XY and XYZ) graphs, as well as pie charts and polar plots. Graph Style determines how data is plotted on a graph. Available styles depend on the selected Graph Type. SigmaPlot’s Graph Wizard conveniently displays all available graph styles associated with each graph type.



 2 Chapter 1



Templates



The SigmaPlot template notebook contains a variety of page layouts. Apply these predetermined template attributes to previously saved pages and graphs, or create a user-defined template. Store your templates in a SigmaPlot Notebook Template file (.JNT). You may want to create your own template notebook. Graph Defaults



Preset graph attribute default settings, such as size and position, font, and symbol, line and bar settings. Axis Scales



Create multiple axes for 2D graphs. SigmaPlot, by default, automatically calculates axis ranges and enables each plot to contain separate X and Y axes. Tick Marks. Use both major and minor axis tick marks and grid lines. Tick intervals, length, direction, thickness, and color are all adjustable; grid line types are also adjustable. Tick labels can be numeric, time series, or customized, using labels in a worksheet column. Axis Breaks. You can specify an axis break with a different post-break tick interval. Automatic Legends



Generate legends automatically, or ungroup legends and individually customize text labels. Smooth 2D and 3D Data



Smooth sharp variations in dependent values within 2D and 3D data sets using SigmaPlot smoothing algorithms.
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SigmaPlot Worksheet



The SigmaPlot worksheet is capable of containing data up to 32,000,000 rows by 32,000 columns. Enter data in columns or rows, and perform calculations either rowwise or column-wise. Worksheet cells within columns are adjustable, and capable of holding up to 14 significant digits. Place labels, customized fill colors and patterns, and error bar direction codes into these cells in order to specify changes to graphs. Microsoft Excel



SigmaPlot uses automation communication standards to create and open Excel workbooks within SigmaPlot. This functionality enables you to run transforms, perform statistical tests, and graph data stored in Excel worksheets. Statistics



Descriptive statistics are available for all your worksheet columns. The Statistics Worksheet lists basic statistics for all worksheet columns. Display linear regression lines with confidence and prediction intervals, chart error bars for graphs of column means, and run paired and unpaired t-tests between worksheet columns. Use the Histogram feature to compute and plot distributions for datasets. Regression Wizard



The regression Wizard steps through curve fitting, plotting, and generating a report. Transforms



Modify and compute data using SigmaPlot’s comprehensive transform language. Drawing Tools



Change the font, size, and style of any text, and change the color, line type, thickness, and fill pattern of graphs and drawn objects with drawing tools.
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Reports



The SigmaPlot Report Editor displays regression results and features complete text editing functionality.



New Features in SigmaPlot New features in SigmaPlot include: „ Full integration with SigmaStat (see page 4). „ A new Notebook Manager (see page 5). „ Category data support (see page 5). „ The ability to import ODBC databases (see page 6). „ Improvements to the worksheet (see page 6). „ Improved symbols (see page 7). „ Equations on a graph page using the Regression Wizard (see page 7). „ Password protection of notebooks (see page 7). „ Improved histograms (see page 8). „ Column titles in Quick Transforms (see page 8). „ Multiple users can use SigmaPlot (see page 9).



Full Integration with SigmaStat If you have installed SigmaStat 3.1, all of its statistical tests are available to you on SigmaPlot’s Statistics menu. Included with SigmaStat are: „ The SigmaStat Advisor Wizard. Use this wizard to select the appropriate test for your



data. „ Automatic assumption checking. This ensures that you don’t violate the rules of the



test. „ Plain English reports. Interprets the results.
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„ Automatic result graph options. Use the graph options to generate the appropriate



analytical display.



New Notebook Manager Use the new browser-style Notebook Manager to quickly navigate between worksheets, graphs and reports in multiple notebooks. Using the Notebook Manager, you can: „ Organize multiple notebooks and notebook objects using one "explorer-like"



control. „ Avoid the hunt and peck of calling up multiple windows to find the graph or



worksheet you want to view. „ Drag and drop the notebook to any position on the screen to optimize your viewing



space. For more information, see “Sizing and Docking the Notebook Manager” in Chapter 2. „ One click can hide and show all notebooks to optimize your viewing space.



For more information, see “Notebook Manager Overview” in Chapter 2.



Category Data Support Use new category data formats in the Graph Wizard to compare groups in graphs. With these new formats, now you can: „ Use the new By Category data format option in the Graph Wizard for 2D scatter



and line plots. „ Use category data (also known as "indexed" or "grouped" data) for groups. You can



choose X, Y, and category variables. The category variable groups are distinguished from each other by color, symbol, line type, and so on, just like data columns are currently. „ Compare groups without reformatting your data into column based groups.



For more information, see “Plotting Category and Grouped Data” in Chapter 6.
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ODBC Import You can import your ODBC compliant database into SigmaPlot. You can: „ Import data from any ODBC compliant database, then specify tables and variables



to import or use SQL statements to import your data. „ Use with category data formats.



Worksheet Improvements The improved data worksheet offers you more control. With the new worksheet, you can: „ Apply column defaults to format empty cells to avoid repetitive formatting steps.



For more information, see “Formatting Worksheets” in Chapter 3. „ Duplicate titles in columns and rows. For more information, see “Setting



Worksheet Display Options” in Chapter 3. „ Preview worksheets before printing. For more information, see “Previewing



Worksheets” in Chapter 3. „ Use multiple undo. For more information, see “Setting Worksheet Display



Options” in Chapter 3. „ Use freeze panes, like spreadsheets, to reference row or columns. For more



information, see “Freezing Panes” in Chapter 3. „ Use the new Find and Replace dialog box to quickly locate or edit a particular



value. „ Use the new arrow keys which now function like the arrow keys in MS Excel 2000.



For more information, see “Moving Around the Worksheet” in Chapter 3. „ Wrap text automatically to fit the column width using multiple line text cell



formats. For more information, see “Formatting Worksheets” in Chapter 3. „ Use better date and time recognition with more and editable date and time formats.



For more information, see “Changing Date and Time Display” in Chapter 3.
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Improved Symbols and Lines Use more symbols and lines to create stunning charts and slides. Improvements include: „ Over 30 additional symbols, including new half-filled symbol options to better



differentiate multiple groups in grayscale or two-color journal papers. „ New symbols, available in the Graph Properties dialog box, and on the Page



toolbar. „ A new symbol rotation parameter in worksheet graphic cells, which you can use to



rotate the symbol display. The new symbols are scalable vector types including half-filled. They work in 3D as well as 2D. Note: These symbols are 2D only, and not 3D. PDF and HTML Export for Reports „ Export graphs and reports in PDF format, so you can email colleagues, or print in



high resolution. „ Export reports in HTLM, then post on the Web.



Equations on a Graph Page Automatically place on the graph page the equation used for a curve fit when using the Regression wizard. For more information, see “Using the Regression Wizard” in Chapter 18.



Security: Password Protection of Notebooks To ensure security of notebook contents, you can lock notebooks using a password. Also, because the Windows logon ID is stored in the notebook, you can track who made the last changes to it. For more information, see “Protecting Notebooks” in Chapter 2.
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Improved Histograms „ Quickly create histograms that characterize your distribution. „ Visualize your distribution, with automatic binning and axis labels that accurately



reflect the data range. „ Quickly confirm normality assumptions.



More Statistical Options in the Regression Wizard Now with more statistical options available in the Regression Wizard, you can: „ Set assumption checking using residuals. Select the Assumption Checking tab



from the options dialog to view the Normality, Constant Variance, and DurbinWatson options. These options test your data for its suitability for regression analysis by checking three assumptions that a nonlinear regression makes about the data. „ Display predicted values for the dependent variable and save them to the



worksheet. „ Specify the residuals to display and save them to the worksheet. „ Display confidence intervals and save them to the worksheet. „ Display the PRESS prediction error. „ Display standardized regression coefficients. „ Specify tests to identify outlying or influential data points. „ Specify tests to identify potential difficulties with the regression parameter



estimates (multicollinearity). „ Display the power. These options are similar to SigmaStat’s nonlinear regression



options.



Column Titles in Quick Transforms Now you can use transforms that you create in the Quick Transforms dialog box as column titles. For more information, see “Performing Quick Transforms” in Chapter 15.
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Changes to the Transform Language The functions x25, x50, and x75 now use linear interpolation for finding the independent variable value. These functions are sometimes used to obtain starting parameter values for fit models in the Regression Wizard.



Multiple SigmaPlot Users After a SigmaPlot administrator installs Sigmaplot, all users on that machine can use SigmaPlot regardless of user privileges. Each user can have his or her own user files and SigmaPlot settings. This is useful in a lab where many people use one machine. For more information, see “Where Files Go” page 11.
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Installing SigmaPlot Install SigmaPlot on your computer from the CD. The installation program automatically starts up when the CD is placed in the CD-ROM drive. The dialog boxes that guide you through the installation process are simple and self-explanatory. Note: In order to accomplish your installation, you will need to have your product registration number available.



System Requirements SigmaPlot .0 runs under the following systems: „ Windows 95 „ Windows 98 „ Windows 2000 „ Windows NT 4.0 „ Windows XP



Excel Workbooks:



Excel for Office 2000, 97, and 95 takes full advantage of SigmaPlot’s functionality. Import excel workbooks into SigmaPlot. Hardware:



Minimum requirements are 486 with 32 MB of RAM.



Serial Numbers This unique serial number is located on the CD cover. Have this number available when you call for product support, payment, or system upgrade. Copy this number to the registration card and send it in to Systat Software, Inc.. Registration entitles you to: „ Unlimited technical support. „ System upgrades.
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Where Files Go SigmaPlot is installed for all users that have user accounts on a machine. It installs its program files into a Program Folder - these are necessary for the program to run - and then creates files in User Folders for each user on a machine. This means that two or more separate users can share SigmaPlot using his or her own set of SigmaPlot files and settings. When someone uses SigmaPlot for the first time, it creates a User Folder just for that person. In this way, many people can use the same version of SigmaPlot without risking damage to others’ files. When SigmaPlot starts, it checks to see if a user folder exists for the current user. The User Folder is either in: „ C:\Documents and Settings\user\My Documents\SigmaPlot\SPW9 for



SigmaPlot, or „ C:\Documents and Settings\user\My Documents\SigmaStat\Stat3 for



SigmaStat. If the User Folder does not exist, SigmaPlot creates the folder and copies user files from the Program Files folder (see below) to the User Folder. The user files for SigmaPlot include: „ Gallery.jgg. This is the Graph Gallery file including any user-defined graph styles. „ GraphWizard.ini. This file stores all Graph Wizard settings. „ HistogramWizard.ini. This file stores Histogram Wizard settings. „ SPW.ini. This file stores all SigmaPlot user’s settings. „ Layout.jnt. This notebook file is the the layout file used when formatting or



arranging graphs. „ SigmaPlot Macro Library.jnt. This notebook file contains the Standard Macro



Library and user-defined macros. „ Standard.jfl. This is Standard Equations Library includes all user-defined



equations. „ Template.jnt. This notebook file is where all the page templates are stored.
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Similarly, when SigmaStat starts for a new user, it copies user files to the Stat3 user folder: „ Stat32.ini „ Stat32.opt „ GraphWzd.ini „ Samples.snb



During installation, SigmaPlot by default installs the following directories and files into C:\Program Files\SigmaPlot\SPW9. The installed files include spw.exe, all the Help files, .dll files, .pdf manuals, and the following sub-folders: „ FAQs directory. This directory contains all the .html and graphics files used in the



SigmaPlot FAQs. For more information, see “SigmaPlot FAQs” page 27. „ Macro Transforms directory. This directory contains the .xfm files used for the



macros Frequency Plot, Power Spectral Density, Rank and Percentile, and Vector Plot. „ Samples directory. This directory includes sample graphs and data. „ Transforms directory. This directory contains sample transforms.



SigmaPlot Basics SigmaPlot runs under the Windows operating system and functions within the standard Windows interface. For information on how Windows works, refer to your Windows documentation.
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Figure 1-1 The SigmaPlot Desktop



Using Toolbars Toolbars contain buttons for the most commonly used commands. Figure 1-2 Standard Toolbar Figure 0–1 Standard Toolbar Open



New Save Notebook



Print



Copy



Cut



Redo



Paste Undo



New Excel Worksheet



New Worksheet



New Graph Page



View Data
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View Graph Statistics Wizard



Graph Properties



Custom Zoom
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Stop refresh



Help



Refresh
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Figure 1-3 Formatting Toolbar
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Bold
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Line Spacing



Color



Figure 1-4 2D Toolbar Line Plot



Scatter Plot



Ternary Plot



Area Plot



Line/Scatter Plot



Polar Plot



Figure 1-5 3D Graph Toolbar 3D Scatter Plot



Contour Plot



3D Mesh Plot



3D Line Plot



3D Bar Chart



Horizontal Bar Chart



Vertical Bar Chart



Pie Chart



Box Plot



Legend Symbol



Decrease Space
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Figure 1-6 The Page Toolbar parallels Graph Properties functionality.



Select Object



Text



Draw Line



Draw Arrow



Draw Box



Draw Ellipse



Line Properties



Fill Properties



Line Thickness



Line Ending



Symbol Fill Pattern Bring To Front Group Align



Fill Color Axis Scale Send To Back Ungroup Show/Hide Grids



Viewing Toolbars E On the View menu, click Toolbars. The Toolbars dialog box appears. E Select a toolbar to view. E Click OK.



Hiding Toolbars There are two ways to hide toolbars: „ Using a shortcut menu. „ Using the Toolbars dialog box.



To hide toolbars using the shortcut menu: E Right-click the toolbar.
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E On the shortcut menu, click Hide.



To hide toolbars using the Toolbars dialog box: E On the View menu, click Toolbars. The Toolbars dialog box appears. E Clear the Toolbar you want to hide. E Click OK.



Changing Toolbar Button Appearance The Large Buttons check box increases the size of Standard, Drawing, Properties, and Arranging toolbar buttons. The Color Buttons check box displays color toolbar buttons on your screen, rather than monochrome. The Show Tool Tips check box hides the toolbar help tags that appear as you drag the mouse over the toolbar.



Positioning Toolbars You can move a toolbar from its default position to anywhere in the screen, and you can change its from horizontal to vertical. To position a toolbar: E Drag the move bar on a docked handle or drag the title bar on a floating tolbar to move



it to another location.



Setting Program Options Use SigmaPlot’s program options to control application settings, as well as how worksheets and new pages and graphs will appear. To change program options: E On the Tools menu, click Options. The Options dialog box appears. E Choose the appropriate tab and make changes.
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Worksheet. Worksheet options include settings for numbers, statistics, date and time, worksheet display, default column width, number of decimal places, and use of engineering notation. Page. Page options control graph page properties. General. The General tab controls application settings. Report. Set report options, such as measurement units or to display rulers, on the



Reports tab. Graph. Graph defaults control attributes that are applied to all new graphs, including: Macro. Select macro options, such as code colors and which macro library to use on



the Macro tab. E Click OK to apply the changes and close the dialog box.



Undoing Mistakes E On the Standard Toolbar, click the Undo button.



If you later decide that you didn’t want to perform an undo, click the Redo button. These commands also appear on the Edit menu, or you can click Ctrl+Z to undo, or Ctrl+Y to redo. You can perform multiple instances of Undo or Redo.



Anatomy of SigmaPlot Gfraphs A SigmaPlot graph consists of one or more plots of data, and one or more sets of axes. It uses a specific coordinate system (e.g., 2D Cartesian, 3D Cartesian, pie, or polar) and has a specific size and location on the page.
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Plots are graphical representations of worksheet data. For example, view data as a vertical bar chart or change the plot to a horizontal bar chart, even after creating the graph. You can even display more than one plot on most graphs. Axes are the scales that determine position of the graph’s data points. Each axis contains tick marks that indicate the type of scale used. Scales range from linear to nonlinear within a Cartesian coordinate system. Customize tick mark labels with worksheet cells or use numeric or time series labels. The X, Y, and for 3D graphs, Z coordinates, are indicated on each axis by tick marks. An axis can use a linear numeric scale, nonlinear scales such as log, natural log, and probability, or a date/time scale. 2D graphs can have multiple sets of X and Y axes. The axes’ tick marks and tick labels, can be numeric, time series, or customized with worksheet column labels.



2D Cartesian Graph The following figures show a examples of 2D Cartesian graphs available in SigmaPlot... 5th and 95th percentiles displayed as symbols 30



Variable box widths can be used to express another variable dimension



Box Widths = Final Population



Lifespan (weeks)



25



Tukey box plot with mean value lines



20



15



10



5



Shaded graph backplane with Y axis grid lines



0 SP1



DL5



HX12



IND7



Diet



Tick mark direction pointing out



X axis tick labels using a category axis scale.
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Graph Title



Scatter plot of column averaged data points, with Y error bars computed from the standard deviations



Population Growth with and without Inhibitor Top X axis with tick marks turned off



6



Y axis with a linear axis scale K1



Left Y axis title



Population (colonies)



5



Left Y axis with major tick marks



Reference line



4



K2



3



Automatically generated legend



2 Without Inhibitor



Spline line plot of data generated with the nonlinear curve fitter



1



With Inhibitor



0 0



2



4



6



8



10



12



Right Y axis with tick marks turned off



Time (hours)



Numeric major tick labels



X axis with a linear axis scale



103



Scatter plot of color gradient filled symbols using a point plot style



102



Counts per Area



Common log scale Y axis with major and minor tick marks



Bottom X axis title



99% confidence and predicted interval linear regression lines



101 Counts 1st Order Regression 95% Confidence Interval 95% Prediction Interval



Base and exponent log axis tick labels 100 January



April



July



1996



October



January



True Date and Time axis scale, displaying months and weeks
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Image art cut from a paint program and pasted onto the page using the Windows Clipboard Post break tick interval set to a new value



1200



Y axis break at 75% along the axis length



400



800



240 Number of Individuals



Error bars using worksheet column data Bar fill colors use a pattern from a worksheet column



Legend symbols and text labels Grouped bar chart with specified bar and group widths



200 monospecies



160



with competition



120 80 40 0 1 months



3 months



5 months



7 months



X axis tick labels using text from a worksheet column



9 months



11 months
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Polar Plot Example Use Polar plots to display modular data such as average monthly temperatures, or satellite positioning in the sky over a period of time. Average Monthly Temperatures April March May



Up to four radial axes can be displayed and the angles and lengths modified



120



February 100 80 60



June



40



Major grid lines for the radial axis, and minor grid lines for the angular axis are shown



20 0



The outer and inner angular axis can be made larger or smaller in diameter



January 0 20



July



40 60 80



November



100



Monthly series labeling



120 August October September



Tropics Forest Plains Desert
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Contour Plot Example Use 2D Contour Plots to graph three dimensional data in two dimensions. The following example includes: „ Major and minor contour lines „ Contour labels



A contour plot displaying major and minor



Minor contour l ines drawn in a different color



Major contour labels
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3D Cartesian Graph Examples 3D Cartesian Graphs include scatter, 3D trajectory and waterfall plots, mesh plots, and bar charts. The following figures contain examples of these plots, as well as some additional 3D features.



Incremented bar fill colors 3D grid lines



Shaded back planes



Waterfall Plot Example 3D waterfall plots are stacked line plots along the Y axis of a 3D line plot. Because hidden lines are eliminated, waterfall plots are useful for showing trends of line plots. The following example includes: „ Incremented line fill color „ Eliminated "hidden" lines
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Overlapping and transparent meshes Z axis drawn at left side



Grid lines at major tick intervals



Light source shading Mesh plot with colored fills and lines



Y axis drawn at front bottom



Axes automatically move to the front view at any rotation



3D graph view can be displayed at any horizontal and vertical rotation



X axis drawn at front bottom



Front view frame lines



Scatter plot with drop lines



3D graphs can be displayed with varying perspectives (depth)
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Line fill color is incremented
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Area Plot Example Area plots are 2D line plots with regions below or between curves filled with a color or pattern. Most commonly, an area plot is a line plot with shading that descends to the axis. You can add shade below a curve and shade in different directions. You can also identify intersecting sections. This example consists of two plots, and includes: „ A simple bar chart using hairline bars. „ A multiple area plot using the X many Y data format.



Average Daily Temperature Range and Precipitation, Oakland CA



A Multiple Area Plot
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SigmaPlot Help SigmaPlot’s online help uses new HTML online Help. View the HTML Help using Microsoft Internet Explorer version 4.0 or higher.



SigmaPlot FAQs Some of SigmaPlot’s most frequently asked questions (and answers) are available on the Help menu. The SigmaPlot FAQ includes helpful tips and work-arounds. To view the SigmaPlot FAQs: E On the Help menu, click SigmaPlot FAQs.



Customer Service If you have any questions concerning your shipment or account, contact your local office. For more information, see “Contacting Systat Software, Inc.” below. Please have your serial number ready for identification when calling.



Training Seminars Systat Software, Inc. provides both public and onsite training seminars for Systat Software, Inc. products. All seminars feature hands-on workshops. Systat seminars will be offered in major U.S. and European cities on a regular basis. For more information, see “Contacting Systat Software, Inc.” below.



Tell Us Your Thoughts Your comments are important. Please send us a letter and let us know about new and interesting applications using Systat products. Write to Systat Software, Inc. Marketing Department, 501 Canal Blvd, Suite C, Richmond, CA 94804.
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Getting Technical Support The services of Systat Technical Support are available to registered customers. Customers may call Technical Support for assistance in using Systat products or for installation help for one of the supported hardware environments. To reach Technical Support, see the Systat home page on the World Wide Web at http://www.systat.com, or contact us: In the U.S.: Telephone: (510)-231-4780 (8:00 A.M. to 5:00 P.M. Pacific Time) Fax: (510) 412-2909 E-mail: [email protected] Mail: 501 Canal Blvd., Suite C Richmond, CA 94804 In Europe: Telephone: 49 2104 / 95480 Fax: 49 2104 / 95410 Email: [email protected]



Contacting Systat Software, Inc. If you would like to be on our mailing list, contact one of our offices or distributors below. We will send you a copy of our newsletter and let you know about Systat Software, Inc. activities in your area. In the U.S.:



Systat Software, Inc. 510 Canal Blvd. Suite C Richmond, CA 94804 Tel: 866.797.8288
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Fax: 510.231.4789



http://www.systat.com Outside the U.S.:



Systat Software, Inc. GmbH Schimmelbuschstrasse 25 40699 Erkrath, Germany Tel: +49.2104.9540 Fax: 49.2104.95410



Or contact the distributor nearest you: http://www.systat.com



References We have found the following references very useful for graph design and layout. M. Brent Charland, Ph.D. 1995. SigmaPlot for Scientists. Wm. C. Brown Communications, Inc., 2460 Kerper Boulevard, Dubuque, Iowa, 52001. Cleveland, William S. 1985. The Elements of Graphing Data. Monterey, Calif.: Wadsworth, Inc. (408) 373-0728. Kosslyn, Stephen M. 1994. Elements of Graph Design. New York: W.H. Freeman and Company. Tufte, Edward R. 1983. The Visual Display of Quantitative Information. Cheshire, Conn.: Graphics Press. Available from Science News Books, 1719 N. St. NW, Washington, D.C. 20036. Scientific Illustration Committee of the Council of Biology Editors. 1988. Illustrating Science: Standards for Publication. Bethesda, Maryland: Council of Biology Editors, Inc.
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2 Notebook Manager Basics SigmaPlot notebook files contains all of your SigmaPlot data and graphs, and are organized within the SigmaPlot Notebook Manager. This chapter covers: „ Notebook Manager organization (see page 31). „ Saving your work (see page 36). „ Creating notebooks and adding notebook items (see page 38). „ Opening notebooks and notebook items (see page 40). „ Copying, pasting, and deleting notebook items (see page 42).



Notebook Manager Overview When you first start SigmaPlot, and empty worksheet appears along with the Notebook Manager. The Notebook Manager is a dockable or floating window that displays all open notebooks. The first time you see the Notebook Manager, it appears with one open notebook, which contains one section. That section contains one empty worksheet. Contents of the Notebook Manager appear as a tree structure, similar to Windows Explorer.
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Figure 2-1 The Notebook Manager Window



Each open notebook appears as the top level, with one or more sections at the second level, and one or more items at the third level. Within each section you can create one worksheet and an unlimited number of graph pages, reports, equations, and macros. The most recently opened notebook file appears at the top of the Notebook Manager.
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Figure 2-2 The Notebook Manager in a Docked Position



Modified Notebook Names



An asterisk next to an item in the Notebook Manager indicates that the item has been modified since the last time you saved the notebook. Notebook Item Names



The default startup notebook is named Notebook1. It contains one notebook section, Section 1, and one worksheet, Data 1. When you save your notebook file, the name of the file appears at the top of the Notebook Manager window. Notebook files use a (.jnb) extension. The default names given to notebook sections and items are, Section (number), Data (number) or Excel (number), and Report (number). Regression equations are named when they are created. New items are numbered sequentially.
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Opening and Closing Notebooks in the Notebook Manager You can open as many notebooks as you like. All opened notebooks appear in the Notebook Manager. You can navigate through the different open notebooks by selecting them in the Notebook Manager. You can hide them by clicking the Close button on the upper right-hand corner of the Notebook window; however, this does not close the item. It only hides it from view. To close notebook, use the File menu. To open a notebook: E From the File menu, click Open. The Open dialog box appears. E Select a notebook (.jnb) file from the list, and click Open. The notebook appears in the



Notebook Manager. To close a notebook: E Select the notebook to close in the Notebook Manager. E Right-click, and from the shortcut menu, click Close Notebook.



You can also choose Close Notebook from the File menu.



Sizing and Docking the Notebook Manager The Notebook Manager can appear in six states: „ Docked with summary information in view. „ Docked with summary information hidden. „ Floating with summary information in view. „ Floating with summary information hidden. „ Docked and collapsed. „ Hidden. E To undock the Notebook Manager, double-click the title bar and drag it to the desired



location.
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E To dock the Notebook Manager and move it back to its original position, double-click the



title bar again. E To view summary information, click Show summary information. To hide it, click Hide



summary information. Figure 2-3 The Notebook Manager Displaying Summary Information



E To collapse the Notebook Manager, click the arrow button on the top right-hand corner



of the Notebook Manager when docked. To view again, click the graph icon. E To drag and drop the Notebook manager, click the title bar and drag the Notebook



Manager anywhere on the SigmaPlot desktop.
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Saving Your Work Be sure to save your work at regular intervals. To save a notebook file for the first time: E Click the Save button. The Save As dialog box appears. E Navigate to the directory where you want to save your notebook. E Type a name for the notebook in the File Name text box. E Click Save to save the notebook file and close the Save As dialog box.



To save changes with the same name and path: E Click the Save button on the Standard toolbar. Your file is saved.



To save to a new name and path: E On the File menu, click Save As. The Save As dialog box appears. E Navigate to the directory where you want to save your notebook. E Type a name for the notebook in the File Name text box. E Click Save to save the notebook file and close the Save As dialog box.



Printing Selected Notebook Items You can print active worksheets, graph pages, reports, and selected notebook items by clicking the Print button on the Standard toolbar. You can print individual or multiple items from the notebook, including entire sections.
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To print one or more items or sections from the notebook: E Select one or more items or sections from the notebook. E Click the Print button on the Standard toolbar to print the worksheet using all the



default settings. To set printing options before printing a report, graph page, or worksheet: E Open each item. E Press Ctrl+P. The Print dialog box appears. E Click Properties.



Protecting Notebooks To ensure security of notebook contents, you can lock notebooks using a password. This is particularly useful if two or more users are using the same version of SigmaPlot. You can also use a password to send confidential data to other SigmaPlot users.



Setting a Password To set a password: E Select the notebook in the Notebook Manager. E On the Tools menu, click Password. The Set Password dialog box appears. E In the New Password box, type a password. E In the Reconfirm box, type the password again. E Click OK.
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Changing or Removing a Password To change or remove a password: E Select the notebook in the Notebook Manager. E On the Tools menu, click Password. The Set Password dialog box appears. E In the Old Password box, type the old password. E In the New Password box, type a new password.



If you want to remove this password, leave this box, and the Reconfirm box, empty. E In the Reconfirm box, type the password again. E Click OK.



Working with Sections in the Notebook Manager Notebook sections are place-holders in the notebook. They contain notebook items, but no data. However, you can name, open, and close notebook sections. You can create as many new sections as you want in a notebook. You may also create reports within each section to document the items in each section. To expand or collapse a section, double-click the section icon or click the (+) or (-) symbol.



Creating New Items in the Notebook Manager Using the right-click shortcut menu, you can create new sections and items in the Notebook Manager, such as: „ Worksheets „ Excel Worksheets „ Graph pages „ Reports
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„ Equations „ Sections „ Macros



To create a new section or item: E Right-click anywhere in the Notebook Manager that you want the new section or item



to appear. E On the shortcut menu click New, and then select the item to create. The new section or



item appears in the Notebook Manager.



Copying and Pasting to Create New Sections Another method to create a new notebook section is to copy and paste a section in the notebook window. Whenever you copy and paste a section, its contents appear at the bottom of the notebook window. SigmaPlot names and numbers the section automatically. For example, if you copy notebook Section 3, the new section is named Copy of Section 3. Copied sections create copies of all items within that section as well.



Renaming Notebook Files and Items You can change summary information for all notebook files and items. To change summary information: E If the summary information is hidden on the Notebook Manager, click View summary



information. E Select the notebook item and edit as appropriate.
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In-place Editing Section and Item Names You can change the name of a notebook section or item in the notebook itself without opening the Summary Information dialog box. To in-place edit: E In the Notebook Manager, click the section or item you want to rename. E Click it a second time. E Type the new name. E Press Enter. The new section or item name appears.



Note: To change the name of the notebook, use the Save As dialog box.For more information, see “Saving Your Work ” above.



Copying a Page to a Section with No Worksheet If you copy a graph page into an empty section or a section that has no worksheet, you create an independent page. The independent page retains all its plotted data without the worksheet. You can store the pages from several different sections that have different data together this way. However, if you ever create or paste a worksheet into a section, all independent pages will revert to plotting the data from the new worksheet. Use independent pages as templates, or to draw or store objects. You cannot create graphs for an independent page until it is associated with a worksheet (and no longer independent).



Opening Files in the Notebook Manager You can open SigmaPlot files and other types of files as SigmaPlot notebooks. To open a notebook file that is stored on a disk: E Click the Open button on the Standard toolbar. The Open dialog box appears.
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Figure 2-4 Open Dialog Box



E Choose the appropriate drive and directory of the notebook file to open. E Double-click the desired notebook file. E If you want to open another type of file, choose the type of file from the Files of type list. E Click Open. The opened notebook appears in the Notebook Manager.



Opening Worksheets, Reports, and Pages You can open a worksheet, report, or page by double-clicking its icon in the Notebook Manager. You can also right-click the item, and on the shortcut menu, click Open. Open worksheets, pages and report appear in their own window, and in the notebook as a colored icons. Double-clicking an item that is already open brings the item’s window to the front.
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Opening Multiple Items



You can open as many items as your system’s memory allows. You can open multiple items from multiple notebooks. The selected item appears highlighted in the Notebook Manager.



Copying and Pasting Items in the Notebook Manager You can copy and paste items from one open notebook file to another in the Notebook Manager; however, you cannot copy a worksheet into a notebook section that already contains a worksheet. Copying and pasting pages and worksheets between sections results in using graph pages as templates. For more information, see “Using Graph Pages as Templates” in Chapter 5. To copy and paste a notebook item: E Right-click the item in the Notebook Manager that you want to copy, and on the



shortcut menu, click Copy. E Right-click the section where you want to paste the item, and on the shortcut menu,



click Paste. The selected item is pasted to the current notebook and section.



Deleting Items in the Notebook Manager To delete an item from the Notebook Manager: E Select the item and press Delete. The item is deleted.



Items removed from a notebook file using the Delete button are removed permanently.
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3 Worksheet Basics Worksheets are the containers for the data you analyze and graph. They are spreadsheet-like in appearance but are limited in function, and are column rather than cell oriented. Type in, paste, or import data from other sources. You can also automatically generate and place data in worksheet columns by data transforms and statistical procedures. This chapter covers: „ Setting worksheet display options (see page 44). „ Moving around the worksheet (see page 46). „ Entering data (see page 47). „ Importing files from other applications (see page 49). „ Exporting worksheets (see page 61). „ Viewing worksheet statistics (see page 62). „ Displaying worksheet data (see page 67). „ Formatting worksheets (see page 78). „ Cutting, copying, pasting, moving, and deleting data (see page 81). „ Entering and promoting column and row titles (see page 85). „ Removing outliers and other data (see page 90). „ Using Excel Workbooks in SigmaPlot (see page 93). „ Printing worksheets (see page 99).



Using the Worksheet Shortcut Menu In addition to the menu commands and toolbar buttons, right-clicking the worksheet displays a shortcut menu. The commands on the right-click shortcut menu are the same as the Edit menu, including the Cut, Copy, Paste, Delete, Transpose Paste, Insert
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Cells, and Delete Cells commands. The Edit menu also includes the Go To and Find and Replace Commands. Figure 3-1 Right-click Edit Worksheet Menu



Setting Worksheet Display Options Use the Options dialog box to set the default display settings for worksheets. Note: You can also change individual cells or blocks of cells using the Format Cells dialog box. These custom formats remain even after editing options in the Options dialog box. For more information, see “Formatting Worksheets” see page 78. To set worksheet display options: E On the Tools menu, click Options. The Options dialog box appears. E Click the Worksheet tab. For more information, see “Displaying Worksheet Data” on



page 67. Options include: „ General. Select to turn Worksheet undo on or off, or to set SigmaPlot to display an



error message if duplicate column titles appear when running transforms. Turn
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Worksheet undo off if you are using a large data set and have a small amount of



memory. „ Numeric. Select to control how many decimal places you want to appear in the



worksheet, or if you want to use E notation. For more information, see “Changing Numbers Display” on page 71. „ Date and Time. Select to set the display for the specified columns. For more



information, see “Changing Date and Time Display” on page 73. „ Statistics. Use the Show and Hide buttons to move the statistics between the



Shown and Not Shown lists. These buttons are available only if a Statistics worksheet is in focus. For more information, see “Statistics Options” on page 65. „ Appearance. Set column widths, row heights, color and thickness of the worksheet



grid lines, adjust data feedback colors, and select a font style and size. For more information, see “Displaying Worksheet Data” on page 67. Figure 3-2 The Options Dialog Box Worksheet Tab Data and Time Options Freezing Panes
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You canfreeze panes to keep rows and columns visible as you scroll through the worksheet. To freeze panes: E Select a cell below and to the right of where you want the split to appear. E On the Window menu, click Freeze Pane.



Moving Around the Worksheet You can move around the worksheet using scroll bars or, move the highlighted worksheet cursor with the keyboard. Function



Keystroke



Move one column right/left Move one row up/down Move one window view up/down Move to end of column Move to end of worksheet Move to top of column Move to column one, row one Move to last column of next data block Move to first column of previous data block Move to top row of previous data block Move to last row of last data block Put cells into Edit mode



→ or ← ↑ or ↓ Page Up or Page Down End End+End or Ctrl+End Home Home+Home or Ctrl+Home



Ctrl + → Ctrl + ← Ctrl + ↑ Ctrl + ↓ F2
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Going to a Cell You can move the worksheet cursor to any cell in the worksheet by specifying the column and row number in the Go to Cell dialog box. To go to a cell: E On the Edit menu, click Go To. The Go to Cell dialog box appears. Figure 3-3 Moving to a Specific in the Worksheet



E Enter the desired column and row number. To select the block of cells between the



current highlight location and the new cell, click Extend Selection to Cell. E Click OK to move to the new cell.



Entering Data into a SigmaPlot Worksheet This section describes entering data into SigmaPlot worksheet columns, and formatting the columns for numeric, label, or date and time display. To enter data in a SigmaPlot worksheet: E Place the cursor in a cell. E Type a number, label, or date and time value. E Press Enter to move down one row, or use the arrow keys to move around the



worksheet.



 48 Chapter 3



If you make a mistake entering data, click Undo on the Standard toolbar. For more information, see “Undoing Mistakes” in Chapter 1.



Entering Dates and Times Dates and times are entered using delimiters. The delimiters used are determined by the Windows Regional Settings. For more information, see “Setting Day Zero” on page 75. Date Delimiters:



The default date delimiter for most systems is a forward slash. An entry that displays only two fields of a date value is assumed to be day and month. If the second field’s value is greater than 31, months and years are assumed. Entries with two delimiters assume month/day/year. If you enter only two digits for the year, the century defined in your Regional Settings is implied. Time Delimiters:



The default time delimiter is usually a colon (:). Entries displaying two fields of a time value are assumed to be hours and minutes. If PM is not specified, hours less than 12 are assumed to be morning hours. An entry with two colons assumes hours:minutes:seconds.



Insertion and Overwrite Modes Press the Insert key or use the Edit menu Insertion Mode command to switch between overwrite and insert data entry modes. If in Insertion Mode, Ins appears in the status bar. A check mark next to the Insertion Mode command on the Edit menu also indicates that the worksheet is in insertion mode. If in Insertion Mode, new data entered in a cell does not erase the previous contents. Any existing data in the column is moved down one row. Pasting a block of cells pushes existing data down to make room for the pasted cells. If you cut or clear data, data below the deleted block moves up.
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If not in Insertion Mode, the worksheet is in overwrite mode. Data entered into a cell replaces any existing data. If you paste a block of data, the block overwrites existing data.



Importing Files from Other Applications You can import data from other applications into an existing worksheet for graphing, worksheet display, or running regressions. When you import data, it appears at the position of the worksheet cursor. You can import the following file types can into SigmaPlot worksheets: „ SPSS (.sav). For more information, see “SPSS (.SAV) ” on page 50. „ SigmaPlot 1.0 and 2.0 files (.spw). For more information, see “SigmaPlot,



SigmaStat, SigmaScan, and Mocha Worksheets ” on page 51. „ SigmaPlot Macintosh 4 Worksheet. „ SigmaPlot Macintosh 5 Worksheet. „ SigmaStat 1.0 files (.spw). „ SigmaPlot and SigmaStat DOS files (.spg, .sp5). „ TableCurve 2D and 3D files. „ Microsoft Excel files (.xls). For more information, see “MicroSoft Excel, Lotus 1-



2-3, Quattro, and dBase Files” on page 51. „ Lotus 1-2-3 files (.wks, .wk*). For more information, see “MicroSoft Excel, Lotus



1-2-3, Quattro, and dBase Files” on page 51. „ Quattro/DOS files (.wk*). For more information, see “MicroSoft Excel, Lotus 1-2-



3, Quattro, and dBase Files” on page 51. „ dBase files (.DBF). For more information, see “MicroSoft Excel, Lotus 1-2-3,



Quattro, and dBase Files” on page 51. „ Plain Text files (.txt, .prn, .dat, .asc). For more information, see “Importing Text



Files” on page 52. „ Comma Delimited files (.csv) „ SigmaScan. For more information, see “SigmaPlot, SigmaStat, SigmaScan, and



Mocha Worksheets ” on page 51. „ SigmaScanPro Worksheets. For more information, see “SigmaPlot, SigmaStat,



SigmaScan, and Mocha Worksheets ” on page 51.
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„ SigmaScan Image „ Mocha Worksheets. For more information, see “SigmaPlot, SigmaStat,



SigmaScan, and Mocha Worksheets ”on page 51. „ Axon Text and Binary formats. For more information, see “Importing Axon Files”



on page 54. „ Paradox (.db) „ Symphony (.wkl, .wri, .wrk, .wks) „ SYSTAT (.sys, .syd) „ Microsoft Access (.mdb)



When you import data from another application that is left-justified, SigmaPlot assumes it is text. To import data: E Place the cursor to the worksheet cell where you want the imported data to start. E On the File menu, click Import. The Import File dialog box appears. E Select the type of file you want to import from the Files of Type drop-down list. E Change the drive and directory as desired, select the file you want to read, then click



Import, or double-click the file name. Depending on the type of file, the data is either



imported immediately, or another dialog box appears.



SPSS (.SAV) If you are importing SPSS (.sav) files, the Import Worksheet dialog box appears prompting you to select variables to import. To select variables to import: E In the Unselected Variables list, select a variable you want to import. E Click the single > arrow to move that variable to the Selected Variables list.
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E Click the double >> arrow to move the entire contents of the Unselected Variables list



to the Selected Variables list. E Click Import to place the data in the SigmaPlot worksheet.



Note: SPSS data files use category data as the default data format. For more information, see “Plotting Category and Grouped Data” in Chapter 6.



SigmaPlot, SigmaStat, SigmaScan, and Mocha Worksheets If you are importing a SigmaPlot, SigmaStat, SigmaScan, or Mocha file, a dialog box appears prompting you to select a range of data to import. E Select the range of data by specifying the start and end of the range; the default is the



entire range. E Click Import to place the data in the SigmaPlot worksheet.



MicroSoft Excel, Lotus 1-2-3, Quattro, and dBase Files To import a spreadsheet or dBase file: E On the File menu, click Import, and then click File. The Import File dialog box appears. E Select an .xls file to import, and click OK. Figure 3-4 Import Spreadsheet Dialog Box
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E Select either the entire spreadsheet or a specified range of cells. Specify cells using the



standard 1-2-3 notation (e.g. A1:C50 for a range from cell a1 to cell c50). For dBase files, cell letters correspond to fields. E When you have finished specifying the range to import, click Import. The selected data



is imported. Note: The dialog box indicates whether or not the worksheet is in overwrite or insert mode, and where the imported data will begin. E To import spreadsheet data from non-compatible programs, save the spreadsheet as either



a Lotus or text file, then import that file. You can only import top sheet of an Excel workbook. If you attempt to import another worksheet, you will receive a warning message. If you want to move data from other sheets, use Copy and Paste. If you want to use an Excel workbook as an actual Excel workbook within SigmaPlot, you must open the workbook instead of importing it. Importing places the Excel data into a SigmaPlot worksheet, and does not open the workbook as an actual Excel workbook. For more information, see “Using Excel Workbooks in SigmaPlot” on page 93.



Importing Text Files If you are importing a text file, the Import Text dialog box appears. Use this dialog box to view the text file and to specify other delimiter types, or to build a model of the data file according to custom column widths.
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Figure 3-5 Import Text Dialog Box



Note: A quicker method of importing text is copying the data in your source application, then opening SigmaPlot and pasting the data. E To specify a different column separator, select Delimiter to activate the delimiter



options; then select the appropriate type. You can select commas, hyphens, or any other characters. For example, many databases use semicolons (;) as delimiters. E To specify a model of the data, use dashes (-) to specify column widths, and bracket



characters [ and ] to define the column edges. Use a vertical bar | character to indicate a single-character width column. Click Analyze to re-display the appearance of the file using the new model. E To save text import formats, enter a name into the Format scheme box, then click Add.



Delete unwanted import formats using the Remove button. E To specify a different range, enter the rows and columns to read, then click Analyze.



You can use this feature to eliminate file headers and other undesired text.
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E When you are finished specifying the file parameters, click Import. The specified data



from the file is imported.



Importing Axon Files SigmaPlot can import data files produced by Axon Instruments, Inc. laboratory equipment and data acquisition programs. SigmaPlot imports both text and binary data files; if you select one of these options, the Import Axon dialog box appears prompting you to select a range of data to import. The File selected is indicated in the dialog box title. Select the range of data by specifying the Row and Column ranges; the default is the entire range. Click Import to place the data in the SigmaPlot worksheet. Figure 3-6 Import Axon File Dialog Box



Importing ODBC Databases You can import ODBC compliant databases into SigmaPlot. To import a database, first define an ODBC Data Source. After defining the data source, you can either then import tables or import using SQL (structured query language). Note: For more information on SQL, see the many sources and tutorials available on the Internet. To define the ODBC data source: E On the File menu, click Import, and then click Database. The ODBC Options dialog



box appears.
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Figure 3-7 Selecting the ODBC Data Source



E Click the ODBC Data Source tab. The User and System Data Sources list contains



all defined the ODBC data sources. E To add a data source that is not on the list, click Add. The ODBC Data Source



Administrator dialog box appears.
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Figure 3-8 Adding a Data Source



Tip: Click Help to learn more about the ODBC Data Source Administrator’s use. E Click the User DSN tab. E Select a name from the User Data Sources list. E Click Add. The Create New Data Source dialog box appears.
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Figure 3-9 Creating a New Data Source



E Select a driver for which you want to set up a data source from the Name list, and click



Finish.



An ODBC Setup dialog box specific to the driver you selected for the data source appears. E Enter a name to identify the new data source.
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Figure 3-10 Identifying the Data Source



E Click Select. The Select Database dialog box appears. E Select the database, and click OK. E Click OK again to close the ODBC Microsoft Access Setup dialog box. E Click OK in the ODBC Data Source Administrator. E Click OK in the ODBC Options dialog box. E If the data source already appears in the User and System Sources drop down-list, select



it. The Import Table dialog box appears.
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Figure 3-11 Importing Fields from a Table



E In the Import Table dialog box, select a table from the Select Table/Query drop-down



list. E Select fields in the table by moving fields from Unselected fields to Selected fields



by double-clicking a selection in the list. You can also click << and >> to move all the selections, or < and > to move them individually. E Click Import to import the fields into the worksheet. Field names in the database



become column headings in the worksheet. All records in the table are imported.
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Figure 3-12 Data that has been Imported into a Worksheet



E To import using SQL, on the ODBC Options dialog box click the SQL Query tab. Figure 3-13 Setting ODBC Options



E Under Recently Used SQL, type the name of the path where the SQL is stored, or



select a recently used SQL (SigmaPlot Query) from the drop-down list. E Click Open to open an .spq file. E Click Import to run the query and import the data.
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„ If the SQL is valid, SigmaPlot imports that data into the worksheet based on the



SQL statement. Field names in the database become column headings in the worksheet. Only the records defined by the SQL (rows) are imported. „ If the SQL is invalid, you are prompted to correct the SQL.



Exporting Worksheet Data Exporting worksheets does not export associated graphs. To export the worksheet and the graph, export the graph page to a SigmaPlot Graph (.spw) file. You can only export the entire SigmaPlot Worksheet. If you want to export a portion of the worksheet, delete the portion you do not want to export, then export the remainder of the worksheet. When you export a SigmaPlot worksheet as a text file, tabs or commas separate the data columns and data is saved at full precision. If you want to save a text file with data as it appears in the worksheet rather than at full precision, copy the selected data to the Clipboard, paste it into a text editor, and save it as a text file. To export a SigmaPlot worksheet: E Select the worksheet you want to export by opening and viewing it, or selecting it in



the notebook window. E On the File menu, click Export. The Export File dialog box appears. E Select a file format from theFiles of type drop-down list , and then enter the file name,



directory, and drive for the exported file. E Click Export to create the file.



Exporting Worksheets as Text Files When you export a SigmaPlot worksheet as a text file, tabs or commas are used to separate data columns and data is saved at full precision.
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If you want to save a text file with data as it appears in the worksheet rather than at full precision, copy the selected data to the Clipboard, paste it into a text editor, and save it as a text file.



Exporting to SYSTAT When exporting SigmaPlot data to SYSTAT, make sure that there are no text cells or indefinites in data columns you export, or they will be converted by SYSTAT into text instead of numbers.



Descriptive Statistics for Worksheets SigmaPlot automatically calculates a number of basic statistical values for all the data in your worksheet columns. For more information, see “Printing Column Statistics” on page 100. To view the statistics for the currently selected worksheet: „ On the View menu, click Statistics.



A check mark appears next to the Statistics command. The running calculations performed for each column appear in a Column Statistics window for that worksheet. Figure 3-14 Column Statistics Worksheet
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To close the Column Statistics window: E On the View menu, click Statistics again.



Available Statistics To determine the statistics shown in the Statistics windows, use the Statistics Options dialog box. Most calculations ignore empty cells, missing values, and text. The following statistics appear in the Column Statistics window. Mean:



The arithmetic mean, or average, of all the cells in the column, excluding the missing values. This is defined by: n



1 x = --n



∑ xi i=1



Std Dev:



The sample standard deviation is defined as the square root of the mean of the square of the differences from their mean of the data samples xi in the column. Missing values are ignored. n



s =



i -----------n–1



∑ ( xi – x )



2



i=1



Std Err:



The standard error is the standard deviation of the mean. It is the sample standard deviation divided by the square root of the number of samples. For sample standard deviations:
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s StdE r r = ------n 95% Conf:



The value for a 95% confidence interval. The end points of the interval are given by:



s x ± t ( v , z ) ------n where



x is the mean, s is the sample standard deviation, and t(v,z) the t statistic for v = n‚-1 degrees of freedom and z = 1.96 standard normal percentile equivalent. 99% Conf:



The value for a 99% confidence interval. The end points for this interval are computed from the equation for the 95% confidence interval using z = 2.576. Size:



The number of occupied cells in the column, whether they are occupied by data, text, or missing values. Sum:



The arithmetic sum of the data values in the column. Min:



The value of the numerically smallest data value in the column, ignoring missing values.
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Max:



The value of the numerically largest data value in the column. Min Pos:



The smallest positive value. Missing:



The number of cells in the column occupied by missing values, denoted with a double dash symbol (--). Other:



Either text or an empty cell.



Statistics Options To display only a portion of the available statistics, use the Worksheet Options dialog box, then select column statistics to show or hide. For more information, see “Displaying Worksheet Data” on page 67. To specify which statistics are shown or hidden: E On the View menu, click Statistics. The Column Statistics worksheet appears. E On the Tools menu, click Options. The Options dialog box appears.
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Figure 3-15 The Statistics Options Dialog Box



E Click the Worksheet tab. E Select the statistic(s) you want shown or hidden. E Click Show and Hide to move the statistics between the Shown and Not Shown lists. E Select the appropriate options to change the column widths and data display.



Engineering and E Notation Explained In SigmaPlot, E Notation is synonymous with scientific notation. The E expresses the power of 10. For example, 1.23 e+03 is 1230, or, equivalently, 1.23 e+03. Select E Notation When Needed or E Notation Always on the Worksheet tab of the Options dialog box if you want to use Scientific Notation. For more information, see “Changing Numbers Display” on page 71.
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Engineering Notation, which you can select as an option on the Worksheet tab of the Options dialog box , uses integral powers of 3 (with 10 as the base). Number



Scientific Notation Engineering Notation Engineering Notation (SigmaPlot



1230 12300



1.23 e+03 1.23 e+04



123000



1.23 e+05



1.23 e+03 12.3 e+03 123 e+03 or 0.123e+06



1.23 x 10^3 12.3 x 10^3 123 x 10^3 or 0.123 x 10^6



Displaying Worksheet Data You can display data in your worksheet columns as: „ Text „ Numbers „ Date and Time values „ Graphic information Figure 3-16 Numbers are displayed in Column 1, dates are displayed in Column 2, and text is shown in Column 3



You can enter numbers, labels, and dates and times directly into the worksheet. You can also convert numbers to dates and times and vice versa. You can change column widths, number decimal places, or date and time format, and you can also change the color and thickness of the worksheet gridlines, and adjust data feedback colors.
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Note: You can format columns to override the defaults set using the Options dialog box. For more information, see “Formatting Worksheets” on page 78.



Sizing Columns and Rows If the contents of your column exceed the column width, cell contents display as pound symbols (####). Label entries are truncated. To change a column width: E Drag the boundary on the right side of the column heading until the column is the



size you want. To change a row height: E Drag the boundary below the row heading until the row is the size you want.



To adjust column width and row height using the Options dialog box: E On the Tools menu, click Options. The Options dialog box appears. E Click the Worksheet tab. E In the Settings For list, click Appearance. E Set column width and row height in the Column Width and Row Height



drop-down lists. E Click OK to apply the changes and close the dialog box.



SigmaPlot is accurate to fourteen significant digits regardless of how many decimal places you specify.



Changing the Appearance of the Worksheet Grid You can change the color and thickness of worksheet grid lines.
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To change the grid appearance: E On the Tools menu, click Options. The Options dialog box appears. E Click the Worksheet tab. E In the Settings For list, click Appearance. E Set color and thickness in the Color and Thickness drop-down lists. E Click OK to apply the changes and close the dialog box.



Setting Data Feedback Colors Data Feedback highlights the cells and columns on the worksheet that correspond to the X and Y values of the selected curve or data point. You can change these colors on the Options dialog box. To change the data feedback colors: E On the Tools menu, click Options. The Options dialog box appears. E Click the Worksheet tab. E In the Settings For list, click Appearance. E Set data feedback colors and thickness in the X and Y drop-down lists. E Click OK to apply the changes and close the dialog box.
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Setting Decimal Places To set the number of decimal places used for worksheet values: E On the Tools menu, click Options. The Options dialog box appears. Figure 3-17 Changing Worksheet Column Width



E Click the Worksheet tab. E In the Settings For list, click Numeric. E Select the number of decimal places from the Decimal Places drop-down list. E Click OK to accept the changes and close the dialog box.



If the number of decimal places exceeds the column width they appear as # symbols.
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Changing Numbers Display You can display numbers in the worksheet in four ways: Numeric Display



Description



Displays worksheet data as scientific E Notation notation only when the length of the When Needed value exceeds the width of the cell. The default column width is twelve. Always displays data as scientific E Notation notation. The number of decimal places Always is set in the Decimal Places edit box. Displays data with a fixed number of decimal places. Set the number of decimal places in the Decimal Places edit box. The number of decimal places Fixed Decimal allowed is limited by the column width—the maximum number of decimal places cannot exceed the column width or it appears as a series of # symbols. The default setting for decimal places is two. Displays data exactly as you enter it in General the worksheet.



Example



12.00



12.00e+0



12.00



12



To set the numeric display for your worksheet: E View the worksheet. E On the Tools menu, click Options. The Options dialog box appears.
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Figure 3-18 Selecting Numbers Display Format



E Click the Worksheet tab. E In the Settings For list, click Numeric. E To set the numeric display, select a Numeric format setting from the Display As



drop-down list. E To use engineering scientific notation for worksheet values, select Engineering



Notation. For more information, see “Engineering and E Notation Explained”



on page 66. E Click OK to accept the settings and close the dialog box.
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Changing Date and Time Display SigmaPlot has a variety of date/time displays. When you enter a value into a date/time formatted cell, SigmaPlot assumes internal date/time information about that value from the year to the millisecond. For example, if you enter a day and month, you can display the month and year. To view and modify the current settings: E On the Tools menu, click Options. The Options dialog box appears. Figure 3-19 Selecting a Date Display Format



E Click the Worksheet tab. E In the Show Settings drop-down list, click Date and Time.
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E To change the display Date format, type one of the following examples into the Date



box, or select a format from the drop-down list: Typing:



Displays:



M/d/yyyy M/d/yy MM/dd/yy MM/dd/yyyy yy/MM/dd yyyy-MM-dd MMMM dd-MMM-yy dddd, MMMM dd, yyyy MMMM dd, yyyy dddd, dd MMMM, yyyy dd-MMMM-yy dd MMMM, yyyy gg



10/8/2003 10/8/03 10/08/03 10/08/2003 03/10/08 2003-10-08 Complete month 08-Oct-03 Tuesday, October 08, 2003 October 08, 2003 Tuesday, 08 October, 2003 08-October-03 08 October, 2003 Era (AD or BC)



E To change the display Time format, type one of the following examples into the Time



box, or select a format from the drop-down list: Typing: hh



HH or H mm or m ss or s uu or u H: h: m: s: or u HH: hh: mm: ss: uu tt t



Displays:



12 hour clock Military hours Minutes Seconds Milliseconds No leading zeroes for single digits Leading zero for single digits Double letter AM or PM Single letter AM or PM



E Click OK to accept the settings and close the dialog box.
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Setting Day Zero SigmaPlot provides three date systems: „ 1900 „ 1904 „ -4713



Note: SigmaPlot by default uses the system zero date of 4713 BC. Setting a Start Date is only necessary if you are importing numbers to be converted to dates, or converting dates to numbers for export. The starting date must match the date used by the other application. To set the start date: E On the Tools menu, click Options. The Options dialog box appears. E Click the Worksheet tab. E Select a date from the Day Zero drop-down list, or type your own start date. The



default start date is 1/1/1900.
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Figure 3-20 The Day Zero Drop-down List



Day Zero becomes the number 01.00 when you change from Date and Time to Numbers format. The basic unit of conversion is the day; that is, whole integers correspond to days. Fractions of numbers convert to times. Zero becomes Day Zero, and negative numbers entered into the worksheet convert to days previous to the Day Zero start date. Conversion between date/time values and numbers can occur for the calendar range of 4713 BC to beyond the year 4,000 AD. The internal calendar calculates dates using the Julian calendar until September, 1752. After that, dates are calculated using the Gregorian calendar. Note: If you convert numbers to dates, a start date is applied. If you convert the dates back to numbers, be sure you use the same start date as when you converted them, or they will have a different value. Regional Settings



Drop-down lists in the Options dialog box worksheet tab use the current date/time settings in your operating system. The Windows Regional Settings control date/time delimiters, 12 or 24 hour clock, and AM/PM display. Date and time display formats may be affected by your operating system’s Regional Settings. For example, if your Time Zones are specified as British (English), your date
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values appear as dd/mm/yy. If the setting is US (English), your date values appear as mm/dd/yy. If you want to view or modify the current settings, or view alternative settings available on your system, click the Regional Settings button, or modify them directly from the Windows Control tab. Note: Date and time values appear on the worksheet using the date and time delimiters, generally a forward slash (/) or colon (:). For more information, see “Entering Dates and Times” on page 48.



Using Date/Time Format with Other Programs You can copy date/time values from a SigmaPlot worksheet and paste them into other programs, such as an Excel workbook, or, you can copy date/time values from another program and paste them into a SigmaPlot worksheet. If the date/time format you are pasting is larger than the worksheet column width, you may need to change the column width. If you are copying date/time values from another program to SigmaPlot, make sure that the program is displaying dates/times in a format that SigmaPlot accepts as valid data entry. For example, if you are pasting dates from Excel, make sure the dates are displayed as numbers separated by slashes (/), or whatever date delimiter Windows is set to. E To change Excel formats, see your Excel reference, or, with an Excel worksheet active



in SigmaPlot, click Microsoft Excel Help on the Help menu to view the topic about Date and Time formats. Keep the following in mind when copying or importing date and time formatted data: „ Pasted or imported numeric data does not automatically convert to Date and Time



format. You must convert it using the same start date (Day Zero) that is used by the other program. „ When copying worksheet values, values are copied as numeric strings, not



date/time. „ SigmaPlot recognizes Date and Time formats imported from Excel, but you will



need to convert most other non-text dates and times from numbers to dates and time.
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Formatting Worksheets You can format entire columns even if they contain no data. If a populated cell in a column is already specifically formatted, as you enter data the entire column continues to use the same format, provided the data is appropriate to that format. When importing data, the import format takes precedence over the column format. Note: Formatting worksheets is not the same as setting worksheet display options. Setting worksheet display options sets the default for the entire worksheet. For more information, see “Setting Worksheet Display Options” on page 44. You can override these defaults by formatting worksheet columns using the Format Cells dialog box. To format worksheet columns: E Select an entire column. E On the Format menu, click Cells. The Format Cells dialog box appears. E Click the Data tab. E Select a Type. The Type you select determines which Settings are available. Available



Types are: „ Numeric. Select Numeric to control how many decimal places you want to appear



or if you want to use E notation in a selected worksheet column. „ Text. Select text to wrap text using the existing column width. „ Date and Time. Select Date and Time to set the display for the specified columns.



For more information, see “Switching Between Date and Time and Numeric Display” on page 79.



Setting Row and Column Size To set row and column size for a selected block of data: E Select a block of data on the worksheet. E On the Format menu, click Cells. The Format Cells dialog box appears.
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Figure 3-21 The Format Cells Dialog Box.



E Click the Rows and Columns tab. The selected box reflects the selected block of rows



and columns. E Set column width and row height from the Column width and Row height drop-down



lists. E To apply the row and column formats to the whole worksheet, select Apply to entire data



region. E Click OK to apply the changes and close the dialog box. The worksheet appears with



new column and row sizes for the selected cells. Note: Setting row height and column width from the Format Cells dialog box only changes the selected block of data. Set row and column defaults on the Worksheet tab in the Tools menu Options dialog box.



Switching Between Date and Time and Numeric Display You can convert between date/time and numeric display when: „ Importing data.
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„ Switching numbers to dates. „ Modifying the display between date, time and date/time.



To display worksheet cells in Date and Time format: E View the worksheet. E Select the data you wish to display in date/time format. E On the Format menu, click Cells. The Format Cells dialog box appears. Figure 3-22 The Format Menu Cells Dialog Box



E Click the Data tab. E In the Type list, click Date and Time. E Select date and time formats from the Date and Time drop-down lists. The sample box



changes according to your choice.
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E Click OK. The data is displayed showing the date, time, or date and time as specified.



The dates and times that are entered as dates and times are automatically displayed as such.



Cutting, Copying, Pasting, Moving, and Deleting Data Use the Edit menu commands to Cut, Copy, Paste, and Clear a selected cell or block. You can also use the Ctrl+X, Ctrl+C, and Ctrl+V shortcut keys or Standard toolbar buttons.



Selecting a Block of Data There are several ways to select a block of worksheet cells. You can: „ Drag the mouse over the desired worksheet cells while pressing and holding down



the left mouse button. „ Hold down the Shift key and press the arrow, PgUp, PgDn, Home, or End keys. „ Use the Go To command on the Edit menu. Figure 3-23 Selecting a Block of Data in the Worksheet



E To select an entire column, move the pointer to the column title row and click.. E To select entire rows, move the pointer to the row title column and click.
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Cutting and Copying Data Cut removes a selected cell or block from the worksheet and copies it to the Clipboard. Copy copies data to the Clipboard without deleting it from the worksheet.



Pasting Data To paste data: E Click or move the worksheet cursor to the cell where you want to paste the data, or to



the upper-left corner of the block. E On the Edit menu click Paste, click the Paste button on the Standard toolbar, or press



Ctrl+V. Any data in the Clipboard is placed in the worksheet.



Moving Data Move a block of data by cutting it, selecting the upper-left cell of the new location, then pasting the block. For more information, see “Deleting Data” on page 82.



Deleting Data Use the Edit menu Clear command to permanently erase selected data. This operation does not copy data to the Clipboard, and is faster than cutting.



Inserting Blocks of Cells, Columns, and Rows of Data You can insert blank blocks cells, rows, and columns into the worksheet, and fill them with data. If you’re moving and copying cells, you can insert them between the existing cells to avoid pasting over data.
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To insert a column, row, or blocks of cells into the worksheet: E Drag the mouse over the region where you want the empty block of cells, column, or



row to appear. The selected region of cells indicates exactly which cells will be inserted. E Right-click, and then on the shortcut menu, click Insert Cells. The Insert Cells dialog



box appears. Figure 3-24 Inserting an Empty Block of Data in the Worksheet



E Select the direction you want the existing data to shift when the cells are inserted, or to



insert an entire column or row, select Insert Columns or Insert Rows. E ClickOK . The column, row, or block of cells appears on the worksheet.
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Figure 3-25 The Result of Inserting an Empty Block with Cells Shifted Down



Deleting Blocks of Cells, Columns, and Rows of Data When you delete blocks of cells, columns, and rows, you are also permanently erasing the data. It will not be available on the Clipboard. To delete columns, rows, and blocks of cells from the worksheet: E Drag the mouse over the block of cells, column, or row you with to delete. E Right-click, and on the shortcut menu, click Delete Columns. The Delete Cells dialog



box appears. E Select the direction you want the existing data to shift when the cells are deleted. E Click OK.
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Switching Rows to Columns You can rearrange data from a row-oriented format to a column orientation, or vice versa. When you swap data, SigmaPlot pastes contents with the row and column coordinates transposed. To swap data column and row positions: E Select the block of data to transpose. E Cut or copy the selected data. E Select the cell where you want to begin pasting the data, E On the Edit menu, click Transpose Paste. The data is pasted to the worksheet with



the column and row coordinates reversed.



Entering and Promoting Column and Row Titles Column and row titles label and identify columns and rows of data. Column titles appear in the Graph and Regression Wizards when you pick columns, identify columns for legends, and can be used instead of column numbers in transforms. To enter or edit a worksheet column or row title: E Double-click the title, and enter or edit the title. E Press Enter to accept the new title.



You must use at least one text character in every column title. If you need to use a number as column title, type a space character (by pressing the space bar) before the number.
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Using the Column and Row Titles Dialog Box You can enter and edit column and row titles using the Column and Row Titles dialog box. To enter or edit a column title: E On the Format menu, click Column and Row Titles. The Column and Row Titles



dialog box appears. E Click the Column tab. E Enter the column title in the Title box. E To edit an existing title, move to that column by clicking Next or Prev, then edit the



title. E Click OK to close the Column Titles dialog box when you are finished editing column



titles. To enter or edit a row title: E On the Format menu, click Column and Row Titles. The Column and Row Titles



dialog box appears. E Click the Row tab. E Enter the row title in the Title box. E To edit an existing title, move to that row by clicking Next or Prev, then edit the title. E Click OK to close the Column and Row Titles dialog box when you are finished



editing row titles.
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Using a Worksheet Row for Column Titles Enter labels into a row, then use that row for worksheet column titles. This is useful for data imported or copied from spreadsheets. All the cells of the selected row are promoted, not just those cells which contain column titles. This may effect other data sets in the worksheet. To use a row for column titles: E If necessary, enter the column titles you want to use in a single worksheet row. E Select the cells in the row you want to use as column titles. E On the Format menu, click Column and Row Titles. The Column and Row Titles



dialog box appears Figure 3-26



E Click the Column tab. The number of the row you wish to promote appears in the



Promote row to titles box. E To delete the original row once it has been promoted, select Delete Promoted Row.
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E Click Promote. The selected row contents appear as column titles and the Column and



Row Titles dialog box closes.



Using a Worksheet Column for Row Titles Enter labels into a column, then use that column for worksheet row titles. This is particularly useful for data imported or copied from spreadsheets. All the cells of the selected row are promoted, not just those cells which contain column titles. This may effect other data sets in the worksheet. To use a column for row titles: E If necessary, enter the row titles you want to use in a single worksheet column. E Select the cells in the row you want to use as row titles. E On the Format menu, click Column and Row Titles. The Column and Row Titles



dialog box appears Figure 3-27 Promoting a Column of Data as Row Titles
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E Click the Row tab. The column you wish to promote appears in the Promote column



to titles box. E Select Delete Promoted Column to delete the original column once it



has been promoted. E Click Promote. The selected column contents appear as row titles and the Column and



Row Titles dialog box closes.



Using a Cell as a Column or Row Title Use the Column and Row Titles dialog box to promote individual cells to column and row titles. To promote individual cells: E Click the cell on the worksheet that you want to promote to a column or row title. E On the Format menu, click Column and Row Titles. The Column and Row Titles



dialog box appears. E Click the Row tab to promote a row cell to title; click the Column tab to promote a



column cell to a title. E Click Promote. The content of the cell appears as the column title. E Select Delete Promoted Column or Delete Promoted Row to delete the original cell



once it has been promoted. E Click Next or Prev to move to the next desired column or row, then follow steps above.
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Removing Outliers and Other Data You can manually omit or ignore an outlying point or group of points by converting the number to a text cell which removes the data point from both graphing and computation. To remove or ignore an outlier: E Find the outlier on the graph, then click it to select the curve, pause, and then click



again (do not double-click). E View the worksheet. The data for the selected symbol is indicated with



colored highlighting. Note: It is possible to highlight data points only if you create graphs using symbols. Figure 3-28 When you find the outlier on the graph, click it once to select it, and click it again, but make sure not to double-click.
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E Select the highlighted worksheet cell(s), then on the Format menu, click Cells. The



Format Cells dialog box appears. Figure 3-29 Format Cells Dialog Box



E Select Text from the Type list, then click OK. This converts the number to text



characters; you can tell this if the alignment of the cell changes to be left aligned. Figure 3-30 Graph with removed outlier
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The data point is no longer plotted, and if you perform additional statistics on the graph, the data point will also be ignored.



Highlighting Outliers Another way to remove an outlier is to cut the data and move it to another part of the worksheet. This is useful if you still want to plot the data but ignore the outlier. Then you can plot the moved outlier data with a second plot to continue displaying the outlying data. To plot outlier data as a separate plot: E Identify the worksheet cell(s) corresponding to the outlier(s). E Select (highlight) the cells, and press Ctrl+X to cut them. E Move to another location in the worksheet and paste the data. Figure 3-31 Moving Outlier Data to a Different Part of the Worksheet



E Plot the outlier data by adding it as a second plot to your graph. Change the symbol



color or other attributes to distinguish the data.
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Using Excel Workbooks in SigmaPlot SigmaPlot supports Microsoft Excel workbooks which you can use to create graphs, run transforms, and perform regressions and other statistics on your data. Most Excel commands are available when Excel workbooks are viewed, as are the Excel toolbars. The SigmaPlot Graph, Statistics, and Transforms menus are also available. When an Excel worksheet is in focus, all keyboard shortcuts are assigned to Excel’s hotkeys, not SigmaPlot’s. Figure 3-32 A New Excel Worksheet in SigmaPlot



Excel workbooks created by SigmaPlot are initially limited to a single worksheet. Excel workbooks with multiple worksheets that are opened by SigmaPlot as notebooks retain all sheets, but only the first sheet can be used for graphs and statistics.
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To open a new Excel worksheet: E On the File menu, click NewNew. The dialog box appears. E From the New drop-down list, select Worksheet. E Under Type, click Excel. E Click OK. An Excel worksheet appears and is added to the notebook.



Unprotecting Excel Workbooks Before you add , delete or move Excel worksheets or macros within workbooks within SigmaPlot you must first unprotect the workbook. However, if you choose to unprotect an Excel workbook, do not delete the worksheet that is used by SigmaPlot. To unprotect an Excel workbook: E Open an Excel workbook. E On the Excel Tools menu, click Protection, and then click Unprotect Workbook.



Using Excel as Default Workbooks You can use Excel workbooks as the default SigmaPlot worksheet. To set Excel as the default worksheet: E Close all open Excel workbooks. E On the SigmaPlot Tools menu, click Options. The Options dialog box appears. E Click the General tab. E Select New Notebooks use Excel Workbook.
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E Click OK to apply the changes and close the dialog box. All new notebooks will use



Excel workbooks as the default worksheet.



Opening Other File Types With Excel Using an Excel workbook as the default SigmaPlot worksheet, you can use Excel’s Open options and also open file types available to Excel. The following file types use the Excel Import filters if Excel workbooks are the default worksheet: „ MS Excel „ Lotus 1-2-3 „ dBase „ Plain Text „ SYLK



Opened data files automatically appear in a new Excel workbook in a new notebook file. To format data that opens into a single column: E On the Excel Data menu, click Text Columns.



SigmaPlot Functionality within Excel Workbooks To understand how Excel works with other applications, please see your Excel documentation. The following functions are unavailable when working with data in an in-place active Excel workbook: „ You cannot insert graphic cells into an Excel workbook for customized sequences



of colors, lines, symbols, and patterns. When an Excel workbook is the active window, there is no Edit menu Insert Graphic Cells command. „ An Excel workbook does not have an associated Statistics worksheet. To view



statistics for data in an Excel workbook, use Excel’s own statistics, or copy and paste the data into a SigmaPlot worksheet. To display the statistics worksheet for the active SigmaPlot worksheet, on the View menu, click Statistics.
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Additional Features With Excel Within sigmaPlot, you can use Excel’s advanced Print functions. You can also export Excel workbooks to the Excel *.xls file format with the File menu Export command. Printing Excel Workbooks:



To specify page setup functions for the active Excel workbook, on the File menu, click Page Setup to open the Page Setup dialog box. You can modify page, margins, headers and footers, and sheet settings. Figure 3-33 Setting Printing Options Using the Excel Page Setup Dialog Box



Exporting Excel Workbooks:



You can export in-place active Excel workbooks to Excel’s native *.xls file format, as well as any other format supported by Excel. To export Excel Workbooks: E View the Excel worksheet. E On the File menu, click Export. Excel’s Save As dialog box appears.
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E Select the desired format from the Save as type drop-down list. E Specify the drive and directory in which to save the file. E Enter a file name. E Click Save to save the file.



Excel Toolbars An Excel workbook in SigmaPlot always uses Excel toolbar default settings of your last Excel session. You can view any of Excel’s toolbars by clicking Toolbars on the View menu. Select a toolbar to use from the Excel Toolbars dialog box; the toolbars appear near the workbook window. Note: Switching from or closing an Excel workbook hides any Excel toolbars you may have displayed.



Creating SigmaPlot Graphs With Excel Workbooks An Excel worksheet works the same as a SigmaPlot worksheet when creating graphs. You can pre-select data before beginning a graph, or click or highlight columns from the Graph Wizard. You can also create SigmaPlot graphs using Excel. For more information, see “Creating SigmaPlot Graphs Using MicroSoft Excel” in Chapter 4.



 98 Chapter 3



Figure 3-34 PIcking data to plot from an Excel worksheet



Using Transforms on Data in Excel Workbooks You can perform Transform menu commands and user-defined transforms on data in Excel worksheets. The transform language uses syntax which refers to columns numerically, or by the column titles currently assigned. When prompted to pick columns, you can select columns as you would on a SigmaPlot worksheet. To perform user-defined transforms on an Excel worksheet, use the corresponding column number in place of the column letter that appears in the gray heading area at the top of the column. For example, the transform function: col(1)=data(1,100)



corresponds to inserting data values from 1 to 100 into column A of an Excel workbook.



Using Statistics with Excel You can use the Statistics menu commands, including the Regression Wizard, with Excel worksheets.
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When prompted to pick columns, select the columns from the Excel worksheet just as you would from a SigmaPlot worksheet. Results for statistics can be placed in Excel worksheets as well. Figure 3-35 Using the Regression Wizard with an Excel Worksheet



Printing Worksheets You can print active worksheets by clicking the Print button on the Standard toolbar. You can print any worksheet in a SigmaPlot notebook. This section explains: „ Printing the current worksheet. For more information, see “Printing the Current



Worksheet” see page 100. „ Previewing worksheets before printing. For more information, see “Previewing



Worksheets” see page 100. „ Printing column statistics. For more information, see “Printing Column Statistics”



see page 100 . „ Setting printing options. For more information, see “Setting Printing Options” see



page 101. „ Configuring printer settings. For more information, see “Configuring Printer



Settings” see page 101.



 100 Chapter 3



Printing the Current Worksheet E Select and view the worksheet. If you want to print only a portion of the columns in



the active worksheet, select a block from the worksheet. E On the File menu, click Print.



Previewing Worksheets E With a worksheet in view, on the File menu, click Print Preview. A preview of the



worksheet appears.



Printing Column Statistics E On the View menu, click Statistics. The column statistics worksheet appears. E On the File menu, click Print. The Print dialog box appears. E From the Name drop-down list, select the printer you wish to use. E Click OK. The Print Data Worksheet dialog box appears. Figure 3-36 The Print Data Worksheet Dialog Box for Columns Statistics



E To print the names of the statistics that appear in the row region of the worksheet, under



Headers select Row Headings.
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E Click OK to print.



Setting Printing Options E On the File menu, click Print. The Print Data Worksheet dialog box appears. Figure 3-37 The Print Data Worksheet Dialog Box



E Specify whether you want to print the entire worksheet, only the selected cells in the



worksheet, or a specified range of columns by selecting one of the options under Area to Print. E Click OK to print the worksheet.



Configuring Printer Settings E With a worksheet in view, on the File menu, click Print. The Print Data Worksheet



dialog box appears. E Click Setup. The Print dialog box appears. E Click OK when you are satisfied with the Printer settings, or click Properties to edit



the printer properties. Note: The Properties dialog box options vary from printer to printer.
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4 Creating and Modifying Graphs A graph is a representation of selected worksheet columns on a graph page. You select the representation, or graph type (for example, 3D scatter plot, vertical bar chart, and so on), when you create a plot or graph, but you can change it at any time. Most plot types can graph many worksheet columns, column pairs, or column triplets. Depending on the plot type, a separate curve or set of bars represents each column. A graph must have at least one plot, but most graphs can hold many more plots, each with a different type and style. This chapter provides an overview of the graph creation process using the Graph Wizard, including descriptions of the different graph types and styles available, and common modifications. This chapter covers: „ Setting graph defaults (see page 104). „ Arranging data for graphs (see page 126). „ Creating graphs (see page 139). „ Creating graphs using templates, layouts, and the Graph Style Gallery (see



page 145). „ Modifying graphs (see page 151). „ Creating and modifying embedded SigmaPlot graphs (see page 166). „ Changing symbol type and other symbol options (see page 168). „ Changing line type and other line options (see page 179). „ Changing bar and box widths and spacing (see page 190). „ Adding and modifying drop lines (see page 194). „ Plotting and solving equations (see page 196).
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Setting Graph Defaults Changing graph defaults affects only new graphs created. To change existing graphs: E Select the graph. E Change its properties using the Graph Wizard, Graph Properties, or other dialog



boxes and commands. The graph default options are intentionally limited and simple. If you want to use more complex graph defaults, use templates or the Graph Style Gallery to create complex graphs that can be applied to data as a template, bypassing graph creation entirely. For more information, see “Creating Graphs Using the Graph Style Gallery” on page 145. To change graph defaults: E On the Tools menu, click Options. The Options dialog box appears. E Click the Graph tab. E Change the graph defaults options as desired.



SigmaPlot Graph Types There are more than a dozen graph types available in SigmaPlot. Choose a graph type using the Graph Wizard or the graph toolbar. Scatter Plot



Plots data as XY points using symbols. For more information, see “Arranging Data for 2D Plots” on page 126.
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Line Plot



Plots data as XY points connected with lines. For more information, see “Arranging Data for 2D Plots” on page 126. Line and Scatter Plot



Plots data as XY points using symbols connected with lines. For more information, see “Arranging Data for 2D Plots” on page 126. Area Plot



Plots data as XY points with regions below or between curves filled with a color or pattern. Polar Plot



Plots data using angles and distance from center. For more information, see “Arranging Data for Polar Plots” on page 131. Ternary Plot



Plots data on a coordinate system based on three different components which always add up to 100%. For more information, see “Arranging Data for a Ternary Graph ” on page 132. Vertical Bar Chart



Plots data as Y points with vertical bars. For more information, see “Arranging Data for 2D Plots” on page 126. Horizontal Bar Chart



Plots data as X points with horizontal bars. For more information, see “Creating 2D Plots ” in Chapter 6.
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Box Plot



Plots data as the median and percentiles. For more information, see “Creating Box Plots” in Chapter 6. Pie Chart



Plots data as a percent of the total. For more information, see “Arranging Data for a Pie Chart” on page 126. Contour Plot



Plots data as XYZ values in 2D space. Format data columns as: many Z; single XY, many Z; or XYZ triplet. For more information, see “Arranging Data for 3D Graphs” on page 136. 3D Scatter Plot



Plots data as XYZ data points in 3D space. Format data columns as: many Z; single XY, many Z; or XYZ triplet. For more information, see “Arranging Data for 3D Graphs” on page 136. 3D Line Plot



Plots data as XYZ data points connected with lines. Format data columns as: many Z; single XY, many Z; or XYZ triplet. For more information, see “Arranging Data for 3D Graphs” on page 136. 3D Mesh Plot



Plots data as a 3D surface. Format data columns as: many Z; single XY, many Z; or XYZ triplet. For more information, see “Arranging Data for 3D Graphs” on page 136.
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3D Bar Chart



Plots data as Z values on an XY grid. Format data columns as: many Z; or single XY, many Z. For more information, see “Arranging Data for 3D Graphs” on page 136.



SigmaPlot Graph Style Many graph types have several styles to choose from. When you select a graph type, either from the graph toolbar or from the Graph Wizard, you are prompted to choose a graph style.



Scatter Plots Simple Scatter Plots a single set of XY pairs. Format data columns as: „ XY Pair „ Single X „ Single Y



Multiple Scatter Plots multiple sets of XY pairs. Format data columns as: „ XY Pairs „ Single Y, Many X „ Single X, Many Y „ Many X „ Many Y „ XY Category „ X Category „ Y Category
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Simple Regression Plots a single set of XY pairs with a regression line. Format data columns as: „ XY Pair „ Single X „ Single Y



Multiple Regressions Plots multiple sets of XY pairs with regression lines. Format data columns as: „ XY Pairs „ Single Y, Many X „ Single X, Many Y „ Many X „ Many Y „ XY Category „ X Category „ Y Category



Simple Error Bars Plots a single set of XY pairs with error bars. If using worksheet columns or asymmetric



error bar columns, format data columns as: „ XY Pair „ Single Y



If using columns means, the first column entry, or the last column entry as symbol values, format data columns as: „ Single X, Many Y „ Many Y



If using Row Mans, Row Median, First Row Entry, or Last Row Entry as symbol values, format data columns as:
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„ Single X, Single Y Replicate „ Y Replicate



Multiple Error Bars Plots multiple sets of XY pairs with error bars. If using worksheet columns, asymmetric



error bar columns, columns means, the first column entry, or the last column entry as symbol values, format data columns as: „ X Many Y „ Many Y



If using row means, row median, first row entry, or last row entry as symbol values, format data columns as: „ Single X, Many Y Replicates „ Many Y Replicates



Simple Error Bars & Regression Plots a single set of XY pairs with error bars and a regression line. If using worksheet columns or asymmetric error bar columns, format data columns as: „ XY Pair „ Single Y



If using columns means, the first column entry, or the last column entry as symbol values, format data columns as: „ Single X Many Y „ Many Y



If using Row Means, Row Median, First Row Entry, or Last Row Entry as symbol values, format data columns as: „ Single X, Single Y replicate „ Y replicate



If using By Category, Mean, or By Category, Median, format data columns as:
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„ Category, Many Y



Multiple Error Bars & Regressions Plots multiple sets of XY pairs with error bars and regression lines. If using worksheet columns, asymmetric error bar columns, columns means, the first column entry, or the last column entry as symbol values, format data columns as: „ Single X Many Y „ Many Y



If using Row Means, Row Median, first Row Entry, or last Row Entry as symbol values, format data columns as: „ Single X, Many Y Replicates „ Many Y Replicates



If using By Category, Mean, or By Category, Median, format data columns as: „ Category, Many Y



Simple Horizontal Error Bars Plots XY pairs with horizontal error bars. If using worksheet columns or asymmetric



error bar columns as the as symbol values, format as: „ XY pairs „ Single X, Single Y, Many X „ Many X



If using column means, column median, the first column entry, or the last column entry as symbol values, format data as: „ Single Y, Many X „ Many X



If using Row Means, Row Median, the First Row Entry, or the Last Row Entry as symbol values, format data columns as: „ Single X Replicates
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„ Single Y, single X Replicates „ Many X Replicates „ Single Y, Many X Replicates



If using By Category, Mean, or By Category, Median, format data columns as: „ Category, Many Y



Bi-directional Error Bars Plots XY pairs with both horizontal and vertical error bars. Format data columns as XY



pairs. If using worksheet columns or asymmetric error bar columns as the as symbol values, format as: „ XY pairs „ Single X „ Single Y, Many X „ Many X



If using column means, column median, the first column entry, or the last column entry as symbol values, format data as: „ Single Y, Many X „ Many X



Vertical Point Plot Plots columns of data as Y values. Format data columns as: „ Many Y „ Single X, Many Y „ Many Y Replicates „ Single X, Many Y Replicates



Horizontal Point Plot Plots columns of data as X values. Format data columns as: Many X
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„ Single Y, Many X „ Many X Replicates „ Single Y, Many X Replicates



Vertical Dot Plot Plots a column of data as Y values. Format data columns as: „ Many Y „ Single X Many Y „ XY pairs „ X Category



Horizontal Dot Plot Plots a column of data as X values. Format data columns as: „ Many X „ Single Y, Many X „ YX pairs



Line Plots Simple Straight Line Plots a single set of XY pairs connecting the data points with straight lines. Format data



columns as: „ XY Pairs „ Single X „ Single Y



Multiple Straight Lines Plots multiple sets of XY pairs connecting the data points with straight lines. Format data



columns as:
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„ XY Pairs „ Many X „ Many Y „ Single X, Many Y „ Many X „ Single Y



Simple Spline Curve Plots a single set of XY pairs connecting the data points with a spline curve. Format data



columns as: „ XY Pairs „ Single X „ Single Y



Multiple Spline Curves Plots multiple sets of XY pairs connecting the data points with spline curves. Format data



columns as: „ XY Pairs „ Many X „ Many Y „ Single X, Many Y „ Single Y, Many X



Simple Vertical Step Plot Plots a single set of XY pairs connecting the data points with vertical and horizontal lines, starting with vertical. Format data columns as: „ XY Pairs „ Many X „ Many Y
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„ Single X, Many Y „ Single Y, Many X



Multiple Vertical Step Plot Plots multiple sets of XY pairs connecting the data points with vertical and horizontal lines, starting with vertical. Format data columns as: „ XY Pairs „ Many X „ Many Y „ Single X, Many Y „ Single Y, Many X



Simple Horizontal Step Plot Plots a single set of XY pairs connecting the data points with vertical and horizontal lines, starting with horizontal. Format data columns as: „ XY Pairs „ Single X „ Single Y



Multiple Horizontal Step Plot Plots multiple sets of XY pairs connecting the data points with vertical and horizontal lines, starting with horizontal. Format data columns as: „ XY Pairs „ Many X „ Many Y „ Single X, Many Y „ Single Y, Many X
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Line & Scatter Plots Simple Straight Line Plots a single set of XY pairs connecting symbols with straight lines. Format data



columns as: „ XY Pairs „ Single X „ Single Y



Multiple Straight Lines Plots multiple sets of XY pairs connecting symbols with straight lines. Format data



columns as: „ XY Pairs „ Many X „ Many Y „ Single X, Many Y „ Single Y, Many X



Simple Spline Curve Plots a single set of XY pairs connecting symbols with a spline curve. Format data



columns as: „ XY Pairs „ Single X „ Single Y



Multiple Spline Curves Plots multiple sets of XY pairs connecting symbols with spline curves. Format data



columns as: „ XY Pairs
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„ Many X „ Many Y „ Single X, Many Y „ Single Y, Many X



Simple Error Bars Plots a single set of XY pairs as symbols with error bars connected with straight lines. If using worksheet columns or asymmetric error bar columns, format data columns as: „ XY Pair „ Single Y



If using columns means, the first column entry, or the last column entry as symbol values, format data columns as: „ X Many Y „ Many Y



If using row means, row median, first row entry, or last row entry as symbol values, format data columns as: „ X, Y Replicate „ Y Replicate



Multiple Error Bars Plots multiple sets of XY pairs as symbols with error bars connected with straight lines. If



using worksheet columns, asymmetric error bar columns, columns means, the first column entry, or the last column entry as symbol values, format data columns as: „ X Many Y „ Many Y



If using row means, row median, first row entry, or last row entry as symbol values, format data columns as: „ X, Many Y Replicates „ Many Y Replicates
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Simple Vertical Step Plot Plots a single set of XY pairs connecting symbols with vertical and horizontal lines, starting with vertical. Format data columns as: „ XY Pairs „ Single X „ Single Y



Multiple Vertical Step Plot Plots a multiple sets of XY pairs connecting symbols with vertical and horizontal lines, starting with vertical. Format data columns as: „ XY Pairs „ Many X „ Many Y „ Single Y, Many X „ Single X, Many Y



Simple Horizontal Step Plot Plots a single set of XY pairs connecting symbols with vertical and horizontal lines, starting with horizontal. Format data columns as: „ XY Pairs „ Single X „ Single Y



Multiple Horizontal Step Plot Plots a multiple sets of XY pairs connecting symbols with vertical and horizontal lines, starting with horizontal. Format data columns as: „ XY Pairs „ Many X „ Many Y
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„ Single Y, Many X „ Single X, Many Y



Area Plots Simple Area Plots single set of XY pairs as a line plot with a downward fills. Format data columns as: „ XY Pairs „ Single X „ Single Y



Multiple Area Plots multiple sets of XY pairs as line plots with downward fills. Format data columns as: „ XY Pairs „ Many Y „ Single X, Many Y „ Many X „ Single Y, Many X



Vertical Area Plots single set of YX pairs as a line plot with a left direction fill. Format data columns as: „ Single X „ YX Pair



Multiple Vertical Area Plots multiple sets of YX pairs as line plots with left direction fills. Format data columns



as: „ Many X „ Single Y, Many X
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Complex Area Plot Plots multiple line plots with downward fills and intersections. Format data columns as: „ XY Pairs „ X Many Y „ Y Many X „ Many X „ Many Y



Polar Plots Scatter Plots angle and distance data as symbols. Format data columns as: „ Theta, R Pairs „ XY Pairs „ Many Theta „ Many R „ Single Theta, Many R „ R, Many Theta



Lines Plots angle and distance data points connected with lines. Format data columns as: „ Theta, R Pairs „ XY Pairs „ Many Theta „ Many R „ Single Theta, Many R „ R, Many Theta
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Scatter & Lines Plots angle and distance data as symbols connected with lines. Format data columns as: „ Theta, R Pairs „ XY Pairs „ Many Theta „ Many R „ Single Theta, Many R „ R, Many Theta



Ternary Plots Scatter Plots ternary triplet data as symbols. Format data columns as: „ Ternary Triplets „ Ternary XY Pairs „ Ternary YZ Pairs „ Ternary XZ Pairs



Lines Plots ternary triplet data as data points connected with lines. Format data columns as: „ Ternary Triplets „ Ternary XY Pairs „ Ternary YZ Pairs „ Ternary XZ Pairs



Scatter & Lines Plots ternary triplet data as symbols connected with lines. Format data columns as: „ Ternary Triplets
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„ Ternary XY Pairs „ Ternary YZ Pairs „ Ternary XZ Pairs



Vertical Bar Charts Simple Bar Plots a single column of data as Y values. Format data columns as: „ XY pair „ Single Y



Grouped Bar Plots multiple columns of data in a series of bars. Format data columns as: „ Single X, Many Y „ Many Y „ Many Y Replicates „ Single X, Many Y Replicates



Simple Error Bars Plots data as Y values with error bars. If using worksheet columns or asymmetric error bar columns as the symbol value source, format data columns as: „ Single Y „ XY Pair



If using columns means, the first column entry, or the last column entry as symbol values, format data columns as: „ Single X Many Y „ Many Y
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If using row means, row median, the first row entry, or the last row entry, format data columns as: „ Single Y Replicate „ X, Y Replicate



Grouped Error Bars Plots data as multiple sets of Y values in a series of bars with error bars. If using worksheet columns or asymmetric error bar columns as the symbol value source, format data columns as: „ Many Y „ Single X, Many Y



If using row means, row median, the first row entry, or the last row entry, format data columns as: „ Many Y Replicates „ Single X „ Many Y Replicates



Error bar values are from the worksheet. Stacked Bars Plots multiple columns of data as a series of stacks in bars. Format data columns as: „ Single X, Many Y „ Many Y „ Many Y Replicates „ Single X, Many Y Replicates



Horizontal Bar Charts Simple Bar Plots a single column of data as X values. Format data columns as:
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„ XY Pairs „ Single X



Grouped Bar Plots multiple columns of data in a series of bars. Format data columns as: „ Single Y, Many X „ Many X, Many X Replicates „ Single Y, Many X Replicates



Simple Error Bars Plots data as X values with error bars. If using worksheet columns or asymmetric error bar columns as the symbol value source, format data columns as: „ Single X „ YX pair



If using columns means, the first column entry, or the last column entry as symbol values, format data columns as: „ Many X; „ Single Y, Many X



If using row means, row median, the first row entry, or the last row entry, format data columns as: „ Many X Replicates „ Single Y, Many X Replicates



Error bar values are from the worksheet. Grouped Error Bars Plots data as multiple sets of X values in a series of bars with error bars. If using



worksheet columns or asymmetric error bar columns as the symbol value source, format data columns as:
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„ Single Y „ Many X „ Many X



If using row means, row median, the first row entry, or the last row entry, format data columns as: „ Many X Replicates „ Single Y, Many X Replicates



Error bar values are from the worksheet. Stacked Bars Plots multiple columns of data as a series of stacks in bars. Format data columns as: „ Single Y, Many X „ Many X „ Single Y „ Many X Replicates



Box Plots Vertical Plots the median, 10th, 25th, 75th, and 90th percentiles as vertical boxes with error bars.



Format data columns as: „ Many Y „ Single X, Many Y



Error bar values are column means. Horizontal Plots the median, 10th, 25th, 75th, and 90th percentiles as horizontal boxes with error bars.



Format data columns as:
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„ Many X „ Single Y, Many X



Error bar values are column means.



Contour Plots Contour Plots data XYZ values in 2D space. Format data columns as: „ XYZ Triplet „ Many Z „ XY, Many Z



Filled Contour Plots data XYZ values in 2D space filling in the area between contour levels. Format data



columns as: „ XYZ Triplet „ Many Z „ XY, Many Z



3D Line Plots 3D Trajectory



Plots data as XYZ data points connected with lines. 3D Waterfall Plots data as XYZ data points, but only displays X or Y gridlines. Format data as: „ Many Z „ Single XY
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„ Many Z



Arranging Data for Graphs For most graph types, the Graph Wizard prompts you to select a data format. Your selection determines how your worksheet data is associated with points on the graph. For example, an XY Pair data format means that graph uses two columns; one column corresponds to the X-axis and the other corresponds to the Y-axis. In the XY, Many Z data format, one column corresponds to the X-axis data, another column corresponds to the Y-axis, and the remaining columns correspond to Z-axis data.



Arranging Data for 2D Plots Organize data for 2D graphs by columns. Place data for the X values of a graph in a single column, and place data for the corresponding Y values in another column.



Arranging Data for a Pie Chart To organize data for a pie chart, place data in a single worksheet column. Figure 4-1 When creating pie charts, all data is placed into a single column.



 127 Creating and Modifying Graphs



Arranging Category Data Use Category Data formats (indexed data) if your data is organized row wise by categories with corresponding data, as is often the default data organization for both statistics data tables and databases. Using this format, you can plot data files from other statistical packages, such as SigmaStat or SPSS, without having to divide the data into groups. Figure 4-2 In this worksheet, the data is arranged for an XY Categories data format. The "Animals" column is what you would select as the "category" column in the Graph Wizard.



The Category Data format is available when creating summary plots. Graph types and styles that can use a category data format appear in the table below. Graph Type



Graph Style



Scatter Plot



Multiple Scatter Multiple Regression



Line Plot



Multiple Straight Lines Multiple Spline Curves Multiple Vertical Step Plot Multiple Horizontal Step Plot Multiple Vertical Midpoint Step Plot Multiple Horizontal Midpoint Step Plot



For more information, see “Plotting Category and Grouped Data” in Chapter 6.
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XY Pair Format for a Single Curve If the graph you are creating uses only one set of X and Y values, enter all X data in one column, and all corresponding Y data in another column. Depending on the setting, these columns do not need to be adjacent or the same length (missing values are ignored). Figure 4-3 Data for a 2D Graph Arranged and Picked as XY



XY Pair Format for Multiple Curves If the graph style you are creating plots more than one curve, place as many additional X and Y values in worksheet columns as you want to plot. Enter X and Y data in the worksheet in consecutive columns, or in any order you want.
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Figure 4-4 Data for a 2D Graph Arranged and Picked as XY Pairs



Using the Same Column for Multiple Curves (Single X or Y vs. Many Y or X) SigmaPlot can graph many curves using the same X or Y data column. There is no need to duplicate a column that is used for more than one curve; for example, enter the X data into only one column, and enter the corresponding Y data into as many columns as you have curves. Order and length of columns does not matter. Figure 4-5 Data for a 2D Graph Arranged and Picked as X Many Y
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Using Row Numbers for X or Y Values (Single X; Single Y; Many X; or Many Y) SigmaPlot can also graph data as only X or Y values, and use the row numbers of the columns as the corresponding Y or X coordinates. If you want to graph data as only X or Y values, enter the data for each plot into a column, and do not enter data for corresponding coordinates. Figure 4-6 Data for a 2D Graph Arranged and Picked as Many Y Only



Arranging Data for Plots with Error Bars Arranging Data for Column Averaged Error Bar Plots



Certain graph styles plot data by representing the mean of an entire column as a single data point. In these cases, place the values you want represented as a single X or Y value into one column. Arranging Data for Asymmetric Error Bar Plots



Asymmetric error bar plots use two columns as the error bar source from which you can independently control the values of error bars. Place the values you want to represent the error bars to the right of the plotted column.
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Arranging Data Using Column Means



Plots the average of an entire worksheet column as a single data point, then uses the column statistics to compute error bars, as specified by the Error Calculation. Arranging Data Using the Column Median



Plots the median of an entire worksheet column as a single data point, then uses the column statistics to compute error bars, as specified by the Error Calculation.



Arranging Data for Polar Plots Data for polar plots can be entered in either one of two ways: „ R, θ values „ X,Y coordinates



Data for Radial and Angular Values (R, Theta) To arrange data using θ (angular) and R (radial) values, enter all θ values in one column, and enter the corresponding R values in another column. Data is plotted as θ versus R, which is similar to X,Y plots in organization, but differs from X,Y plots in that R is usually the dependent variable.



Using X,Y Values for Polar Plots Polar plot X,Y data is arranged the same as 2D plot X,Y data, with all X values in one column, and all Y values in another column; however, polar plots are plotted as R,θ pairs defined as:



R =



x2 + y 2



and



y θ = atan  -   x
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where R is the radius, and θ is the angle of the data point from the origin.



Data for Multiple Curves Since SigmaPlot can graph more than one curve per plot, place as many additional θ, R values, or X,Y coordinates, as you want to plot in worksheet columns.



Using Data from One Column for Multiple Curves SigmaPlot can also graph many curves using the same column as the θ or R data (or, X or Y data). There is no need to duplicate a column that is used for more than one plot; for example, enter the θ data into only one column, and enter the corresponding R or dependent data into as many columns as needed.



Arranging Data for a Ternary Graph Data for ternary plots can be XYZ data in three separate columns or SigmaPlot can extrapolate a third column from data pairs in two columns. Ternary graphs must have at least one single or multiple curve plot, but can hold many more plots, each with a different style and data format. If your raw values do not add up to 100% or 1, SigmaPlot can convert them to normalized ternary data. If you have XY, YZ, or YZ pair data, SigmaPlot can compute the third-column values shown in the resulting graph.



Data for a Single Curve Plot (Ternary Triplets) If you are creating a graph with a single curve plot using only one set of XYZ values whose sum is 100% or 1, enter all X data in one column, all Y data in another column, and the corresponding Z data in another column. The columns do not have to be adjacent to one another, but they must be the same length. Ternary triplet data should always add up to 100% or 1. For more information, see “Normalizing Ternary Data” in Chapter 15.
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Data for a Multiple Curve Plot (Ternary Triplets) If you are creating a graph with a multiple-curve plot using multiple sets of XYZ values where the sum of each set is 100% or 1, enter into worksheet columns as many additional ternary triplet data sets as you want to plot. Each set of ternary triplet data is a separate plot-curve. All ternary triplet data sets should add up to 100% or 1. For more information, see “Normalizing Ternary Data” in Chapter 15. Figure 4-7 Multiple Columns of Triplet Percentage Data for a Ternary Plot



Data for a Single or Multiple-Curve Plot (Ternary XY, YZ, or XZ Pairs) If you are creating a graph with a single or multiple curve plot using XY, YZ, or XZ pairs, enter all X, Y, or Z data in one column, and the corresponding X, Y, or Z pair values in another column. As long as all data pairs use a percentage or unitary scale, SigmaPlot will compute the third-column data shown in the resulting graph. SigmaPlot computes third column data for plotting only. Computed third-column data is not displayed in the worksheet.



Arranging Data for Bubble Plots Data for bubble plots can either be X, Y data in two separate columns or single X or single Y data in one column. In both cases, an additional column is needed to indicate bubble size values. Since the bubble size column corresponds to symbol diameter, you must convert the data for your third variable to diameters. Bubble plots must have at least one plot, but can hold many more plots using different data formats if appropriate. The bubble plot type has available only the
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default scatter style. You can change the symbol type. However, if you use something other than a circle you will need a different equation to transform area to diameter. Figure 4-8 Example of a Bubble Plot 18 16 14



Y Data
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Using X, Y Values for Bubble Plots Bubble plot X, Y data is arranged in the same way as other 2D plot X, Y data, with all X values in one column and all Y values in another.



Data for Bubble Size SigmaPlot can graph bubble plots using XY pair, Single Y, Single X, and bubble size data. Bubble size values must be entered in a separate column. Each value corresponds to the diameter of the symbol, in whatever page units are being used. If you want bubble size to correspond to area data, you must convert your area data to diameters before creating the bubble plot.



Converting Area Data to Diameters If you want your bubble plot to display area data, you must run this transform where area is the source column number and the diameter is the results column number. This transform is derived from the formula for the area of a circle.
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To convert your area data into diameters: E On the Transforms menu, click User-Defined. The User-Defined Transform dialog



box appears. Figure 4-9 User-Defined Transform dialog box



E Type the transform function as follows:



pi=3.14159265359 col(diameter)=sqrt(col(area)*factor/pi)



where diameter is the column number for your diameter data, area is the column number for your original data to be represented by area, and factor is some number to increase or decrease the magnitude of your data to a reasonable range. Tip: Reduce the diameters of your symbols to a reasonable size before plotting them.
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Figure 4-10 Transforming Area Data to Diameters



E Click Run.



Your new data appears in the worksheet. If you change the symbol shape, you must use a different equation to transform area data.



Arranging Data for 3D Graphs Organize data for SigmaPlot graphs by column. Typically, data for contour plots and 3D graphs is composed of X, Y, and Z value columns, or one or more Z columns and optional X and Y columns. 3D bar charts, scatter plots, and line plots can use any three columns as XYZ data; however, contour and mesh plots require a strict arrangement of the data. Note: If multiple Z columns are plotted, they all must be next to each other. The X and Y columns can be located anywhere.



Data for 3D Bar Charts, 3D Scatter Plots, and 3D Line Plots Arrange data for 3D bar charts, scatter plots, and line plots either as XYZ triplet data, multiple columns of Z data, or as a single column for Y values, a single column for X values, and multiple columns for Z values. For each of these graph types, the data in
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each row is graphed as a data point. For bar charts, each column of Z data is plotted as a row parallel to either the X axis, with Y values as the constants. If you are formatting XYZ triplet data, you also can use one of the multiple Z column formats designed for 3D mesh plots. Note: 3D bar charts cannot use XYZ triplet data. You can use the X, Y, and many Z format; however, you must have at least two columns of Z data.



Data for Contour and Mesh Plots Data for a contour or mesh plot requires XYZ coordinates for each intersection of a rectangular mesh.



X1 X2 X3



Y1



Y2



Y3



Y4



Z1 Z2 Z3



Z4 Z5 Z6



Z7 Z8 Z9



Z10 Z11 Z12



The arrangement of this data for the three possible methods of picking columns to plot are described in the following sections. X, Y, and Z Data in Three Columns:



To plot three columns as the X, Y, and Z values of a contour or mesh plot, the data must be in long form mesh format. This format assigns the proper Z value to each X and Y point in the mesh, in the required order. For example, for the table of X, Y, and Z values shown above, the three column mesh format must be arranged in the worksheet as: X data



Y data Z data



X1 X2 X3 X1 X2 X3 X1 X2



Y1 Y1 Z1 Y2 Y2 Y2 Y3 Y3



Z1 Z2 Z3 Z4 Z5 Z6 Z7 Z8
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X data



Y data Z data



X3 X1 X2 X3



Y3 Y4 Y4 Y4



Z9 Z10 Z11 Z12



This arrangement places the XYZ data point coordinate values in the required order. The XYZ columns must be the same length. Figure 4-11 Data Arranged in Long Form Mesh Format



X and Y Columns vs. Many Z Columns: You can also place the X and Y data in single



columns, then place the corresponding Z data in many continuous columns. This method may work best if you have XYZ data displayed in a table, or if you have irregularly incremented X or Y values. To use this option, you should have as many Z columns as you have Y rows, and the Z columns should be the same length as the X column. X data



Y data



Z data



X1 X2 X3



Y1 Y2 Y3 Y4



Z1 Z4 Z7 Z10 Z2 Z5 Z8 Z11 Z3 Z6 Z9 Z12



The data in the first Z column is assigned to the first Y value, the data in the second Z column to the second Y value, etc. The data in each row of the X column is assigned as the X value for the data in the same row in the Z columns.
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Figure 4-12 XYZ Data Arranged as One X Column, One Y Column, and Many Z Columns



The X and Y data must be strictly ascending or descending. Note that in this case, you can use columns of uneven length. Extra X, Y, or Z values created by uneven columns are not plotted, as mesh plots cannot graph missing values. Z Data vs. Row and Column Numbers: You can also plot columns as Z values versus the cell columns and row numbers as the X and Y values. This is the appropriate column assignment option to use: for mesh plots and 3D Bar Charts where X and Y values are evenly and equally spaced; for example, when graphing pixel intensity data for an image. All data is assigned as a Z value, and the Z columns must be contiguous. To use this format for a mesh plot, no special data arrangement is required other than equal column length. The rows and columns of the cells can be used as either the X or Y values.



Creating Graphs You create graphs in SigmaPlot using Graph Wizard. You can start the Graph Wizard either by: „ Clicking the Graph Wizard button on the Standard toolbar. „ Clicking Create Graph on the Graph menu. „ Clicking any graph type on one of the Graph toolbars. „ Using the Graph Style Gallery.



You can also create graphs using graph page templates. For more information, see “Using Graph Pages as Templates” in Chapter 5.
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Then follow the instructions as they appear in the Graph Wizard and click Next to move to the next panel. Tip: You can either select the worksheet columns to plot before creating your graph by dragging the pointer over your data, or you can select data columns later in the Graph Wizard. You can even select data ranges. For more information, see “Manually Entering Data Ranges into the Graph Wizard” on page 143.



Creating Graphs Using the Graph Toolbar To create a graph using the graph toolbar: E Select the desired graph type from a 2D or 3D Graph toolbar.



If you selected to create a Graph Type that has more than one style, a Graph Style toolbar appears. E Select a graph style. Graph Wizard The appears.



Creating a Graphs Using the Graph Wizard To create a 2D graph using the Graph Wizard: E On the Standard toolbar, click the Graph Wizard button. The Graph Wizard appears. Figure 4-13 Graph Wizard Graph Types
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E Under Graph Types, select the type of graph you want to make. E Click Next. E Under Graph Styles, select the desired graph style. Figure 4-14 Graph Wizard - Style



E Click Next. If the graph style you have chosen uses error bars, you are prompted to



choose an error bar source and a value to use for the error bars. For more information, see “Creating 2D Scatter Plots with Error Bars” in Chapter 6. E Click Next. E Under Data format, select how your data is formatted, and click Next.
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Figure 4-15 Specifying the Data Format



E From the Data for drop down list, select the worksheet columns that correspond to the



axis or error bar of your plot. You can also drag a range of data on the worksheet using the mouse. Note: When creating graphs using Microsoft Excel, you can only enter ranges manually. You can also select a range of data by entering the range manually into the Data for box. After entering the range, press Enter. The range appears in the Graph Wizard. For more information, see “Manually Entering Data Ranges into the Graph Wizard” on page 143. If you make a mistake while selecting data, double-click the mistaken column in the Selected Columns list to clear the selection.
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Figure 4-16 Selecting Columns to Plot



For more information, see “Creating SigmaPlot Graphs Using MicroSoft Excel” on page 168. E Click Finish to create the plot.



Manually Entering Data Ranges into the Graph Wizard The simplest way to select a region of data is to drag the columns or range using the mouse. You can, however, manually enter the ranges into the Graph Wizard. This is necessary when creating graphs using Microsoft Excel where it is not possible to use the mouse to select a range of data. The Graph Wizard supports the following formats when specifying a region in the worksheet: „ rc Notation : Specify a cell using the letter r to denote the row, and the letter c to



denote the column. For example, to specify the cell in the third row and twelfth column, you would enter r3c12. To specify a rectangular region, follow the upper left cell of the region by the lower right cell, separated by two periods. For example, if the upper left cell of the region is r2c1 (second row, first column), and the lower right cell of the region is r4c4 (fourth row, fourth column), you would enter r2c1..r4c4 into the Graph Wizard. You can also specify the column first. For example, both c2r2...c4r5 and r2c2...r5c4 denote the same region in the worksheet.
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Figure 4-17 Selecting a Range of Data Using the rc Format



„ Excel Notation: You can use Excel notation in the Graph Wizard. In Excel notation,



the columns are alphabetized in lexicographic order and the rows are numbered. In this case, to specify a rectangular region you would again specify the upper left and lower right cells. For example, both A3:D9 and $A3;$D9 specify a region with the upper left cell in the first column, third row and the lower right cell as the fourth column, ninth row. Note that the separator is a colon. The letters are case insensitive. Figure 4-18 Selecting a Range of Data Using the Excel Forma



„ Column Numbers Notation: You can make a selection of a consecutive group of



entire columns by specifying the range of column indices. For example, to specify columns 1 through nine, type 1:9 or 1..9.
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Figure 4-19 Selecting a Range of Data Using the Column Numbers Format



Creating Graphs Using Templates, Layouts, and the Graph Style Gallery Templates apply the contents of an entire page, which you can use as the source for new pages. This is useful if the graphs you use have a complex layout with multiple graphs and non-graph objects. Layouts are similar to templates, but do not overwrite existing pages. Instead, they use the size and position attributes of the pages in the layouts to modify your existing graph. Create your own layout to fully maximize the potential of this feature. Use the Graph Style Gallery to create individual graphs. When you create and define a graph in the Graph Style Gallery, you simultaneously set the graph defaults for future graphs. The Graph Style Gallery preserves all attributes of a graph, except for the data, which you select when you create a graph using the Graph Style Gallery.



Creating Graphs Using the Graph Style Gallery Use the SigmaPlot Graph Style Gallery to create a graph from a predefined graph style. When creating a custom graph style, you save all graph, plot, and axes attributes, including graph size and position. Then you can quickly use these attributes to create future graphs. All you supply is the data, and the Graph Style Gallery formats the rest. Each graph style that you create appears as a thumbnail preview in the Graph Style Gallery. You can create new graphs by choosing one of the styles from the window.
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You can either double-click a graph or click Create Graph to create a graph. The graph then appears in a location defined by the graph style.



Docking the Graph Style Gallery The SigmaPlot Graph Style Gallery is a resizable window that you can dock like a toolbar, or leave floating. Double-click the Graph Gallery title bar to dock or undock it, or drag it to the desired docked or undocked position.



Applying Graph Styles to Pages Use the Graph Style Gallery to quickly apply your own custom graph styles to data. To apply a graph style: E On the View menu, click Graph Style Gallery. The Graph Style Gallery



window appears.
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Figure 4-20 Graph Style Gallery Box



E Double-click the graph style you want to use.



The Graph Wizard - Create Graph panel appears. For more information, see “Creating a Graphs Using the Graph Wizard ” on page 140. E Select the worksheet columns you want to use for the plot. E Click Finish to create the plot.



Adding Styles to the Graph Style Gallery After creating and formatting a graph, you can save its style in the Graph Style Gallery, and later apply that style to future SigmaPlot graphs. To add a graph style or object to the Graph Style Gallery: E Open the graph that you wish to add to the Graph Style Gallery.
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E If the Graph Style Gallery is not visible on your SigmaPlot desktop, on the View menu,



click Graph Style Gallery. E From the graph page, select the graph and drag and drop it into the Graph Style



Gallery window. A thumbnail of the graph appears in the Graph Style Gallery palette. The graph title appears as the graph style’s name. To use the right-click short cut menu: E Select the graph on the page. E Right-click and on the shortcut menu click Add Graph. The graph style appears



in the Gallery. Figure 4-21 Using the Right-Click Shortcut menu to Add a Graph to the Graph Style Gallery. Here, the Graph Style Gallery is docked.
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Creating Graph Style Gallery Graphs Using the Graph Wizard You can use the Graph Wizard in conjunction with the Graph Style Gallery to create graphs by selecting Graph Gallery as a graph type in the Graph Wizard. To create a Graph Style Gallery graph from the Graph Wizard: E On the Standard toolbar, click the Graph Wizard button. The Create Graph - Type



panel of the Graph Wizard appears. Figure 4-22 You can choose Graph Gallery as a Graph Type when creating graphs using the Graph Wizard.



E Under Graph Types, select Graph Gallery, and click Next.



The Create Graph - Gallery panel of the Graph Wizard appears. All graphs that appear in the Gallery graphs list are also in the Graph Styles Gallery.
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Figure 4-23 Selecting a Style from the Graph Style Gallery



E Under Gallery graphs, select the graph type that you want to apply to your data, and



click Next. The Create Graph - Select Data panel of the Graph Wizard appears. Figure 4-24 Selecting Data in the Graph Wizard



E Under Data for, select the worksheet columns to plot. If you make a mistake while



selecting data, select the correct column in the Selected Columns list. E Click Finish to create the graph. A graph appears on the page using the applied Gallery



graph style.
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Modifying Graphs Use the Graph Properties dialog box to make most graph modifications. To display the Graph Properties dialog box, double-click the graph.



Modifying Plots and Axes To modify a plot or the axes of a selected graph, click the Plots tab or the Axes tab. Use the Plot or Axis list to specify which plot or axis in the current graph you are modifying. Use the Settings for lists in the Plots and Axes tabs to gain access to many different plot and axis modification options. Figure 4-25 Using the Graph Properties Dialog Box Plots Tab to modify a graph. You can select a plot to modify from the Plot drop-down list.



Modifying Grids and Planes, Titles and Legends To modify grids or planes, open the Graph Properties dialog box, click the Graphs tab, and under Settings for, click Grid Lines or Backplanes.
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To hide or show graph titles and automatic legends, to hide or show plots, and to make modifications to automatic legends, click the Graph tab, and under Settings for, click Legends. To apply your changes, click Apply, or click OK to apply your changes and close the Graph Properties dialog box.



Selecting a Graph or a Plot To select a graph or plot: E View the page window. E On the Tools menu, click Select Object. A check mark appears next to the menu



command. Figure 4-26 On the Tools menu click Select Object to select objects on the graph page.



E Place the pointer over the desired graph or plot and click.
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Figure 4-27 Small, square handles surround selected graphs.



A selected graph is surrounded by small square handles. Alternative Method



As an alternative method to select a graph, on the Graph menu, click Select graph, and then click the name of the graph. Figure 4-28 To select a graph on a page, on the Graph menu, click Select Graph, and then click the graph.
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Naming Plots The default plot names are numeric; for example, Plot 1, Plot 2, etc. To assign a new name to a plot: E On the Standard toolbar, click the Graph Properties button. The Graph Properties



dialog box appears. Figure 4-29 Using the Graph Properties dialog box to rename a graph. Click Rename to open the Rename dialog box.



E Click the Plots tab. E From the Plot drop-down list, select the plot to rename. E Click Rename. The Rename Item dialog box appears.
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Figure 4-30 Type a new name for the plot in the Rename Item dialog box.



E Type a new name. E Click OK. The Rename Item dialog box closes. E Click OK to close the Graph Properties dialog box.



Naming Graphs The default graph names are numeric, and include the graph type; for example, 2D Graph 1, 2D Graph 2, and so on. To assign a new name to a graph: E Double-click the graph title that appears above the graph to select it. E Type the new name, making any font changes as necessary using the Format Text



toolbar. E Click elsewhere on the graph when finished.



Picking Different Data for the Current Plot To change data columns for an existing plot: E Click the plot to modify.



Square handles appear over the data points for the clicked curve. Do not click the graph, or you will add a plot to the graph.
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E On the Standard toolbar, click the Graph Wizard button. The Graph Wizard appears. Figure 4-31 The Graph Wizard displays the available Data Formats for the current plot



E Under Data Format, select a data format, and click Next. E If you don’t change the data format for your graph, your previous column choices appear



under Selected Columns. To change column assignments, under Selected Columns, select the desired assignment, then under Data For, select the appropriate column from the worksheet or from the data list. Figure 4-32 You can change the column assignments using the Graph Wizard.



Note: To clear a column assignment by double-click it in the Selected Columns list. E If you change the data format for your graph, a single data type is highlighted in the



Selected Columns list. To pick data, either click the corresponding column directly in the worksheet, or choose the appropriate column from the Data for list. Use this method to pick X, Y, or Z data, R and theta data, and error bar data, if applicable.
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E If you make a mistake while picking data, click the mistaken entry in the Graph Wizard,



then choose the correct column from the worksheet. E Repeat the process for every data column. When you have chosen the data appropriate



for your style of plot, click Back to repick data columns, or if applicable, click Next to pick data for additional plots. E Click Finish to close the Graph Wizard and view the changed graph.



Changing Graph Type and Style Change plots using the Graph Wizard; however, once you have defined a plot style and type, the styles and types available for you to apply to the created plot are limited. If the plot you have selected cannot be changed to the plot type or style that you want, use the Graph Wizard to create another plot using the desired style and type. To change graph type and style: E Click the plot to modify.



Square handles appear over the data points for the clicked curve. Do not click the graph, or you will add a plot to the graph. E On the Standard toolbar, click the Graph Wizard button.



The Graph Wizard appears displaying the data format of the current plot. E To change plot style, click Back to view the Graph Styles list. Choose from the list of



available styles then click Next.
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Figure 4-33 You can use Graph Wizard to change the type and style of the graph.



E To change the plot type, click Back twice to view the Graph Types list. Choose from



the list of available graph types, then click Next. E Click next until you can select a data format again for the new plot type or style from



the Data Format list, then click Next. You are prompted to specify which worksheet columns to plot. E If necessary, repick the data columns to plot. Otherwise, click Finish to complete you



plot type or style change. Note: If you are changing a 3D plot to a mesh plot, you may need to smooth your data..



Adding New Plots Graphs can have multiple plots and plot types. Although most 2D graphs with multiple curves do not require more than one plot, if you want to mix plot types on a single graph you will need to create multiple plots. Use multiple plots per graph rather than a single plot with many curves only if different plot types or styles are required (i.e., placing a bar chart and a line plot, or a 3D scatter and mesh plot on a graph), if different data formats are required (such as XY and Y only for a scatter plot), or if a curve requires a different axis (scale, range, etc.). 2D graphs with multiple plots can also have multiple axes.
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Figure 4-34 In this example of a graph with two plots, each plot has separate Y-axes



Creating Additional Plots Use the Graph Wizard, the Add Plot command, or Graph Wizard toolbar button to add a plot to a selected graph. To add another plot to a graph: E Click the graph to modify.



Note: Small square handles surround the graph. Do not click a curve, or you will modify that curve instead. E On the Graph menu, click Add Plot. The Graph Wizard appears displaying all the



graph types.
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The available styles and types for a new plot are limited depending on the other plot types and styles in the current graph; for example, you cannot add a Polar plot to a 2D Cartesian plot, or vice versa. Note: If the selected graph cannot accommodate the plot type or style that you want to add, the plot will be created as a new graph. You can move the graph of the new plot over the original graph so that it appears to be in the same graph. E Select a Graph Type and click Next. E Select a Graph Style and click Next. E Select a Data Format and click Next. E Pick data either by clicking the corresponding column directly in the worksheet, or



choosing the appropriate column from the data list. Use this method to pick X, Y, or Z data, R and theta data, and error bar data. Note: If you make a mistake while picking data, click the wrong entry in the Graph Wizard, then choose the correct column from the worksheet. You can also clear a column assignment by double-clicking it in the Selected Columns list. E Repeat the process for every data column. When you have chosen the data appropriate



for your style of plot, click Back to repick data columns, or if applicable, click Next to pick data for additional plots. E Click Finish.



Hiding, Showing, and Deleting Plots Occasionally, you may want to remove a plot from a graph without deleting it. You can hide plots from view without deleting them by using the right-click shortcut menu, or the Graph Properties dialog box. To hide a plot: E Right-click the plot.
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E On the shortcut menu, click Hide.



The plot is hidden, but not removed. Figure 4-35 You can use the right-click shorcut menu to hide graphs.



To show a hidden plot: E Double-click the graph. The Graph Properties dialog box appears.
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Figure 4-36 Showing and Hiding Plots using Graph Properties



E Click the Graph tab. E Under Settings for, click Plots.



All plots associated with the current graph are listed under Show/hide plots. A check mark in the check box next to the name of a plot indicates that the plot is displayed. E Clear a check box to hide a plot from view, or select it to show the plot.



To delete a plot: E Select the graph. E On the Graph menu, click Delete Plot. E Choose the plot you want to delete. E To delete the individual curves of a plot, select a curve on a graph, then press the Delete



key.
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Sampling Fewer Data Points If you have a graph with a large number of data points, you can plot only a portion of the column(s) or sample only a portion of the data from the column. This is useful if you are interested only in graphing part of the data, or if you want to increase drawing speed while working on the graph. To plot only a portion of your data: E Double-click the graph. The Graph Properties dialog box appears. E Click the Plots tab. E Select the desired plot from the Plot drop-down list. E To plot only a portion of your data, under Data sampling, select Only Rows, and then



enter the range to plot. E To sample the column rows by a specified increment, select by and type a number.



Typing a 2 samples every other row and reduces the number of rows plotted by 50%, typing a 3 samples every third row, and so on. You can also use the By list to select a number of rows plotted.
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Figure 4-37 You can sample data using the Plots tab on the Graph Properties dialog box.



Plotting Missing and Out of Axis Range Data Points You can choose to either plot or ignore bad points. Bad points are either missing values, or data that lie outside the axis ranges. Figure 4-38 The graph on the left plots both a missing data point and out-of-range data point. The graph on the right ignores both missing and out of range points.
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To ignore missing and out of-range points: E Double-click the graph. The Graph Properties dialog box appears. Figure 4-39 Graph Properties Dialog Box Plots Tab Data Settings



E Click the Plots tab. E Select Data from the Settings for list. E Select the desired plot from the Plot drop-down list. E To plot data without missing values, under Ignore, select Missing values. To plot



missing values, clear the option. E To plot data without out of range values, under Ignore, select Out of Range Values. To



plot out of range values, clear the option. E Click OK.
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Creating and Modifying Embedded SigmaPlot Graphs When you insert a SigmaPlot graph into a document as a SigmaPlot object, some different menus and options are available than when viewing graphs inside SigmaPlot. The following describes the behavior of SigmaPlot features while editing a SigmaPlot graph. Tip: You can also open embedded graphs inside SigmaPlot, gaining full SigmaPlot functionality.



Creating Embedded Graphs You can create embedded graphs in any number of ways, including: „ Copying and pasting into an application that accepts embedded objects, like Word,



Excel or PowerPoint. „ Using the Insert File or Object menu from an application that accepts embedded



objects. „ Running any of the SigmaPlot integration routines (for example., Excel



integration). „ Using the Paste to PowerPoint Slide or Insert Graphs into Word Toolbox macros.



Using Embedded Graph Menus and Commands The following SigmaPlot menu commands are available while editing embedded SigmaPlot graphs: „ Edit: Undo/Redo, Cut, Copy, Paste, Paste Link, Insert New Object, Links, Object. „ View: Toolbar*, Stop, Refresh, Suspend Redraw . „ Format: Text Properties, Line, Fill, Size and Position, Bring to Front, Send to Back,



Group, Ungroup, Align, Arrange Graphs. „ Tools: Select Object, Text, Draw Box, Draw Ellipse, Draw Line, Draw Arrow. „ Graph: Select Graph, Graph Properties, Add to Gallery*, Save as Web Page, Paste



to PowerPoint Slide, Paste Setup. „ Help: Contents and Index, Tip of the Day, SigmaPlot Tutorial, SigmaPlot



Automation, SigmaPlot on the Web, Publication Assistant, About SigmaPlot and more.
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*Denotes a command only available from the embedded graph menus.



Editing Embedded Graphs You can choose to edit a SigmaPlot graph from inside the current program, or open the embedded graph inside SigmaPlot. Editing "In-Place"



To edit a graph in place, double-click it. You can also right-click it and select Edit the SigmaPlot Graph Object. To modify the graph at this point, right-click or double-click the graph to access the different settings. Opening Graphs



To open an embedded graph inside SigmaPlot, you can right-click the inactive graph, and click Open the SigmaPlot Graph Object. The graph will open as a graph page and worksheet inside SigmaPlot as an Embedded Page. Note: No notebook window or file is associated with this graph. You can use the File menu to update the source document, or save a copy of the graph off as a new file.



Viewing Data for an Embedded Graph If you need to view or edit the data for an embedded graph, you must open that graph inside SigmaPlot.



Resizing Embedded Graphs The sizing and scaling of the SigmaPlot graph is controlled by the "container" application, that is, the program for the document where the graph has been embedded. However, you can change the size of the page for the embedded graph itself. This is particularly useful if for some reason the graph has been clipped, or you need to rescale and resize the graph or other page objects. The embedded graph resides on a graph page that has been clipped to just contain the embedded content. You can resize this page if necessary from the Graph menu.
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Creating SigmaPlot Graphs Using MicroSoft Excel You can launch the Graph Wizard and subsequently create a SigmaPlot graph using Microsoft Excel. Just as you would using SigmaPlot, you can select data from the workseet. You can also select ranges of data. If you change your data in Excel, the SigmaPlot graph automatically updates. To create a graph using Microsoft Excel: E On the Excel toolbar, click the SPW button, or on the Excel Insert menu, click



SigmaPlot graph.



The Graph Wizard appears. E Select Excel data and create the graph using the Graph Wizard.



Changing Symbol Type and Other Symbol Options You can specify the symbol type used either for the symbols in a single curve, or for all the curves in a plot. The default is to use the same symbol for a single curve and increment symbols for multiple curves. You can only modify symbols. Plots that normally use symbols are scatter plots, line plots, line/scatter plots, bubble plots, polar plots, box plots, 3D scatter plots, 3D trajectory plots, and ternary plots. Bubble plots use circles as the default symbol shape. If you choose a different symbol shape, you must change the transform function used to translate area to diameter. You cannot increment Symbols for single curves, unless there is only one curve within a plot.



Changing Symbol Type, Size, and Color To change symbol attributes: E Double-click the plot. The Graph Properties dialog box appears.
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Figure 4-40 Graph Properties Dialog Box Plots Tab Symbols Setting



E Click the Plots tab. E From the Settings for list, select Symbols. E From the Plot drop-down list, select the plot to modify. E To change the symbol type for the selected plot, from the Type drop-down list select a



symbol type, or choose to increment symbols using the one of the symbol schemes. To create a plot that displays lines only, turn off symbols by choosing (none). For more information, see “Automatically Incrementing Symbols” on page 170. E To change the size of the symbol, move the Size slider, or type a new value in the Size



box. By default, all symbols in a plot are the same size. Use symbols of different sizes by entering symbol sizes in a worksheet column, then selecting the column from the Size list. E To change the fill color of symbols for the selected plot, under Fill Color, select a color



from the Color list, or choose to increment fill colors using the one of the incrementing schemes. To turn off symbol fills select (none). For more information, see “Using Custom Symbol, Fill, Line, and Color Increments ” on page 187.
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Select (Custom) to open the Color dialog box to create or choose a custom color. For more information, see “Using Custom Colors” in Chapter 5. Note: Hollow Symbols are symbols that use (none) as the fill color. They are hollow, that is, they are composed of the edge lines only. Lines, error bars, and graph background colors all show through unfilled symbols. This is useful if you have many overlapping data points. E To change the edge color of symbols, from the Edge Color drop-down list, select a



color, or select to increment edge colors using the one of the incrementing schemes. To turn off symbol edge color, select (none). Use the (Custom) option to open the Color dialog box from which you can create or choose a custom color. E To control the color of symbol dots and crosshairs, or of text used as symbols, use the



Edge Color option. If a symbol is filled with black and has a black edge, then dots and



crosshairs automatically default to white. E To change the thickness of the symbol edge, move the Thickness slider, or type a new



value. E Click OK.



For more information, see “Using Characters and Text as Symbols” on page 173.



Automatically Incrementing Symbols When incrementing symbols automatically, symbol types are assigned to curves (or points, if the plot has only one curve) in the same order as the column pairs listed in the Graph Wizard. SigmaPlot increments symbols according to the selected scheme.
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Figure 4-41 Both graphs use the Doubles symbol scheme and the Black and White color scheme. The first graph has only one curve; the second has four. 16
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Symbol types and colors appear on the curves of the plot in the same order as the symbol types and colors in the right-click popup menus of the incrementing option. For more information, see “Using Custom Symbol, Fill, Line, and Color Increments ” on page 187. To automatically increment symbols: E Double-click the plot. The Graph Properties dialog box appears. E Click the Plots tab. E From the Settings for list, select Symbols. E From the Plot drop-down list, select the desired plot. E To increment symbol types and fill and edge colors automatically, under Symbols, from



the Type, Fill Color, and Color lists, select a symbol scheme.
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Figure 4-42 Right-click the symbol type to select the first symbol of the incrementing scheme.



Note: Increment schemes do not include (None) as a symbol type. E To change the first symbol type or color used in the incrementing sequence, from the



Symbols Type, Fill Color, and Edge Color drop-down lists, select Incrementing. Rightclick the selected Incrementing option, and from the shortcut menu, click First Symbol or First Color, then click the symbol type or color to start the incrementing sequence. E Click OK.
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Using Characters and Text as Symbols You can use numbers, characters, and text as symbols by entering them in a worksheet column and specifying the column in the Graph Properties dialog box. Figure 4-43 Using Text from a Worksheet Column as Plot Symbols 50
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For more information, see “Using Different Symbol Sizes” on page 176. To specify characters as symbols: E Enter the text you want to use as symbols in a worksheet column in the order you want



the curve(s) to use them. To use numeric values as symbols, add a space after each value in the worksheet. You can assign the numbers that appear aligned to the left as symbols.
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Figure 4-44 Example of Worksheet with Plot Symbol Text Entered in Column 3



You can use all the non-keyboard characters available for the default font. To view and access these characters, you can use the Windows Character Map utility. The Windows User’s Guide also lists these special characters, along with the keystrokes required to enter them. E On the Standard toolbar, click the View Page button. E Double-click the plot on which you want to use text symbols. The Graph Properties



dialog box appears.
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Figure 4-45 Change the font for text symbols by right-clicking the Type option and choosing Symbol Font.



E Click the Plots tab. E From the Settings for list, click Symbols. E Under Symbols, from the Type drop-down list select the column that contains the text



or numeric values you want to use as symbols. Note: The column option does not appear in the Type list unless text or symbols are entered in a worksheet column. E Under Symbols, right-click the Type box, and from the shortcut menu, click Symbol



Font. The Text Properties dialog box appears.
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Figure 4-46 Change the font for text symbols by right-clicking the Type option and choosing Symbol Font.



E Click the Font tab. E Select another font from the Font drop-down list.



This feature is especially useful if you wish to use Wingdings, Zapf Dingbats, or other iconic or symbolic fonts as a symbol. The Fill Color and Edge Thickness options do not apply to text and characters. E Click OK.



Using Different Symbol Sizes By default, all symbols in a plot are the same size. To use symbols of varying sizes, enter symbol size values in a worksheet column, then set symbol size using the Graph Properties dialog box.
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Figure 4-47 Using Symbol Sizes from a Worksheet Column for Plot Symbols Bubble Plot 18 16 14



Y Data



12 10 8 6 4 2 0 0



2



4



6



8



10



12



14



16



X Data



Symbol sizes are assigned to symbols and curves (or points, if the plot has only one curve) in the same order as the column pairs that form the curves are listed in Graph Wizard. To use worksheet values for symbol size: E Select the first cell of an empty column in the worksheet containing data for the current



plot. E Type the size values to use in the order you want to use them. Since the symbol sizes



correspond to symbol diameters or widths, make sure that the symbol sizes you enter are of a reasonable size, that is, small fractions of inches or only a few millimeters or points. If desired, you can also include the measurement unit for the value. For example, for inches type in, for millimeters type mm, or for points type pt.
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Figure 4-48 Example of Worksheet with Symbol Sizes Entered in Column 3



If you omit the measurement unit, the numeric values in the symbol size column are assigned the measurement unit specified in the Options dialog box Page tab. E Click the toolbar button to view the graph page. E Double-click the plot.



The Graph Properties dialog box appears. E Select the plot that contains the symbols to modify from the Plot drop-down list. E Use the Size drop-down list to choose the worksheet column containing the symbol



size values.
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Figure 4-49 Using the Plots Tab to Select Symbol Size from a Worksheet Column



E Click OK.



When creating a bubble plot, the Graph Wizard automatically prompts you to pick a column to specify bubble size. For more information, see “Bubble Plots” in Chapter 6.



Changing Line Type and Other Line Options You can change the line type, shape, thickness, and color for all lines in a plot. Because plots can also have multiple curves, you can also increment the line types and colors for any plot with multiple curves. Lines can only be modified in or added to plots that normally use lines, i.e., scatter plots, line plots, line/scatter plots, polar plots, 3D scatter plots, 3D trajectory plots, and ternary scatter, line, and line/scatter plots.
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Changing Plot Line Attributes To change the attributes of lines in a selected plot: E Double-click the plot. The Graph Properties dialog box appears. Figure 4-50 Graph Properties Dialog Box Plots Tab



E Click the Plots tab. E Select Lines from the Settings for list. E Under Line style, from the Type drop-down list, choose a line type. For more



information, see “Using Custom Symbol, Fill, Line, and Color Increments ” on page 187. Tip: To create a plot that displays symbols only, choose (None) to turn off lines. E To change the thickness of the line, move the Thickness slider, or by type the new value



in the Type box. E Choose a line shape from the Shape drop-down list.
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E To change the color of the lines in the selected plot, select a color from the Color drop-



down list, or choose to increment line color using the one of the incrementing schemes. Select (None) to create transparent lines. This in effect turns them off. Use (Custom) to create or choose a custom color. For more information, see “Using Custom Colors” in Chapter 5. E To control the layering of plot lines, use the Layering drop-down list to place lines



behind or in front of plot symbols. Note: Hollow symbols (None) will always show plot lines. E Click OK.



Automatically Incrementing Lines Line types and colors appear on the curves of the plot in the same order as the line types and colors in the right-click popup menus of the incrementing option. There are two line type incrementing schemes: Incrementing and Monochrome. There are nine different incrementing color schemes to choose from for line colors. Figure 4-51 Each of these graphs uses the Incrementing option, but are assigned different starting line types. 80
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For more information, see “Using Custom Symbol, Fill, Line, and Color Increments ” on page 187.
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To use automatically incrementing line types: E Double-click the plot. The Graph Properties dialog box appears. Figure 4-52 Graph Properties Dialog Box Plots Tab Right-click Menu



E Click the Plots tab. E Select Lines from the Settings for list. E Select a plot from the Plot drop-down list. E From the Type and Color drop-down lists, choose a line scheme.



Note: Windows is limited in its ability to supply the true colors for lines by the number of system colors available. For the best representation of true line colors, set your display to either HiColor (16-bit) or TrueColor (24-bit). E Right-click the incrementing option selected in the Type and Color drop-down lists,



and from the shortcut menu, select First Line or First Color. E Choose First Line or First Color from the shortcut menu.
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E Choose the line type or color to start the incrementing sequence. E Use the Line Thickness, Shape, Line Color, and Layering options to modify the lines,



if necessary. For more information, see “Changing Plot Line Attributes” on page 180. E Click OK.



Changing Patterns and Fill Colors You can modify and increment the background colors, patterns, and pattern colors used for plots. You can only modify or add fill colors and patterns to plots that normally use fills, i.e.,area plots, bar charts, box plots, pie charts, 3D bar charts, and ternary plots.



Changing Plot Fill Patterns and Colors Modern laser printing and color slides have removed much of the need for using hatch marks and other line patterns for bar and pie charts. Use gray shades and colors whenever possible.
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Figure 4-53 Example of a Bar Chart with a Gray Scale Fill Color Scheme 25 Col 2 Col 3 Col 4 Col 5 Col 6
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To change fill attributes: E Double-click the plot. The Graph Properties dialog box appears.
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Figure 4-54 Changing Fill AttributesUsing the Graph Properties Dialog Box



E Click the Plots tab. E From the Plot drop-down list, select the plot that contains the fills to modify. E From the Settings for list, select Fills. E To change the background fill color, under Fill Color, from the Color list, select a



color, or choose to increment fill colors using the one of the incrementing schemes to change the background fill color. E To turn off background fills, select (None). E To create a custom color, select (Custom). For more information, see “Using Custom



Colors” in Chapter 5. E To change the fill pattern and density for the selected plot, under Pattern and Edge,



from the Pattern list, select a fill pattern, or select to increment fill patterns using one of the fill schemes. To turn off fill patterns, select (None). E To change the thickness of the pattern lines and edges, move the Thickness slider.
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E Click OK.



Automatically Incrementing Chart Fills You can increment fills for bar charts automatically using the Graph Properties dialog box. When incrementing fills, different fill colors and patterns are assigned to each bar, box and pie chart slice in the plot. If you are incrementing fills for a grouped bar chart fill colors and patterns are assigned to each group in the plot in the same order the column pairs forming the groups are listed in the Graph Wizard. For more information, see “Using Custom Symbol, Fill, Line, and Color Increments ” on page 187. There are two file type incrementing schemes: Monochrome and Incrementing. There are nine different incrementing color schemes to choose from for fills. To use automatically incrementing fills: E Double-click the plot. The Graph Properties dialog box appears. Figure 4-55 Graph Properties Dialog Box Plots Tab Right-click Menu



E Click the Plots tab.
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E From the Plot drop-down list, select the plot that contains the fills to modify. E From the Settings For list, select Fills. E Select a scheme from the Color and Pattern drop-down lists. Colors and patterns



appear in the bars, boxes, or pie chart slices of the plot in the same order as the rightclick shortcut menu. E Right-click the incrementing option and from the shortcut menu, select First Pattern



or First Color, and then select the pattern or color to start the incrementing sequence. E Click OK.



For more information, see “Changing Plot Fill Patterns and Colors” on page 183.



Using Custom Symbol, Fill, Line, and Color Increments When using a series of incremented symbols, fills, lines, or colors you have defined, the increment scheme is assigned to curves or points in the same order the columns plotted for the curves are listed in the Graph Wizard. Figure 4-56 A Bar Chart Using Custom Incremented Fills
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To define and apply a series of incremented symbols, fills, lines, or colors: E View the worksheet. E On the Insert menu, click Graphic Cells. The Insert Graphic Cells dialog box appears. Figure 4-57 Using the Insert Graphic Cells Dialog Box to Specify a Custom Line Sequence



E Click the Colors, Lines, Symbols, or Patterns tab.



Note: Using symbol types from a column specifies the symbol shape only. If you want to change the symbol fills, create another color column and use it as the symbol fill colors. Typically, white is used for hollow symbols, and black for solid symbols. E Select the first cell in an empty column in the worksheet. E Double-click the color, line, symbol, or fill pattern in the Insert Graphic Cells dialog



box you want to place in the cell. Note: Do not mix graphic cell types within the same column; for example, place colors in one column, symbols in a different column, fills in yet another column, and lines in a fourth column. However, you can use multiple columns to define several different increments of the same graphic cell type. For example, you can have several columns containing colors of differently ordered increments. The item appears in the worksheet cell.
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E Continue adding to the column, in the order you want the curves to use the colors, lines,



symbols, or patterns. The order of the curves is the order in which they appear in the Selected Columns drop-down list in the Graph Wizard. E Close the Insert Graphic Cells dialog box. E Click the View Page button. E Double-click the plot. The Graph Properties dialog box appears. Figure 4-58 Assigning Custom Symbol Colors in a Worksheet Column to a Plot



E From the Plot drop-down list, select the plot to modify. E From the Settings for list, select Fills, Area Fills, Symbols, or Lines, depending on



what you have defined in the worksheet. E Choose the name of the column which contains the appropriate graphic cells from the



Symbols Type, Fills Foreground Pattern, or Lines Type, or Color drop-down lists.



If you are applying a large number of colors or other property schemes, you may wish to turn off the automatic legend, which will attempt to display your first 25 different data points. For more information, see “Editing Automatic Legends” in Chapter 5.
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E Click OK.



Changing Bar and Box Widths and Spacing Control the amount of space between bars and boxes, and between grouped 2D and 3D bars by adjusting the percent of the maximum possible widths of both the individual bars and the bar groups. Figure 4-59 From left to right: bar charts with a group spacing of 50% and relative thickness of 100%, group spacing and relative thickness both set to 66%, and both settings set to 100%. 10
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To control bar and box width and spacing for bar charts and box plots: E Double-click the plot to modify. The Graph Properties dialog box appears.
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Figure 4-60 Graph Properties Dialog Box Plots Tab Widths Settings



E Click the Plots tab. E From the Settings For list, select Widths. E To change the width and spacing between bars for all bar charts and box plots, move the



Bar Thickness slider. The wider the bars or boxes, the less space between them. The narrower the bars or boxes, the more space between them. E To change the width and spacing between groups of 2D and 3D bars, move the Group



Spacing slider. This option is only available for grouped and 3D bar charts. SigmaPlot sets grouped bar widths and spacing to as wide or as narrow and as far or as close as possible given the corresponding spacing or width setting. E To set a constant width for all bars or boxes, from the Width drop-down list, select



Uniform. This is the default setting. If the bars are set to Uniform, the Bar Thickness setting has the same effect on all bars. For more information, see “Uniform versus Variable Bar Widths” on page 193.



 192 Chapter 4



E To set potentially uneven widths for bars and boxes, select from the Width drop-down



list, select Variable. If the constant column values are uneven, the bars will vary in width according to the corresponding axis values. Change bar widths according to the percent of their total widths, if the bars are set to Variable, so that wide bars are more affected than thin bars. Note: Bars created with a single plot will not overlap. However, you can create bars using separate plots and overlap them. For more information, see “Spacing Bars from Different Plots” in Chapter 6. E To create a needle plot, move the Bar Thickness slider to set bar widths to the narrowest



possible widths. Figure 4-61 To make a histogram needle plot, create a bar chart and set the Bar Thickness to Needle. Histogram 700 600
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E To change bar alignment, from the Align drop-down list, select either Center, Left, or



Right. By default, bar chart bars are centered around the data point. Use Align to alternately draw the bars right or left aligned with the data points.
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Figure 4-62 From Left To Right: Bar Charts with Alignments to the Left of the X Points, to the Right of the X Points, and Centered over the X Data Points



E Click OK.



Uniform versus Variable Bar Widths Uniform bar widths set all individual bars to the same width, using the width of the narrowest bar. If the values which the bars are plotted along are unevenly incremented, the bar widths still remain constant. Variable bar widths set the widths to be as wide as possible, as determined by the Bar Thickness and Group Spacing settings. If the values which the bars are plotted along are evenly incremented, this option has no effect. However, if the values which the bars are plotted along are unevenly incremented, the bar widths will vary according to their corresponding values. Figure 4-63 The bar chart on the left is set to a uniform width; the bar chart on the right uses a variable width.



 194 Chapter 4



Adding and Modifying Drop Lines Use drop lines to produce dot plots and other types of graphs which connect data points to their axis values. You can add drop lines from plotted data points to either or both axes in a 2D scatter, line, or line/scatter plot, or to any or all back planes in a 3D scatter or trajectory plot. Drop lines are drawn for every curve in a plot. Figure 4-64 The graphs on the left are examples of 2D plots with drop lines to the Y and X axes. The graph on the right is an example of a 3D graph with drop lines to all axes. 7 Defense 6
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Drop lines always fall toward the minimum of a range; for example, if a Y axis range were reversed, a drop line to the X axis would fall to the top of the graph rather than the bottom. Use the Drop Lines settings in the Graph Properties dialog box Plots tab to create new drop lines, and to modify existing drop line type, thickness, and color. To add or modify drop lines for a selected plot: E Double-click the plot to modify.



The Graph Properties dialog box appears.
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Figure 4-65 Graph Properties Dialog Box Plots Tab Drop Lines Setting for a 2D Scatter Plot



E Click the Plots tab. E From the Plot drop-down list, select the plot that contains the drop lines to modify. E From the Settings For list, select Drop Lines. E Select the X or Y drop-line check box. Drop lines are added to any and all planes or



axes that are selected. E From the Type drop-down list specify the type of line to use for selected drop lines. E To adjust line thickness, move the Thickness slider, or type the new value in the



Thickness box. E To set drop line color, select a color from the Color drop-down lists. Select any of the



listed colors, or select (Custom) to select or define a custom color. For more information, see “Using Custom Colors” in Chapter 5. E Click OK.
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Drop Lines for a Single Point You can use drop lines to indicate the position of a single point. To show a single drop line, create a second plot which graphs only the desired data point, then add drop lines to the single-point plot. If you do not want the symbol to show for the point, set the symbol type to (None). Figure 4-66 Drop Lines Used to Indicate the Values of Points on a Graph Spline Graph with Drop Lines Y axis 16 14 12 10 8 6 4 2 0 0
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Plotting and Solving Equations Use the Plot Equation dialog box to create and plot equations defined using the Transform language. You can use one of over 100 built-in equations, or create an equation of your own and save it to a notebook. To create and plot an equation and save it to a notebook: E With the worksheet in view, on the Graph menu, click Plot Equation. The Plot



Equations dialog box Equation tab appears, either with Untitled or the name of the last used equation in the Name field.
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Figure 4-67 Plot Equation Dialog Box Equation Tab and Functions Palette



E To manually enter the equation, from the Name drop-down list, select Untitled. E If necessary, delete the existing equation in the f = field, and then either type the



equation, or click the Functions Palette button to open the Functions Palette. The Functions Palette provides immediate access to some of the most frequently used functions. You can also select one of the last ten used functions from the Name drop-down list. For more information, see “Plotting Saved Equations” on page 201. E From the Variables group box, select either 2D or 3D. E Set the independent variables using the Name, Minimum, Maximum, and Intervals



boxes. „ Name: Type the name of the independent variable(s).



Minimum and Maximum: Type the extent of the range of values for the corresponding



independent variables.
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„ Intervals: Set the number of intervals for sampling independent variables over a



specified range. Note: You can also select a column in the worksheet. The range of that column appears in the Minimum and Maximum edit boxes. E To set the equation parameters, click the Options tab. For more information, see



“Setting Equation Parameters” on page 200. E Click Add As. The Add As dialog box appears. Figure 4-68 Add As Dialog Box



E Type the name of the equation in the Equation Name edit box. E Click OK. The equation name appears in the Name drop-down list on the Equation tab. Figure 4-69 Plot Equation Dialog Box Equation Tab



E Click Plot. A graph page appears with the plotted equation, and the equation values



appear in the worksheet.
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E Click Close to close the dialog box.



If desired, you can add plot an equation and add it to the existing graph, or plot a new equation on a new graph page.



Plotting Equations onto Existing Graphs Use the Plot Equation dialog box to plot equations onto existing graphs. This is especially helpful if you want to see how the curves change by modifying the parameters. To plot the equation: E Select the graph. E On the Graph menu, click Plot Equation. The Plot Equation dialog box appears. Figure 4-70 Plot Equation Dialog Box Equation Tab



E Either manually enter the equation in the f = edit box, or choose an existing equation,



or use the same equation as used previously if you want to change the parameters. E To set the equation parameters, click the Options tab. For more information, see



“Setting Equation Parameters” on page 200.
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Figure 4-71



E If you don’t want to create a second graph page, select Add to current graph and clear



Create new graph. E Click Plot. The plot appears on the current graph. E Click Close to close the Plot Equations dialog box.



Setting Equation Parameters All equations that you create or use from the Standard.jfl library have editable parameters. You can either enter the parameters or modify them using the Graph Equation dialog box Options tab. To set equation parameters: E With the worksheet in view, on the Graph menu, click Plot Equation. The Plot



Equation dialog box appears.
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Figure 4-72 Plot Equation Dialog Box Options Tab



E Click the Options tab. E In the Parameters box, enter or edit the parameters.



Enter parameters with the name of the parameter first, followed by an = sign, and then the value, i.e. a=3 or b=7.231 E To assign a value to the next parameter, press Enter. E Click Plot to plot the equation.



Plotting Saved Equations Each equation you create is saved in the Standard.jfl library. Select the equation to plot from the Library tab of the Plot Equation dialog box. You can also select one of the last ten equations plotted from the Name drop-down list of the Plot Equation dialog box Equations tab. To plot an equation using the Library tab: E With the worksheet in view, on the Graph menu, click Plot Equation. The Plot



Equation dialog box appears.
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Figure 4-73 Plot Equation Dialog Box Library Tab



E Click the Library Tab. E Select an equation category from the Equation Category drop-down list. The items that



appear in the Equation Category drop-down list are sections in the Standard.jfl library. Below, in the Equation Name list, are items that appear under that section name in the notebook. E Select an equation from the Equation Name list. E Click Select. The Equation tab appears with the selected equation displayed in the



Name drop-down list.
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Figure 4-74 Plot Equation Dialog Box Equation Tab



Some of the settings for SigmaPlot’s built-in equations in the Standard.jfl library are read-only. To modify a built-in equation, click Add As to create an equation based on the built-in equation. E Click Plot.



A graph page appears with the plotted equation, and the equation values appear in the worksheet. E Click Close to close the Plot Equation dialog box.



Solving Equations Use the Equation Solver on the Plot Equations dialog box to evaluate mathematical expressions for functions and to solve equations. The Equation Solver uses the expression entered in the Equation tab on the Plot Equations dialog box as the basis for its results. This expression then appears on the Solve tab for evaluation. To solve an equation: E On the Graph menu, click Plot Equation. The Plot Equation dialog box appears.
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Figure 4-75 Plot Equation Dialog Box



E Click the Equation tab, and enter an equation in the f = box.



You can also select one of the last ten used functions from the Name drop-down list, or you can choose any of the built-in parameterized equations used by the Regression Wizard. Select these equations from the Library, too. For more information, see “Plotting Saved Equations” on page 201. E Click the Solve tab. The entered equation appears in the f = box on the Solve tab. Figure 4-76 Solve Tab of the Plot Equation Dialog Box
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E Under Options, select the mode of operation. You can select from one of the following: „ Evaluate F at Enter a numerical value for each variable that occurs in the



expression in the boxes that appear at the bottom of the dialog box. „ Solve equation for x within range Enter a numerical value into the box which



appears to the left of the expression (the default value is 0) to complete the definition of the equation. You must also enter limits for a range of values of the equation variable. The default range limits are taken from the values entered on the Equation tab. The Solver is only available for expressions containing a single independent variable, although any number of parameters can be present. E Under Options, click Evaluate or Solve, depending on the selected mode of operation.



The resulting value or the equation solutions that lie between the prescribed range appear in the Results box. Figure 4-77 Solve Tab of the Plot Equation Dialog Box



Results Box Tips and Tricks „ The Results box keeps a tally of all evaluation and solving results relative to the



given expression. If you alter this expression on the Equation tab or select a new plot expression, the Results box appears with no text. Modifying the expression also clears the other boxes on the Solve tab. „ Click Copy to place the entire contents of the Results box onto the Clipboard.
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„ You can annotate the results in the Results box. All annotations are preserved when



your perform further computations using the same expression. „ In addition to displaying the results of evaluating functions and solving equations,



the Results box also displays estimates for any singularities found in the course of solving an equation. Singularities are values of the expression variable (in the given range) where the expression is undefined. When you perform a computation, a label precedes the values in the Results box to indicate the type of output displayed.



Equation Solving Guidelines Sometimes the solutions to an equation 0 = f(x) are not obvious and the basic methods for solving it are unavailable. If this is the case, then the simplest way to estimate the location of solutions is to: E Using the Plot Equations dialog box, graph the function equation y = f(x). E Observe where the graph intersects the x-axis.



This technique aids in determining range limits for the independent variable in the Function Solver (Solve tab of the Plot Equation dialog box). If the distance between two solutions of an equation is small relative to the size of the range, then the Function Solver may not return both solutions. The resolution of the solutions is approximately two orders of magnitude less than the size of the range. You can obtain higher resolution by adjusting the range limits to reduce the range size. There is particular difficulty, due to roundoff error, in determining solutions to 0 = f(x) at points where the graph of y = f(x) does not cross the x-axis, but lies on one side of it. An example of this situation is the graph of y = x^3+x^2 at x = 0. Although in many cases, as with the above equation, the Function Solver provides the solution, in some cases, however, the solution will not be found and recorded in the Results box. If you suspect that there is such a solution and the Function Solver does not find it, then try the following technique for approximating the solution: E Alter the value for the left side of the equation by a small amount. E Re-solve the equation.
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This is equivalent to slightly shifting the graph of the equation up or down until it lies on both sides of the axis. In general, the Results edit box then reports two solutions that are very close together. As smaller amounts are used to adjust the left side of the equation, these two solutions are seen to converge to one solution. As an example, try solving the equation 0 = sin(2*x)*cos(3*x) over the range from x = 1 to x = 2. The Function Solver will indicate that there are no solutions. Using the above technique will yield solutions that are close to the true solution of PI/2. Spurious Solutions



A less frequent problem involves the appearance of spurious solutions. Due to the limits of floating point numbers, the value of an expression f(x) at x = a might compute to zero even if x = a is not a true solution to 0 = f(x). This situation commonly arises when the graph of y = f(x) is very "flat" near a point where it intersects the x-axis. For example, consider the equation 0 = x^201. If you solve this equation over the range from x=0 to x=1, then the Function Solver will return 13 solutions even though the only true solution is x = 0. This is because each of 13 results raised to the 201st power is equal to zero in the machine’s floating point representation.
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5 Graph Page Basics Use Graph Pages to display and modify graworking_with_page_objectsphs that plot data from your worksheets. You can create as many graph pages as you wish per worksheet. New graph pages are associated with the current worksheet, and are placed in the current notebook section. This chapter covers: „ An overview of graph pages (see page 210). „ Working with page objects (see page 212). „ Adding another graph to a page (see page 215). „ Zooming in and out (see page 216). „ Using graph pages as templates (see page 219). „ Cutting, copying, and pasting graphs and other objects (see page 226). „ Dragging and dropping graphs (see page 238). „ Hiding and deleting objects from the page (see page 239). „ Modifying object colors and lines (see page 244). „ Moving and sizing graphs and objects (see page 248). „ Aligning page objects (see page 253). „ Editing text (see page 260). „ Working with automatic legends (see page 264). „ Changing graph page format (see page 271). „ Using custom colors (see page 276).
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About Graph Pages Graph pages are true graphical representations of a printed page that contain graphs, text, and other drawn and pasted objects. You can select objects on graph pages and modify them using the Graph and Object Properties dialog boxes, and with the Graph and Drawing toolbars. You can manipulate all objects graphically using your mouse. A page can contain an unlimited number of graphs and other objects, and you can create an unlimited number of pages for each worksheet. You can also paste graphics, OLE (Object Linking and Embedding) objects, and other objects onto a page. Graph pages are created in several ways. You can create a graph page as a notebook item, or by using the Graph Wizard, the Graph Style Gallery, or by templates. For more information, see “Creating Graphs” in Chapter 4.



Setting Page Options Control graph page properties are using the Options dialog box Page tab. To open the Options dialog box, on the Tools menu, click Options, and then click the Page tab.



Exporting Graphs and Pages You can export SigmaPlot graphs and graph pages to other files formats. To export a graph or graph page: E Select and view the graph page. If you want to export specific graph(s), select the



graphs you want to export to a file. E On the File menu, click Export. The Export File dialog box appears. E Enter the file name, directory and drive for the export file destination. E Click Export. If you chose one of the graphic file formats, a secondary dialog box



appears, asking you to enter some graphic format information.
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Figure 5-1 Export Tagged Info File Dialog Box



E Enter the desired DPI and Color Resolutions; for EPS files, these setting only affect



the resolutions of the TIFF header, not the actual PostScript resolution. For metafiles, this setting affects only 3D graphs. The higher the DPI and Color resolutions, the better quality the image, but also the larger the file. Limit the DPI and Color resolutions to the capability of the intended output device. For example, if you are going to create 600 dpi slide output, set the DPI resolution no larger than 600. E If you want to export only the selected graph(s) or objects, select Export selected only. E Click OK to create the exported file using the specified file name and graphic



resolutions, if applicable.



Printing Graph Pages You can print any graph in a SigmaPlot notebook. To print a graph page: E Select and view the page window. E Click the Print button to print the page using all the default settings.
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To set printing options before you print the graph page: E On the File menu, click Print. The Print dialog box appears. E Click Properties. The printer Properties dialog box appears. E Click OK when you are satisfied with the printer properties settings. The Properties



dialog box closes. Note: The Properties dialog box options vary from printer to printer. E Click OK to print the report.



Working with Page Objects Using SigmaPlot menu commands, dialog boxes, and wizards you can create and modify graphs and other page objects. Graph Wizard



The Graph Wizard guides you through a series of dialog boxes to select the type and style of graph, and to select worksheet data for plotting. After you create the graph, you can open the Graph Wizard to add or modify plots and axes. Graph Properties



The Graph Properties dialog box customizes the plots, axes, grids planes, titles and legends of your graph. Use it for more advanced modifications to your graph. To open the Graph Properties dialog box, double-click anywhere on the graph, or on the Graph menu, click Graph Properties. The Plots, Axes, and Graph tabs offer many customizing features. The tab that appears depends on where you click on the graph. Click the Help button to learn more about the specific options and controls for each tab.
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Object Properties



The Object Properties dialog box modifies many graph attributes including drawn objects. Use the Object Properties dialog box to make simple modifications to the objects and graphs. The Line and Fill tabs change fill patterns, lines of your plots and objects. The Size and Position tab changes position, scaling and size for all objects. To open the Object Properties dialog box, select an object on the graph page, rightclick, and then on the shortcut menu, click Object Properties. Text Properties



The Text Properties dialog box modifies font and paragraph text attributes for all text on a page. Use the Text Properties dialog box to change attributes of non-editable text, as well as attributes for multiple text labels, and making global text changes. Selecting text properties with no selected text sets the default attributes for new text labels. To open the Text Properties dialog box, on the Format menu, click Text Properties.



Selecting Page Objects When you select text, drawn objects, or individual elements on the graph page, and then double-click, you open the dialog box specific to that element. To select a graph element, make sure you are in selection mode by clicking the Page toolbar Select Object button, or choose the Tools menu Select Object command, or press Ctrl+B. A check mark next to this command indicates that you are in selection mode. Selected objects are surrounded with square handles; selected axes and text are surrounded by dotted lines.
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Figure 5-2 Selecting an Axis



Selecting Multiple Objects



To select multiple objects, hold down the Shift key while clicking objects, or drag a window completely around the objects you want to select. When you select multiple objects, only the last selected object has solid black handles; the other objects have hollow handles. Figure 5-3 Selecting Multiple Objects
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You can edit, copy, paste, move, size and scale, delete or hide all selected page objects, including graphs, text, drawn objects, and pasted objects. The following table summarizes the results of selecting various objects on the graph page. Select:



Graphs Plots Axes Tick marks Tick labels Axis titles Legends Fills or Lines



By: Double-click Double-click Double-click Double-click Double-click Double-click Double-click Right-click



Opens: Graph Properties dialog box/Plots tab Graph Properties dialog box/Plots tab Graph Properties dialog box/Axes tab Graph Properties dialog box/Axes tab Graph Properties dialog box/Axes tab Edit manually Edit manually Graph Properties dialog box/Plots tab



Adding Another Graph to a Page You can add additional graphs to the current graph page by: „ Creating a new graph onto the current page. For more information, see “Creating a



New Graph for the Current Page” on page 215. „ Copying a graph to the same page. For more information, see “Copying a Graph on



the Same Page” on page 216. „ Copying and pasting a graph from another page. For more information, see



“Copying and Pasting a Graph from One Page to Another” on page 216.



Creating a New Graph for the Current Page If you want to add a graph to a page by creating a new graph, first add the data for the new graph in the worksheet associated with the current graph page. View the active graph page, then either select a graph from the graph toolbars, choose the Graph menu Create Graph command, or click the Graph Wizard button.



 216 Chapter 5



Copying a Graph on the Same Page One of the quickest and the easiest ways to add a second graph is to copy the one you have already created, then modify it.



Copying and Pasting a Graph from One Page to Another You can copy a graph from a graph page within the current notebook section, or from a different notebook section. To copy a graph from one page to another: E Select the graph you want to copy. E Press Ctrl+C. E Make the destination page the current page either by opening it, or if it is already open,



select the graph page name from the Window menu. A check mark next to the page name indicates that it is the active window. Note: If the destination page is in a different notebook than the source page, you must close the source page, and any other open work in the source notebook. E Press Ctrl+V to paste the graph.



The graph appears on the current page, and the graph data appears in the worksheet associated with the current page. Another method is dragging and dropping. For more information, see “Dragging and Dropping Graphs” on page 238.



Zooming In and Out Use View menu commands to control display of the worksheet window. You can view the page at several different levels of magnification, magnify the page centering on a specified page location, or choose a completely unobstructed view of the page.
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Viewing the Full Page To view the full page without toolbars, title bars, scroll bars, or the status bar, on the View



menu, click Full Screen. The page appears without any obstructions. To return to normal view of the page, press any key on the keyboard. The screen returns



to its normal appearance.



Magnifying the Page There are three ways to change the magnification of the entire graph page: „ Select a zoom level from the toolbar drop-down list. You can also enter a custom



zoom anywhere between 10 to 2500. „ Click the Custom Zoom button on the Standard toolbar to zoom in on a specific



region of the page. The pointer changes to a magnifying glass; select a region on the page by dragging the mouse, then release the mouse button. The region is zoomed to the selected area. Figure 5-4 Using the Zoom Pointer to Select a Region on the Page



„ Use keyboard shortcuts while viewing the page window. The zoom keyboard



shortcuts to view the page are: E At 50% actual size, press Ctrl+5.
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E At 100% actual size, press Ctrl+1. E At 200% actual size, press Ctrl+2. E At 400% actual size, press Ctrl+4 E Entire page, press Ctrl+F E Magnified for a specific region, press Ctrl+U.



Using the Zoom Dialog Box Use the Zoom dialog box to change the zoom level to fixed or custom levels. To change the zoom: E On the View menu, click Zoom. The Zoom dialog box appears. Figure 5-5 The Zoom Dialog Box



E Choose the desired zoom level to fit the page to the window, or to zoom to a full screen



view. Select Custom and move the slider or enter a specific zoom level to set a percentage of magnification.
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Figure 5-6 Graph Page Zomed to 200%



Using Graph Pages as Templates Graph page templates simplify graph and graph page creation and modification. You can use templates to create pages and graphs with preset properties. For example, if you need to create a set of slides, you can open pages that are already set to attributes for slides. Note: Never use templates to add a graph to a page. Template pages are ordinary graph pages. Any graph page can act as a template page if it is copied to a section or used from the File menu New command to create a new page. All attributes from the page - size, color, margins, and orientation - are retained. Any graphs and other objects on the page are also duplicated. Template graphs automatically plot the worksheet column data that was selected when the graph was created. When applying a page to a worksheet, make sure your data is already arranged as required, or re-pick the data for the graph after applying the template. You can determine which columns are plotted by either looking at the worksheet footers, or you can open the Graph Properties dialog box for the template graph, and click the Plots tab, and then under Settings for, click Data.
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Note: Graphs created by templates can be modified like any other graph. For more information, see “Creating Graphs” in Chapter 4.



Applying Templates There are three methods for using pages as templates: Method



Result



Creates a new page with attributes from the template applied. Using a template from the New For more information, see “Creating a New Page with Attributes Page command. from a Template” on page 220. Creates a new page in a section, using the data in the existing Copying a graph page from one worksheet for graphs. For more information, see “Copying a notebook section to another. Graph Page to Use as a Template” on page 221. Replaces the existing page. For more information, see Overwriting an existing page. “Overwriting an Existing Page” on page 221.



Creating a New Page with Attributes from a Template E On the File menu, click New. The New dialog box appears. Figure 5-7 Graph Page Zomed to 200%



E Select Graph Page from the New drop-down list. E Select the type of graph page you want to open from the Type scroll-down list.
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E Click OK.



Copying a Graph Page to Use as a Template The best method of applying a page template to a worksheet is to use an existing graph page as a template. The copied page acts as a template using the worksheet in the new section. For more information, see “Copying and Pasting Items in the Notebook Manager” in Chapter 2. If you plan to copy a page, set up your worksheet so that the data is in the appropriate columns before applying the template. You can also change the columns to plot after applying a template by selecting the plot, opening the Graph Properties dialog box, and clicking the Graph Wizard button. For more information, see “Picking Different Data for the Current Plot” in Chapter 4.



Overwriting an Existing Page When you apply a template to an existing graph page, all features of the existing page are lost. To apply a template to an existing page: E Make the graph page the active window. E On the File menu, click Templates. The Templates dialog box appears. E Select a template from the Templates list. E Click Apply.



To apply a template from a different notebook template file: E Make the graph page the active window. E On the File menu, click Templates. The Templates dialog box appears. E Click Browse.
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E Select the path and file name of the desired SigmaPlot Notebook or template file. E Click Open. E Select a template from the Templates list in the Templates dialog box. Figure 5-8 The Templates Dialog Box



E Click Apply.



Templates and Notebooks Store templates as pages in notebook files with the extension .jnt. You can open and edit template notebooks like any other notebook file; the different extension is only provided for organizational purposes. A sample template notebook, Template.jnt, is provided with SigmaPlot, and is set as the initial template source notebook. For more information, see “Where Files Go” in Chapter 1.
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Figure 5-9 An Opened Template.jnt file in the Notebook Manager..



Template.jnt is the default source for new pages. It contains both pages with no graphs and pages with graphs. You can modify existing pages or add your own graphs or graph pages to Template.jnt. Open the file, open the page you want to modify, then save your changes. You can add files by creating new pages or by copying pages from your notebooks to Template.jnt. For more information, see “Adding Another Graph to a Page” on page 215. You can also create your own template notebook containing your own customized graph pages. Save template notebooks as SigmaPlot Template (.jnt) files, then specify that file to be your Template File.



Changing the Page Created with the New Page Button The New Page toolbar button automatically uses whichever page is titled Normal as the source for new pages. If you want to modify the attributes of your new page, open and modify the Normal page, or replace it with the desired page.
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If there is no page named Normal in your template file, the page is formatted according to settings found in the spw.ini file. For more information, see “Where Files Go” in Chapter 1.



Changing the Template File Used for New Pages SigmaPlot automatically uses the template notebook when you open a graph or graph page. Set the file name in the General tab of the Options dialog box. To change the source file template: E On the Tools menu, click Options. The Options dialog box appears. Figure 5-10 Options Dialog Box General Tab



E Click the General tab.
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E Type the path and file name of the desired template file in the Template File field. E Click OK. The notebook becomes the default template source.



Note: If a valid default template source file is not specified, a default page is created instead. This page is a letter-sized, white portrait page by default.



Adding New Pages to Template.jnt You can add a previously created page to the Template.jnt notebook. To add a page to Template.jnt: E On the File menu, click Open. The Open dialog box appears. E Select Template Notebook from the Files of type drop-down list. E Select Template.jnt from the SPW9 folder. E Click Open. E Open or view the notebook file containing the page you want to add to Template.jnt. E Select the page you want to copy. E Press Ctrl+C. E Select the section of Template.jnt where you want to add the new page. E Press Ctrl+V. The page is added to Template.jnt. E Save and close Template.jnt. E On the File menu, click New. The New dialog box appears. E Under New, select Graph page. The page you copied appears on the list.
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Cutting, Copying and Pasting Graphs and other Page Objects Cut and copy selected page objects to theClipboard using the toolbar, or by using Edit menu commands.



Cutting and Copying Graphs The easiest way o cut or copy a graph or other page object select the graph or object to cut or copy by clicking it. To cut the item, click the Cut button on the Standard toolbar, choose the Edit menu Cut command, or press Ctrl+X . To copy the item, click the Copy button on the Standard toolbar, choose the Edit menu Copy command , or press Ctrl+C . A copy of the selected graph or object or is placed in the Clipboard. Since copied items remain in the Clipboard until replaced, you can paste as many copies as you want without having to cut or copy the object each time.



Pasting Objects You can paste Clipboard contents to any open page, report, or into any other Windows application that supports Windows Metafiles or OLE (Object Linking and Embedding). To paste an object to a page, click where you want the object to appear, then press Ctrl+V . You can also click the Paste button on the Standard toolbar, or choose the Edit menu Paste command . For more information, see “Using OLE to Paste, Link, and Embed Objects ” on page 227. Note: The Clipboard is a Microsoft Windows feature. To learn more about how the Clipboard works, refer to your Windows User’s Guide.
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Using OLE to Paste, Link, and Embed Objects There are various ways to paste SigmaPlot objects into other applications, and vice versa. One method is using OLE (Object Linking and Embedding), which is fully supported by the SigmaPlot page. OLE provides the ability to move or copy information among supporting applications, and to use the applications interchangeably to modify the data.



SigmaPlot and OLE SigmaPlot can place and receive OLE and other types of objects, such as scanned images, clip art, or text from a word processor. For example, you can place an equation created with the Microsoft Word Equation Editor into a SigmaPlot report, and edit it with the Word Equation Editor when it changes. Figure 5-11 Example of an Microsoft Excel Equation Embedded into a SigmaPlot Report
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Methods Of Placing Objects You can copy, cut, and paste graphs among applications without using OLE. The method of placing objects depends on each application’s implementation. The following table shows how objects can be placed: Type of Object



Destination Application



OLE object



Can be placed if application supports OLE. Can be placed if application doesn’t support OLE, but supports pictures. Can be placed in Windows applications only. Can be pasted in applications that support bitmaps only (for example, Microsoft Paint).



Windows Metafile Enhanced Metafile Bitmap



Note: SigmaPlot always pastes an OLE object if it is available. The SigmaPlot graph and report pages support OLE. Graphs (not graph pages) pasted into SigmaPlot reports are always pasted as Windows metafiles.



Commands to Place Objects SigmaPlot provides the following commands and functions to place, link, and embed objects on a graph or report page: Command or Function Definition and Use



Embeds an OLE object, if there is one in the Clipboard. Connects to data in the originating application but not directly to a file. If there is Paste Command no OLE object in the Clipboard, a non-editable picture or text is placed. Allows you to choose Clipboard file types and to also embed objects Paste Special Command and links. Insert New Object Directly creates and places an OLE object without using the Command Clipboard. Allows embedding the object or linking to a file. Drag and Drop Moves, or copies any Clipboard object (usually OLE).



Linking or Embedding Objects Use Paste Special, Insert Object , and Ctrl+Drag to either link or embed the object in the page or report.
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Linking appears to place a copy of the object in the destination application, but actually only places a reference to it. Therefore, the object is modified every time the original file is modified. You can only link to a file if you create an object using the Paste Special or Insert New Object commands , or if you drag and drop an object with the Ctrl key held down. Linking is useful when you need to update an embedded object when the file is updated. The disadvantage of linking objects is that you cannot open a referenced file if the locations of either the SigmaPlot file and the source file change. Embedding places a copy of the object in the destination application, and then you can edit it by activating its source application when you double-click it. Embedding does not use a reference file; the "file" is actually embedded completely in the SigmaPlot file. For example, if a Microsoft Word embedded object has been placed in a SigmaPlot report, and you double-click it, Microsoft Word opens. Word temporarily runs under SigmaPlot. When you are finished editing the item and close Word, SigmaPlot remains open. Embedding an object has the advantage of keeping all the associated data in one place, but can create large files. To embed an object: E With a graph page in view, on the Insert menu, click New Object . The New Object



dialog box appears. E Select the type of object to insert from the Object dialog box. A description of the



object type appears in below. E Click OK to insert the object.
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Placing SigmaPlot Objects into Other Applications You can paste SigmaPlot graphs and reports into other applications, and link or embed them for future editing with SigmaPlot. For example, you can paste a SigmaPlot graph into a Microsoft Word document (as an OLE object), and use the SigmaPlot Graph Properties dialog box to edit it by double-clicking the graph. When you link to SigmaPlot and double-click the graph or report, the notebook file containing the graph or report opens. You can change the source of any linked object, with the Change Source command. For more information, see “Viewing and Modifying Object Links” on page 236.



View as Icon With OLE, the View as Icon allows you to place an icon representing the application that created the file in your data. For example, if you have a description of a graph written in a Microsoft Word document, you can embed it, and display it as an icon that shows on the graph page. If you want the object displayed as an icon, select the Display As Icon option. Click the icon to view and edit the object in its source application. Figure 5-12 Displaying a Microsoft Word Document as an Icon on a Graph Page
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To embed the object and view as an icon: E With a graph view, on the Insert menu, click Insert Object . The Insert Object dialog



box appears. E Select the type of object to insert from the Object drop-down list, and click OK . E Select Display as Icon . E Click OK to insert the object as an icon.



Identifying Objects on the Graph Page You can determine the type of object on the graph or report page with the Edit menu Object command. Select the object, then on the Edit menu click Object. The Object command changes to reflect the file type of the selected object. For example, if you select a bitmap object, the Object command displays Bitmap Image Object.



Placing SigmaPlot Graphs into Other Applications You can copy or cut SigmaPlot graphs to the Windows Clipboard, then paste the graph directly into another document, like a word processing or desktop publishing page, without having to do any file exporting or importing. You can also drag and drop graphs directly from SigmaPlot into any other Windows program that supports OLE. For more information, see “Dragging and Dropping Graphs” on page 238. To paste a graph to another application: E Select the graph to cut or copy. E Press Ctrl+X or Ctrl+C . The graph is cut or copied. E Open or switch to the other application, and click where you want the graph to appear.
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E Paste the graph, typically using the Edit menu Paste command . If the graph isn’t an



OLE object, try the Paste Special command, and select SigmaPlot Graph or SigmaPlot Graph Object. To create a link between SigmaPlot and the other application, click the Paste Link button. To insure you are pasting an OLE object, use the Paste Special command. If a Paste Special command doesn’t exist, the application probably doesn’t support OLE. Figure 5-13 Using the Paste Special Dialog Box to Paste a Graph from SigmaPlot to another program



The SigmaPlot graph appears in the other application. E You can now in-place activate the graph by double-clicking it, or open it in SigmaPlot,



by choosing the Edit menu Object command. If the application does not support OLE, the SigmaPlot graph is pasted as a metafile or bitmap graphic. SigmaPlot graphs pasted with the Edit menu Paste command take their plotted data with them in the form of the plotted graph (the worksheet is not shown). If you want to view or edit the data, you must open the graph rather than simply editing it.
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Figure 5-14 Example of a SigmaPlot Graph Pasted into Microsoft Word.



Pasting Objects onto a Graph Page or Report You can paste contents, including OLE objects, into both page and report documents. To paste artwork, text from a word processing application, or other objects onto a graph or report page: E Open the application and file containing the desired artwork or text, and cut or copy



the object. E Switch to SigmaPlot and view the graph or report page. E Click the location where you want the object to appear, then press Ctrl+V. The graphic



is pasted to the page. If the object can be an OLE object, SigmaPlot always defaults to the OLE object. E To paste the object as a specified file type, choose the Edit menu Paste Special



command. The Paste Special dialog box appears.
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Figure 5-15 Using the Paste Special Dialog Box to Paste an Object from Microsoft Word to SigmaPlot



Note: The options available in the Paste Special dialog box depend on the type of file being pasted. E If you want the object displayed as an icon, click Display As Icon. Click the icon to



view and edit the object in its source application. You can also specify a different icon to display the pasted object. Click Change Icon and select a different icon. E Click Paste to paste the object as a specified file type. Select Paste Link to paste the



object as a linked file that can be updated in another application. The options in the As list change depending on your selection of either Paste or Paste Link, and the explanation in the Result box changes depending on your selection in the As list. E Select the type of object to paste from the As box, then click OK. The object appears



at the selected location.
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Placing Objects without the Clipboard You can select objects from applications that are installed on your system and to place them into a SigmaPlot graph or report with the Insert New Object command. The object types available on your system depend on the applications installed, and appear in the Object Type drop-down list of the Insert New Object dialog box. To insert an object using the Insert Object command: E View the report or graph page, and click where you want the insertion point. E On the Insert menu, click New Object. The Insert Object dialog box appears. E If you want to display the new object as an icon, select Display As Icon.



You can also specify a different icon to display the inserted object. Click the Icon button to open the Change Icon dialog box. Choose a different icon from the available options, or click the Browse button to search for alternative icons on your system. E To create a new object to place on the report or graph page, select Create New, then



choose the type of object from the Object Type list. Click OK to open the application associated with the selected object. Create the desired object, then use the application’s appropriate Exit command to close the application and return to SigmaPlot. The created object is displayed on the graph or report page as an embedded object. Figure 5-16 The Insert Object Dialog Box
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E To insert an object from an existing file on the report or graph page, select Create from



File, then type the path and file name of the desired file in the File edit box, or click the Browse button to open the Browse dialog box, from which you can select the



appropriate path and file name of the object you want to place. E Select the Link option to place the object on the page as a linked object. When a file



is linked, it is modified in your graph or report page when it is modified in the original application. If you did not select theLink option, the object is pasted as an embedded object. Figure 5-17 The Insert Object Dialog Box After Selecting Create From File, with the Display as Icon Option Checked



E Click OK.



Viewing and Modifying Object Links You can view and modify links with the Links dialog box. The Links dialog box displays all links associated with the current graph or report page. To view and modify links: E View the graph or report page by selecting it.
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E On the Edit menu, click Links. The Links dialog box appears displaying the path, file



name, type of file, and if it is a manually updated or automatically updated link, of all links on the page. Figure 5-18 The Links Dialog Box



If you do not have any linked objects on the page, the Links box is empty. E To change the updating to either Automatic or Manual, select the unselected option. If



Automatic updating is selected, the object changes automatically when the source file is changed. If Manual updating is selected, you must click Update Now to update the linked object with any changes made to the source file. E To edit a linked object, select the object name in the Links dialog box, then click Open



Source. The source file opens in the appropriate application where you can make



changes, then exit the application and return to SigmaPlot. If Automatic updating is selected, the object reflects the changes; if Manual updating is selected, you must click the Update Now button to apply changes to the linked object. E To change the source file for a linked object, click Change Source. Choose the new



path and file name, then click OK. The link appears in the Links dialog box with the new path and file name. You may need to click the Update Now button to view this change in your document.
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Figure 5-19 The Change Source Dialog Box



E To end the link between an object and its source file, click Break Link.



The object is no longer treated as a linked object. E Click OK to close the Links dialog box.



Dragging and Dropping Graphs Using OLE you can drag objects between compatible applications within Windows. Additionally, you can drag and drop graphs from one graph page to another. To drag a graph into another application, you must be operating within Windows or Windows NT 4, and the other application must support OLE. E Make sure the other application is open and visible from the desktop, with the location



where you want to drop the graph also visible. E Select the SigmaPlot graph you want placed in the other program, then drag the graph



from the SigmaPlot page. If you want to drop a copy of the graph, press the Ctrl key while dragging. E Move the mouse to the location you want the SigmaPlot graph to appear. E Release the mouse; the graph appears at the drop location. You can now edit the graph



with SigmaPlot in the future by double-clicking.
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Note: You can also drag and drop graphs onto your Windows desktop. Dropping a graph onto the desktop creates a scrap file that can be dragged into another document at a later date.



Dragging and Dropping Graphs Between Pages You can drag a graph from one graph page to another. If you drag a graph from a different notebook section, it will insert its data into the destination section worksheet. To copy or move a graph from one graph page to another: E Open the source and destination pages. The pages must still be within the same



notebook, but can be in different sections. E Select the graph and drag it from the original page to the new page. If you want to copy



rather than move the graph, press the Ctrl key while dragging. E Release the mouse where you want the graph to appear. The graph is placed on the new



page. If the page is in a different section, the data plotted by the graph is copied to the current worksheet.



Hiding and Deleting Objects from the Page You can delete drawn and pasted page objects from the page, and graphs, automatic legends, automatically created graph titles, plots, and axes can be deleted and/or hidden from view. For more information, see “Hiding, Displaying, and Deleting Axes” in Chapter 9.



Hiding and Viewing Graphs on a Page The quickest way to hide a graph on page is to select the graph page, then right-click the graph you want to hide, and on the shortcut menu, click Hide.
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To control which graphs are displayed on the page: E On the File menu, click Page Setup. The Page Setup dialog box appears. Figure 5-20 Graph Layout Tab of the Page Setup Dialog Box



E Click the Page Layout tab. The graphs on the current page are listed in the Sh?wn box. E To hide a graph, select it from the list and click Hide. The selected graph is moved to



the Hidden list. (To select multiple graphs, hold down the Shift or Ctrl key while making selections.) E To view a hidden graph, select it from the Hidden list and click Show. E Click OK to apply your selections and close the Page Setup dialog box.



Note that hidden graphs do not print.



Hiding Graph Titles and Legends You can hide automatically generated graph and axis titles and legends from view without being permanently removed from the graph page.
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To hide an automatic legend or automatically created graph title: E Right-click the legend or title and on the shortcut menu, click Hide. The title or legend



is not deleted, only hidden. E You can also hide graph titles, axis title, and legends using the Graph Properties



dialog box. Open the Graph Properties dialog box by double-clicking the graph. You can also right-click the graph, and on the shortcut menu, click Graph Properties. E Click the Graph tab. E Under Settings for, select Legends. E To hide the graph title, clear Show Title. E To hide the automatic legend, under Legend properties, clear Show Legend. E To hide axis titles, select the Axes tab, under Settings for click Labels, and clear the



Show Axis Title option(s). E Click OK to apply the changes and to close the Graph Properties dialog box.



The titles and automatic legend no longer appear on the graph page. Restore the title and legend by returning to the Graph Properties dialog box and checking the Show Title and Show Legend options.



Removing Graphs, Plots, Titles, Legends, and Other Page Objects Anything on the graph page can be removed from the page by selecting the object, then pressing the Delete key, or choosing the Edit menu Clear command. Deleting removes curves, plots and graphs entirely. You can use undo (Ctrl+Z) to retrieve these items. When a graph or plot is removed, worksheet data remains intact. Delete also completely removes drawn and pasted objects. Note that delete only hides titles and legends, and does not remove them permanently.
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Drawing Objects on the Page Use the Tools menu Draw Box, Draw Ellipse, Draw Line, and Draw Arrow commands to draw rectangles, ellipses, lines, and arrows, or use the Page toolbar. Any drawn object or text is not attached to the graph until they are grouped with the graph. For more information, see “Grouping and Ungrouping Objects” on page 252.



The Page Toolbar Use the Page toolbar to quickly and easily access Tools menu commands. Figure 5-21 Drawing Objects on a Page
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The drawing tools on the Page toolbar buttons are:



Select Object: Use the Select Object button to select objects on the graph page.



Draw Line:Click this button to draw a line on the graph page.



Draw Arrow:Click this button to draw an arrow on the graph page.



Draw Box:Use the Draw Box button to draw a box on the graph page.



Draw Ellipse:Click this button to draw an ellipse on the graph page.



Text: Click this button to add text, labels, or manually created legends to the graph page.



Drawing an Object To draw an object: E Click a drawing tool on the Page toolbar, or choose a drawing command from the



Tools menu. E The pointer has a crosshair appearance when over the graph page. Place the pointer



over the page where you want the object to begin, press and hold down the left mouse button, then drag the pointer to draw the object.
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E Release the mouse button to finish drawing the object.



Modifying Object Colors and Lines Use Format menu commands or double-click selected objects to modify line type, thickness, color, line end appearance (arrow heads, etc.), object fill color, pattern, and pattern color. You can make these modifications using the Object Properties dialog box. You can also use the Graph Properties dialog box to change fill patterns and colors. For more information, see “Changing Object Fills” on page 244.



Changing Object Fills Change fill patterns and colors of drawn rectangles and ellipses, and of graph symbols, bars, and boxes using the Object Properties dialog box. Note: When you select multiple objects, fill options apply to all selected objects that can be filled, including lines. For more information, see “Using Custom Colors” on page 276. To change the background color of an object fill: E Select the object(s) to modify on the graph page. E On the Format menu, click Fill. The Object Properties dialog box appears.
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Figure 5-22 Object Properties Dialog Box Fill Tab



E Click the Fills tab. E From the Background Color drop-down list, choose a color. E Click OK to apply your changes and to close the dialog box.



Changing Lines For drawn lines and graph lines, you can change line type, color, and thickness. You can also use the Object Properties dialog box to add arrowheads and other line endings to lines. For more information, see “Using Custom Colors” on page 276. To change line color: E Select the object(s) to modify: E On the Format menu, click Line. The Object Properties dialog box appears.
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Figure 5-23 Object Properties Dialog Box Line Tab



E Click the Line tab. E Under Line, select a color from the Color drop-down list. Choose None to create a



transparent line. E Click OK to apply your changes and to close the dialog box.



To change line type and thickness: E Select the object(s) to modify: E On the Format menu, click Line. The Object Properties dialog box appears. E Click the Line tab. E To set the line type, under Line, select a type from the Type drop-down list. E To set the line thickness, use the Thickness slider. Clicking the slider causes the slider



to move incrementally, while dragging it moves it more precisely. To change the range of control of the slider, move the slider to one end of the selectable range, select the text in the corresponding edit box, and type a new numeric value.
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E Click OK to apply your changes and to close the dialog box.



Changing Line Ending Attributes Edit line ending attributes for existing lines and arrows, or set the default line endings for drawn arrows. Line ending attributes affect only plain lines and arrows, not graph lines. To change line ending attributes: E Select the line(s) to modify: E On the Format menu, click Line. The Object Properties dialog box appears. Figure 5-24 The Line End tab of the Object Properties Dialog Box



E Click the Line End tab. E Add or edit line ends at both the start and end of a line. The Start options add or modify



the beginning end of the line (where you start drawing the line). The End options add
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or modify the line end at the end of the drawn line (where you stop drawing the line by releasing the mouse button). E To change the type of line used, select a style from the Style drop-down list. E To change the arrowhead length and angle, move the Angle and Length slider. The



angle is the angle between the arrowhead line and the main line. The Angle option is unavailable if the line Style is dotted or plain. Note: Clicking the slider causes the slider to move incrementally, while dragging it moves it more precisely. To change the range of control of the slider, move the slider to one end of the selectable range, select the text in the corresponding edit box, and type a new numeric value. E Click OK to apply your changes and to close the dialog box.



Changing Multiple Page Objects When making changes to multiple objects with different properties, the Object Properties dialog box options are blank. Only options that are changed are applied to selected objects. For more information, see “Selecting Page Objects ” on page 213.



Moving and Sizing Graphs and Objects You can modify graph or object size and position either by using your mouse on the page, or by setting specific position, size, and scaling options in the Size and Position tab of the Object Properties dialog box.



Using Your Mouse to Move Graphs and Objects When you use your mouse to move graphs, graph titles, axis labels, and automatic legends are automatically grouped with a graph and move with it. You can move graphs and objects to other page windows.
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Figure 5-25 Moving a Graph



To move a graph or object with your mouse: E Select the desired graph. E Drag it to the desired position. A dotted outline of the graph follows the pointer



indicating the location of the moved graph. E Release the mouse button. The graph moves to the new position.



Using Your Mouse to Change Graph and Object Size The easiest way to adjust the size and shape of a graph is to resize the graph using the mouse. You can also specify proportional scaling of graphs and objects so that the height and width ratios are maintained, and choose to rescale graph and axis titles and tick marks accordingly. To adjust graph or object size with the mouse: E View the page window.
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E Click the graph or desired objects to select them. Selected page objects are surrounded



with small square handles. Place the pointer over a handle. E Press and hold down the left mouse button to drag the handle to a new location. The



shape of the pointer changes when you move it over a handle, indicating the direction you can stretch the graph or object. Drag a side handle to stretch or shrink an object horizontally, drag a top or bottom handle to stretch or shrink an object vertically, or drag a corner handle to stretch an object two-dimensionally. A dotted outline of the resized graph or object follows the pointer position. Figure 5-26 Resizing a Graph



Dragging a corner handle preserves the aspect ratio (relative height and width) of objects by default. Also, graph text, symbols and tick marks are rescaled along with the graph. To disable these features, use the Tools menu Options command and change these Page option settings. For more information, see “Setting Page Options ” on page 210. E Release the mouse button when finished. The graph or object resizes to the



indicated size. Note: Unlike graphs and drawn objects, you cannot stretch or shrink text labels manually. To resize text, change the font size. For more information, see “Formatting Text ” on page 262.
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Setting a Specific Size and Location To move a graph or object to a specific location on the page, or to scale the graph or object to a specific size, use the Object Properties dialog box Size and Position tab. To set graph size and location with the Object Properties dialog box: E Select the graph or object on the page by clicking it. E Right-click the selected item, and on the shortcut menu, click Object Properties. The



Object Properties dialog box appears. Figure 5-27 Object Properties Dialog Box Size and Position Tab



E Click the Size and Position tab. E To set the distance of the selected object from the top and the left of the page, under



Position, move the Top and Left sliders or type new values in the Top and Left boxes. E To change the size of the selected object, under Size, move the Height and Width sliders



to set the size to specific measurements, or scale the object to a new size by typing a percentage in the Height and Width boxes. E Click OK.
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Nudging Graphs and Objects You can use your keyboard arrow keys to move graphs and objects on a graph page. Select the object using your mouse, and then move the object by using the arrow keys. You can also select objects by pressing the Tab key. Press Shift+Tab to scroll back. Press Shift+Arrow to select multiple objects. Pressing an arrow key moves the graph or object one one point, or .014in. You can change this default setting in the spw.ini file. If you have activated Snap-to grids, nudge will not work unless you set the nudge value to be greater than or equal to the Snap-to value. You cannot nudge computable objects, such as plots and all parts of plots, tick marks, and regression, reference, and grid lines.



Moving Objects to the Front or Back You can move selected objects so that they appear in front of or behind other page objects. To move an object to the front or back: E Select the object to move by clicking it. E To move the selected object to the foreground, on the Page toolbar, click Bring to Front.



The selected object is drawn in front of all other objects. E To move the selected object to the background, on the Page toolbar, click Send to Back.



The selected object is drawn behind all other objects. Note: If you select more than one object, the selected objects remain in their relative front to back positions. Grouped objects, including titles and legends with graphs, move as a single object.



Grouping and Ungrouping Objects You can move and modify selected items on the page by grouping multiple objects as one object. To individually modify grouped objects, you must ungroup them first.
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Objects and text must be grouped with the graph for them to stay in place, and move with the graph if you shift the graphÔø¾s location. To group and ungroup objects: E On the Page toolbar, click Select Object. E Select the graph, by clicking it, if you wish to attach the graph to the objects or text. E Select the objects and text to group by holding down the Shift key while selecting



individual objects. Handles appear around the graph and each selected object. E On the Page toolbar, click Group. The Group command and button are available only



when more than one object is selected. All selected objects are grouped and can be selected, moved, sized, aligned, and positioned as a single object. To ungroup objects on a graph page: E Select the group. E On the Page toolbar, click Ungroup.



If you have grouped a group, you may need to ungroup the objects as many times as they have been grouped.



Aligning Page Objects You can align labels and objects with each other as well as with graphs and axes. To align page objects: E Select the labels, graphs or other object(s) you want to align by holding down the Shift



key while selecting individual objects. (You must select more than one object to use the Align command.)
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E On the Page toolbar, click Align. The Align dialog box appears. E Under Horizontal and Vertical, choose the appropriate options to align the selected



objects vertically, horizontally, or both. Graphical feedback for your selections appears in the lower right corner of the dialog box. E To align selected objects relative to each other, select Each Other.



You must have multiple objects selected if you want to align selected objects relative to each other. Each Other moves aligned objects with respect to the last selected object, which remains in a fixed position. The last selected object can be distinguished from other selected objects by solid rather than hollow selection handles. E To align objects relative to the page margins rather than the page edge, select Page



Margins.



Note: If you select Page Margins, objects will not move with respect to each other. You can select Page Margins to place single objects. To set margins for each page, on the File menu, click Page Setup. E Click OK.



Working with Grids and Rulers Use grids and rulers to quickly and easily align graphs and objects on the page. You can show or hide grids and rulers from the Options box, View menu, or you can rightclick the graph page to open the shortcut menu. Although visible on the screen, they do not print with the page. Control the grid and ruler attributes using the Options dialog box.



Using Rulers Rulers are optionally displayed at the top and left hand side of all graph pages. They display the current units set in the Tools menu Options dialog box. You can choose between inches, centimeters, or points.
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Using Snap-to You can use Snap-to if the grids are displayed or hidden. Select Snap-to in the Tools menu Options dialog box, or right-click the graph page and on the shortcut menu, click Snap-to. Graphs and objects snap to the nearest grid.



Using Crosshairs Use Crosshairs as an object alignment tool. To turn on crosshairs, click the Crosshairs button on the upper left hand corner of the graph page window. Crosshair lines extend from the pointer tip to the rulers and to the right and bottom of the window, and follow the pointer. To hide crosshairs, click the Crosshairs button again.



Arranging Graphs Use layout templates to quickly arrange, resize, and set positions of graphs on a page. Layouts, like templates, use a .jnt extension and are stored in notebooks. For more information, see “Using Graph Pages as Templates” on page 219. A sample layout notebook, layout.jnt, is provided with SigmaPlot and is set as the default layout source notebook. For more information, see “Where Files Go” in Chapter 1. Using SigmaPlot’s Arrange Graph dialog box and General tab on the Options dialog box, you can: „ Apply an existing layout template to a graph page. „ Add new pages to Layout.jnt. „ Create your own custom layout template file. „ Change the default template file.



Applying Layout Templates to Arrange Graphs Use the Arrange Graphs dialog box to apply existing layout templates to a graph page.
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To arrange graphs on a page: E Select the graph page. E On the Format menu, click Arrange Graphs. The Arrange Graphs dialog box



appears. Figure 5-28 Arrange Graph Dialog Box



E From the Layouts list, select a layout for the page. A preview of the layout appears in



the Preview window. Note: You must apply a layout to a page that has the same or fewer number of graphs. E Click Apply. The graphs on the page match the layout you selected, and the Layout



dialog box remains open. E To arrange the graphs again, you can select another layout from the Layouts list, then



click Apply, or click Close to close the dialog box.
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Adding New Pages to Layout.jnt You can add a previously created page to the Layout.jnt notebook. This is especially useful for saving layouts you create yourself. For example, you can add a layout created in one notebook, and copy and paste it into the layout.jnt notebook. .Jnt files are template files. For more information, see “Applying Templates” on page 220. To add a page: E On the File menu, click Open. The Open dialog box appears. Figure 5-29 Open Dialog Box



E Select Template Notebook (*.jnt) from the Files of type drop-down list. E Select Layout.jnt from the SPW9 folder. E Click Open. The Layout.jnt notebook appears in the Notebook Manager.
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Figure 5-30 Layout Notebook



E Open or view the notebook file containing the page you want to add to Layout.jnt. E Select the page you want to copy. E Press Ctrl+C. E Select the section of Layout.jnt where you want to add the new page. E Press Ctrl+V. The page appears in Layout.jnt and also at the bottom of the section. E On the File menu, click Save to save the notebook.
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Creating a Custom Layout Template File You can create your own template file with a .jnt extension in which you can create and save your own custom layouts. To create your own layout template file: E Create a graph page and position the graphs as desired. E On the File menu, click Save. The Save As dialog box appears. Figure 5-31 Save As Dialog Box



E Type the name of the new layout template notebook in File name box. E Select SigmaPlot Template File from the Save as type drop-down list. E Click Save. Now you can add future layouts to their own separate layout notebook.



Changing the Default Layout Template File Set the default layout template file using the Options dialog box General tab.
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To change the source template file: E On the Tools menu, click Options. The Options dialog box appears. Figure 5-32



E Click the General tab. E Type the path and file name of the desired layout file in the Layout file field. E Click OK. The notebook becomes the default layout source.



Editing Text Use the Page toolbar to add and edit text labels and legends to the graph page, in addition to editing automatically created graph and axis titles. SigmaPlot automatically creates legends for every plot. You can modify the existing automatic legend by
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clicking the Text button on the Page toolbar, and then edit the text using the Formatting toolbar. You can format tick and contour labels, but you cannot edit their content.



Creating Text Labels You can add an unlimited number of text labels and legends to any graph page. SigmaPlot for Windows supports: „ All TrueType, PostScript, and other fonts installed on your system. „ Multiple lines of text aligned left, right, or centered, with adjustable line heights. „ Mixed fonts and other attributes within a single label. „ Multiple levels of superscripting and subscripting. „ Rotation of text in single degree increments. „ Color using up to 16.7 million different combinations of red, green, and blue



To create text labels or legends on a page: E Select and view the page window, then click theText button on the Page toolbar. This



places you into text mode until another mode or tool is selected E Click the page where you want the label to begin. A text box appears. E Select the font, character size, and other starting character attributes from the



Formatting toolbar.



The Rotation, Alignment, and Line Spacing options affect the entire label, not just the selected text, and Line Spacing is a minimum spacing control, not fixed. If you change the height of characters by changing font sizes or by adding superscripts or subscripts, the line height adjusts automatically. Note: Using the Default Text Properties you can set default text label attributes by opening the Text Properties dialog box with no labels selected. For more information, see “Formatting Text ” on page 262. Note: In addition to using the Greek Characters button to add a Greek symbol to text, you can also select pre-existing text and choose Symbol as the font type in the Text Properties dialog box. For more information, see “Formatting Text ” on page 262.



 262 Chapter 5



E Type your label. E To type additional lines, insert a line break by pressing Enter. E To change the attributes of text already typed in the Edit Text dialog box, drag the cursor



over the text you want to change to highlight it, then click the appropriate button, such as normal font, bold, italics, underline, sub or superscript, or symbol. E To switch back to normal text from greek, superscript, or subscript text, click the Normal



button. E To add legend symbols to your text, click Symbols. The Symbol palette appears.



Editing Text and Individual Characters To edit existing text on a graph page, you can click the text if you are in text mode, or if you are in select mode, double-click the text. For more information, see “Selecting Page Objects ” on page 213.



Formatting Text If you want only to change the attributes (the formatting) of selected text on a graph page, use the Formatting toolbar. The Text Properties dialog box sets properties for all selected labels, and applies changes to all characters within selected labels. Note: If you have complex font and character changes within a label, take care not to overwrite these formats with Text Properties dialog box settings. Global Text Changes:



The Text Properties dialog box is useful for formatting multiple labels as well as all text on a graph. Select the graph and choose Text Properties, then select the attributes you want applied to all graph labels and titles.
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Default Text Properties:



The Text Properties dialog box is used to set the default character and paragraph properties for new labels. Open the Text Properties dialog box with nothing selected, and set the options you want applied to new text labels. To format text using the Text Properties dialog box: E Select the text object you want to modify.



If you want to modify several text objects, hold down the Shift key while clicking the objects, or drag a select window around all objects E On the Format menu, click Text Properties. The Text Properties dialog box appears. Figure 5-33



E To change the font, style, character size, or color of text, or to underline text, click the



Font tab.



Note: If you have multiple text objects with different text properties selected, the attributes that are not the same appear blank. Do not select an attribute for these options unless you want it to be applied to all selected objects. E To change paragraph attributes, including line spacing, alignment, or rotation, click the



Paragraph tab.
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Figure 5-34 Text Properties Dialog Box Paragraph Tab



E Click OK to apply the changes and close the dialog box.



Working with Automatic Legends Legends work as a key for your graph. They label what the different graph symbols, lines, or fills represent. SigmaPlot automatically creates legends for all graphs, always placing them below the graph on the left side. Legend entries are labeled using the titles of the columns plotted; if there are no column titles, column numbers are used instead. Move and modify legends as you would any other page object. They also have a special set of controls and features. This section describes how to modify and control these automatic legend features. You can also add legend symbols to any text label or title. For more information, see “Creating Text Labels” on page 261.



 265 Graph Page Basics



Figure 5-35 Example of a Graph Displaying an Automatic Legend. The legend uses the columns of the data plotted.
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Editing Individual Legend Entries For more information, see “Formatting Text ” on page 262. To edit legend entries: E View the page. E On the Page menu, click the Text button. E Double-click the legend entry that you want to edit. E Edit the text of the legend entry as desired using the Formatting toolbar. You can also



change the legend symbol properties, including Symbol size, by clicking the Symbol button. For more information, see “Sizing Legend Symbols” on page 266.
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Increasing the Line Spacing for a Legend You can increase the spacing between legend symbols by increasing the height of the legend box. Click the box to select it, then drag the top or bottom handle to increase the height. Figure 5-36 Increasing Spacing Between Legend Entries



You cannot change the widths of automatic legends. These are determined automatically by the width of the text. You can edit individual labels and add multiple lines. You can also ungroup a legend and format it manually. For more information, see “Ungrouping a Legend” on page 270.



Sizing Legend Symbols You can individually control legend symbol size using the Symbols dialog box. To resize legend symbols: E Double-click the legend. E On the Formatting toolbar, click the Symbol button. The Symbol dialog box appears.
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Figure 5-37 Using the Symbol Dialog Box to Resize Legend Symbols



E Under Symbol, select the symbol to use for the label. This list displays all symbols,



lines and fills used by the selected graph source. E Under Size, move the Width and Height sliders to increase symbol size, or enter a



symbol size value. The Width value determines the space between symbols, while the Height value determines the actual symbol size. This means the larger the height, the larger the symbol size; the larger the width, the larger the space between the symbol and text. For line and scatter plots, the width can never be less than the height. E Click OK to close the dialog box and save the changes.



Editing Automatic Legends You can edit a legend as a single object. To edit an automatic legend: E Double-click the graph to open the Graph Properties dialog box. E Click the Graph tab.
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Figure 5-38 Use the Graph tab of the Graph Properties dialog dox to Edit an Automatic Legend



E To show or hide an automatic legend, under Legend Properties, select or clear Show



Legend. For more information, see “Hiding and Viewing Graphs on a Page” on



page 239. E To enclose the legend in a box, under Legend properties, select Framed in box. E To hide a legend box, under Legend properties, clear Framed in box. E To modify the line thickness and fill of the legend box, under Legend Properties, click



Box to open the Object Properties dialog box. E To halt all automatic updating of the legend text for the whole legend, select Lock legend.



For more information, see “Locking Legend Text” on page 270. E To show or hide individual legend entries for a specific plot or curve, under Legend



appearance, from the For legend symbol list, select or clear a legend entry. E To annotate from the For legend symbol drop-down list, enter the text for a legend symbol



by selecting the symbol then select the Legend text box and type text. Do this for as many legend symbols as you want.
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E To move the legend symbols either to the right or to the left of text, select a position from



the Symbol placement drop-down list. If you have no legend symbol selected, this operates on all legends. If you select a specific entry from the For legend symbol list, this option affects only that symbol. E To modify the appearance of the symbols for the current legend, select a symbol style



from the Style drop-down list. The Style drop-down list only affects scatter and line plots. If you have no legend symbol selected, this operates on all symbols. If you select a specific entry from the For symbol list, this option affects only that symbol. E To change the text size or style, under Legend properties, click Font. The Text



Properties dialog box appears. For more information, see “Formatting Text ” on



page 262. E To restore all legend text and symbols to the default settings, under Legend properties,



click Reset. Note: The Reset button also unlocks the legend, if locked. When you click Reset defaults, a Novice prompt appears which you can disable. E Click OK to apply the changes and close the Graph Properties dialog box. The legend



is updated as specified.



Permanently Displaying and Hiding Automatic Legends You can control the display of automatic legends either for all subsequently created graphs. To view or hide automatic legends for all subsequently created plots: E On the Tools menu, click Options. The Options dialog box appears. E Click the General tab. E Select Automatic legends to display the legend, or clear it to hide the legend. E Click OK to close the dialog box and save the changes.
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Ungrouping a Legend You can ungroup the legend entries and box by selecting the legend, then choosing the Format menu Ungroup command, or clicking the Page toolbar Ungroup button. You can then edit each object like an ordinary graphic object or label. You can also use your mouse to move any of the legend items to a new location,and the Format menu Align command. Note: Ungrouping a legend removes automatic legend features.



Locking Legend Text Locking legends halts all automatic updating of the legend text for the whole legend. For example, if you lock the legend, you can change column titles and column data without resetting the legend label. The legend will automatically update, however, if you remove or add a curve. You can also lock a legend by editing it. If you do not lock the legend, either from the Graph Properties dialog box, or by editing the legend, the legend automatically updates itself when you change column titles and data. Locking the legend affects the entire legend, not just individual entries. To lock legend text: E Double-click the graph to open the Graph Properties dialog box.
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Figure 5-39 Use the Graph tab on the Graph Properties dialog box to lock legend text.



E Click the Graph tab. E Under Settings for, click Legends. E Under Legend properties, click Lock legend. E Click OK to close the dialog box.



Changing Graph Page Format You can change graph page margins and size use the Page Setup dialog box, by clicking Page Setup on the File menu. This dialog box also controls which graphs on a page are displayed or hidden from view, and the color of the page. For more information, see “Hiding and Deleting Objects from the Page ” on page 239.
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Figure 5-40 The Margins Tab of the Page Setup Dialog Box



Note: The options in the Page Setup dialog box affect both the view of the page onscreen, and the printer settings for the page you are printing. For more information, see “Printing Graph Pages” on page 211.



Changing and Displaying Graph Page Margins To change page margins, and to view or hide margins on the current page: E On the File menu, click Page Setup. The Page Setup dialog box appears in which



you can select the Margins tab. E Use the Top, Bottom, Left, and Right options to specify the width or height of the



corresponding page margin. You can type values in the edit boxes using any of the available units of measurement; the value is converted to the current measurement units specified in the Options dialog box. Type in for inches, mm for millimeters, and pts for points. Margins do not affect printing, they are only a guide. The Align dialog box uses margins when aligning the page. E Clear or check the Show Margins option by selecting it. If this option is checked,



margins are displayed on the page. To hide page margins, clear Show Margins.
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E Click OK. For more information, see “Changing Page Units of Measurement ” on



page 273.



Graph Page Size and Orientation To change the size or orientation of the graph page: E On the File menu, click Page Setup. The Page Setup dialog box appears. E Click the Page Size tab. E From the Paper Size drop-down list choose the appropriate size for the page, or select



unique page sizes from the Width and Height drop-down lists. Note: SigmaPlot does not support heights or widths greater than 32 inches. E To switch between portrait (normal) and landscape (sideways) orientation, select either



the Portrait or Landscape option. E Click OK to accept your changes and close the dialog box.



Note: If you change the page size and/or orientation, the page changes on the screen, but your graphs remain in the same relative position. You may have to move the graphs back into position.



Changing Page Units of Measurement Use the Page Options dialog box to change the units of measurement used on the page. Page units of measurement are important when specifying margins and object size and position. These settings apply to all pages and graph and object properties dialog boxes. To change the unit of measurement used: E On the Tools menu, click Options. The Options dialog box appears.
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Figure 5-41 Options Dialog Box Page Tab



E Click the Page tab. E From the Units box, select the unit of measurement to use on the page. You can choose



to use inches, millimeters, or points. E Click OK to accept the changes and close the dialog box.



Changing Page Color You can change the color of a page using the Page Setup dialog box. This is especially useful when creating output for slides or for overhead projectors. To change the color of a page: E Make the page active by selecting it, or by choosing its name from the Window menu.



A check mark next to the name of the page indicates that the page is active. E On the File menu, click Page Setup. The Page Setup dialog box appears.
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Figure 5-42 The Graph Layout Tab of the Page Setup Dialog Box



E Click the Graph Layout tab. E From the Color drop-down list, select the color to use for the page. Select (Custom) to



use or create a custom color. For more information, see “Using Custom Colors” on page 276. E Click OK.



Note: If you want no background color to show up for pasted graphs (e.g., pasting a graph into PowerPoint), set the page color to None.



Page Color Default Setting You can set the default color for a new page by opening the template file and change the attributes for the Normal page using the Page Setup dialog box for that page. If there is no template file or Normal page present, page settings are derived from the settings stored in the spw.ini file. For more information, see “Where Files Go” in Chapter 1.



Templates You can overwrite the current page entirely by applying a template to it. This is not recommended as a means of reformatting the page unless you intend to discard all
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changes made to the page up to this point. For more information, see “Using Graph Pages as Templates” on page 219.



Using Custom Colors Color drop-down lists have a (Custom) option that opens the Color dialog box, from which you can select a custom color from over 16.7 million possible combinations of red, green, and blue (24-bit color). These color controls are available in the Graph Properties, Object Properties, Options, and Page Setup dialog boxes.



Configuring Your Display for Color If you want the truest representation of what your colors will appear like when printed, you should always set you display to the highest color level possible. Most Windows systems support Hi Color (16-bit) or True Color (24-bit) modes. Right-click your desktop, choose Properties, select Settings, then set your Color palette to the highest possible level. To select a custom color: E Open the dialog box that has the color option in it, and from the Color drop-down list,



select (Custom). Figure 5-43 Selecting the Custom Color option from the Text Properties Dialog Box.



If you have not already selected a custom color, the Color dialog box appears.
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Figure 5-44 The Color Dialog Box



If a custom color has already been defined for this option, the custom color is selected. E From the Basic Colors list, select a color, or click Define Custom Colors to define



your own color. The dialog box expands to show a color palette. Figure 5-45 The Color Dialog Box



Color Field
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E Click the large color field, or drag your mouse across it to indicate the approximate



color you want to use. If you know the numeric RGB (red, green, blue) values of the desired color, you can select each of the Red, Green, and Blue edit boxes and type the correct values. The selected color box appears. E Move the slider next to the vertical color bar along the right of the dialog box to finetune the range of the Hue, Saturation, and Luminosity of the selected color, or type new



values in the edit boxes. The current custom color appears in the Color|Solid box as a gradational color and a solid. E To change the color assigned to a Custom Color box, select the box in thelist, then specify



the new color from the large color field. E To select the gradational color, click Add to Custom Colors. The color appears in the first available box of the Custom Colors list. E To select the solid version of the color, double-click the solid in the Color|Solid box, then click Add to Custom Colors.



The color appears in the first available box of the Custom Colors list. E Select the color to use from the Custom Color list, then click OK. E The Color dialog box closes, and you are returned to the dialog box from which you opened the Color dialog box. E The color drop-down list that you are using now has the color you created as an option



with the word (Custom) next to it. If the custom color you created is a duplicate of a pre-existing system color, the system color is selected instead of the (Custom) option in the drop-down list.
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Re-defining Custom Colors If you want to change a custom color, right-click the Color drop-down list (without opening it). E On the shortcut menu, click Custom Color; the Colors dialog box appears. E Select a new custom color to use as described above.
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 281 Working with 2D Plots



6 Working with 2D Plots Create 2D Cartesian (XY) plots from many worksheet columns or column pairs. Each column is represented as a separate curve, set of bars, or box, depending on the plot type. 2D graphs must have at least one plot, but can display many more plots, each with a different type and style. You can draw linear or polynomial regressions with confidence and prediction intervals. For more information, see “Plotting and Modifying Regression Lines” in Chapter 10. You can also draw reference lines for each curve. For more information, see “Adding Reference Lines” in Chapter 10. This chapter covers: „ 2D plot types (see page 281). „ Creating 2D plots (see page 284). „ Creating 2D scatter plots with error bars (see page 290). „ Creating 2D scatter plots with asymmetric error bars (see page 295). „ Modifying error bars (see page 299). „ Creating grouped bar charts (see page 308). „ Creating box plots (see page 314). „ Creating area plots (see page 319). „ Creating bubble plots (see page 336).



2D Plot Types Scatter, Line, and Line/Scatter Plots



Scatter, line, and line/scatter plots graph data as symbols, as lines only with no symbols, or as symbols and lines. Line shapes can be straight segments, splines, or steps. Add drop lines to either axis to any of these plot types, and add error bars to plots with symbols. Draw linear or polynomial regressions with confidence and prediction intervals for each curve.
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Figure 6-1 Examples of a Stepped Line Plot, a Scatter Plot, and a Line Scatter Plot
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For more information, see “Creating 2D Plots with Asymmetric Error Bars” on page 295. Area Plots



Using area plots, you can fill an area under a curve with a color making the curve easier to see. You can orient the fill up, down, left, or right. If your curve is a closed polygon, you can also fill the polygon. You can have multiple curves (plots) on a page, so you can stack Area Plots. Figure 6-2 Examples of Area Plots 80 10000
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For more information, see “Creating Area Plots” on page 319.
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Bar Charts



Bar charts plot data either as vertical or horizontal bars. They originate from zero in either a positive or negative direction. Simple bar charts plot each row of data as a separate bar, and grouped bar charts plot multiple columns of data by grouping data in the same rows. Stacked bar charts plot data as segments of a bar; each data point is drawn as a bar segment starting where the previous data point ended. Use the Graph Properties dialog box to modify bar width, bar fill colors, and bar fill patterns. Add error bars to simple and grouped bar charts. For more information, see “Creating Grouped Bar Charts” on page 309. Figure 6-3 Examples of a Simple Bar Chart, a Grouped Bar Chart, and a Stacked Bar Chart 20
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Box Plots



Box plots graph data as a box representing statistical values. The boundary of the box closest to zero indicates the 25th percentile, a line within the box marks the median, and the boundary of the box farthest from zero indicates the 75th percentile. Whiskers (error bars) above and below the box indicate the 90th and 10th percentiles. In addition, you can graph the mean and outlying points. For more information, see “Creating Box Plots” on page 314. You need a minimum number of data points to compute each set of percentiles. At least three points are required to compute the 25th and 75th percentiles, and at least nine points are required for the 5th, 10th, 90th and 95th percentiles. If SigmaPlot is unable to compute a percentile point, that set of points is not drawn.
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Figure 6-4 Example of a Box Plot 35 30 25 20 15 10 5 0 10
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Creating 2D Plots To create a 2D plot: E Select the worksheet columns to plot before creating your graph by dragging the



pointer over your data. E Select the desired graph type and style from the Graph toolbar. The Graph Wizard



appears. Figure 6-5 Using the Graph Wizard to Specify the Data Format
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E From the Data Format list, choose the appropriate data format, and click Next. E Specify which worksheet columns correspond to the data for your plot. Since you



selected columns prior to opening the Graph Wizard, your choices automatically appear in the dialog box and you can click Finish to create the graph. Note: If you have not already picked columns, note that a single data type is highlighted in the Selected Columns list. This shows the data type you are picking a column for. Begin picking data either by clicking the corresponding column directly in the worksheet, or choosing the appropriate column from the Data Columns list. Repeat this process for every column you are using to create your graph. E If you make a mistake while picking data, select the wrong entry in the Graph Wizard,



then choose the correct column from the worksheet. You can also clear a column assignment by double-clicking it in the list. E When you have finished picking data, click Finish to create the plot and close the



Graph Wizard. Use the Graph Properties dialog box to modify the plot, or reopen the Graph Wizard to pick different data columns for your plot, or to add another plot to your graph. For more information, see “Creating Graphs” in Chapter 4.



Creating 2D Plots with Multiple Curves You do not have to create multiple plots to obtain multiple curves. To plot more than one curve, choose any of the plot styles described as Multiple and add additional columns, or column pairs to the list of curves in the Graph Wizard. The order of the curves is determined by the order of the column pairs in the Graph Wizard. To change the curve order, repick columns by selecting them in the Graph Wizard or by clicking the column in the worksheet.
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Figure 6-6 Plot Styles that Include Multiple Curves 9 8
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Plotting Category and Grouped Data Use the Category Data formats (indexed data) if your data is organized row-wise by categories with corresponding data. For more information, see “Arranging Category Data” in Chapter 4. Figure 6-7 The data in this worksheet is arranged as category (or indexed) data. The data is organized row-wise by categories.
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To plot category (grouped) data: E On the Graph menu, click Create Graph. The Type panel of the Graph Wizard



appears. E Select one of the following graph types: „ Line Plot „ Scatter Plot „ Line and Scatter Plot



Click Next. The Style panel of the Graph Wizard appears. If you selected Line Plot as the graph type, then select any one of the following graph



styles: „ Multiple Scatter „ Multiple Regression „ Multiple Spline Curves „ Multiple Vertical Step Plot „ Multiple Horizontal Step Plot „ Multiple Vertical Midpoint Step Plot „ Multiple Horizontal Midpoint Step Plot



If you select either Scatter Plot or Scatter and Line Plot as the Graph Type, then select any



one of these graph styles: „ Multiple Straight Lines „ Multiple Spline Curves „ Multiple Vertical Step Plot „ Multiple Horizontal Step Plot „ Multiple Vertical Midpoint Step Plot „ Multiple Horizontal Midpoint Step Plot



Click Next. The Data Format panel of the Graph Wizard appears.
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Figure 6-8 Selecting a Category data format from the Graph Wizard.t



E Select one of the following category data formats: „ XY Category. Uses one worksheet column to graph the categories, and a pair of XY



columns. „ X Category. Uses one X column, and a column for categories, indexes, or levels to



group the data in corresponding rows. „ Y Category. Uses one Y column, and a column for categories, indexes, or levels to



group the data in corresponding rows. Click Next. The Select Data panel of the Graph Wizard Appears. E Select which data columns will correspond to which axis or category. For example, if



you are using an XY Category Data format, first select the column to use for the X data from the Data for drop-down list. This selection appears in the Selected columns list. Then select the column to use for the Y data from the drop-down list. Lastly, select the column to use as the Categories from the drop-down list.
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Figure 6-9 Selecting columns of data for category or grouped data.



E If you make a mistake while picking data, select another entry in the Graph Wizard, then



choose the correct column from the worksheet. You can also clear a column assignment by double-clicking it in the list. E When you have finished picking data, click Finish to create the plot and close the



Graph Wizard.
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Figure 6-10 Legends for category data plots include the title of the two columns containing the observation data and also text describing which category group each symbol pertains to.



Use the Graph Properties dialog box to modify the plot, or reopen the Graph Wizard to pick different data columns for your plot, or to add another plot to your graph. For more information, see “Creating Graphs” in Chapter 4.



Creating 2D Scatter Plots with Error Bars In a Line and Scatter Plot with Error Bars, plot the means of each column as the Y value, and represent the standard deviations with error bars. Use the Graph Wizard to create 2D plots with error bars. Scatter plots, line/scatter plots, or simple bar charts can be created with error bars. For more information, see “SigmaPlot Graph Style ” in Chapter 4.
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Figure 6-11 2D Plots with Error Bars
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To add error bars to a pre-existing plot, you must change the plot type. For more information, see “Changing Graph Type and Style ” in Chapter 4. To create a scatter plot with error bars: E Select the worksheet columns to plot before creating your graph by dragging the



pointer over your data. E On the 2D Graph toolbar, click Scatter Plot, and then click Simple Scatter Error



Bars. The Graph Wizard appears. E From the Symbol Value drop-down list, select the error bar source.



Symbol Value: Choose either Column Means to use the column means as the error bar source, Replicate Row Means to use the row means as the error bar source, Worksheet Columns to use values you’ve entered in the worksheet, or 2 Worksheet Columns to read error bar end values from sets of two adjacent columns. You are prompted during data picking to specify the column to use as error bar source data.
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Figure 6-12 Specifying Error Bar Information



Error Calculation: If you choose any option besides Worksheet Columns as the symbol value, specify the error calculation method to use for upper and lower error bars. Figure 6-13 Selecting the Error Bar Source



E From the Error Calculation - Upper and Error Calculation - Lower drop-down lists,



specify the error calculation for the error bars. Error Calculations are not applicable if you select Worksheet Columns or Asymmetrical Error Bars from the Symbol Value list. E Click Next.
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Figure 6-14 Selecting the Data Format for the Plot



E From the Data Format list, select the appropriate data format. X column averaged plots



require a constant Y column value, and Y column averaged plots require a constant X column value. E Click Next. Figure 6-15 Specifying the Data Columns for the Error Bars



E Specify which worksheet columns correspond to the data for your plot. Since you



selected columns prior to opening the Graph Wizard, your choices automatically appear in the dialog box, and you can click Finish to create the graph.
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E To create a single plot graph, choose data for every column you are using to make the



graph. To create a graph of multiple plots, choose data for the first plot, then click Next to pick data for the next plot. Repeat this process for as many plots as necessary. E To make a graph with simple error bars or a graph with multiple error bars using



worksheet columns as the Symbol Value for error bar data, you are prompted to choose columns for error bar data. Repeat the data picking process for every column you are using to create your plot. For more information, see “Computing Percentile Methods” on page 317. E To make a graph using any of the other sources for error bar data (i.e. Column Means,



Column Median, Standard Error, etc.) with multiple error bars, you can create a graph



using a single plot, or a graph with multiple plots. Use multiple plots if you want to use different symbols to distinguish between data sets. Note: If you make a mistake while picking data, click the wrong entry in the Graph Wizard, then choose the correct column from the worksheet. You can also clear a column assignment by double-clicking it in the Selected Columns list. Click Back to access previous Graph Wizard panels. E Click Finish when you have finished picking the data to create the plot.



Creating a Range Plot A range plot is an error plot that plots the highest and lowest values in a column or row of data as the range of the error bar, using the mean or median value as the data point. To create a range plot from columns of data: E Select the worksheet columns to plot before creating your graph by dragging the



pointer over your data. E On the 2D Graph toolbar click Scatter Plot and then Simple Scatter - Error Bars. The



Graph Wizard - Create Graph dialog box appears. E Select Column Means or Column Median from the Symbol Value drop-down list.
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E Select Maximum from the Error Calculation - Upper drop-down list. E Select Minimum from the Error Calculation - Lower drop-down list. E Click Next. The Graph Wizard prompts you to select a data format. E Select X Many Y from the Data Format list, and click Next. Since you’ve already



selected the data columns to plot, the appropriate column titles appear in the Selected Columns list. E Click Finish. A range plot appears.



Creating 2D Plots with Asymmetric Error Bars Create 2D scatter plots with error bars using two adjacent worksheetcolumns as the error bar source to independently control the error bar values. SigmaPlot computes the asymmetrical error bars by using the column value as the absolute value. The column to the right of the plotted data is the source for the bottom or left error bar; the next column is the source for the top or right error bar. For more information, see “Computing Percentile Methods” on page 317. Figure 6-16 2D Plots with Asymmetrical Error Bars
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To create a plot with asymmetric error bars: E Drag the pointer over your worksheet data to select the data. E On the 2D Graph toolbar, click Scatter Plot, and then click either Simple Scatter -



Vertical Asymmetrical Error Bars or Simple Scatter - Horizontal Asymmetrical Error Bars.



The Graph Wizard appears. E From the Data Format list, select a data format, and click Next. E Specify which worksheet columns correspond to the data for your plot. For more



information, see “Picking Different Data for the Current Plot” in Chapter 4. Since you selected columns prior to opening the Graph Wizard, your choices automatically appear in the Selected Columns list. E Click Finish to create the graph.



For more information, see “Modifying Error Bars” on page 299.



Creating Quartile Plots A quartile plot is an asymmetrical error bar plot that divides the total sample of a frequency distribution into four quarters. The median of the data is the data point, while the 75th and 25th percentiles of the data represent the upper and lower error bars. For more information, see “Computing Percentile Methods” on page 317.
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Figure 6-17 Example of a Quartile Plot



To create a quartile plot: E Select the worksheet columns to plot before creating your graph by dragging the



pointer over your data. E On the 2D Graph toolbar click Scatter Plot and then Multiple Scatter - Error Bars.



The Graph Wizard - Create Graph dialog box appears. E Select Column Median from the Symbol Value drop-down list. E Select 75th Percentile from the Error Calculation - Upper drop-down list. E Select 25th Percentile from the Error Calculation - Lower drop-down list.
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E Click Next. The Graph Wizard prompts you to select a data format. E Select X Many Y from the Data Format list, and click Next.



Since you’ve already selected the data columns to plot, the appropriate column titles appear in the Selected Columns list. E Click Finish.



Creating Error Bar Plots Using Category Data You can create SigmaPlot error bar plots using category data either entered into a SigmaPlot worksheet or imported from SPSS. For more information, see “Arranging Category Data” in Chapter 4. You can also create graphs as embedded objects in SPSS. You can also create scatter plots and bar charts using category data. To create a SigmaPlot error bar plot using category data: E Open or import a worksheet using a category data format. For more information, see



“Importing Files from Other Applications” in Chapter 3. E On the Graph menu, click Create Graph. The Graph Wizard - Create Graph - Type



dialog box appears. E Select a graph type from Graph types list, and click Next. The Graph Wizard - Create



Graph - Style dialog box appears. E Select a graph style that uses error bars from the Graph styles list, and click Next. The



Create Graph - Error BarsGraph Wizard - dialog box appears. E Select either Category Mean or Category Median from the drop-down list. E Select error calculations from the Error calculation - upper and Error calculation -



lower drop-down lists, and click Next. The Graph Wizard - Create Graph - Data Format dialog box appears.
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E From the Data for Categories drop-down list, select a column that corresponds to the



categorical data you wish to plot. E From the Data for Y drop-down list, select the column that corresponds to the Y data



you wish to plot, and click Finish. An error bar plot appears.



Modifying Error Bars Compute error bars for scatter, line/scatter, and bar charts. Select error bar values when you pick the data for a plot and compute using values in a worksheet column or using column means. For more information, see “Computing Percentile Methods” on page 317. Note: You cannot add error bars to existing plots. However, you can select the desired plot on the page and change its plot type and style so that it includes error bars. For more information, see “Changing Graph Type and Style ” in Chapter 4. Figure 6-18 Examples of Graphs with Error Bars
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Changing Error Bar Appearance Use the Graph Properties dialog box to change error bar color, cap width, line thickness, mean computation method, and direction. Note that you cannot select error bar values from this dialog box; the Graph Properties dialog box only affects the appearance of error bars. Determine error bar values when you pick data to plot.
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To change error bar appearance: E Double-click the plot. The Graph Properties dialog box appears. E From the Settings for list, select Error Bars. Figure 6-19 Graph Properties Dialog Plots Tab Error Bar Setting



E To change the color of the error bars, from the Line Color list, select a line color. E To change line thickness and error bar cap width, move the Thickness and Cap Width



sliders. E Click OK.



Changing Error Bar Directions Specify error bar direction using two different methods: absolute and relative. You can specify absolute error bars to point in either a positive or negative direction; specify relative error bars to point either towards or away from zero.
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To change error bar direction E Double-click the plot. The Graph Properties dialog box appears. Figure 6-20 You can change the direction of the error bars by selecting a direction from the Error Bar Direction drop-down list on the Plots tab of the Graph Properties dialog box.



E Click the Plots tab. E From the Plot drop-down list, select the plot with error bars to modify. E From the Settings for drop-down list, select Error Bars. E Under Error Bars, from the Direction drop-down list, select the direction of Y. E Select either X or Y Positive or Negative.



Note: An X positive absolute direction always points right; a Y positive direction always point up. An X negative absolute direction always points left; a Y negative absolute direction always points down.
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Figure 6-21 The bar chart on the left uses Y error bars with an absolute positive direction. The bar chart on the right uses a relative direction away from zero.
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E Double-click the plot. The Graph Properties dialog box appears. E Click the Plots tab. E From the Settings for list, select Error Bars. E From the Error Bars Direction drop-down list, select X or Y From Zero or To Zero.



Note: A relative to zero direction always points toward or away from zero. This option is useful for bar charts that have negative values.
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Figure 6-22 The bar chart on the left uses X error bars with an absolute negative direction. The bar chart on the right uses a relative direction towards zero.
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E Click OK.



Customizing Error Bar Directions Control the error bar direction used for each data point by entering error bar directions into a worksheet column.
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Figure 6-23 Error Bars Using Custom Directions from Worksheet Columns



To use custom error bar directions: E Select the first cell in an empty worksheet column. E Enter the codes for the error bar directions. The codes for the directions are:



Direction



Code



Absolute Positive Absolute Negative Relative From Zero Relative To Zero Absolute or Relative, Both Directions



Positive or P Negative or N From Zero or F To Zero or T Both, PN or FT



Note: Codes you type in the worksheet can be either upper or lower case. E Double-click the plot. The Graph Properties dialog box appears.
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Figure 6-24 Setting Error Bars



E Click the Plots tab. E From the Settings for list, select Error Bars. E Under Error bars, from the Direction list, choose the name of the first column which



contains the error bar direction codes. Note: SigmaPlot assumes that it is the next column that contains the second column of error bar codes. E Click OK to apply the changes and close the dialog box.



Changing the Mean Computation Method If your graph uses a log axis scale, you can choose between calculating the column means arithmetically (the default) or geometrically on a log scale. This option is only available for log axis scales.
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To change the mean computation method: E Double-click the plot with a log axis scale to open the Graph Properties dialog box. E Click the Plots tab. E From the Settings for list, select Error Bars. E From the Mean Computation drop-down list, select Arithmetic or Geometric. Figure 6-25 Selecting Arithmetic or Geometric from the Mean Computation list



E Click OK.
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Changing Error Bar Source Use this method to change the error bar source after you have created a graph. You can: „ Plot the means of worksheet columns as single data points and compute the error



bars values from column statistics (column averaging). For more information, see “Grouping Column Averaged Bars” on page 311. „ Use data in worksheet rows and columns as error bar values. For more information,



see “Creating 2D Scatter Plots with Error Bars” on page 290. „ Use data in two adjacent worksheet columns as the absolute error bar values. For



more information, see “Creating 2D Plots with Asymmetric Error Bars” on page 295. To change the error bar source after you have created the graph: E Select the plot to modify by clicking it.



Small, square, black handles surround the selected plot. E On the Standard toolbar, click the Graph Wizard button.



The Graph Wizard appears. Figure 6-26 Graph Wizard - Modify Plot



E Click Next.
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E From the Data for Error drop-down list, select a column as a new error bar source. Figure 6-27 Choosing the New Error Bar Source from the Data for Error drop-down list.



E Click Finish. The graph appears with the new error bars.



Grouped Bar Charts Create grouped bars charts by picking multiple columns for a single plot. Data points within the same row appear within the same group, and each additional column adds another bar to each group. There are as many groups as there are rows of data. The order of the column pairs in the list determines the order of the bars for each group. To change the bar orders within groups, change the order the column pairs appear in the list by using the Graph Wizard to repick column data. For more information, see “Picking Different Data for the Current Plot” in Chapter 4. Use the Graph Wizard to create grouped bar charts with or without error bars. If creating a grouped bar chart with error bars, error bar values must be from worksheet column values entered prior to creating the plot. You are prompted during graph creation for error bar worksheet columns.
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Figure 6-28 Examples of Grouped Bar Charts with and without Error Bars 8
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Creating Grouped Bar Charts To create a grouped bar chart: E Select the worksheet columns to plot before creating your graph by dragging the



pointer over your data. For more information, see “Picking Different Data for the Current Plot” in Chapter 4. E On the 2D Graph toolbar, click Horizontal or Vertical Bar Chart, and then click either



Grouped Bar Chart, or Grouped Error Bars. The Graph Wizard appears. Figure 6-29 Using the Graph Wizard to Specify the Data Format



E From the Data Format list, choose the appropriate data format to specify how your



data is formatted. The data formats available depend on the graph type and style. E Click Next.



 310 Chapter 6



Since you selected columns prior to opening the Graph Wizard, your choices automatically appear in the in the Selected Columns list. To change the selected data, select the wrong entry in the Graph Wizard, then choose the correct column from the worksheet. You can also clear a column assignment by double-clicking it in the Selected Columns list. Figure 6-30 Using the Create Graph Dialog to Pick Columns to Plot.



E Click Finish.



For more information, see “Modifying Error Bars” on page 299.



Spacing Bars from Different Plots If you need to create a bar chart with two or more different axes scales, or a chart with overlapping bars, use multiple plots. SigmaPlot does not automatically space bars from different plots. However, you can manually space bars by grouping your data column(s) with column(s) containing missing or empty data. This creates bar groups with null values and leaves room for other bars. When picking columns to plot, pick the missing columns in a different order for each plot, so that the bars do not overlap. To overlap bars, plot your bar values versus a column of evenly incremented values rather than by row numbers.
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Figure 6-31 Bars graphed with different plots that both overlap and are spaced differently by using different x increments.



Grouping Column Averaged Bars You cannot create a grouped bar chart with error bars using column averaging; the bars do not group or space correctly. However, you can copy the worksheet means and standard deviations from the statistics window, then plot this data as a grouped bar chart with error bars. To create a bar chart with grouped column averaged bars: E On the View menu, click Statistics. The statistics window for the worksheet appears.



 312 Chapter 6



Figure 6-32 Column Statistics Worksheet



E Select the block of data in the statistics window that consists of the means and standard



deviations of the first set of bars. E Right-click, and on the shortcut menu click Copy. E Select the first row of an empty column in the worksheet. E On the Edit menu, click Transpose Paste.



The first pasted column of data is the mean, and the next column is the standard deviations. For more information, see “Switching Rows to Columns” in Chapter 3.



 313 Working with 2D Plots



Figure 6-33 The data in columns 13 and 14 of the worksheet are transposed from the selected data in rows 1 and 2 of the Column Statistics window. Column 13 contains the means of the column data and column 14 contains the standard deviations of the data.



E Repeat the copy and transpose paste procedure for the remaining sets of bars. Each pair



of mean and standard deviation columns you create adds an additional bar to each group. E To plot the results, on the 2D Graph toolbar, select a vertical or horizontal bar chart



graph type with grouped error bars, then select the desired data format. If you already have a graph, repick the plotted data by selecting the plot to modify, then clicking the toolbar button. E If you select X Many Y as the data format, pick your constant value column (either a



row number or a single column), then pick the first column of means as your data column, and the first column of standard deviations as the associated error bar column. E Continue picking the mean columns and error bars for each set. E Click Finish when done.
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Figure 6-34 Picking Data to Plot for a Grouped Bar Chart with Error Bars



Creating Box Plots A box plot is a summary plot that plots graph data as a box representing statistical values. The boundary of the box closest to zero indicates the 25th percentile, a line within the box marks the median, and the boundary of the box farthest from zero indicates the 75th percentile. Whiskers (error bars) above and below the box indicate the 90th and 10th percentiles. In addition, you can graph the mean and outlying points. To create a box plot: E Select the worksheet columns to plot by dragging the pointer over your data. E On the 2D Graph toolbar, click Box Plot and then click Horizontal Box or Vertical



Box. The Graph Wizard appears.
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Figure 6-35 Graph Wizard - Data Format



E From the Data Format list, choose the appropriate data format, and click Next. Figure 6-36 Graph Wizard - Select Data



Since you already selected columns prior to opening the Graph Wizard, your choices automatically appear in the Selected Columns list. Note: You need a minimum number of data points to compute each set of percentiles. At least three points are required to compute the 25th and 75th percentiles, and at least nine points are required for the 5th, 10th, 90th and 95th percentiles. If SigmaPlot is unable to compute a percentile point, that set of points is not drawn. E Click Finish to create the graph.
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Use the Graph Properties dialog box to modify the plot, or reopen the Graph Wizard to pick different data columns for your plot, or to add another plot to your graph.



Changing Other Box Plot Attributes To add a mean line, change which outliers are displayed, and change the 10th and 90th percentile whisker cap widths: E Double-click the plot to open the Graph Properties dialog box. Figure 6-37 Graph Properties Plots Tab



E Click the Plots tab. E From the Settings for list, select Box Options. E To display a mean line in addition to the median line, under Box Plot Mean Line, select



Display Mean Line. If the check box is clear, the mean line is not displayed. E To modify the mean line, under Box Plot Mean line, from the Line Type drop-down list,



select a mean line type.
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E Select a line thickness and color using the Thickness and Color options.



Selecting (none) from the Line Type or Color lists creates a transparent mean line. Selecting (Custom) from the color list enables you to use a custom mean line color, or to create a new color. E To change how outliers are handled, from the Handling Outliers drop-down list, select



either Show Each Outlier (to plot outside the 10th and 90th percentiles), or Show 5th/10th Percentiles (to plot only the 5th and 95th percentiles as symbols). Note: At least nine data points are required to compute the 5th, 10th, 90th and 95th percentiles. Also, there may be no data points beyond the 10th and 90th percentiles. E To modify whisker cap width, under Whisker Caps, move the Width slider, or type a



new value in the Width box. E Click OK.



Modifying Box Plots The fill, width, and symbol settings for the boxes can be modified using the appropriate Graph Properties Plot tab settings. You can change: „ Symbols used to display extreme data points. For more information, see “Changing



Symbol Type and Other Symbol Options” in Chapter 4. „ Box fill color and patterns (including edge and whisker color). For more



information, see “Changing Plot Fill Patterns and Colors” in Chapter 4. „ Box widths. For more information, see “Changing Bar and Box Widths and



Spacing” in Chapter 4.



Computing Percentile Methods When graphing error bars and creating box plots, you can select the method of computing percentiles.
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To compute the percentile method: E On the Tools menu, click Options. The Options dialog box appears. E Click the General tab. E From the Percentile Method drop-down list, select either: „ Cleveland „ Standard



Both the Cleveland method and the Standard method use linear interpolation to determine the percentile value, but each uses a different method of rounding when determining the smallest data index used for the interpolation. The two methods give the same result when computing the 50th percentile (median). If the data in increasing order is x1, x2, ..., xN and the percentile is p, then the two methods compute the data percentile value v using the following formulas: „ Cleveland: Let k be the nearest integer to N*p/100, and let f = N*p/100 + .5 - k. „ Standard: Let k be the largest integer less than or equal to (N+1)*p/100, and let f =



(N+1)*p/100 - k. E To compute the percentile value, each of the above methods uses the formula:



v=f*xk+1+(1-f)*xk. E Click OK.
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Creating Area Plots Area plots are 2D line plots with regions below or between curves filled with a color or pattern. Most commonly, an area plot is a line plot with shading that descends to the axis. You can add shade below a curve and shade in different directions, and you can uniquely fill and identify intersecting regions. Figure 6-38 This example is actually four plots: a simple straight line, simple scatter, vertical area, and multiple area. You can find this example in Samples.jnb.
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Creating Simple and Vertical Area Plots Simple Area Plots plot a single line plot with a downward fill. Vertical Plots plot single YX line plots with a left direction fill.
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Figure 6-39 In this example, there are see two vertical area plots, a simple area plot, and a simple scatter plot.



To create a simple straight line area plot: E Select the worksheet columns to plot by dragging the pointer over your data. E On the 2D Graph toolbar, click Area Plot and then click Simple Area Plot. The Graph



Wizard appears.
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Figure 6-40 Graph Wizard - Data Format



E From the Data Format list, choose the appropriate data format, and click Next. Figure 6-41 Graph Wizard - Select Data



Since you already selected columns prior to opening the Graph Wizard, your choices automatically appear in the Selected Columns list. Note: You can plot no more than 2500 data points per curve. E Click Finish to create the graph.
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Figure 6-42 Example of a Vertical Area Plot



Use the Graph Properties dialog box to modify the plot, or reopen the Graph Wizard to pick different data columns for your plot, or to add another plot to your graph.



Creating Multiple Area and Multiple Vertical Area Plots Multiple Area Plots plot multiple line plots with downward fills. Multiple Vertical Area Plots plot single YX line plots with left downward fills. To create a multiple area plot: E Select the worksheet columns to plot by dragging the pointer over your data. E On the 2D Graph toolbar, click Area Plot, and then click Multiple Area plot. The



Graph Wizard appears.
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Figure 6-43 Graph Wizard - Data Format



E From the Data Format list, choose the appropriate data format, and click Next.



Since you already selected columns prior to opening the Graph Wizard, your choices automatically appear in the Selected Columns list. To change the selected data, select the wrong entry in the Graph Wizard, then choose the correct column from the worksheet. You can also clear a column assignment by double-clicking it in the Selected Columns list. Figure 6-44 Graph Wizard - Select Data



Note: You can plot no more than 2500 data points per curve. E Click Finish to create the graph.
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Figure 6-45 Example of a Multiple Area Plot using a Y Many X data format.



Use the Graph Properties dialog box to modify the plot, or reopen the Graph Wizard to pick different data columns for your plot, or to add another plot to your graph. You can identify intersections either by using the Graph Properties dialog box or by creating a complex area plot. For more information, see “Creating Complex Area Plots” on page 324.



Creating Complex Area Plots Complex Area Plots plot multiple line plots with downward fills and intersections. To create a complex area plot: E Select the worksheet columns to plot by dragging the pointer over your data. E On the 2D Graph toolbar, click Area Plot, and then click Complex Area Plot. The



Graph Wizard appears.
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Figure 6-46 Graph Wizard - Data Format



E From the Data Format list, choose the appropriate data format, and click Next.



Since you already selected columns prior to opening the Graph Wizard, your choices automatically appear in the Selected Columns list. To change the selected data, select the wrong entry in the Graph Wizard, then choose the correct column from the worksheet. You can also clear a column assignment by double-clicking it in the Selected Columns list. Figure 6-47 Graph Wizard - Select Data



Note: You can plot no more than 2500 data points per curve, and you cannot plot more than four curves. E Click Finish to create the graph.
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Figure 6-48 Intersections only appear for two our more curves, and a legend appears for each intersection.



Converting a Multiple Area Plot to a Complex Area Plot You can uniquely identify intersecting areas of all curves of a multiple area plot with a separate fill by using the Graph Properties dialog box. Each possible intersection appears on the area plot, and each identifiable set of intersections uses the next color or pattern in the selected scheme. You can display intersections for a minimum of two curves and a maximum of four. Plots with two curves will have up to three different regions, one region for each tuple, and one region for the intersection. Three curves yield up to seven regions, and four curves up to fifteen. To change a multiple area plot to a complex area plot: E Double-click the multiple area plot. The Graph Properties dialog box appears.
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Figure 6-49 Using the Graph Properties Dialog Box to Identify Intersections



E Click the Plots tab. E Select Area Fills from the Settings for list. E Select Identify Intersections. E Click OK to close the dialog box and accept the changes.



Shading in Different Directions Use the Graph Properties dialog box to change the direction of fill colors in an area plot. To change the area fill direction: E Create an area plot. E Double-click the graph. The Graph Properties dialog box appears.
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Figure 6-50 Using the Graph Properties Dialog Box to change the direction of the area fill



E Click the Plots tab. E From the Settings for list, select Area Fills. E From the Direction drop-down list, select Up, Down, Left, or Right. E Click OK.



Changing Area Plot Fill Colors Use the Graph Properties dialog box to change area plot fill colors. Note: SigmaPlot only supports system patterns. If you enter patterns into the worksheet, you should only use system patterns. To change the area plot fill color: E Double-click the area plot. The Graph Properties dialog box appears.
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Figure 6-51 Using the Graph Properties Dialog Box to change the area fill color and pattern



E Click the Plots tab. E From the Settings for list, select Area Fills. E From the Color drop-down list, select (none) to create a transparent fill color,



(Custom) to create a custom color, or an incremental color scheme to use a color array, or any one of many available colors. E From the Pattern drop-down list, select a pattern. E Click OK.



For more information, see “Changing Patterns and Fill Colors” in Chapter 4.



Shading Between Two Curves You can emphasize the difference between two curves by filling in the area. This is useful when creating a climograph, for example, where two lines could show high and
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low temperatures throughout the year. Shading between the curves aids in visualizing the range in temperatures which would otherwise be lost in a sea of data points. Figure 6-52 An example of two plots, a bar chart and an area plot. In the area plot (in red), the area between the two curves is shaded. 80
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You can shade the area between two curves by: „ Using the Object Properties dialog box to change the background color of the



graph to match the lower shade. „ Using the Insert Graphic Cells dialog box to insert colors in to the worksheet, and



then applying those to the plot. To shade the area using the Object Properties dialog box: E Create an area plot that uses either X Many Y or XY Pairs data formats. Make sure,



when in the Graph Wizard, that you first select to plot the column with the largest Y values for the upper curve. Then use the column with the smallest Y values for the lower curve. E Once you’ve created the graph, right-click. On the shortcut menu, click Object



Properties. The Object Properties dialog box appears. E Click the Fill tab. E Under Fill Color, from the Color drop-down list, select a color that matches the color



of the lower curve.
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Figure 6-53 Shading an Area Using the Object Properties Dialog Box



E Click Close. The graph appears with the area between the two curves shaded.



To insert graphic cells to shade between two curves:



For more flexibility you can define the area colors by inserting colors into a column in the worksheet and then use the front area color as the graph background color. E As above, create an area plot. E View the worksheet, and select a cell in the first row of an empty column. E On the Insert menu, click Graphic Cells. The Insert Graphic Cells dialog box appears. E Click the Colors tab. E Double-click to select two colors. In the first cell (row 1), select the color that you want



the area to be and in the second cell (row 2), select the color you want the background to be.



 333 Working with 2D Plots



Figure 6-54 Insert Graphic Cells Dialog Box



E Click Close to close the dialog box. E To assign the area plot colors to those in the worksheet, double-click the graph. The



Graph Properties dialog box appears. E Click the Plots tab. E Select Area Fills. E Under Fill Color, scroll to the bottom of the Color drop-down list and select the column



that contains the colors you selected in the Insert Graphic Cells dialog box.
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Figure 6-55 Select the column that contains the graphic cells that you inserted into the worksheet.



E Click OK to apply the changes and close the dialog box. The graph now appears with



the two shaded areas filled with the colors you inserted in worksheet; however, the background of the graph is still white. Figure 6-56 Once you’ve selected the color for the lower curve, you still must match a color for the background. E Right-click the graph, and select Object Properties. The Object Properties dialog box



appears.
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Figure 6-57 Selecting a color that matches the lower shaded area on the graph.



E Click the Fills tab. E Under Fills color, from the Color drop-down list, select the color that matches the lower



shaded area on the graph. E Click OK to apply the changes and close the dialog box. The graph appears with one



shaded area between the two curves.
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Bubble Plots Bubble plots are XY scatter plots that use symbols to represent not only XY locations, but also a third dimension represented by the size of the symbol. Use bubble plots to plot population density, epidemiological data, or other similar data sets where a third variable can be clearly illustrated by the size of the symbols. Figure 6-58 Example of a Bubble Plot Bubble Plot 18 16 14
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Creating a Bubble Plot To create a bubble plot: E Select the worksheet columns to plot before creating your graph by dragging the



pointer over your data. E On the Standard tool bar, click the Graph Wizard button. The Graph Wizard appears.
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Figure 6-59 Graph Wizard Dialog Box



E From the Graph Types scroll-down list, select Bubble Plot, and click Next. E From the Data Format list, select the appropriate format, and click Next. E When you have selected all the columns to plot, including the Bubble Size column,



click Finish.



About Axes and Plots You can only create new pairs of X or Y axes if you have more than one plot on a graph and you want to scale these plots differently. For more information, see “Modifying Axes, Tick Marks, and Grids” in Chapter 9.



Creating Additional Axes for Multiple Plots If you have more than one plot on a graph and want to use multiple axes, use the following steps to add additional axes. For more information, see “Modifying Axes, Tick Marks, and Grids” in Chapter 9. To create an additional axis: E Right-click the plot, and on the shortcut menu, click Add New Axis. The Graph



Wizard appears.
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Figure 6-60 Using the Graph Wizard - Add Axis Dialog Box to Select the Plot for the New Axis



E Select to create either a new X axis or Y axis for the specified plot. E Click Next. Figure 6-61 Selecting to Create a New Y Axis for the Selected Plot



E Select which side of the graph to add the new axis. You can add the new axis to the



left, right, top, or bottom of the graph. Selecting an Offset location moves the new axis slightly to the side, top, or bottom of the original axis.
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Figure 6-62



E Click Finish to add the new axis according to the specified settings. The New axis



appears on the graph, and the plot re-scales to reflect the new axis Figure 6-63 Example of a Second Y Axis Added to the Graph for a Line Plot
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Creating Multiple Axes for a Single Plot If you want to use two or more X or Y axes for a single plot (for example, to show two different units of measurement), first create a plot which graphs empty columns, then add an axis to the empty plot. To add an axis to the second plot: E Right-click the graph, and on the shortcut menu, click Add New Plot.



The plot type does not matter, so long as it is a 2D Cartesian plot. E Pick any data format. E Pick empty columns when prompted to select the data to plot. E Create an axis for this "dummy" plot at the desired location E Select the new axis, then use manual scaling to set the appropriate range and tick



interval for the new axis. This scale is often a linear transformation of the opposite axis scale, for example, a Celsius scale to a Fahrenheit scale. Figure 6-64 The second temperature axis for the single plot was created by first creating a “dummy” plot, creating a Y axis for the dummy plot, then manually scaling the axis range.



For more information, see “Modifying Axes, Tick Marks, and Grids” in Chapter 9.
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7 Working with 3D and Contour Graphs Create 3D (XYZ) plots from many worksheet columns or column triplets. XYZ plots must have at least one plot, but can display many more plots, each with a different type and style. Graphs can be rotated and shaded added to enhance the height and depth of mesh and bar charts. This chapter covers: „ Creating 3D scatter plots and 3D bar charts (see page 341). „ Creating trajectory plots (see page 345). „ Creating waterfall plots (see page 346). „ Creating mesh plots (see page 348). „ Changing graph perspective, rotation, and shading (see page 351). „ 3D axis placement (see page 356). „ Creating contour plots (see page 359). „ Modifying contour plots (see page 361).



3D Scatter and Line Plots 3D scatter and line plots graph data as symbols, as lines only with no symbols, or as symbols and lines. Use the Graph Properties dialog box Plots tab Symbols settings to add symbols to a 3D line plot, or the Lines settings to add lines to a scatter plot. You can add drop lines to any back plane of either of these plot types.
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Figure 7-1 Examples of a 3D Scatter Plot and a 3D Line Plot



Mesh Plots Mesh plots graph 3D data as a continuous surface with a mesh. Use the Graph Properties dialog box to modify mesh lines, color, transparency, and to enable the light source for shading. Figure 7-2 Mesh Plot with No Fill Color and with a Gradient of Colors
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3D Bar Charts Create bar charts in 3D space using 3D data. Modify 3D bar charts by changing fill color and pattern. For more information, see “Changing Patterns and Fill Colors” in Chapter 4. You can also adjust bar width and spacing. For more information, see “Changing Bar and Box Widths and Spacing” in Chapter 4. Figure 7-3 3D Bar Charts



Waterfall Plots Waterfall plots graph 3D data as stacked line plots along the Y axis. Use the Graph Properties dialog box to modify plot lines, color, and transparency. Figure 7-4 Waterfall Plots
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Creating 3D Scatter Plots and 3D Bar Charts 3D scatter plots can use any data format; however, 3D bar charts are limited to XY Many Z or Many Z only.



Creating a 3D Scatter Plot or 3D Bar Chart: E Select the worksheet columns to plot by dragging the pointer over your data. E On the 3D Graph toolbar, click 3D Scatter Plot or 3D Bar Chart. The Graph Wizard



appears. Figure 7-5 Specifying the Data Format



E From the Data Format list, specify how your data is formatted. The data formats



available depend on the graph type you are making. E Click Next.
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Figure 7-6 Selecting Columns to Plot



Since you already selected columns prior to opening the Graph Wizard, your choices automatically appear in the dialog box. E Click Finish.



Use the Graph Properties dialog box to modify the plot, or reopen the Graph Wizard to pick different data columns for your plot, or to add another plot to your graph. For more information, see “Modifying Graphs ” in Chapter 4.



Creating Trajectory Plots Trajectory plots use an XYZ coordinate system to create a 3D line plot.



Creating a Trajectory Plot E Select the worksheet columns to plot by dragging the pointer over your data. E On the 3D Graph toolbar, click 3D Line Plot and then 3D Trajectory.



The Graph Wizard appears. Since you already selected columns prior to opening the Graph Wizard, your choices automatically appear in the Selected Columns list.
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Figure 7-7 Graph Wizard Select Columns Panel



E Click Finish.



Use the Graph Properties dialog box to modify the plot, or reopen the Graph Wizard to pick different data columns for your plot, or to add another plot to your graph.



Creating Waterfall Plots 3D waterfall plots are stacked line plots along the Y axis. Because hidden lines are eliminated, waterfall plots are useful for showing trends of line plots. Figure 7-8 Waterfall Plot
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3D waterfall plots are limited to Many Z and XY Many Z data formats.



Creating a Waterfall Plot E Select the worksheet columns to plot by dragging the pointer over your data. E On the 3D Graph toolbar, click 3D Line Plot and then click 3D Waterfall. The Graph



Wizard appears. Figure 7-9 Graph Wizard Data Format Panel



E From the Data Format list, choose the appropriate data format. E Click Next. Figure 7-10 Graph Wizard Select Columns Panel /caption
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Since you already selected columns prior to opening the Graph Wizard, your choices automatically appear in the Selected Columns list. E Click Finish.



Use the Graph Properties dialog box to modify plot lines, color, and transparency. For more information, see “Modifying Graphs ” in Chapter 4.



Creating Mesh Plots When you create a mesh plot you can choose between solid and transparent mesh with discrete or gradient shading. Use a transparent mesh to highlight the relationship of one mesh plot to another on the same graph. 3D mesh plots use an XYZ coordinate system; the data points are graphed as intersections of a mesh grid. If you select Many Z as the data format, SigmaPlot uses column numbers as the X values, and row numbers as the Y values. If you are using XYZ triplet data, you need to reformat the data.



Creating a 3D Mesh Plot E Select the columns to plot by dragging the pointer over your data. E On the 3D Graph toolbar, click 3D Mesh Plot. The Graph Wizard appears. Figure 7-11 Specifying the Data Format



E From the Data Format list, choose the appropriate data format, and click Next.
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Figure 7-12 Using the Create Graph Dialog Box to Pick Columns to Plot



Since you already selected columns prior to opening the Graph Wizard, your choices automatically appear in the dialog box. E Click Finish.



Use the Graph Properties dialog box to modify the plot, or reopen the Graph Wizard to pick different data columns for your plot, or to add another plot to your graph. For more information, see “Modifying Mesh Lines and Fill Color” on page 349.



Modifying Mesh Lines and Fill Color To modify mesh lines and fill color: E Double-click the plot. The Graph Properties dialog box appears.
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Figure 7-13 Graph Properties Dialog Box Plots Tab Mesh Settings



E Click the Plots tab. E From the Settings For list, select Mesh. E To change the color of the mesh, under Fill Colors, from the Color drop-down list, select



a color. Select (none) to create a transparent mesh, select (Custom) to create a custom color, and select one of the color schemes or color columns to increment the mesh from bottom to top using a color array. For more information, see “Using Custom Symbol, Fill, Line, and Color Increments ” in Chapter 4. E To make your mesh translucent, under Fill Colors, select Transparent. Objects behind



it will be visible. Use this option to more clearly show the intersections between two or more 3D meshes. Tip: Set your display to High Color (16 bit) or True Color (24 bit) for this feature to work properly. Check your system’s color capabilities under the Windows Display Properties Settings. E If you are using a color scheme, under Fill Colors, from the Transition drop-down list,



specify how the colors flow across the grid. Select Discrete to use an increment with a clear shift between colors, or select Gradient to use an increment with a gradual shift between colors. Note: The Transition drop-down list is available only when using a fill color scheme.
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E To change mesh lines, from the Settings For list, select Lines. Use the Color drop-



down list to change line color. Selecting (none) creates transparent mesh lines, and selecting (Custom) enables you to use or create a custom color. For more information, see “Using Custom Colors” in Chapter 5. E To change line thickness, move the Thickness slider, or type a new value in the



Thickness box. E Click OK.



Changing Graph Perspective, Rotation, and Shading Modify the view of the 3D graph by changing perspective and rotation of the graph, and by enabling a light source to add shading.



Changing the View of a 3D Graph To change the perspective of a 3D graph, rotate a graph, and enable the light source: E Double-click the plot. The Graph Properties dialog box appears.
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Figure 7-14 Graph Properties Dialog Box 3D View Tab Rotation Settings



E Click the Graph tab. E From the Settings for list, select Rotation. This tab displays a Preview that shows how



the current settings affect the selected graph. E To rotate the graph, move the Horizontal View and Vertical View sliders, or type



horizontal or vertical values into the boxes. Note: Horizontal and vertical values are in degrees. Rotate the graph horizontally from 0° to 360°, or vertically from ‚-90° to +90°. The recommended Horizontal View is 205°, and the Vertical View is 25°. The three solid red axes displayed in the Preview box of the 3D View tab are the origin axes for the rotation, and are used as reference when determining the angles of rotation. The rotation is displayed in the axes degrees from 0°. The origin used to determine the degree from the horizontal or vertical is the intersection of the three axes. When both rotation angles are set to 0°, the origin as you see the graph, is the left bottom rear corner.
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Note: The origin axes are not related to the axes marked with ticks and tick labels, but act as the zero point for tick labels and data. Figure 7-15 An example of a rotated 3D graph.



E To change the perspective of the graph, move the Perspective slider, or type a new



value into Perspective box. Figure 7-16 A 3D graph with a horizontal rotation of 0°, a vertical rotation of 0°, and a perspective of 20
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Figure 7-17 A 3D graph with a horizontal rotation of 45°, a vertical rotation of 45°, and a perspective of 20



Figure 7-18 A 3D graph with a perspective of 50.



Note: The Perspective value is based on the "depth" of the graph. A perspective of 0% means that the graph has no depth; 100% means that the graph has maximum depth. The recommended perspective is 20%.
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Figure 7-19 A 3D graph with a perspective of 0.



Figure 7-20 A 3D graph with a perspective of 100.



E To enable the light source and create shading on your graph, select Enable Light Source.



If the check box is cleared, the light source is not applied to the graph. Note: Set your display to High Color (16 bit) or True Color (24 bit) for this feature to work properly. You may check your system’s color capabilities under the Windows Display Properties Settings.
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Figure 7-21 The graph on the right has the light source option selected.



3D line and scatter plots are not affected by the light source option. E To return to the 3D View settings you had before applying any changes, click Revert to



original settings. E Click OK.



3D Graph Axis Placement 3D axes are always at the following positions (unless you rotate the graph horizontally): „ X: bottom right front „ Y: bottom left front „ Z: left front



Axis Placement During Graph Rotation When you rotate the view of a 3D graph, SigmaPlot automatically repositions the visible axes to the front of the graph so that the axes do not become positioned behind the graph.
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For more information, see “Changing Graph Perspective, Rotation, and Shading” on page 351.



Drawing, Modifying, and Hiding Frame Lines Drawing a 3D graph frame completes the cube surrounding the plotted data. Normally, these lines are hidden. You can use a frame to mark the origin axes, or to mark the 3D extent of the graph. Frame lines are unrelated to the lines used to draw axes and planes, and are controlled independently of those lines. Frame lines are drawn over the axes. To add frame lines, modify frame lines, or hide frame lines from view: E Double-click the plot. The Graph Properties dialog box appears. Figure 7-22 Graph Properties Dialog Box 3D View Tab Frame Lines Settings



E Click the Graph tab. E From the Settings for list, select Frame Lines.
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E From the Frame Lines drop-down list, select either: „ Relative to Viewer: If the frame is oriented from your perspective, one set of lines



is composed of the three cube edges closest to you, and the other lines are the remaining sides of the cube. The position of these lines is independent of the graph’s rotation. This is the default position. „ Relative to Graph Origin: If the frame is drawn according to the origin, one set of the



lines is drawn over the origin axes, and the other lines draw the remainder of the cube. The position of these lines is dependent on the graph’s rotation Figure 7-23 These graphs use the Viewer as the point of reference. The graph on the left draws only the front lines, and the right graph draws only the back lines.



Figure 7-24 These graphs use the Origin as the point of reference. The graph on the left draws only the origin lines, and the right graph draws only the non-origin lines
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E Hide frame lines, or add frame lines to your graph by selecting or clearing the



appropriate Show check box. Selected frame lines are drawn. A graph cannot display frame lines for both the Relative To Viewer and Relative To Graph Origin perspectives. If Relative To Graph Origin is selected from the Frame Lines drop-down list, the Show check boxes for Relative To Viewer are cleared automatically, and vice versa. E To change the frame line type, under Front lines, from the Line Type drop-down list,



select a line type. E To change a frame line color, under Front Lines, from the Color drop-down list, select



a frame line color. Choose (none) from either list to create transparent frame lines. Choose (Custom) from the Color drop-down list to use or create a custom color. For more information, see “Using Custom Colors” in Chapter 5. E To the modify frame line thickness, move the Thickness slider, or type a new thickness



value into the thickness field. E Click OK.



Creating Contour Plots Contour graphs and filled contour graphs plot 3D data on an XYZ coordinate system with the Z data (vertical) indicated with lines at specified Z intervals. If you select Many Z as the data format, SigmaPlot uses column numbers as the X values, and row numbers as the Y values. If you are using XYZ triplet data, it needs to be reformatted as mesh data. For more information, see “Smoothing 3D Data” in Chapter 15.
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Figure 7-25 Contour Plots



Creating a Contour Plot E Select the worksheet columns to plot by dragging the pointer over your data. E On the 3D Graph toolbar, click Contour Plot and then Contour. The Graph Wizard



appears. E From the Data Format list, select the appropriate data format, and click Next. The



Graph Wizard prompts you to specify which worksheet columns correspond to the data for your plot. Since you selected columns prior to opening the Graph Wizard, your choices automatically appear in the Figure 7-26 Graph Wizard Select Columns Panel



Selected Columns list.
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Note: If you made a mistake picking data, click the wrong entry in the Selected Columns list, then select the correct column from the worksheet. You can also clear a column assignment by double-clicking it in the Selected Columns list. E Click Finish.



Creating a Filled Contour Plot: E Select the worksheet columns to plot by dragging the pointer over your data. E On the 3D Graph toolbar, click Contour Plot and then Filled Contour. The Graph



Wizard appears. E From the Data Format list, select the appropriate data format and click Next. The



Graph Wizard prompts you to specify which worksheet columns correspond to the data for your plot. Since you selected columns prior to opening the Graph Wizard, your choices automatically appear in the Selected Columns list. E Click Finish.



Modifying Contour Plots Use the Graph Properties dialog box to modify a contour plot. You can: „ Pick new data for the plot. For more information, see “Picking Different Data for



the Current Plot” in Chapter 4. „ Change contour line attributes, and hide or display lines. For more information, see



“Displaying and Changing Contour Lines ” on page 362. „ Modify back plane color and grid lines. For more information, see “Modifying



Backplanes ” in Chapter 9. „ Change the vertical (Z data) range and scale. For more information, see “Changing



Contour Vertical (Z Data) Range and Scale ” on page 365. „ Change X and Y axis and tick attributes. For more information, see “Changing Tick



Mark Line Attributes” in Chapter 9. „ Add colors to contour fills. For more information, see “Adding Fills to Contour



Plots” on page 363.
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„ Turn on or off interpolated fills. For more information, see “Modifying



Interpolated Filled Contours” on page 364. „ Change and display contour labels. For more information, see “Displaying and



Modifying Contour Labels ” on page 362.



Displaying and Changing Contour Lines To hide, display, and modify contour plot lines: E Double-click the plot. The Graph Properties dialog box appears. Figure 7-27 Graph Properties Dialog Box Plots Tab Contours Settings



E Click the Plots tab. E From the Settings For list, select Contours. E To modify contour lines, from the Contours drop-down list ,select Major or Minor. The



Line Styles reflect the contour you select in the Contour drop-down list. Select Major to change the Line Styles for major contours. Select Minor to change the Line Styles for minor contours.
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E To specify the line type of major and minor contour lines, from the Type drop-down list,



select a line type. Select one of the incrementing schemes to increment contour line types, or select (none) to create transparent lines. E To select the color of the contour lines, from the Line Style Color drop-down list, select



a color. You can choose from several predefined color schemes, or select (none) to create transparent lines. Select the (Custom) option to create a custom color. E To set the thickness of the contour lines, move the Thickness slider, or type a new value



in the Thickness box. E Click OK.



Adding Fills to Contour Plots To fill intervals between contour lines with colors: E Double-click the plot. The Graph Properties dialog box appears. Figure 7-28 Graph Properties Dialog Box Plots Tab Contours Settings
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E Click the Plots tab. E From the Settings for list, select Contours. E From the Contours drop-down list, select Major. E From the Color drop-down list, select from several predefined color schemes. E From the Fill Start drop-down list, set the direction of the contour fills. The default



direction is bottom. That is, the fill starts from the lowest z value. You can also create filled contour plots automatically when you first create the graph. You can either select the Filled Contour Plot style from the 3D Graph toolbar, or choose Filled Contours from the Graph Wizard.



Modifying Interpolated Filled Contours When you create a filled contour plot from the toolbar, its fill colors are automatically interpolated and stretched to fit the number of z-intervals. To turn off interpolated fills: E Double-click the graph. The Graph Properties dialog box appears.
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Figure 7-29 Graph Properties Plots Tab Contour Settings



E Click the Plots tab. E From the Settings for list, select Contours. E From the Contours drop-down list, select Minor. E Under Fills, from the Color drop-down list, select (none). E Click OK.



Changing Contour Vertical (Z Data) Range and Scale Use the Graph Properties Range settings to select the scale type and set the vertical range used by the contour lines. To set the scale and range used by contour lines: E Double-click the plot. The Graph Properties dialog box appears.
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Figure 7-30 Graph Properties Plots Tab Scale Settings



E Click the Plots tab. E From the Settings for list, select Scale. E From the Scale Type list, select Linear or Log (Common) scale. The linear scale uses



a standard base 10 numeric scale, and the log scale uses a base 10 logarithmic scale. E To manually set the Z axis range, in the Start and End boxes, enter beginning and ending



range values. E To automatically set the Z axis range, from the Calculation drop-down lists, select Data



Range. SigmaPlot automatically determines the vertical range based on the Z data plotted. E To add padding to both ends of the axis, select Pad 5%. E To extend the range to the nearest major tick mark, select Nearest Tick. E Click OK.
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Changing Contour Line Intervals Use the Graph Properties Line Interval settings to select line intervals for Major and Minor contours. To set line intervals: E Double-click the plot. The Graph Properties dialog box appears. Figure 7-31 Graph Properties Plots Tab Scale Settings



E Click the Plots tab. E From the Settings for list, select Scale. E From the Apply to drop-down list, select the Major or Minor lines to modify. E Under Line intervals, from the Lines drop-down list, select one of the following



intervals:
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„ Automatic: SigmaPlot automatically determines the interval at which contour lines



are drawn. „ Manually: Manually set the number of contour lines are drawn. Enter the z interval



in the Every field, and the value at which the first interval is drawn in the From field. „ Columns: Select the column used to determine major contour line z values.



Note: When major contour lines are plotted from a column, no minor lines are drawn. E Click OK.



Displaying and Modifying Contour Labels Use the Graph Properties dialog box Label settings to switch contour line labels on and off, add prefixes or suffixes to labels, and rotate labels relative to the contour line. To add, hide, or modify contour line labels: E Double-click the contour plot. The Graph Properties dialog box appears. Figure 7-32 Graph Properties Dialog Box Plots Tab Labels Settings
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E Click the Plots tab. E From the Settings for list, select Labels. E To display or hide contour labels, under Contour Labels, select or clear Major Contour



Labels and Minor Contour Labels.



Selected options display labels, and cleared options hide labels. E To align contour labels parallel to the contour line, under Label Appearance, select



Align With Contour Line.



Clear the option to align the contour labels parallel to the X axis. E To control how many labels appear for the contour lines, move the Label Frequency



slider. Move the slider toward Fewer to reduce the number of contour labels, or move the slider toward More to increase the number of contour labels. E To add to the contour labels, under Add to Major Labels and Add to Minor Labels, in



the Prefix and Suffix boxes, type the prefix or suffix. E To separate a suffix or prefix from the tick label, type a space before a suffix or after a



prefix. E Click OK.



Changing Contour Label Text Attributes Changing the text attributes for both major and minor contour labels involves changing the font, style, size, and color of the text. To open the Text Properties dialog box: E Double-click the contour plot. The Graph Properties dialog box appears. E Click the Plots tab. E From the Settings for list, select Details.
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E Click Font. The Text Properties dialog box appears.



Changing Numeric Contour Label Settings Use the Graph Properties Detail settings to modify numeric contour labels. To change numeric contour labels: E Double-click the plot. The Graph Properties dialog box appears. E Click the Plots tab. E From the Settings for list, select Details. The numeric contour settings appear. E To use a numeric type of contour label, from the Type list, select Numeric, then use the



Label Notation options. E From the Use list, specify which type of numeric display to use.



The Scientific Notation and Engineering Notation options always use scientific notation or engineering notation to display numbers. „ For large numbers options, use scientific or engineering notation only when



numbers exceed a specified range. Use the Above and Below lists to specify the range beyond which scientific notation or engineering notation is used. „ For linear scale, you can always use scientific notation, or only when needed. If you



use scientific notation only when needed, set the range to by typing values in the Lower and Upper ranges in the edit boxes. These values are expressed in log units. E Use the Precision options to specify the number of places used to display numeric tick



labels. Select Automatic to let SigmaPlot automatically determine precision, or select Manual, then select the number of decimal places to use from the Places drop-down list. E To use a series type of contour label, from the Type drop-down list, select Series then



from the Series list, select the type of series.
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Figure 7-33 The Series Labels Settings for Contour Labels



E From the Length drop-down list, select the number of characters to use for the labels. E From the Start At drop-down list, select the series item to begin labeling tick marks



with, then from the Step By drop-down list, select the frequency or increment for the series. E To restart tick labeling from a specified point, use the After and Repeat From drop-down



lists. E To use values or text from a worksheet column, enter the values or text in a worksheet



column, then from the Series list, select the column containing tick labels. E To change the font size, style, or color of text labels, click Contour label font to open the



Text Properties dialog box. For more information, see “Formatting Text ” in Chapter



5. E Click OK.
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8 Working with Pie, Polar, and Ternary Plots This chapter describes basic procedures specific to pie charts, polar plots, and ternary plots, including: Creating pie charts. „ Creating polar plots (see page 374). „ Modifying polar plots (see page 375). „ Creating ternary graphs (see page 381). „ Changing basic ternary graphs attributes (see page 383).



Pie Charts Pie charts plot a single worksheet column by representing each data point in the column as a pie slice. Each data point in the column is graphed as a slice size equivalent to the data point’s percent of the sum of all the data. Figure 8-1 Examples of Pie Charts
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The first pie slice starts at 0 degrees (3 o’clock) by default. Additional slices are added counterclockwise, in the order the data points occur in the column.



Creating Pie Chart E Select worksheet data before creating the graph. E On the 2D Graph Toolbar, click Pie Chart. The Graph Wizard appears. Figure 8-2 Using the Create Graph Dialog Box to Pick Columns to Plot



E Specify which worksheet column corresponds to data for your plot. Since you selected



a column prior to opening the Graph Wizard, your choice automatically appears in the dialog box and you can click Finish to create the pie chart. E If you selected the incorrect columns to plot, select a column either by clicking the



corresponding column directly in the worksheet, or selecting the appropriate column from the Data for Pie list. Note: If you make a mistake while picking data, click the wrong entry in the Graph Wizard, then select the correct column from the worksheet. E Click OK.



Use the Graph Properties dialog box to modify the pie chart, or reopen the Graph Wizard to pick a different data column for your plot. Note: You cannot add plots or axes to pie charts.
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Modifying Pie Charts Modifying pie charts includes: „ Changing fill color and patterns of pie chart slices. For more information, see



“Changing Patterns and Fill Colors” in Chapter 4. „ Rotating the pie chart. For more information, see “Rotating the Pie ” on page 375. „ Adding exploded pie slices to the pie chart. For more information, see “Adding



Exploding Slices” on page 376. „ Picking new data for the graph. For more information, see “Picking Different Data



for the Current Plot” in Chapter 4. To modify a pie chart, select the graph and open the Graph Properties dialog box. For more information, see “Modifying Graphs ” in Chapter 4.



Rotating the Pie Use the Graph Properties dialog box to rotate pie charts or add single or multiple exploding slices. To rotate the pie: E Double-click the pie chart. The Graph Properties dialog box appears.
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Figure 8-3 Graph Properties Dialog Box Plots Tab Pie Slices Settings



E Click the Plots tab. E Select Pie Slices from the Settings For list. E Move the Counterclockwise from slider to change the starting angle. Increasing the



starting angle for the first slice moves the starting slice counterclockwise. The default is 0° (3 o’clock). E Click OK.



Adding Exploding Slices E Use the Graph Properties dialog box to add single or multiple exploding slices.



To explode one slice: E Double-click the pie chart. The Graph Properties dialog box appears.
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Figure 8-4 Graph Properties Dialog Box Plots Tab Pie Slices Settings



E Click the Plots tab. E Select Pie Slices from the Settings For list. E Select Single Slice from the Exploded Slices drop-down list. E Select the number of the slice to explode from the Slice drop-down list.



By default, the first slice begins at 0° and proceeds counterclockwise. If you have not rotated the pie chart, the slice number corresponds to the worksheet row number. E Click OK.



Note: Choosing No Exploded Slices from the Exploded Slices drop-down lists replaces any exploded pie slices. To explode multiple slices: E Select an empty column.
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E Type a 1 in the same row as the data point for each row you want to emphasize with



an exploding slice. E Double-click the pie chart. The Graph Properties dialog box appears. Figure 8-5 Graph Properties Dialog Box Plots Tab Pie Slices Settings



E Click the Plots tab. E Select Pie Slices from the Settings For list. E Select the column containing exploding slice data from the Exploded Slices drop-



down list. E Click OK.



Polar Plots Polar plots display data in the coordinate system format where r is the distance from the origin of the graph, and theta (θ) is the angle between the positive horizontal axis and the radius vector extending from the origin to the plotted data point.
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Use polar plots to show data where one value (θ) is periodic in nature, like a clock. An example of this is a graph that shows average temperatures of differing geographical regions during the days of a month, or months of a year. Figure 8-6 Polar Plots 90
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Creating a Polar Plot E Select the worksheet columns to plot by dragging the pointer over your data.



On the 2D Graph Toolbar, click Polar Plot, and then click the style of polar plot you want to create. The Graph Wizard appears. E Choose a unit type from the Angular Axis Unit list.



The Range Lower Bound and Range Upper Bound options change depending on your selection from the list. Tip: If you don’t see the axis units you want to use for your polar plot listed in the list, you can type the desired values in the Range Lower Bound and Range Upper Bound fields. E Click Next. E Select the appropriate data format from the Data Format list. E Click Next. E Click Finish.
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Use the Graph Properties dialog box to modify the plot, or reopen the Graph Wizard to pick different data columns for your plot. For more information, see “Modifying Graphs ” in Chapter 4.



Modifying a Polar Plot Modifying polar plots involves: „ Modifying angular and radial axes. For more information, see “Modifying Polar



Axes” in Chapter 9. „ Picking new data for the plot. For more information, see “Picking Different Data



for the Current Plot” in Chapter 4. „ Changing symbol type, size, and color. For more information, see “Changing



Symbol Type and Other Symbol Options” in Chapter 4. „ Changing line type, size, and color. For more information, see “Changing Line



Type and Other Line Options” in Chapter 4. „ Modifying back plane color and grid lines. For more information, see “Modifying



Backplanes ” in Chapter 9. To modify a polar plot, select the graph and open the Graph Properties dialog box. For more information, see “Modifying Graphs ” in Chapter 4.



Ternary Graphs Ternary graphs plot data on an XYZ coordinate system in the form of three variables that add up to 100% or 1. These variables are typically the normalized proportions of three substances and are plotted on three axes generally arranged as an equilateral triangle. These graphs are also commonly referred to as triangle plots.
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Figure 8-7 Examples of a Ternary Line Plot, Scatter Plot, and Scatter and Line Plot 0
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Ternary Plot Styles You can create ternary scatter, line, and scatter and line plots. These graph data as symbols, as lines only with no symbols, or as symbols and lines, respectively. Line shapes can be straight segments or spline.



Creating a Ternary Plot Ternary plot data set (triplet or pair) must be based on a percentage or unitary scale with the sum of all values being 100% or 1. If your data does not add up to 100% or 1, you must first normalize the data. For more information, see “Normalizing Ternary Data” in Chapter 15. E Drag the pointer over your data to select the worksheet columns to plot. E On the 2D Graph Toolbar, click Ternary Plot, and then click the style of ternary plot



you want to create. The Graph Wizard appears. For more information, see “Creating Graphs” in Chapter 4.
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Figure 8-8 Selecting a Ternary Graph Data Format from the Graph Wizard



E Select the appropriate format, and click Next. Figure 8-9 Selecting Columns to Plot Using the Graph Wizard



Since you selected columns prior to opening the Graph Wizard, your choices automatically appear in the dialog box. Tip: If you made a mistake picking columns, highlight the wrong entry in the Graph Wizard, then choose the correct column either in the worksheet or from the column list. E Click Finish.



Use the Graph Properties dialog box to modify the plot or to open the Graph Wizard to pick different data columns to plot or to add another plot to your graph. For more information, see “Modifying Ternary Axes” in Chapter 9.
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Modifying Ternary Graphs Modifying ternary graphs involves: „ Changing axis properties. For more information, see “Modifying Ternary Axes” in



Chapter 9. „ Picking new data for the plot. For more information, see “Picking Different Data



for the Current Plot” in Chapter 4. „ Changing line and symbol type, size, and color. For more information, see



“Changing Symbol Type and Other Symbol Options” in Chapter 4. „ Modifying backplane color and grid lines. For more information, see “Modifying



Backplanes ” in Chapter 9. To modify a ternary graph, select the graph and open the Graph Properties dialog box. For more information, see “Modifying Graphs ” in Chapter 4.
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9 Modifying Axes, Tick Marks, and Grids Axes are the scales or rulers along which data is plotted. 2D Cartesian graphs have an X (horizontal) axis, and a Y (vertical) axis. For 3D graphs, the X and Y axes form the base of the graph, and the Z axis is the vertical axis. Polar plots use an angular axis to draw the circumference of the plot and the radial axes to draw the radius of the plot. An axis is always associated with at least one plot on a graph, and determines the scaling of the plot. Each axis consists of pairs of lines that you can move and modify independently. Tick marks are short lines along the axis that represent scale intervals. You can display and modify tick marks for each axis. Grid lines are attached to the graph planes, and can be drawn at tick intervals for all axes. Make most axis modifications using the Axes tab of the Graph Properties dialog box. This chapter covers: „ Changing axis scales and ranges (see page 386). „ Changing scale type (see page 391). „ Hiding, displaying, and deleting axes (see page 395). „ Setting axis breaks (see page 399). „ Working with axis titles and tick labels (see page 401). „ Changing tick mark intervals (see page 404). „ Changing tick mark appearance (see page 412). „ Changing tick labels (see page 415). „ Displaying grid lines and backplanes (see page 425). „ Modifying polar axes (see page 428). „ Modifying ternary axes (see page 439).
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Changing Axis Scales and Range You can control the axis units and increments used in representing your data. Axis scale and range are modified with the Scaling settings of the Graph Properties dialog box Axes tab. You can also use transforms and tick labels and intervals from worksheet columns to create your own custom axis scales.



Axis Scale Types Linear:



A standard base 10 numeric scale. (This scale is recommended for a date axis when an exact representation of spacing depicted by dates is not required. Otherwise, use the date/time scale.) Common Log:



A base 10 logarithmic scale. Natural Log:



A base e logarithmic scale. Figure 9-1 Graphs of the Same Data Using Linear, Common Log, and Natural Log Scales
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Probability:



The inverse of the Gaussian cumulative distribution function. The graph of the sigmoidally shaped Gaussian cumulative distribution function on a probability scale is a straight line. Probabilities are expressed as percentages with the minimum range value set at 0.001 and the maximum range value set at 99.999. The default range depends on the range of the actual data. Probit:



A scale similar to the probability scale; the Gaussian cumulative distribution function plots as a straight line on a probit scale. The scale is linear, however, with major tick marks at each Normal Equivalent Deviation (N.E.D. = X - Œº)/œÉ) plus 5.0. At the mean (X = Œº) the probit = 5.0; at the mean plus one standard deviation (X = Œº + œÉ) the probit = 6.0, etc. The default range is from 3 to 7. The range limit for a probit axis scale is 1 to 9. Figure 9-2 Graphs of the Same Data Using Linear, Probability, and Probit Scales
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Uses the transformation y λογ i t = λν  -----------  a – y



where a = 100 and 0 ≤ y ≤ 100
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Category:



A scale which uses numerical values or text from a worksheet column used to generate a plot. Each distinct entry in the column is a separate category against which the corresponding data values are plotted. This scale is commonly used for bar charts or other plots used to graph different categories of data. Figure 9-3 A Graph Showing the Category Scale
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Any plot generated by plotting a column containing any text versus a column containing data will use a category axis automatically. For more information, see “Using a Category Scale” on page 392. You can select a category scale for numeric data, and each unique value will be treated as its own category.



 389 Modifying Axes, Tick Marks, and Grids



Note: If a column contains more than one instance of the same category, the category appears only once, and all corresponding data is plotted within that category. Date/Time:



Date and time formatted data are automatically plotted using a Date/Time axis scale. This scale is specifically designed to handle true calendar date and time units, labeling and spacing. You can: „ Plot date and time data. For more information, see “Entering Dates and Times” in



Chapter 3. „ Change data and time intervals. For more information, see “Tick Intervals for



Date/Time Axes ” on page 410. „ Change date and time labels. For more information, see “Changing Date and Time



Tick Labels” on page 421. Although you can plot numeric data as date and time, you should first view these numbers as dates and times in the worksheet to make sure they are sensible values. If a worksheet cell is a label, it won’t plot as a date and time value. In this case, you may want to reenter the label as a date and time value.



Changing Axis Range Axis range includes the values of the starting and ending points of an axis. You can choose to set axis range automatically or manually. To change the axis range: E Double-click the axis to modify. The Graph Properties dialog box appears. E Click the Axes tab. From the Axis drop-down list, select the axis you wish to modify. E From the Settings for list, select Scaling.To automatically set the axis range, select



Data Range from the Calculation list. SigmaPlot automatically determines the axis range based on the data plotted.
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E For log axes, or axes that forbid zero or negative numbers, the minimum is set to the



nearest major tick mark beyond the smallest value. To manually set the axis range, select Constant then type beginning and ending axis range values in the Start and End edit boxes. Note: Date/Time axes display the ranges in date and time units. Figure 9-4 Graph Properties Dialog Box Axes Tab Scaling Settings



E Select Pad 5% to add padding to both ends of the axis. E Select Nearest Tick to extend the range to the nearest major tick mark. E Click OK.
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Changing Scale Type To change an axis scale type: E Select the axis to modify. E On the Properties toolbar, click the Axis Scale button. The Graph Properties dialog



box appears. Figure 9-5 Using the Scale Type list from the Axes Tab of the Graph Properties Dialog Box



E From the Settings for list, select Scaling. E From the Scale Type list, select the desired axis scale type. The default axis scale is



Linear for all numeric data, Category for text data, and Date/Time for date and time data. E Click OK.
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Using a Category Scale Use the category scale type by plotting a column containing categories against other columns of data values, or modify an already existing plot to use a category scale by changing the axis scale type to Category, then using the Graph Wizard to repick the data and assign your category column as the X or Y coordinate values. Figure 9-6 Plotting Category Data Using a Category Scale



To plot a column of text as a category scale: E Enter your category data (text) into a worksheet column, and corresponding data into



adjacent worksheet columns. E On the Graph toolbar, click the graph type and style you want to create. The Graph



Wizard appears. E Select the data format, and click Next. E Since you have not already selected your data from the worksheet, click the worksheet



columns to assign them under Selected Columns. Plot your category column as the category axis data type, and pick your other column(s) as the corresponding data type.
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E Click Finish to create the graph.



To modify a plot to use a category scale: E Double-click the axis you want to modify. The Graph Properties dialog box Axes tab



appears. E Select Scaling from the Settings for list. E Select Category from the Scale Type drop-down list. E Click Apply to change the scale type without closing the dialog box. E Click the Plots tab, and then click Graph Wizard. The Graph Wizard - Modify Plot



dialog box appears. E Under Data Format, select the data format you want to use, and click Next. E Click the columns in the worksheet to choose the worksheet columns to assign to



plotted data under Selected Columns. Plot your category column as the data type you want to use as the category axis, and pick you other columns(s) as the corresponding data type. E Click Finish to create the graph with the newly assigned worksheet data and



modified axis.



Using a Date and Time Scale SigmaPlot graphs date and time data from worksheet columns as specific calendar dates and times against which corresponding data values in other columns are plotted. To create a plot using a date/time scale: E Enter dates or times into a column of a worksheet. For example, enter 1/1, 2/1, 3/1, etc.,



indicating months and days. E Enter corresponding data into a separate worksheet column or columns.
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E Drag the pointer over both the date and data columns. E Create the graph using the Graph toolbar or the Graph Wizard. E Plot your date and time column as the date/time axis. E Pick your other column(s) as the corresponding axis. E Click Finish to create the graph.



Using a Custom Axis Scale Use the transform language to transform your data for a new axis scale, then use tick intervals from a column to the place correct ticks marks and labels. Figure 9-7 This graph uses the Arrhenius scale. You can skip labeling tick intervals by using empty cells in the tick label column.



For example, to use an Extreme Value Distribution scale, apply the transform: f(y)=ln(ln(100/(100-y)))



and for the Arrhenius scale, use the transform: f(y)=1-273/(T+273)
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Apply the transform to both your original interval values and data, then plot the transformed data using the transformed intervals as the tick mark values, and the original interval data as tick labels. For more information, see “Transform Basics” in Chapter 15.



Hiding, Displaying, and Deleting Axes The easiest way to hide an axis is to select it, then press Delete. The axis is hidden rather than deleted. You can also hide an axis by right-clicking the axis, then choosing Hide. Control the display of axes using the Lines settings of the Graph Properties dialog box Axes tab. To view, hide or modify the display of an axis: E Double-click the axis (you can double-click hidden axes as well). The Graph



Properties dialog box appears. Figure 9-8 Graph Properties Dialog Box Axes Tab Line Settings
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E Click the Axes tab. E From the Settings for list, select Lines. E Under Show/Place Axes, select an axis to display that axis, or clear an axis to hide it.



Hidden axes hide all ticks and labels associated with that axis. Note: You can hide 3D axes, but if frame lines are active, a line will remain present. For more information, see “Drawing, Modifying, and Hiding Frame Lines” in Chapter 7. Also, if the graph has grid lines, a line will remain present. For more information, see “Displaying Grid Lines and Backplanes” on page 425. E Click OK.



Changing Axis Line, Color, and Thickness Use the Axes tab of the Graph Properties dialog box to change axis color and thickness. To change the color and thickness of an axis: E Double-click the axis. The Graph Properties dialog box appears. E Click the Axes tab. E Select Lines from the Settings for list. E Select the axis you want to modify from the Axis drop-down list. E To change the color of the axis, under Line Properties, select a color from the Color



drop-down list. Choose (None) to make the axis transparent, and choose (Custom) to open the Custom Color dialog box. E To change the thickness of the axis, under Line Properties, move the Thickness slider



or type a thickness in the Thickness box. E Click OK to apply the changes and close the dialog box.
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Note: 3D graph frame lines are drawn over axes lines and may obscure 3D axes modifications.



Using the Object Properties Dialog Box to Change Line Attributes You can change axis line attributes by right-clicking the axis and choosing Line Properties. You can also select the axis, and then on the Format menu, click Line. Figure 9-9 The Line Tab of the Object Properties Dialog Box Note that the Type option is unavailable for axes.



Moving Axes You can move 2D axes with your mouse, or to a precise location with the Graph properties dialog box. You cannot move 3D axes, but you can hide them from view. For more information, see “Hiding, Displaying, and Deleting Axes” on page 395.



Moving 2D Axes Manually To move a 2D axis with the mouse, select the axis and drag it to a new position. Y axes move only horizontally and X axes only vertically. Moving ternary graph axes changes the axis range and scale, along with the size and shape of the graph. Axis titles move with the axis.
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Figure 9-10 Moving an Axis by Dragging



Moving Axes to a Precise Location Use the Lines settings in the Graph Properties dialog box Axes tab to position axes a precise distance from the graph origin. For more information, see “Modifying Ternary Axes” on page 439. To move an axis: E Double-click the axis you want to move. The Graph Properties dialog box appears.
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Figure 9-11 Graph Properties Dialog Box Axes Tab



E Click the Axes tab. E From the Settings for list, select Lines. E Under Show/Place Axes, move the sliders to change the percentage in the Top and



Bottom boxes for X axes or Y axes, or type the value in the fields.



Locations are described as the percentage of the graph dimension the axes lie from the original position. To move an axis up or right, enter a percent greater than 0% (positive). To move an axis down or left, enter a percent less than 0% (negative). The defaults are 0.0%, and Normal. E Click OK.



Setting Axis Breaks You can set axis breaks for 2D Cartesian graphs over specific ranges, at a specific location along the axis, and you can change the major tick intervals that occur after the break. You can also use several different break symbols.
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Figure 9-12 A Graph Before and After the Addition of a Y Axis Break
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Creating an Axis Break To create an axis break: E Double-click the axis where you want to add the break. The Graph Properties dialog



box appears.Click the Axes tab. E From the Settings for list, select Breaks. E From the Break Range group box, select Show Break. E In the Omit boxes, enter the Break to omit. E To specify the break position, move the Position slider.



The location of the break is determined as a percent of the total axis length, from the origin. E To set the width of the space between break lines, move the Gap Width slider. E To set a post break interval, type a value in the Post Break Interval box.



The default value is the interval specified for the axis range.
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Figure 9-13 Graph Properties Dialog Box Axes Tab Breaks Settings



Note: Tick values from a column are not applied to the post break interval. To set axis break properties, under Break Properties, from the Symbol drop-down list, select a break symbol type then use the Length, Color, and Thickness options. E Click OK.



Working with Axis Titles and Tick Labels SigmaPlot automatically labels graph axes with titles and tick labels. Axis titles can be modified like any other text label.



Editing an Axis Title To edit an axis title: E On the graph page, double-click the axis title. The title appears highlighted.
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E Make your changes to the title.



Note: You can also rename an axis title from within the Axis tab of the Graph Properties dialog box. Double-click the axis, then click Rename. The Edit Text dialog box opens.



Rotating Axis Titles To rotate an axis title: E Right-click the axis title. On the shortcut menu, click Edit.



Edit Text dialog box appears. E Select a degree of rotation for the selected label from the Rotation drop-down list.



Viewing and Hiding Axis Titles and Tick Labels The easiest way to hide a graph axis title or tick label is to click it and press delete. You can also use the Graph Properties dialog box.
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To view or hide axis titles: E Double-click the desired axis. The Graph Properties dialog box appears. Figure 9-14 Graph Properties Dialog Box Axes Tab Labels Settings



E Select Labels from the Settings for list. E To view or hide the axis title, under Show Axis Title select or clear Bottom or Top to



specify the position of the axis label. E To view or hide Major Tick labels, from the Apply to list, select Major Ticks, then under



Major Tick Labels, then select or clear Bottom or Top to specify the position of the



tick label. E To view or hide Minor Tick labels, from the Apply to list, select Minor Ticks, then under



Minor Tick Labels select or clear Bottom or Top to specify the position of the tick



label. E Click OK.
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Moving an Axis Title To move an axis title, drag it with the mouse, just like any other text label, or on the Format menu, click Size and Position. For more information, see “Using Your Mouse to Move Graphs and Objects” in Chapter 5. Note: Axis title position, relative to the axis, remains constant when the axis or graph is moved.



Changing Tick Mark Intervals Use the Graph Properties dialog box to modify tick intervals. For more information, see “Displaying and Changing Radial Axis Ticks and Labels” on page 436. You can also change tick marks for ternary graphs. For more information, see “Changing Ternary Axis Tick Marks and Tick Labels” on page 447. Note: Tick Intervals options vary depending upon the axis scale used. For example, there are no tick interval options for category axes.



Changing Linear and Probit Scale Tick Mark Intervals To change the tick intervals for linear and probit axis scales: E Double-click the tick marks you want to change. The Graph Properties dialog box



appears.
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Figure 9-15 The Axes Major Tick Intervals Options for a Linear Axis



E Click the Axes tab. E From the Settings for list, select Ticks. E To change tick intervals, select from the Ticks and Every drop-down lists in the Tick



Intervals group box. E If you select Manual, enter interval values by typing into the Every and From fields. The



value in the Every field specifies how often major tick marks appear, and the From value specifies and origin point on the axes from which major tick marks start appearing. For example, if you type 0 into the From field and the 2 into the Every field, the major tick marks appear at even numbers on the axis. If you type 1 into the From field , the major tick marks appear at odd numbers on the axis. Custom Tick Intervals: You can also choose major tick interval values from the worksheet from the Major Tick Intervals list. Custom tick intervals are not available



for minor ticks. For more information, see “Customizing Tick Intervals” on page 410.
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E Click OK.



Tick Intervals for Log Axes You can only specify log axis major tick marks automatically or from a column. However, you can select specific intervals for log scale minor ticks. Figure 9-16 A View of a Graph with Log Y Axis Minor Ticks



To change log scale minor tick intervals: E Change the axis scale to a log axis. For more information, see “Changing Axis Scales



and Range” on page 386. E Double-click the tick marks. The Graph Properties dialog box appears.
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Figure 9-17 The Axes Minor Tick Intervals Options for a Log Axis



E Click the Axes tab. E From the Settings for list, select Ticks. E From the Apply to drop-down list, select Minor Ticks. E Select all minor tick intervals you want to appear, and clear those you want hidden. E Click OK.
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Natural Log and Logit Scales Natural log and logit scales have only Automatic and from column Tick Intervals. Natural log intervals occur at every factor of e. Logit ticks occur at 7, 10, then every ten until 90, then 95 and 97. Figure 9-18 Tick Intervals for Natural Log and Logit Scales 97 e10
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Tick Intervals for Probability Scales Probability scale axes have no minor ticks, but have three different settings for major tick intervals, coarse, medium, and fine, as well as the option to set tick intervals from a worksheet column. Figure 9-19 Coarse, Medium and Fine Tick Intervals for Probability Scales 99
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To specify the tick mark density for probability scales: E Double-click the tick marks.



The Graph Properties dialog box appears. Figure 9-20 Axes Tick Intervals Options for a Probability Axis



E Click the Axes tab. E From the Settings for list, select Ticks. E Under Tick Intervals, from the Density drop-down list, select a tick mark density. E Click OK.
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Tick Intervals for Date/Time Axes SigmaPlot automatically sets both major and minor tick intervals that are computed from the data range. You can also manually set Major Ticks and Minor Ticks. To set tick intervals for a date/time axis: E Double-click the tick marks. The Graph Properties dialog box appears. E Click the Axis tab. E From the Settings for drop-down list, select Ticks. E Under Tick Intervals, from the Type drop-down list, select a tick interval type. Tick



intervals are defined by the unit Type used and the selected Count. Dates fall at 12:00 AM of the first day for that period. The major tick interval options available are limited by the data range. You are prevented from selecting time units that would create too many tick marks. E To increase the period between tick occurrences, change the Count. For example, set



ticks to occur every other Type date by changing the Count to 2, or every fifth by changing the count to 5. Counts must be positive integers. E To set minor tick intervals, from the Apply to drop-down list, select Minor Ticks. E Select the minor tick Type and Count. Any time unit equal to or smaller than the Major



interval type can be used as the Minor interval type. Note: Do not select a minor interval that creates hundreds or even many thousands of minor tick marks.



Customizing Tick Intervals You can specify major tick locations by entering major tick values into a worksheet column, then selecting that column from the Graph Properties dialog box.
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Custom tick intervals are not available for minor ticks. To use worksheet columns to customize tick intervals: E Enter the desired tick marks into an empty worksheet column. E Double-click the tick marks. The Graph Properties dialog box appears. Figure 9-21 Selecting a Column for Tick Label Intervals



E Click the Axes tab. E From the Settings for drop-down list, select Ticks. E From the Apply To drop-down list, select Major Tick Intervals. E Under Major Tick Intervals, from the Ticks drop-down list, select the column number



or title of the column you want to use for major tick marks.
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E Click OK. The numeric values of the intervals are automatically used for tick labels,



that you can modify them like any other tick labels.



Changing Tick Mark Appearance Use the Graph Properties dialog box to modify tick appearance including tick length and color. You can also specify tick mark direction, or hide tick marks altogether. You can change: „ Tick marks for polar plots. For more information, see “Displaying and Changing



Radial Axis Ticks and Labels” on page 436. „ Tick marks for ternary graphs. For more information, see “Changing Ternary Axis



Tick Marks and Tick Labels” on page 447.



Tick Mark Direction To turn tick drawing on and off and to select tick directions for both sides of an axis: E Double-click the tick marks. The Graph Properties dialog box appears. Figure 9-22 The Axes Tick Direction Options
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E Click the Axes tab. E From the Settings for list, select Ticks. E From the Direction list for either axis: E Select Outward, to point tick marks away from the graph. E Select Inward to point tick marks toward the inside of the graph. E Select Both to point tick marks in both directions. E Select (none) to hide tick marks.



Directions for tick marks are independent for either side of the axis.



Hiding Tick Marks To hide tick marks: E Click the tick marks on the page. E Press Delete, or right-click and from the shortcut menu, click Hide.



Changing Tick Mark Line Attributes To change tick mark length, color, and thickness: E Double-click the tick mark. The Graph Properties dialog box appears.
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Figure 9-23 Graph Properties Dialog Box Axes Tab Ticks Settings



E From the Settings for list, select Ticks. E From the Apply to drop-down list, select Major Ticks or Minor Ticks. E To change tick length an thickness, under Tick Line, move the Length and Thickness



sliders. E Select a color from the Color drop-down list. Choose from any of the listed colors, or



select (Custom) to use a pre-defined custom color or create your own color. For more information, see “Using Custom Colors” in Chapter 5. Select (none) to create transparent tick marks. E Click OK.
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Changing Tick Labels SigmaPlot can display tick labels for: „ Both major and minor tick marks. „ Standard numeric labels. „ Time and series labels.



You can also add a suffix or prefix to all major or minor tick labels on a selected axis, and modify the calculation and precision of numeric labels, view different dates and times, select among many different series labels, and change the font and other text attributes.



Changing Tick Label Font and Other Text Attributes To change the font size, style, or color of tick labels: E Right-click the tick labels, and from the shortcut menu, click Text Properties. Figure 9-24 Selecting a Column for Tick Label Intervals



The Text Properties dialog box appears. E Click the Font tab.



 416 Chapter 9



E Change text attributes for tick labels the same way you would for any text label.



You can also use the Rotation drop-down list on the Paragraph tab to rotate tick labels, but no other Paragraph settings are applied to tick labels. For more information, see “Formatting Text ” in Chapter 5.



Changing Tick Label Type You can change the type of tick label used for all axis types except for category axes. To change all other tick label types for all other axes: E Double-click the tick labels you want to change. The Graph Properties dialog box



appears. Figure 9-25 Changing the Tick Label Type



E Click the Axes tab. E From the Settings for list, select Tick Labels.
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E From the Apply to drop-down list, select either Major Ticks or Minor Ticks. E To use a numeric type of tick label, from the Type list, select Numeric, then use the



Label Notation options. E To use a series type of tick label, from the Type list, select Series. E Click OK.



Note: If you want to plot data versus true calendar dates, you should have entered date and time data in the worksheet, and use a date/time axis scale.



Formatting Numeric Tick Labels To format numeric tick labels: E Double-click the tick labels of the axis you want to change. The Graph Properties



dialog box appears. Figure 9-26 Selecting Numeric Tick Label Notation



E Click the Axes tab.
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E From the Settings for list, select Tick Labels. E From the Apply to drop-down list, select either Major Ticks or Minor Ticks. E Under Label appearance, from the use drop-down list, select the type of label



notation to use. Scientific Notation or Engineering Notation for large numbers use scientific or engineering notation only when numbers exceed a specified range. Use the When below and or above drop-down lists to specify the range beyond which scientific notation or engineering notation is used. For log axes, you can select to display the number, only the Exponent, or both the Base and exponent. For linear axes, you can select Scientific notation or Engineering notation to use always, or you can select Scientific notation, for large numbers or Engineering notation, for large numbers to use only when needed for large numbers. To specify when scientific notation is needed, enter the lower and upper ranges in the When below and or above. Figure 9-27 Log Scale Y Axes Using Numbers, Exponent Only, and Base and Exponent 10000
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E To divide numeric tick label values by a specific number, enter a divisor in the Factor



Out drop-down list. A value of 2 divides label values in half, a factor of 0.5 doubles



the tick label values, etc. E To specify the number of places used to display numeric tick labels, under Precision,



select Automatic to let SigmaPlot automatically determine precision, or select Manual, then select the number of decimal places to use from the Places drop-down list.
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E Click OK.



Formatting Series Tick Labels To format series tick labels: E Double-click the tick labels of the axis you want to change. The Graph Properties



dialog box appears. Figure 9-28 Selecting Series Tick Label Format



E From the Settings for list, select Tick Label. E From the Apply to drop-down list, select either Major Ticks or Minor Ticks. E From the Type drop-down list, select Series. E From the Series drop-down list, select a series. E From the Length drop-down list, set the number of characters to use for the tick label.



 420 Chapter 9



E From the Start At drop-down list, specify which series item to begin labeling tick



marks with. E From the Step By list, set the frequency, or increment, of series items to use.



For example, if you are using a Days of the Week series, you might choose to start with Monday, and to step labeling by 2 days at a time. Tick labels appear as Monday, Wednesday, Friday, Sunday, Tuesday, etc. E To re-start tick labeling from a specified point, use the After and Repeat From drop-



down lists. For example, if you were using a Days of the Week series, and were stepping by 2 days at a time, you might use the After and Repeat From lists to specify that after Friday, repeat the series from Monday. Tick labels appear as Monday, Wednesday, Friday, Monday, Wednesday, Friday, etc. E Click OK.



Adding a Prefix or Suffix to Tick Labels To add a suffix or prefix to the major or minor tick labels on a selected axis: E Double-click the axis you want to change. The Graph Properties dialog box appears. E Click the Axes tab. E From the Settings for list, select Labels. E From the Apply to drop-down list, select either Major Ticks or Minor Ticks. E To add a prefix or suffix to the major or minor tick labels, type the prefix or suffix into



the appropriate Add to Tick Labels Prefix or Suffix boxes. All labels on the selected axis appear with the specified suffix or prefix. You can use any keyboard or extended characters. Use the Windows Character map accessory program, or Alt+Numeric keypad combinations to enter extended characters like degrees symbols (Alt+0176).
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E Click OK.



Changing Date and Time Tick Labels To change the format of date/time tick labels,use the Graph Properties dialog box. Entering values in these boxes is similar to entering date/time values in the worksheet. To change date and time tick label format: E Double-click the tick labels of the axis you want to change. The Graph Properties



dialog box appears. Figure 9-29 Changing Date/Time Tick Labels



E From the Settings For list, select Tick Label. E From the Apply to drop-down list, select either Major Ticks or Minor Ticks. 10. To change the display Date format, select a format from the list, or use the following table to



enter a new label, using any additional characters as delimiters (i.e., slashes, commas, spaces,
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etc.). As you enter a different format, the Sample window shows an example of the label. Typing:



Displays:



M/d/yy



No leading 0 for single digit month, day or year



MM/dd/yy



Leading 0 for single digit month, day or year



MMMM



Complete month



dddd



Complete day



yyy or yyyy



Complete year



MMM



Three-letter month



ddd



Three-letter day



gg



Era (AD or BC)



11. To change the display Time format, select a format from the list, or use the following table to



enter a new label, using any additional characters as delimiters (i.e., colons, spaces, etc.). As you enter a different format, the Sample window shows an example of the label.



Typing:



Displays:



hh or h



12 hour clock



HH or H



Military hours



mm or m



Minutes



ss or s



Seconds



uu or u



Milliseconds



H: h: m: s: or u



No leading zeroes for single digits



HH: hh: mm: ss: uu



Leading zero for single digits



tt



Double letter AM or PM



t



Single letter AM or PM



E Click OK.
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Using Custom Tick Labels You can enter text and numbers into worksheet columns and use them as major tick labels. To customize tick labels using worksheet columns: E Enter the labels you want to use in a worksheet column in the order you want them to



appear. Enter minor labels in the right adjacent column. Figure 11-1 Tick Labels from a Column using the Symbol Font



Note: To skip specific labels, leave an empty cell for that tick mark when entering the labels into the worksheet column. E Double-click the axis tick labels you want to modify. The Graph Properties dialog box



appears.
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Figure 11-2 Selecting a Columns as the Source for the Tick Labels



E Click the Axes tab. E From the Settings for list, select Tick Labels. E From the Type drop-down list, select the column to use for major labels. Labels for



minor ticks are automatically taken from the column to the right of the major tick labels. E To change the font used for the tick labels, click Font.



The Text Properties dialog box appears. You can use the Symbols font for Greek characters, and the Wingdings and other symbol fonts for iconic labels. E Click OK.
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Displaying Grid Lines and Backplanes Display and modify grids for each graph plane using the Graph Properties dialog box. Grid lines are associated with both a backplane and one of the two axes which form the plane. If a graph has multiple axes, the axes used are the original pair. You can choose to turn on and modify grid lines for both major and minor tick intervals. Tick intervals are controlled using the Graph Properties dialog box Axes tab Scaling settings.



Modifying Backplanes To change back planes: E Double-click the graph to modify. The Graph Properties dialog box appears. E Click the Graph tab. E Under Settings for, select Backplanes. E If your graph is a 3D graph, from the Plane list, select the plane to modify.



Note: When modifying a 2D graph, only one plane is available. E To select a background color for the selected plane, under Background, select a color



from the Color drop-down list. E Select any of the listed colors, or select (Custom) to use or create a custom color. For



more information, see “Using Custom Colors” in Chapter 5. E Select (none) to create a transparent plane. Transparent planes are especially useful



when superimposing graphs over one another. The grid lines available for Cartesian plots are X, Y, and Z for 3D plots. The grid lines for polar plots are for the Angular and Radial axes. Ternary plots have X, Y and Z direction grid lines. E Click OK.
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Modifying Grid Lines To change major or minor grid lines: E Double-click the graph to modify. The Graph Properties dialog box appears. E Click the Graph tab. E Under Settings for, select Grid Lines. Figure 11-3 Selecting the Grid Lines



E To change grid line thickness, under Gridlines, move the Thickness slider type a



thickness value in the Thickness box. E To change grid line style, under Lineproperties , from the Style drop-down list, select



a style. E To change grid line color, under Line properties, from the Color drop-down list, select



a color. Choose any of the listed colors, or choose (Custom) to use or create a custom color. Choose (none) to turn off grid lines. For more information, see “Hiding and Viewing Grid Lines” on page 427.
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E To move the grid behind or in front of the plot, from the Layering drop-down list, select



to move either the plot or grid to the front. This feature is especially useful for bar charts, and is not available for 3D plots. E Click OK. Figure 11-4 A Bar Chart with a White Backplane and White Grid Lines Placed in Front of the Plot
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Hiding and Viewing Grid Lines To view hidden grid lines, or hide visible grid lines: E Open the Graph Properties dialog box. E Click the Graph tab.
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E Select Grid Lines from the Settings for list. E To hide grid lines, under Style, select (none) from the Style drop-down list. E To display grid lines, change the style to a style other than (none). E Click OK.



Modifying Polar Axes Polar plots have a radial axis and an angular axis. The angular axis describes a circle and can use radians, degrees, or other units as the scale. There are both outer and inner angular axes. The radial axes are spokes of the circle and scale the distance from the center of the circle (the radius, or R). There are four radial axes, referred to as spokes 1-4. Figure 11-5 A Diagram of the Axes of a Polar Plot
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Note: Axis breaks cannot be created for either radial or angular axes.



Angular Axes The angular axes can be drawn along the inner and outer circumferences of the graph. By default, the inner axis is not displayed. You can modify angular axes by: „ Changing axis titles. For more information, see “Working with Axis Titles and



Tick Labels” on page 401. „ Displaying or hiding either axis. For more information, see “Hiding, Displaying,



and Deleting Axes” on page 395. „ Changing axis lines. For more information, see “Changing Axis Line, Color, and



Thickness ” on page 396. „ Changing tick marks. For more information, see “Changing Tick Mark Intervals”



on page 404. „ Changing axis tick labels. For more information, see “Changing Tick Labels” on



page 415. „ Changing axis scaling, range, and rotation. For more information, see “Changing



Angular Axis Scaling and Position” on page 429.



Changing Angular Axis Scaling and Position Polar plot angular axis scale and range settings control the axis units and increments used to plot data. You can modify axis scale, range, units, and rotation using the Scaling settings of the Graph Properties dialog box Axes tab. To change an axis scale, range, units, and rotation: E Double-click the plot. The Graph Properties dialog box appears.Click the Axes tab. E Select Scaling from the Settings for list. E To change the axis scale used, choose the desired axis scale type from the Scale Type



list. For more information, see “Axis Scale Types” on page 386.
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E To change the measurement units of the angular axis, select measurement units from the



Angular Axis Units drop-down list. If you don’t see the axis units you want to use for your polar plot listed in the list, select Other, then type new axis range values in the Range Lower Bound and Range Upper Bound fields. If using a predefined measurement unit, the Range Lower Bound and Range Upper Bound box values are entered automatically. For more information, see “Using a Custom Axis Scale” on page 394. Figure 11-6 Graph Properties Dialog Box Axes Tab Scaling Settings



Note: The only effect of changing units is to change the pre-defined axis range. This range can be manually changed regardless of the current units. E To change the size of the displayed arc of the polar plot, move the Arc slider. A setting



of 360 degrees displays the entire circle, 270 degrees displays three-quarters of the circle, and 90 degrees displays half of the circle. Note: If you change the arc of the angular axis, the axis range remains the same. The current axis range appears along the new distance of the arc.
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E To change the start angle for the displayed arc, move the Start Angle slider. The default



is 0 degrees (3 o’clock). Rotation is counterclockwise. Figure 11-7 Polar plots with: Starting angle of 315° and arc of 270°; start angle of 0° and arc of 180°; and start angle of 135° and arc of 22.5°. 180 210
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E Click OK.



Moving Angular Axis Positions You can drag both inner and outer angular axes closer or further from the center of the graph. Select the axis, and move it using the mouse. To set exact locations for angular axes: E Double-click an angular axis. The Graph Properties dialog box appears.
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Figure 11-8 Graph Properties Dialog Box Axes Tab Lines Settings



E Click the Axes tab. E Select Lines from the Settings for list. E To change the percentage in the Outer and Inner axes, under Show/Place Axes, move



the Outer and Inner slider controls. Locations are described as the percentage of the distance the axes lie from the center of the graph. To move an axis out, increase the percent. To move an axis in, decrease the percent. E Click OK.
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Radial Axes The radial axes are drawn along the radius of the graph, and by default are displayed as four axes extending from the center of the graph to the outer of edge the graph. Each of the radial axes is a representation of the same data, so the range and scale must be the same for each radial axis; however, you can modify the color, tick marks, labels, location, and display of each radial axis independently. Modify radial axes by: „ Displaying or hiding any axis. For more information, see “Hiding, Displaying, and



Deleting Axes” on page 395. „ Changing display of axis and tick label titles. For more information, see



“Displaying and Changing Radial Axis Ticks and Labels” on page 436. „ Changing axis lines. For more information, see “Modifying Radial Axes Lines and



Position” on page 433. „ Changing axis scaling. For more information, see “Changing Axis Scales and



Range” on page 386. „ Changing tick marks. For more information, see “Changing Tick Mark Intervals”



on page 404. „ Changing axis tick label type. For more information, see “Changing Tick Labels”



on page 415.



Modifying Radial Axes Lines and Position To control polar plot radial axes line settings: E Double-click the graph to open the Graph Properties dialog box. E Click the Axes tab. E Select Lines. Moving a Radial Axis



To move a radial axis: E Select the axis on the page.
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E Use the mouse to drag it to a new location. Radial axes rotate about the center of the



graph like the spokes of a wheel. Setting Radial Axis Positions to Exact Degree Positions To set radial axis positions to exact degree positions E Double-click a radial axis. The Graph Properties dialog box appears. Figure 11-9 Graph Properties Dialog Box Axes Tab Lines Settings



E Click the Axes tab. E Select Lines from the Settings for list. E To move a radial axis, under Show/Place Axes, move the sliders to set a new location.



The axis location is in degrees from 0 degrees (3 o’clock). The defaults are 0 degrees, 90 degrees, 180 degrees, and 270 degrees. E To offset an axis from the center of the graph, move the Axes Start slider to change the



length of the radial axes.
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Setting the slider to 0% draws the axis from the center of the graph outward, 25% draws the axis beginning a quarter of the distance from the center, 50% draws it half the distance from the center, and so on. Figure 11-10 Radial Axes in the Default Positions, and Offset by 45 degrees with an Axes Start of 30%. 90 120
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E Click OK. Displaying and Modifying Radial Axes Lines



To display and modify radial axes lines: E Double-click a radial axis. The Graph Properties dialog box appears.
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Figure 11-11 Graph Properties Dialog Box Axes Tab Lines Settings



E Click the Axes tab. E Select Lines from the Settings for list. E To view or hide a radial axis, select Spoke 1, 2, 3, or 4. E Select or clear the Show/Place Axes boxes to show or hide the axis. E To change line color and thickness, under Line Properties, select a color and thickness



from the Color and Thickness drop-down lists. E Click OK.



Displaying and Changing Radial Axis Ticks and Labels Use the Graph Properties dialog box Axes tab Labels settings to display polar radial axis labels, and modify tick labels. Angular axes labels are analogous to standard Cartesian graph titles and labels. However, radial tick marks and labels have additional positioning options.
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Other than display and position, polar plot tick marks and labels have the same options as Cartesian graph tick marks and labels. Viewing, Hiding, or Moving Titles and Tick Labels on the Radial Axes



To view, hide, or move titles and tick kabels on the radial axes: E Double-click a radial axis. The Graph Properties dialog box appears. Figure 11-12 Graph Properties Dialog Box Axes Tab Labels Settings



E Click the Axes tab. E Select Labels from the Settings for list. E Select either Minor Ticks or Major Ticks from the Apply to drop-down list. E To move or hide the major or minor tick labels on the radial axes, use the Major (or Minor)



Tick Labels options. E Select (none) to hide the labels.
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E Select clockwise or counterclockwise to move the label from one side of the axis to



the other. E Click OK.



Hiding Tick Marks



Hide tick marks by clicking the ticks and pressing the Delete key. You can also rightclick the labels and click Hide. Specifying the Direction for Radial Axis Tick Marks for Each Pair of Radial Axes



To specify the direction for radial axis tick marks for each pair of radial axes: E Double-click any radial axis tick mark. The Graph Properties dialog box appears. Figure 11-13 Graph Properties Dialog Box Axes Tab Ticks Settings



E Click the Axes tab. E Select Ticks from the Settings for list.
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E Select either Minor Ticks or Major Ticks from the Apply to drop-down list. E Use Direction options to change the tick directions on the radial axes. You can only



change the directions for Spokes 1 and 3 together, and for 2 and 4 together. Note: Selecting Inward orients the ticks clockwise, and Outward points the ticks counterclockwise.
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Figure 11-14 Polar Plots with All Ticks Pointing Inward, Spokes 1, 3 Inward and 2,4 Outward, and All Ticks Pointing in Both Directions
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E Selecting Both directions draws ticks both clockwise and counterclockwise, and



selecting (none) hides the tick marks. E Click OK.



Modifying Ternary Axes Ternary axes are drawn to represent increases in data value in a counterclockwise direction by default. Axis direction can be reversed, indicated by a reversal of tick labels, and the tick direction changes accordingly. Because ternary axes are interdependent, any modification in the scale type or range of one of the axes is reflected in the other axes, and may alter the shape and size of the graph. You can modify the color and thickness of axis lines, the appearance of tick marks and tick labels, location and rotation of axis titles, and display of each ternary axis independently. Ternary axes can be modified similarly to other graph axes.
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Note: You cannot create axis breaks for ternary axes.



Modifying Ternary Axis Title Location You can position axis titles of ternary graphs either at the apex or along the length of the axis. You can also rotate them to a position parallel to the axis. To reposition a ternary graph axis title: E Double-click the axis. The Graph Properties dialog box appears. E Click the Axes tab. E Select Labels from the Settings for list.



Tip: To identify which axis is associated with and axis title, keep in mind that the title at the apex is always at the 100% point or maximum for that axis. E Under Show Axis Title, select the desired Axis title location from the At drop-down



list. E Select Axis Title in the Rotate with Axis group box to rotate the axis title parallel to the



axis. E Click Apply. E Continue to modify the titles of the other axes. Specify the axis title you want to change



using the Axis list, then make the desired changes. E When you have finished click OK.
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Figure 11-15 The titles along the axes are also rotated with the axes. Y Data 0 10
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Changing Ternary Axis Range, Scale, and Direction Ternary axis scale type and range settings control the units and increments used to plot the data. Axis scale, range, and direction are modified using the Scaling settings displayed in the Graph Properties dialog box Axes tab. Axis range can also be modified by dragging a selected axis. Modifying a ternary axis range can alter the size and even the shape of the graph.



Modifying Axis Range by Dragging You can modify axis range by dragging a selected axis or apex. Because ternary axes are interdependent, dragging an axis to modify its range can change the ranges of the other axes. Dragging an apex modifies the ranges of the two axes which form the apex; reducing the maximum of an axis range introduces a fourth axis, creating a trapezoid graph. Dragging a selected axis toward or away from the center of the graph modifies all three axis ranges by the same increment, maintaining the original shape of the graph. To modify ternary axis ranges: E View the ternary graph. E Select either an apex or an axis to modify.
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A selected apex displays a black, square selection handle and is surrounded by a dotted line; a selected axis displays a selection handle at the center point of its range and is surrounded by a dotted line. Figure 11-16 Dragging an Axis to Rescale a Ternary Plot Range



E Drag either the apex or the axis toward or away from the center of the graph. The axis



ranges adjust accordingly. Note: Modifying axis ranges of ternary graphs often introduces additional axes. These axes are the second axes of each "pair’ of axis lines. An axis which appears as a result of moving an apex is paired with the axis opposite the apex which moved. Additional axes can be modified and are controlled in the same way as the three original ternary axes using the Axes tab of the Graph Properties dialog box.
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Figure 11-17 The left graph Y axis was dragged to 50%. The right graph Y apex was dragged to 50%. 50
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Modifying Ternary Axis Range Modify ternary graph ranges using the Graph Properties dialog box: E Double-click the axis. The Graph Properties dialog box appears. Figure 11-18 Graph Properties Dialog Box Axes Tab Scaling Settings



E Click the Axes tab. E Select Scaling from the Settings for list.



90



100
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E Use the slider controls for X Range, Y Range, and Z Range to change individual axis



ranges. Note: When you change the Minimum for any axis, the maximums for the other axes adjust automatically. The Maximum value must be greater than the Minimum value. E Click OK.



Note: Increasing an axis range minimum reduces the size of the ternary graph because it is always reduces the other axis range maximums. Reducing the maximum of a ternary axis range changes the graph shape.



Ternary Scale Type All ternary axes on a single graph use either the default Percentage (0-100) scale or the Unitary (0.0-1.0) scale. Data used by each scale should be within the required ranges for each scale. The type of graph you create determines the graph scale. There should be no need to change the scale unless a mistake was made while creating the graph.. Changing the scaling from Percentage to Unitary can also hide out-of-range data. Figure 11-19 The data range used for Percentage is 0-100; the data range for Unitary data is 0-1. 60 70
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To change ternary axis scale type: E Double-click the angular axis. The Graph Properties dialog box appears. Figure 11-20 Graph Properties Dialog Box Axes Tab Scaling Settings



E Click the Axes tab. E Select Scaling from the Settings for list. E Select the new axis scale type from the Scale Type drop-down list. E Click OK.



When you change the axis scale type for one axis, it is changed for all axes.
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Changing Ternary Axis Direction Ternary graph axes show data increasing in either a clockwise or counterclockwise direction. Each axis line can represent either or both of two values in the graph. Changing the direction changes which values are shown on the axis by default. Modifying axis direction changes all three axes; ternary axes are interdependent. Ternary graph axes have interdependent axis ranges from 0 to 100, where 0 to 100 is the default setting or 0-1.0 where 0-1.0 is the default setting. For more information, see “Ternary Scale Type” on page 444. The axis range and scale control the axis units and increments used to plot data. To modify the axis direction: E Double-click the plot. The Graph Properties dialog box appears. Figure 11-21 Graph Properties Dialog Box Axes Tab Scaling Settings



E Click the Axes tab. E Select Scaling from the Settings for list. E Select the axis you wish to modify from the Axis drop-down list.
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E Select the axis direction from the Direction drop-down list. E Click OK.



The tick directions change on all three axes and the axis ranges reverse. Changing the axis directions inverts the 0-100 direction of the labels and changes the direction of the tick marks. However, axis titles only move if they are positioned along an axis, not at an apex. Apex position for each variable remain constant regardless of axis direction. Figure 11-22 Ternary Graphs Displaying Counterclockwise (Left) and Clockwise (Right) Axis Directions 0
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Changing Ternary Axis Tick Marks and Tick Labels Ternary axes tick marks indicate the precise location of each value at specific intervals determined by the axis range. Tick marks and tick labels along ternary axes have both direction and origin. Every tick location can have tick marks and labels pointing in clockwise, counterclockwise, both clockwise and counterclockwise, and perpendicular directions, independent of the actual direction of the data.



Tick and Tick Label Directions and Ownership Tick marks and labels indicate which values correspond to the plotted data points by the direction they lean in. The direction also indicates which axis the tick is actually controlled by. This can be a different axis than the tick mark is actually drawn on. For example, the default ticks for the X axis are drawn leaning in a clockwise direction on the bottom axis. These tick marks also correspond to the counterclockwise
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tick marks on the Y axis. If you change the tick mark attributes for X axis ticks, you can affect tick marks that are actually drawn on a different axis. The following figure best illustrates tick mark and label ownership. Figure 11-23 The X Axis ticks and labels are drawn in light gray, the Y Axis ticks and labels are drawn in black, and the Z Axis ticks and labels are drawn in dark gray. 0 0 100 X Axis Ticks and Labels Z AXis Ticks and Labels Y Axis Ticks and Labels



100



10 90



10 90



20 80



20 80



30 70



Z Data



30 70



40 60



40 60



50 50



50 50



60 40



Y Data



60 40



70 30



70 30



80 20



80 20



90 10



90 10



100 100 0 0 0 100 10 90 20 80 30 70 40 60 50 50 60 40 70 30 80 20 90 10 100 0



X Data



Modifying Ternary Tick Marks Direction and Intervals Use the Graph Properties dialog box to modify tick appearance including tick length and color. You can also specify to view or hide tick marks, which side of the axis they extend from, and the tick interval.
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To modify tick marks: E Double-click the tick marks. The Graph Properties dialog box appears. Figure 11-24 Graph Properties Dialog Box Axes Tab Ticks Settings



E Click the Axes tab. E Select Ticks from the Settings for list. E Select either Major Ticks or Minor Ticks from the Apply to drop-down list. E To turn tick drawing on and off and to select tick directions for both sides of an axis line,



use the Direction lists. The second list is only available if a ternary plot range change has created a secondary axis. E Select Out, In, or In and Out to display tick marks on the selected axis out from the



center of the graph, in toward the center of the graph, or both outward and inward. Select a clockwise, counterclockwise, both, or 90 Degree option to select the tick mark direction along the axis. Select (none) to hide tick marks.
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Figure 11-25 Graph Examples of Tick Marks Pointing, counterclockwise, Clockwise, Both, and 90 Degrees



E To change major tick intervals, move the Major Tick Intervals slider. E To change minor tick intervals, under Tick Intervals, select a new value from the Minor



Tick Intervals drop-down list. Figure 11-26 Ternary Graphs with Tick Intervals of 15 and 30 0 0
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E Click Apply. E Use the Axis drop-down list to modify tick marks on a different axis, or use the Apply



to drop-down list to switch to modifying major or minor tick marks. E Click OK.



Modifying Ternary Tick Mark Line Appearance To change tick mark display, length, color, and interval:
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E Double-click the tick marks you want to change. The Graph Properties dialog box



appears. Figure 11-27 Graph Properties Dialog Box Axes Tab Ticks Settings



E Click the Axes tab. E Select Ticks from the Settings for list. E Select either Major Ticks or Minor Ticks from the Apply to drop-down list. E To change tick length and thickness, under Tick Line, move the Length and Thickness



sliders. Drag the slider control with the mouse or set the tick length and thickness to specific values by typing directly in the Length and Thickness boxes. E To change tick color, under Tick Line, select a color from the Color drop-down list.



Choose from any of the listed colors, or select (Custom) to use a pre-defined custom color or create your own color. Select (none) to create transparent tick marks. E Click Apply.
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E Use the Axis drop-down list to modify tick marks on a different axis, or use the Apply



to drop-down list to switch to modifying major or minor tick marks. E Click OK.



Modifying Tick Label Display Tick labels are drawn using directions clockwise, counterclockwise, and both clockwise and counterclockwise. Tick label direction is controlled independently of the data direction. Tick labels can also be turned off, have a prefix or suffix added, and be rotated along the angle of the axis line. You can also modify the tick label. For more information, see “Formatting Numeric Tick Labels” on page 417. To modify tick label display along an axis: E Double-click the axis you want to change. The Graph Properties dialog box appears. Figure 11-28 Graph Properties Dialog Box Axes Tab Labels Settings



E Click the Axes tab. E Select Labels from the Settings for list.
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E Select the Major (or Minor) Tick Labels check boxes. Depending on the selected axis,



the check boxes are Top, Bottom, Left, or Right. E To change the direction of the axis tick labels, select the Clockwise and



counterclockwise (CCW) check boxes. You can draw in both directions at once. E To draw tick labels at the 90 degrees tick position, clear both direction options. Figure 11-29 Ternary Graph Axes with Tick Labels counterclockwise, Both Clockwise and CounterClockwise, and Neither (90 Degrees) 50 50
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E To add a suffix or prefix to the major or minor tick labels on ternary axes, select either



Major Ticks or Minor Ticks from the Apply to drop-down list, then use the Add To Major (or Minor) Tick Labels options to type a prefix or suffix to the major or minor



tick labels. E To rotate major or minor tick labels parallel to their axis, select either Major Ticks or



Minor Ticks from the Apply to drop-down list, then under Rotate with Axis, select Tick Labels. E Click Apply. E Use the Axis list to modify tick labels on a different axis, or use the Apply To drop-



down list to switch to modifying major or minor tick labels. E Click OK.



Note: Tick labels and tick marks are controlled by their axis of origin, but may be drawn on axes other than their own.
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10 Statistics This chapter covers many of the features available on the Statistics menu, including: „ Running t-tests (see page 455). „ Computing a histogram (see page 458). „ Plotting and modifying linear regression lines (see page 462). „ Adding and modifying reference lines (see page 469).



Running Paired and Independent t-Tests A t-test determines if the mean values of two data columns are significantly different by testing the hypothesis that the means of the two columns are equal. SigmaPlot can perform both paired and unpaired t-tests. A paired t-test requires columns of equal length, since the data is assumed to be before and after data on the same subjects. An independent t-test can be performed on differently sized columns, since no relationship is assumed between the groups. To perform a t-test: E On the Statistics menu, click t-test or Paired t-test. The t-test Column Picker dialog box



appears.
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Figure 10-1 t-test Column Picker Dialog Box



E Select the columns from the Selected Columns list or click the columns in the



worksheet to pick the columns you want to compare. Selected columns are assigned to the highlighted group in the Selected Columns list. E Click Finish. SigmaPlot displays results for the t-test. Figure 10-2 t-test Results Dialog Box



E To save the t-test results, copy and paste the data to the worksheet, page, or another



application. For each test these values are displayed: „ T, the Student’s t statistic „ P, the probability that you are incorrect in stating that the two means are different „ The Degrees of Freedom, a measure of the sample size
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Calculation of t When performing t-tests, t is defined differently for paired t-tests than for unpaired tests. Paired Test:



For a paired t-test on data sets {x1, x2, xn} and {y1, y2, , yn}



D where D = x – y and t = ----SD



2



( Σ Di ) 2 Σ D i – --------------n ---------------------------------- where D i = x i – y i n(n – 1)



SD =



Unpaired Test: n2}



For an independent t-test on data sets {x1, x2, , xn1} and {y1, y2, , yn2}



t =
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Creating Histograms Histograms are step, needle, or bar charts that represent counts of the data points that fall within specified ranges. The Histogram Wizard guides you through the steps in creating a histogram: generating frequency data, specifying the number of buckets or intervals, and selecting a graph style. The Histogram Wizard allows you to specify the number of bins into which to partition the source data. The range of each interval is identical; the total range is the data minimum to the data maximum. The number of bars, steps, or needles displayed is generally equal to the number of bins. You can also create a histogram with an uneven bucket size. For more information, see “The Histogram Transform Function ” on page 461.



Using the Histogram Wizard To use the Histogram Wizard: E Enter the data you want to analyze in an empty column of the active worksheet. E On the Statistics menu, click Histogram. The Histogram Wizard appears. E Select the data for the histogram by choosing the appropriate column from the Source



data for histogram drop-down list. Figure 10-3 Histogram Wizard - Select Data Panel
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E Select the column for the Output for histogram either from the drop-down list, or by



clicking the column. Figure 10-4 Selecting the Output for Bin Centers in the Histogram Wizard



E Select the column for the Output for bin counts either from the drop-down list, or by



clicking the column. Figure 10-5 Selecting the Output for Bin Counts in the Histogram Wizard.



E Click Next.



The Histogram - Bin Options panel appears, with Automatic binning already selected. The algorithm calculates the number of bins for representation, based upon the number of data points. Approximate Bins = 3 + log10(N) * log10(N)/log10(2)
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where N = number of non-missing points. Figure 10-6 The Histogram Wizard ‚Äì Buckets Dialog Box



E To specify a different number of bins, clear Automatic binning and select a number from



the Number of bins list. You can enter values from 1 to 100. E Click Next. E Select a graph style from the Graph Styles list. A preview of the graph appears. Figure 10-7 The Histogram Wizard ‚Äì Graph Style Dialog Box



E Click Finish.



The graph appears on the active graph page, or a new page if the worksheet has no associated graph pages. The X axis representing the buckets is titled Raw Data. The Y
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axis representing the frequency or the number of data points in each bin, is titled Bin Count. Both use a linear scale. Note: If you choose None, SigmaPlot displays the worksheet with the output column containing the histogram frequency data. Figure 10-8 Example of a Histogram Created Using the Histogram Wizard



The Histogram Transform Function If you need to use uneven bucket sizes for a histogram, use SigmaPlot’s built-in histogram transform function. To use the histogram transform function: E Enter the data to analyze in column 1 the bin values in column 2 of the worksheet.



Bin values are used as the upper bounds (inclusive) of the histogram interval ranges. The number of data points that fall within each specified range is counted. The number of histogram bars is equal to the number of interval upper bounds entered. The number of values that fall beyond the largest upper bound is also counted. E On the Transforms menu, click User-Defined. The User-Defined Transform dialog



box appears.
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E Enter the following transform into the Edit Transform box:



col(3)=histogram(col(1),col(2)) Figure 10-9 Graphing the results of the HISTOGRM.XFM transform as a bar chart



E Click Run. The histogram data appears in column 3. E To graph the data, plot column 3 as a bar chart. For more information, see “Creating



2D Plots ” in Chapter 6.



Plotting and Modifying Regression Lines You can automatically compute and draw linear and polynomial regressions with confidence and prediction intervals. The regression equation can be computed using all the data in a plot, or individually for each curve in a multiple-curve plot. Polynomial curves can be fitted up to the 10th order. Regressions for column averaged data are computed using all the data from the columns, not just from the mean value. Regressions are computed and drawn linearly on nonlinear (e.g., log, probability, etc.) axis scales. Regression equation coefficients, R2 values, and predicted values can be viewed and copied to the Clipboard. To perform nonlinear regressions and curve fits, such as sigmoidal, exponential, and peak functions use SigmaPlot’s Regression Wizard. The Regression Wizard provides an extensive set of equations for curve fitting.
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Modifying and Adding Linear Regression Lines Add a first order regression to a graph by selecting one of the graph styles that has a regression. These styles include: „ Simple Regression „ Multiple Regression „ Simple Error Bars and Regression „ Multiple Error Bars and Regression



To modify or add a regression to a plot: E Click the plot to select it. E On the Graph menu, click Linear Regression. The Linear Regression dialog box



appears. Figure 10-10 Regression Line Tab



E Click the Regression Line tab.
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E Under Regressions, select either Each Curve to draw a regression for the data in each



curve of the selected plot, or All data in plot to draw a single regression for all of the data in the selected plot from the Regressions group box. If neither box is selected a regression is not drawn. If both boxes are selected, regressions are drawn for each curve and for all the data in the plot. E Under Line, select the desired regression order from the Order drop-down list. E Select the regression line type from Type drop-down list. E Select line color from the Color drop-down list. E To change line thickness, move the Thickness slider. E To set the extent of regression line(s) all the way across the graph, under Options, select



Extend to Axes. E Click OK.



Viewing and Saving Regression Equation Results If you want to view and save the coefficients of the regression(s), select the Results tab of the Linear Regression dialog box. The Results panel appears displaying regression equation results. The regression equation coefficients, correlation coefficient R2, and function results are displayed for each regression curve computed. If you computed confidence and prediction intervals, these values are also displayed
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Figure 10-11



Click Copy to copy the results and paste them into the worksheet, a report, or any other Windows application. For more information, see “Linear Regression, Confidence, and Prediction Calculation” on page 467.



Adding Confidence and Prediction Intervals SigmaPlot can draw lines which describe either the 95% or 99% confidence and prediction intervals around a regression line. Confidence intervals, also called the confidence interval for a regression, describe the range where the regression line values will fall a percentage of the time for repeated measurements. Prediction intervals, also called the confidence interval for the population, describe the range where the data values will fall a percentage of the time for repeated measurements. Note: You must compute a regression in order to compute confidence and prediction lines.
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To add prediction and confidence lines: E On the Graph menu, click Linear Regression. The Linear Regression dialog box



appears. Figure 10-12 The Confidence Intervals Panel of the Linear Regression Dialog Box



E Click the Confidence Intervals tab. E Choose the method of prediction to use from the Method drop-down list. Select either



95% or 99% for confidence and prediction intervals. E Select the Confidence Interval or Prediction Interval option and select a line type and



color, then move the Thickness slider or enter a value in the Thickness box to set line thickness. Line color, type, and thickness options work identically to the regression line type, color, and thickness options. E Click OK.
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Linear Regression, Confidence, and Prediction Calculation Regression Calculation



SigmaPlot linear regression uses the least squares method to construct a fit a set of data points (xi, yi) i = 1, ..., n by a polynomial of degree p where::



y = β 0 + β 1 x + β 2 x 2 + ... + β p x p In vector-matrix notation this problem is formulated as:



Y = Xβ + ε where the n * 1 vector containing the yn data is:



Y = y1 y2 … yn and the n * (p +1) design matrix is:



1 x 1 x 12 … x 1p X =



1 x 2 x 22 … x 2p



… ……… … 1 x n x n2 … x np



β is a (p + 1) * 1 vector of parameters to be estimated: β = β0 β1 … βp ε is an n x 1 vector of residuals. The solution for the least squares estimates of the parameters β is:



b = ( X ′ X ) –1 X ′ Y
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where X1 denotes the transpose of X. SigmaPlot uses the Cholesky decomposition to invert the X1Ymatrix. (see Dongarra, J.J., Bunch, J.R., Moler, C.B., and Stewart, G.W., Linpack User’s Guide, SIAM, Philadelphia, 1979). This produces the regression curve:



y = b 0 + b 1 x 0 + b 2 x 02 + … + b p x 0p For further details on matrix linear regression, refer to chapter 2 of Draper, Norman, and Smith, Harry, Applied Regression Analysis, Second Edition, John Wiley & Sons, Inc., New York, 1981. Confidence Interval Calculation



Given a set of n data points (xi, yi) from two columns in the worksheet, SigmaPlot computes the pth order polynomial regression:



y 0 = b 0 + b 1 x 0 + b 2 x 02 + … + b p x 0p = where (b0, b1, ..., bp) are the p + 1 estimated parameters and Ý²0 is the Y value predicted for any x0. The confidence interval for this calculated regression is defined by the two confidence limits:



y 0 ± t ( n – p – 1 ) s X ′ 0 ( X ′ X ) –1 X0



where X0 is the (p +1) * 1 vector defined by



X 0 = 1 x 0 x 02 … x 0p
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X is the n * (p +1) design matrix:



1 x 1 x 12 … x 1p X =



1 x 2 x 22 … x 2p



……… …… 1 x n x n2 … x np



s is obtained from the variance about the regression n



s2 =



( yi – yi ) 2 -------------------(n – 2) i=1



∑



and the t value for n ‚- p ‚- 1 degrees of freedom and the standard normal percentile equivalent z (z = 1.96 or 2.576 for 95% and 99% confidence intervals respectively) is computed from a six term rational polynomial approximation taken from Sahai, H. and Thompson, W., "Comparisons of Approximation to the Percentile of t,χ2, and F Distributions," Journal of Statistical Computation and Simulation, 1974, Vol. 3, pp. 81-93. Prediction Interval Calculation



The prediction interval is calculated using the following equation: y 0 ± t ( n – p – 1 )s 1 + X′ 0 ( X′X ) – 1 X 0



Adding Reference Lines



You can add horizontal or vertical lines at specific locations using the Graph Properties Plots tab Reference settings. Reference lines can be used to draw lines at specific values, to set quality control limits, and specify other reference values. Note: Bar and stacked bar charts automatically place a reference line at the zero value. You can add up to five reference lines. All lines can be drawn only horizontally or vertically as a set. The Reference settings display the current calculation, line type, label, and color for each line.
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One set of five reference lines, either horizontal or vertical, can be drawn for each plot. If you need more than five lines or need both horizontal and vertical lines, you must create an additional plot. For more information, see “Adding New Plots” in Chapter 4. Figure 10-13 Graphs Lsing References Lines
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Drawing Reference Lines To draw reference lines: E Double-click the plot to open the Graph Properties dialog box.
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Figure 10-14 Graph Properties Dialog Plots Tab



E Click the Plots tab. E Select Reference from the Settings for list. E Select a reference line to draw by selecting its check box. You can add up to five lines



for each plot. The default names and calculations are the names commonly used when employing reference lines for quality control charts. E To change the reference line name, select the line from the list, then edit the Label box



for that line. E To display the label next to the reference line, select Left or Right for horizontal



reference lines, or Top or Bottom for vertical reference lines. E To change the value or statistic used for the line, select an option from the Calc drop-



down list. If you are not using a mean as the calculation, type a value to multiply the statistic by, or a value to use as a constant, in the box next to the Calc drop-down list. The
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calculation options apply only to the reference line highlighted in the Graph Properties dialog box list of reference lines. To set the reference line value to a specific value, select the Constant Calc option, and



enter the value to the right. Automatically calculated statistics are derived from the plot data. All data points graphed, including multiple columns of data, are used for reference line calculations. E Use the Appearance options to set a line type, thickness, and color for the highlighted



reference line. Each reference line can have separate line attributes. E Use the Direction drop-down list to draw reference lines horizontally or vertically. E Use the Layering drop-down list to draw reference lines either Behind or In Front of



the selected plot. E Click Apply when finished modifying the current reference line, then highlight another



reference line to continue modifying reference lines, or click OK.
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11 Using the Report Editor Use the Report Editor to annotate and document your graphs and data. The Report Editor features a complete text editor and OLE2 insertion and editing. It is also used by the Regression Wizard to report regression results. This chapter covers: „ Creating, exporting, and printing reports (see page 473). „ Setting report options (see page 476). „ Using the Report Editor ruler (see page 477). „ Formatting text and paragraphs (see page 480). „ Inserting the current date and time into a report (see page 481).



Creating Reports Create reports using the New command, or the Regression Wizard. To create a new report: E Right-click the section in the notebook where you want to create the report, and on the



shortcut menu click New, and then click Report. A report window opens and a new report is added to the selected section.



Setting Report Page Size and Margins Use the report Page Setup dialog box to set report margins, paper orientation, paper size, and paper source. Note: These settings apply to the current report, but not to other open reports. To have these settings apply to subsequently opened or created reports, make your changes, then close the page. Newly opened or created reports will use all of these settings.
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To open the Page Setup dialog box: E Select the report window. E On the File menu, click Page Setup. The Page Setup dialog box appears. Figure 11-1 Page Setup Dialog Box



The page sample at the top of the dialog box reflects changes. E Select the paper size and source from the Size and Source drop-down lists. E To select the printer, click Printer. The Page Setup dialog box appears on which you



can select and setup any printer configured for your system. E To change the paper orientation, under Orientation, select either Portrait or Landscape. E To change the margins, under Margins (inches), type the desired values into the four



boxes. The current ruler units appear in the Margins title.
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Exporting Reports You can only export the entire report. If you want to export a portion of the report, delete the portion you don’t want to export, then export the remainder as the file. To export a report: E Select and view the report window you want to export. E On the File menu, click Export. The Export File dialog box appears. E From the Files of type drop-down list, select a file format. E Enter the file name, directory, and drive for the exported file. E Click Export to create the file.



Printing Reports You can print any report in a SigmaPlot notebook. To display a report as it will look when printed: „ On the File menu, click Print Preview. A preview of the report appears.



To print a report: E Select and view the report window. E Click the Print button to print the report using all the default settings.



To set printing options before printing the report: E On the File menu, click Print. The Print dialog box appears. E Click Properties. The printer Properties dialog box appears.
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E Click OK when you are satisfied with the printer properties settings. The Properties



dialog box closes. Note: The Properties dialog box options vary from printer to printer. E Click OK to print the report.



Setting Report Options To set report options: E On the Tools menu, click Options to open the Options dialog box. E Click the Report tab.



Setting Ruler Units To set ruler units: E On the Tools menu, click Options to open the Options dialog box. E Click the Report tab. E Under Measurement units select to set units to Inches or Centimeters.



Ruler Display To view the report ruler: E On the Tools menu, click Options to open the Options dialog box. E Click the Report tab. E Select Show ruler.
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Setting Significant Digits for Regression Reports You can control how many decimal places appear in regression reports. E On the Tools menu, click Options to open the Options dialog box. E Click the Report tab. E Select Significant Digits for Regression Reports.



Using the Report Editor Ruler Use the Report Editor ruler to view margins and to both view and modify report page tabs and paragraph indents. Figure 11-2 The Report Editor Ruler
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The ruler indicates: „ Usable page column width „ Default tabs „ User-defined tabs „ Left and right paragraph indents „ First line indent



Setting Tabs All tab stops appear on the report ruler. The default tab stop is 0.25" regardless of the current units. Tab stops are made for individual and selected paragraphs, and are saved with reports.
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To set a tab: E Select the paragraph(s) to change the tab stops. E Click the ruler where you want to place a tab. A tab marker appears at the clicked



location. E To move a tab, drag the tab marker to another location on the ruler. To delete a tab, drag



the tab marker off the ruler. You can also set tabs from the Tabs dialog box: E On the Format menu, click Tabs.



Note: This command is only available while viewing a report window. The Set Tab dialog box appears. Figure 11-3 Set Tab Dialog Box



E Enter tab stops in the Tab stop position (in) box. Enter Tab locations using the current



ruler units. E Click OK to add the tab setting to the list.
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Setting Paragraph Indents You can set left, right, and first line indents for individual paragraphs. These settings are saved with the report. To set paragraph indents: E Select the paragraph(s) to change the indents. Figure 11-4 Report Editor Ruler



E To change the first line indent, drag the marker at the top left of the ruler. E To change the left indent, drag the marker on the bottom left of the ruler. E To move both the left and first line indents, drag each marker separately. E To change the right indent, drag the marker on the bottom right side of the ruler.



Note: To create an indented line, drag the top left marker to the right of the left indent. To create a hanging indent, drag top left marker to the left of the bottom left indent marker.
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Figure 11-5 Paragraph Indent Formatting



Formatting Text and Paragraphs The Formatting toolbar appears at the top of the Report Editor. Using it, you can change report text attributes such as font, font size, color, and style of selected text. Figure 11-6 Formatting Toolbar



To modify text with the Formatting Toolbar: E Select the text you want to modify. You can select individual characters, words,



paragraphs, or the entire report. E To format character font, size, weight, underlining, or color, use the formatting toolbar



buttons. For more information, see “Formatting Text ” in Chapter 5. E To set paragraph alignment, use the Formatting Toolbar Align Left, Align Center, and



Align Right and Justify.
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E To add bullets or numbers a to selected paragraph, click the Bullet Style or Number



Style button. To remove bullets, click the Bullet Style or Number Style button again. You can also right-click the report page and on the shortcut menu click Bullet or Number.



Bullets are applied to the selected text.



Inserting the Current Date and Time into a Report To insert the current date and time into reports: E Select the report and click where you want to insert the Date or Time. E On the Insert menu, click Date and Time. E Select the date and time format from the Available formats list. E Click OK.



The current date and time appear as text at the specified location. Note: The list of available date and time formats depends on your Regional Settings. You can view or modify the Regional Settings directly from your Windows Control Panel.
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12 Publishing Graphs You can use SigmaPlot to publish graphs on the World Wide Web, and to create publication quality graphs for submission to journals and other printed forms. This chapter covers: „ Publishing graphs on the World Wide Web (see page 483). „ Submitting graphs for publication (see page 487).



Publishing Graphs on the World Wide Web Using SigmaPlot’s latest web publishing technology, you can save your graphs in high resolution, and then later publish them on the Web (Internet or your Intranet). Saving your graphs as a web page creates HTML code that you can later import into any HTML editor. You can then view SigmaPlot graphs on the Web even if SigmaPlot is not installed using the SigmaPlot WebViewer.



About the SigmaPlot WebViewer The SigmaPlot WebViewer is an ActiveX control freely distributed from the Systat Web site. If this control is not installed the first time a SigmaPlot graph is viewed on a web page, the WebViewer is automatically installed. Then you can view the graphs in high resolution on the Intranet or Internet. Using the SigmaPlot WebViewer, you can: „ View the graphs in high resolution. „ Pan, and zoom the graph without losing resolution. „ Print in high resolution (printer resolution) as opposed to typical Web graphics



(GIFs, JPEGs, etc.) that are printed in low resolution. „ View the data used to create the graph.



 484 Chapter 12



Exporting Graphs into HTML Format When you export a graph to the Web, SigmaPlot automatically creates three files: „ A notebook .JNB file which contains the SigmaPlot graph and data worksheet. „ A .JPG of the graph, viewable by those who do not have the SigmaPlot



WebViewer. „ An .HTM file which references a .JPG of the graph and the .JNB file.



You can export an entire graph page or other pasted objects. To export a SigmaPlot graph into HTML format: E Open a graph page. E Select the page objects you want to publish. E On the File menu, click Save As Web Page. The Export File dialog box appears. E Enter a name of the file in the File name box. HTML (SigmaPlot Web Graph) already



appears in the Save as type box. Click Export. The Export Web Graph dialog box appears. Figure 12-1 Export Web Graph Dialog Box



E To set the size of the figure, select desired measurements from the Height and Width



drop-down lists. Note: One inch is 96 pixels, and the Export Web Graph dialog box uses a fixed aspect ratio. E To export the currently selected graph or objects, select Export Selected Only.
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E To export the entire graph page, clear Export Selected Only. E To password protect the file, click Set Password. E Click OK.



Three files are created: an .HTM file which references a saved .JPG file and a .JNB file. You can later insert this .HTM file into any HTML editor.



Password Protecting Data on the Web You can secure your data for a graph you export to an HTML file by setting a password for viewers to enter when viewing this graph on the Internet. Setting a password also prevents the opening and downloading of this file. To set a password: E On the Export Web Graph dialog box, click Set Password. The Set Password dialog



box appears. Figure 12-2 Set Password Dialog Box
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Exporting Data Associated with the Graph When you export a graph to a web page, you not only export the data for the graph but the entire worksheet as well. This can be useful if you want to associate or display additional data for the graph. However, it can also increase the size of the .JNB file, which can slow viewing. To export just the data associated with the graph: E Select the graph on the page, and copy it. E On the Standard toolbar, click the New Page button. The Graph Page dialog box



appears asking if you would like to create a graph. E Click No. E Paste the graph to the new page.



Now when you export this graph, you will also only export the data associated with the graph. Inserting a Graph into FrontPage After you’ve exported a graph into HTML format, you can import the graph into most HTML editors. The following example describes importing a SigmaPlot graph into FrontPage. To insert the graph into FrontPage: E Export a graph into HTML format. E In FrontPage, place the cursor on the page where you want to insert the WebViewer



graph. On the Insert menu, click File. The Select File dialog box appears. E Select the HTML file you created in SigmaPlot to import into your FrontPage project,



and click Open. A Javascript object containing WebViewer graph information appears at the insertion point on the page. The graph is not visible on the page until viewed using Internet Explorer.
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Submitting Graphs for Publication The following are some guidelines for preparing graphs for submission to journals or other printed form. This process is not necessarily simple, and requires understanding both the figure requirements of the publication as well as graphic file formats and terminology.



Figure Submission Requirements The ultimate destination for most SigmaPlot graphs is a publication, and most publishers are now equipped for digital pre-press. This requires graphic files with specific formats and properties. Keep in mind the requirements of the different journals and other publications. These tend to vary, but are usually available at the web site for the journal submission requirements. Some URLs (as of the writing of this document) for requirements for some major publications are: „ Nature: http://www.nature.com/nature/submit/gta/index.html „ Science: http://www.submit2science.org/ws/menu.asp „ The Proceedings of the National Academy of Sciences:



http://www.pnas.org/misc/iforc.shtml#Submitting%20Manuscripts „ Journal of the American Chemical Society: http://pubs.acs.org/instruct/illus.html



and http://pubs.acs.org/cgi-bin/submission_gen/si-filetypes.pl?Journal=jacsat Many journals also use the Cadmus electronic prepress service. Their requirements can be found at: http://cjs.cadmus.com/da/guidelines.asp.



Creating Files for Figure Submission The steps to producing a file for publication can vary from publisher to publisher. For more information, see “Figure Submission Requirements” on page 487. When preparing a figure for file export, first determine: „ The final size of the figure, including the size of text (usually inches or



millimeters). „ The required line weights.
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„ Acceptable typefaces (especially important for EPS - Encapsulated Postscript -



files). „ The desired final dpi (the dots-per-inch resolution), if necessary.



To produce a file for publication: E Determine the final size of the figure, the heights of text and thicknesses of lines and



whether the figure will be color, grayscale, or black and white. E Determine what file formats are acceptable, and choose the best one. The ranking in



which you should choose your format is: „ SigmaPlot „ EPS „ TIFF E Printed hardcopy (not really a file, but some publications actually still prefer this).



These formats are regardless of whether the graph is color or not. Some publishers will directly accept SigmaPlot files. Most others accept EPS, TIFF, or both. E Determine how much the figure is going to be scaled using the size of your current



figure. For example, if your graph is 5 inches wide, but the figures are printed at 3.25 inches wide, then scale your graph by a factor of 3.25/5, or .65. E Increase text labels and line widths accordingly on your SigmaPlot graph.



For example, if you reduce your graph to .65 of the original size, and text must be 10pt in height, increase your labels to at least 15.5pt. Alternately, you can reduce the graph itself to the final publication size. E Make any other changes to your graph to meet the publisher’s requirements, such as



typeface, labeling, and so on. E Once you have your graph formatted, produce the selected file. Make sure that you



select the figure (click it) before choosing export-this will automatically crop your figure for you. If you are producing an EPS file, you don’t need to pay attention to dpi at all.
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If you must use TIFF format, make sure you use the CMYK-compressed TIFF format. Uncompressed TIFF files are too big to easily handle. Also, you will now have to do some dpi calculations. For example, if you are producing a file that requires a final printed dpi of 600, and the graph is being reduced by a .65 ratio, do not set the file dpi to 600. Instead, use a dpi of 390 (600*.65). When this file shrinks to the final printed size, the final dpi will also be 600.



Why Use EPS? Most publishers request either EPS or TIFF formats. When given a choice, choose EPS. Why? Because EPS is known as a vector format. This means that the image is not made up of pixels, but instead graphic descriptions of lines, fills, text, and so on. A vector format has no "size." It is dimensionless. This means you can shrink it as small as you want, or grow it as big as you want, with no change in resolution. dpi has no meaning for a vector file. This format is ideal for a graph figure since there is no degradation of the quality of the figure as it re-scales. It is also means that when you place a vector format file in a document, it often first appears at an arbitrary size, and then you can scale it to the final desired size. This can often startle, annoy or confuse someone not familiar with the behavior of vector files. The other vector format supported by SigmaPlot is the Windows Metafile format.



Post-Processing TIFF Files If you must use TIFF files and you have access to Photoshop, use it to optimize the file. SigmaPlot does not have access to the expensive, proprietary compression formats available in Photoshop. This means that SigmaPlot files will always be much larger than Photoshop files saved with the LZW compression algorithm. Also, SigmaPlot does not support Monochrome or Grayscale TIFF, which are also proprietary export formats. Opening and re-saving a SigmaPlot file using LZW compression and the correct color mode can create dramatic differences in file size. A 100-fold reduction in size is typical. „ For color figures, leave the figure as a CMYK TIFF, but save it using LZW



compression.



 490 Chapter 12



„ For grayscale figures, change the Image Mode to Grayscale. „ For black and white figures, change the Image Mode to Bitmap.



About dpi dpi (dots per inch) is a printer term, and is often misleading. dpi determines how many pixels are used to create the figure. A more accurate term would be resolution. You can increase the final dpi of a raster figure by shrinking it. This creates more pixels within a smaller space, increasing the dpi. Most printed figures do not require a dpi higher than 600 for grayscale figures, and 300 dpi for color figures. The 1200 dpi number is for black and white figures only that have no half toning. If you must produce a 1200 dpi figure, you will have to do some post-processing on your file in order make it palatable to the printer. This can be beneficial if you must use TIFF file and have Photoshop.



Publication Tips and Tricks Making Global Changes



Use the Line and Text Properties dialog boxes to make global changes to your graphs before publishing. To make global changes to text and lines: E Select the graph. E From the Format menu, click Line or Text Properties. The Object or Text Properties



dialog box appears from which you can make graph format changes. Resizing Graphs



If you need to resize you graph for publication, set your fonts and line widths first, then turn the automatic re-scaling of these objects off before resizing your graph.
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To resize your graph for publication: E From the Tools menu, click Options. The Options dialog box appears. E Click the Page tab. E Clear Graph objects resize with graph.



To re-scale the graph precisely: E From the Format menu, click Size and Position.



Before You Export



Select the graph before you export; otherwise, you will export the entire page including unnecessary white space surrounding the graph. Disk Space and Memory



Make sure you have enough disk space and memory before trying to export a large graphic file. For a large file, you need at least 200 megabytes or more free on both your system drive (for swap and temp file space) as well as the same on your destination drive. You can also increase your Virtual Memory to a very large size, but this isn’t necessary if you have sufficient hard drive space available. Note that it can take awhile to generate these files, depending on your system’s speed and available RAM.
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13 Automating Routine Tasks SigmaPlot uses a VBA®-like macro language to access automation internally. However, whether you have never programmed, or are an expert programmer, you can take advantage of this technology by using the Macro Recorder. This chapter describes how to use SigmaPlot’s Macro Recorder and integrated development environment (IDE). It also contains descriptions of related features accessible in the Macro window, including the Sax Basic programming language, debugging tool, dialog box editor, and user-defined functions. Record a macro any time that you find yourself regularly typing the same keystrokes, choosing the same commands, or going through the same sequence of operations.



Before you Record a Macro Before you record the macro: „ Analyze the task you want to automate. If the macro has more than a few steps,



write down an outline of the steps. „ Rehearse the sequence to make sure you have included every single action. „ Decide what to call the macro, where to assign it, and where to save it. For more



information, see “Creating Macros as Menu Commands ” on page 507.



Recording Macros To record a macro: E On the Tools menu, click Macro, and then click Record New Macro.



REC appears in the status area of SigmaPlot’s main window, indicating that the macro



is recording your menu selections and keystrokes. E Complete the activity you want to include in this macro.
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Note: The Macro Recorder does not record cursor movements. E When you are finished recording the macro, on the Tools menu, click Macro, and then



click Stop Recording. The Macro Recorder stops recording and the Macro Options dialog box appears. E Type a name for the macro in the Name text box.



Give the macro a descriptive name. You can use a combination of upper- and lowercase letters, numbers, and underscores. For example a macro that formats all of your graph legends to match a certain report might be called "Report1AddFormatToLegend". E Enter a more detailed description in the Description text box. E Click OK.



After you have finished recording the macro, save it globally (for use in all of SigmaPlot) or locally (for use in a particular notebook file). Your macro appears in the Notebook Manager.



Creating Macros Using the Macro Language You can record a macro using the Macro Recorder, or you can create a macro manually using a VBA®-like macro language in the Macro Window. To create a macro using the Macro Window: E On the File menu, click New.



The New dialog box appears. For more information, see “Creating New Items in the Notebook Manager” in Chapter 2.
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Figure 13-1 Select Macro in the New dialog box to create a new macro from scratch.



E From the New drop-down list, select Macro. E Click OK. The Macro Window appears. Figure 13-2 A new Macro Window. You can create SigmaPlot macros from scratch using SigmaPlot’s VBA-like macro language.



For more information, see “Editing Macros” on page 496.
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Running Macros After you have recorded and saved a macro, it is ready to run. To run a macro using the Macros dialog box: E On the Tools menu, click Macro, and then click Macros. The Macros dialog box



appears with a list of available macros. E Select the macro to run. E Click Run.



To run a macro from the Notebook Manager: E Double-click the macro icon in the Notebook Manager. The Macro dialog box



appears with the corresponding macro selected. E Click Run. If the macro does not have any errors or run into difficulties with your data,



it will run to completion. Note: You can also run a macro from the Macro script window. This is useful for debugging the macro script.



Editing Macros When you record a macro, SigmaPlot generates a series of program statements that are equivalent to the actions that you perform. These statements are in a form of SigmaPlot language that has custom extensions specifically for SigmaPlot automation and appear in the Macro Window. You can edit these statements to modify the actions of the macro. You can also add comments to describe code. To edit a macro: E On the Tools menu, click Macro, and then click Macros. The Macros dialog box



appears.
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E Select a macro from the Macro list. E Click Edit. The Macro Window appears.



For more information, see “Creating Macros Using the Macro Language” on page 494.



Using the Macro Window Toolbar The Macro Window toolbar appears at the top of the Macro Window. It contains buttons grouped by function. The following table describes the functions of the toolbar buttons in the Macro Window. Toolbar button



New Procedure Start Pause/Continue Stop Find Step in Step Over Step Out Step to Toggle Breakpoint Quick View Macros Dialog Box Editor Object Browser Reference



Description



Opens the Add Procedure dialog box that lets you name the procedure and paste procedure code into your macro file. Runs the active macro and opens the Debug Window. Pauses and restarts a running macro. This button also pauses and restarts recording of SigmaPlot commands while using the Macro Recorder. Terminates recording of SigmaPlot commands in the Macro Recorder. Also, stops a running macro. Opens the Find dialog where you can define a search for text strings in the Macro Window. Executes the current line. If the current line is a subroutine or function call, execution will stop on the first line of that subroutine or call. Executes to the next line. If the current line is a subroutine or a function call, execution of that subroutine or function call will complete. Steps execution out of the current line the cursor is on. CursorSteps execution out to the current subroutine or function call. Toggles the breakpoint on the current line. The breakpoint stops program execution. Shows the value of the expression under the cursor in the Immediate Window. Opens the Macros dialog box. Opens the Dialog Box Editor. Object Browser Editing Macros Opens the Reference dialog box which contains a list of all programs that are extensions of the SigmaPlot Basic language.
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Color-Coded Display The color-coding of text in the Macro Window indicates what type of code you are viewing. The following table describes the default text colors used in the script text: Text Color



Blue Magenta Green



Description



Identifies reserved words in Visual Basic (for example, Sub End Sub, and Dim). Identifies SigmaPlot macro commands and functions. Identifies comments in your macro code. Separates program documentation from the code as you read through your macros.



Object and Procedure Lists The Object and Procedure lists show SigmaPlot objects and procedures for the current macro. These lists are useful when your macros become longer and more complex. „ The object identified as (General) groups all of the procedures that are not part of



any specific object. „ The Procedure list shows all of the procedures for the currently selected object.



Setting Macro Window Options You can set appearance options for the Macro window in the Macros tab of the Options dialog box. To set the options of the Macro Window: E With a Macro window open, on the Tools, click Options. The Options dialog box



appears. E Click the Macros tab. E Set text colors for different types of macro code and Debug Window output. E Change font characteristics.
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E Set the location for the macro library.



Parts of the Macro Programming Language The following topics list the parts of the macro programming language: „ Statements are instructions to SigmaPlot to perform an action(s). Statements can



consist of keywords, operators, variables, and procedure calls. „ Keywords are terms that have special meaning in SigmaPlot. For example, the Sub



and End Sub keywords mark the beginning and end of a macro. By default, keywords appears as blue text on color monitors. To find out more about a specific keyword in a macro, select the keyword and press F1. When you do this, a topic in the SigmaPlot on-line reference appears and presents information about the term. „ You can add optional comments to describe a macro command or function, and



how it interacts in the script. When the macro is running, comment lines are ignored. Indicate a comment by beginning a line with an apostrophe. Comments always must end the line they’re on. The next program line must go on a new line. By default, comment lines appear as green text.



Scrolling and Moving the Insertion Point When you use the scroll bars the insertion point does not change. To edit the macro code that you are viewing in the macro window, you must move the insertion point manually. To edit macro code manually: E In the Macro Window, click where you want to edit. E You can also use arrows and key combinations to move the insertion point; when you



do this the window scrolls automatically.



Editing Macro Code You can edit macro code in the same way you edit text in most word-processing and text editing programs. You add select and delete text, type over code, or insert text by
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moving the insertion point and then typing in new text. As with other programming languages, you can also add comments to code. To edit macro code: E Open the macro code window and select the text to edit.



Adding Comments to Code



Add comments to code to identify the purpose of the various parts of a macro and to map locations as you edit a complex macro. Insert comments to fully document how to use and how to understand the macro code. Deleting Unnecessary Code



The Macro Recorder creates code corresponding exactly to the actions that you make in SigmaPlot while the recorder was turned on. You may need to edit out unwanted steps. Moving and Copying Code



You can cut, copy, and paste selected text. Finding and Replacing Code



When you need to find and change text in a macro that you have written, use the Find commands. For example, if you change the name of a file that is referenced in your macro, you need to change every instance of the file name in your macro. Use Find to locate the instances of the filename in the macro and replace using cut and paste edit commands.



Adding Existing Macros to a Macro If you have another macro that already does what you want, you can just paste it into your new macro. Copy and paste the macro into your new macro, test it in the new code and run it.
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Creating Custom Dialog Boxes Design and customize your own dialog boxes using the UserDialog Editor. When you are designing and creating SigmaPlot macros, you can automatically create the necessary dialog box code and dialog monitor function code. Like the other automated coding features in SigmaPlot, the code may require further customizing. To create a custom dialog box: E In the Macro Window, place the insertion point where you want to put the code for the



dialog box. For more information, see “Editing Macros” on page 496. E On the Macro Window toolbar click the User Dialog button. The blank grid in the



UserDialog Editor appears. E On the left hand side of the UserDialog Editor there is a Toolbox. You can select a tool,



such as a button or check boxes, from the Toolbox. The cursor changes to a cross when you move it over the grid. E To place a tool on the dialog box, click a position on the grid. A default tool will be



added to the dialog grid. E Resize the dialog box by dragging the handles on the sides and the corners. E Right-click any of the controls that you have placed on the dialog surface (after



selecting the control) and enter a name for the control. E Right-click the dialog form (with no control selected) and enter a name for the dialog



monitor function in the DialogFunc field. E To finish, click OK. The code for the dialog box with controls will be written to the



Macro Window. Finally, and in most cases, you must edit the code for dialog box monitor function to define the specific behavior of the elements in your dialog box. For more information, see “SigmaPlot Automation Reference” in Chapter 14.
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Using the Object Browser The Object Browser displays all SigmaPlot object classes. The methods and properties associated with each SigmaPlot macro object class are listed. A short description of each object appears in the dialog box as you select them from the list. To view the Object Browser, the Macro Window must first be in view. For more information, see “Creating Macros Using the Macro Language” on page 494. To open the Object Browser: E On the Macro Window toolbar, click the Object Browser button. E Use Paste to insert generic code based on your selection into a macro.



Tip: Press F1 at any time for full details on using the Object Browser.



Using the Add Procedure Dialog Box Organizing your code in procedures makes it easier to manage and reuse. SigmaPlot macros, like Visual Basic programs, must have at least one procedure (the main subroutine) and often they have several. The main procedure may contain only a few statements, aside from calling subroutines that do the work. You add procedures using the Add Procedure dialog box. To add a procedure: E On the Macro Window toolbar, click the New Procedure button.



The Add Procedure dialog box appears. E Define a sub, function, or property using the Name, Type, and Scope boxes. E Click OK to paste the code for a new procedure. The new procedure appears at the



bottom of the macro. Tip: For full details on using the Add Procedure dialog box, press F1 from anywhere in the Macro Window.
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About User-Defined Functions A user-defined function is a combination of math expressions and Basic code. The function always requires input data values and always returns a value. You supply the function with a value; it performs calculations on the values and returns a new value as the answer. Functions can work with text, dates, and codes, not just numbers. A userdefined function is similar to a macro but there are differences. Some of the differences are listed in the following table. Recorded Macro



User-Defined Functions a value; cannot perform actions. Performs a SigmaPlot action, such as creating a new Returns Functions return answers based on input chart. Macros change the state of the program. values. Can be recorded. Must be created in Macro code. Are enclosed in the keywords Function Are enclosed in the Sub and End Sub keywords. and End Function. For More Information



Press F1 from anywhere in the Macro window to view user-defined function on-line Help.



Creating User-Defined Functions A user-defined function is like any of the built-in SigmaPlot function. Because you create the user-defined function, however, you have control over exactly what it does. A single user-defined function can replace database and spreadsheet data manipulation with a single program that you call from inside SigmaPlot. It is a lot easier to remember a single program than it is to remember several spreadsheet macros. For more information, see “SigmaPlot Automation Reference” in Chapter 14.



Using the Debug Window The Debug Window contains a group of features that are helpful when you are trying to locate and resolve errors in your macro code. The debugging tools in SigmaPlot will be familiar if you have used one of the modern visual programming languages or Microsoft Visual Basic for Applications. Essentially, the Debug Window gives you incremental control over the execution of your program so that you can sleuth errors in your programs. The Debug Window also gives you a precise way to determine the
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contents of your variables. Again, a series of buttons is used to select the operation mode of the Debug Window.



Debug Toolbar Buttons The debugging features of the Debug Window are controlled by buttons on the Macro Window toolbar. To review: „ The four Step buttons provide methods for controlling the execution of commands.



They offer various ways of responding to subroutines and functions. „ The Breakpoint button lets you set a point and execute the program until it reaches



that point. „ The Quick View button displays the value of the expression in the immediate



window. The inclusion of these features for controlling program execution are a standard but powerful combination of tools for writing and editing macros.



Debug Window Tabs The output from the Debug Window is organized in four tabs that allow you to type in statements, observe program execution responses, and iteratively modify your code using this feedback. If you have never used a debugging tool and are new to programming, it would be a good idea to supplement the following description with further study.



Immediate Tab The Immediate Tab lets you evaluate an expression, assign a specific value to a variable or call a subroutine and evaluate the results. Trace mode prints the code in the tab when the macro is running. „ Type "?expr" and press Enter to show the value of "expr". „ Type "var = expr" and press Enter to change the value of "var". „ Type "set var = expr" and press Enter to change the reference of "var" for object



vars. „ Type "subname args" and press Enter to call a subroutine or built-in expression



"subname" with arguments "args".
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„ Type "trace" and press Enter to toggle trace mode. Trace mode prints each



statement in the Immediate Tab when a macro is running.



Watch Tab The Watch Tab lists variables, functions, and expressions that are calculated during execution of the program. „ Each time program execution pauses, the value of each line in the window is



updated. „ The expression to the left of the "->" may be edited. „ Pressing Enter updates all the values immediately. „ Pressing Ctrl+Y deletes the line.



Stack Tab The output from the Stack Tab lists the program lines that called the current statement. This is a macro command audit and is helpful to determine the order of statements in you program. „ The first line is the current statement. The second line is the one that called the first,



and so on. „ Clicking a line brings that macro into a sheet and highlights the line in the edit



window.



SigmaPlot Macro Examples You can use macros to use SigmaPlot in ways that are not immediately visible to the naked eye. For example, you can create macros in Microsoft Word or Excel that allow you to open SigmaPlot from within either application. You can place macros that you create yourself on the main menu. You can even run a SigmaPlot macro by specifying its path in your command prompt without ever having to open SigmaPlot.
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Opening SigmaPlot from Microsoft Word or Excel You can create a macro in either Microsoft Word or Microsoft Excel that can open SigmaPlot directly from either application. To create this macro: E On the Tools menu in either Microsoft Word or Excel, click Macro, and then click



Visual Basic Editor. Microsoft Visual Basic appears. E On the Insert menu, click Module. E Type:



Sub SigmaPlot() ’ SigmaPlot Objects and Collections ’ SigmaPlot Macro ’ ’ Dim SPApp as Object Set SPApp = CreateObject("SigmaPlot.Application.1") SPApp.Visible = True SPApp.Application.Notebooks.Add End Sub 4. E On the Run menu click Run Sub/User Form to run the macro. SigmaPlot appears with



an empty worksheet and notebook window.
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In the future: E On the Tools menu, click Macro and then click Macros to open the Macros dialog box. E Select SigmaPlot. E Click Run.



Running SigmaPlot Macros from the Command Prompt You can run SigmaPlot macros directly from your command prompt, saving you valuable time. Suppose you need to produce the same graph report of a data set week after week. Rather than going through the trouble of starting up SigmaPlot, opening a file, and then running a macro, you can run the entire macro from a run command on the Start menu instead. E In your command prompt type: c:\spw "filename" /runmacro:"macroname".



For example, if you want to run a macro you created called "ErrorBars", and it is stored in a notebook file called "MyNotebook.jnb", you would type c:\spw MyNotebook.jnb\runmacro:ErrorBar. Tip: You can also create a batch file or script that runs SigmaPlot from the DOS command prompt as part of the batch file’s set of operations.



Creating Macros as Menu Commands You can place your macro as a menu command on the main menu that you specify. For example, your new macro could appear on the main menu under the macro command "My Macros". To create a new menu command: E On the Tools menu, click Macro, and then click Macros. The Macros dialog box



appears. E Select a macro from the Macro Name scroll-down list.
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E Click Options. The Macro Options dialog box appears. E Select Command Name. E Enter the name of the macro in the Command Name field. If the Command Name is



cleared, the macro doesn’t appear on a menu. E Enter the name of the menu under which you want the macro to appear in the Menu



Name field. E Click OK.



Your new macro appears under the menu command you have just created. E Enter the same menu command name in the Menu Name field of future macros if you



want them to appear on your new macro command menu. By default, if the Menu Name field is left empty, the macro name appears on the Tools menu. You can also create your own menu by entering the menu name in the Menu Name field.
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14 SigmaPlot Automation Reference OLE Automation is a technology that lets other applications, development tools, and macro languages use a program. SigmaPlot Automation allows you to integrate SigmaPlot with the applications you have developed. It also provides an effective tool to customize or automate frequent tasks you want to perform. Automation uses objects to manipulate a program. Objects are the fundamental building block of macros; nearly all macro programs involve modifying objects. Every item in SigmaPlot-graphs, worksheets, axes, tick marks, reports, notebooks, etc.-can be represented by an object. SigmaPlot uses a VBA®-like macro language to access automation internally. For more information, see “Recording Macros” in Chapter 13.



Objects and Collections An object represents any type of identifiable item in SigmaPlot. Graphs, axes, notebooks, worksheets, and worksheet columns are all objects. A collection is an object that contains several other objects, usually of the same type; for example, all the items in a notebook are contained in a single collection object. Collections can have methods and properties that affect the all objects in the collection. Properties and methods are used to modify objects and collections of objects. To specify the properties and methods for an object that is part of a collection, you need to return that individual object from the collection first. For more information, refer to SigmaPlot Automation Help from the SigmaPlot Help menu.



Application Object An Application object represents the SigmaPlot application, within which all other objects are found. (Most other objects must exist inside higher-level objects. You access objects by applying properties and methods on these higher-level objects.) It is



 510 Chapter 14



a "user-creatable" object, that is, outside programs can run SigmaPlot and access its properties directly, and will be registered in registry as SPW32.Application. The Application object properties and methods return or manipulate attributes of the SigmaPlot application and main window, and access the list of notebooks and from there all other objects. To use the Application Object:



Use Application properties to return attributes of the SigmaPlot application. Note that when using the SigmaPlot macro window, all Application methods and properties are global, that is, you do not need to specify the Application object. Conversely, when using an external programming language (such as VBA) in Microsoft Excel or Word, you usually need to create the SigmaPlot Application object as the first step in using SigmaPlot automation objects.



Notebooks Collection Object The Notebooks collection represents the list of open notebooks in SigmaPlot. Use this collection to create new documents and open existing documents, as well as to specify and return individual notebooks as objects. To use the NotebooksCollection:



A Notebooks collection is returned using the Application object Notebooks property. Use the Add method to add a new notebook to the collection. You can return a specific Notebook object using either the Item property or the collection index.



Notebook Object Represents a SigmaPlot notebook file (including template and equation library files). Notebook properties and methods are used to set individual notebook file attributes and specify individual notebook items, i.e., worksheets, graph pages, reports, and so on. Also used to return a collection of notebook items as objects.
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To use the Notebook Object: Notebook objects are returned using the Notebooks or ActiveDocument Application object properties. Access individual notebook items using the NotebookItems property, which returns the NotebookItems collection.



NotebookItems Collection Object This collection represents all the items in a notebook, and is used to create new items and open existing items. Also used to specify and return the different notebook items as objects. Worksheets, pages, equations, reports, macros, and section and notebook folders are all notebook items and can be returned as objects. To use the NotebookItems Collection:



The NotebookItems collection is returned using the NotebookItems property of a Notebook object. You can return individual notebook item objects using either the Item method or collection index, and add new notebook item objects, such as worksheets and graph pages, using the Add method.



NativeWorksheetItem Object This object represents the SigmaPlot data worksheet. Use this object to perform worksheet edit operations, and to access the data using the DataTable property. To use the NativeWorksheetItem Object:



The NativeWorksheetItem object has the standard notebook item properties and methods. A NativeWorksheetItem is returned from the NotebookItems collection using the Item property or collection index, and created using the NotebookItemsAdd method. The NativeWorksheetItem object has an ItemType property and NotebookItems.Add method value of 1.
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ExcelItem Object Use this object to manipulate in-place activated Excel worksheets. In general, most NativeWorksheetItem properties and methods also apply to Excel worksheets. To use the ExcelItem Object:



The ExcelItem object also has the standard notebook item properties and methods. An ExcelItem is returned from the NotebookItems collection using the Item property or collection index, and created using the NotebookItems Add method. The ExcelItem object has an ItemType property and NotebookItems.Add method value of 8.



DataTable Object Represents a table of data as used by a worksheet or graph page. This object’s properties and methods can be used to access the data in a worksheet or page, and also return the NamedRanges (row and column titles) collection object. To use the DataTable Object:



The DataTable objects is returned from NativeWorksheetItem, ExcelItem, and GraphItem objects using the DataTable method, and in turn accesses data using the GetData and PutData methods and the Cell property.



NamedDataRanges Collection Object The NamedDataRanges collection contains all ranges in the DataTable object that have been assigned a name. Column and row titles are named ranges. To use the NamedDataRanges Collection:



The NamedDataRanges collection is mainly used to retrieve existing ranges and add new ranges to DataTable objects within NativeWorksheetItem and GraphItem objects.
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NamedDataRange Object Represents named data range objects (i.e.. column and row titles) in the worksheet and page data tables. To use the NamedDataRange Object:



The NamedDataRange object is returned from the NamedRanges collection using an index or the Item property. The NamedRange object properties are mainly the range name, dimensions and other similar attributes.



GraphItem Object The GraphItem object represents a SigmaPlot graph page. GraphItem properties can be used to return a collection of the graphs on the page using the GraphObjects property. It can also be used to create graphs using the CreateWizardGraph method. To use the GraphItem Object:



The GraphItem object has the standard notebook item properties and methods. A GraphItem is returned from the NotebookItems collection using the Item property or collection index, and created using the NotebookItems Add method. The GraphItem object has an ItemType property and NotebookItems Add method value of 2.



Pages Collection/Page Object The Page object represents a SigmaPlot graph page. Graph pages can be different sizes and colors, and a page object can be used to return the collections of objects on that page. Pages have an ObjectType value of 1 or GPT_PAGE. To use the Page Object:



A graph page is returned from a GraphItem object using the GraphPages property. Note that since there is currently only one page per graph item, you can always use .GraphPages(0) to return a page. Use the ChildObjects property to return the GraphObjects collection, or the Graphs property.
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Note that if a graph is part of a Group object, it can only be returned easily using the Graph property. Many Page attributes and attribute values can only be returned or set using the GetAttribute and SetAttribute methods. Use the Page Attribute constants to specify these attributes.



Page GraphObjects Collection The Page GraphObjects Collection represents a collection of the child objects returned from a Page object. To use the Page GraphObjects Collection:



A Page GraphObjects collection is returned from a Page object using the ChildObjects property. You can also return Page GraphObjects collections composed only of Graph objects using the Graphs property.



Graph Object The Graph object represents a SigmaPlot graph. A graph is used to access the parts of a graph, e.g., plots, axes, etc., as well as to change graph attributes such as title, size, and position. Graph objects have an ObjectType value of 2 or GPT_GRAPH. To use the Graph Object:



A Graph object is returned from a Page GraphObjects collection. Note that you can create a GraphObjects collection composed only of the graphs using the Page object Graphs property. The ChildObjects or Plots properties are used to return the graph object’s Plots collection. Other properties, such as Axes and AutoLegend, are used to return other graph objects. Many Graph attributes and attribute values can only be returned or set using the GetAttribute and SetAttribute methods. Use the Graph Attribute constants to specify these attributes.
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Plot GraphObjects Collection Represents a collection of the child objects returned from a Graph object. To use the Plot GraphObjects Collection:



A Plot GraphObjects collection is returned from a Graph object using either the ChildObjects orPlots property. Use the Plots collection to return specific Plot objects.



Plot Object The Plot object represents a data plot and all its attributes and child objects. Plots have an ObjectType value of 3 or GPT_PLOT. To use the Plot Object:



Plot properties and methods are mainly used to return the Plot child objects. Return specific Plot child objects using different Plot properties: „ Line returns the Line plot object „ Symbols returns the Symbol plot object „ Fill returns the Solid plot object (i.e. bars) „ DropLines returns a collection of the drop line Line objects „ Functions returns collection of the Function objects (i.e.. regression and reference



lines)
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Use .ChildObjects(0) to return the Tuple GraphObjects collection. Tuples represent the individual plot curves. Many Plot attributes and attribute values can only be returned or set using the GetAttribute and SetAttribute methods. Use the Plot Attribute constants to specify these attributes.



Axes GraphObjects Collection The Axes collection corresponds to all the sets of axes available for a graph. To use the Axes Collection:



Use the index to return specific x, y or ζ axes from an Axes collection.



Axis Object The Axis objects represents a SigmaPlot axis. Axes have an ObjectType value of 4 or GPT_AXIS. To use the Axis Object:



An axis has several Line and Text objects associated with it, including the axis line itself, grid lines, tick marks and labels, and the axis title. Use the LineAttributes property to return the collection of axis lines, and the AxisTitles and TickLabelAttributes property to return collection of axis text objects. Most other Axis attributes, such as range, scale, breaks, etc., can only be returned or set using the GetAttribute and SetAttribute methods. Use the Axis Attribute constants to specify these attributes.



Text Object All characters and labels found on a SigmaPlot change correspond to a text object and can be modified using text object properties and methods. Axes have an ObjectType value of 5 or GPT_TEXT.
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To use the Text Object:



The Text object for most graph objects can be returned using the NameObject property. Text objects are also found below both AutoLegend and Axis objects. Use the TickLabelAttributes property to access the tick label Text object. Use the AxisTitles property to access the axis titles. To access the text objects within a Page or an AutoLegend, use the ChildObjects property. Use the Name property to change the string used for the text. Most other Text attributes and attribute values can only be returned or set using the GetAttribute and SetAttribute methods. Use the Text Attribute constants to specify these attributes.



Line Object Objects that correspond to drawn lines. These lines include all lines used for axes and plots, regression and reference lines, drop lines, and manually drawn lines. Lines have an ObjectType value of 6 or GPT_LINE. To use the Lines Object:



Lines are returned from a number of different objects: „ Drawn lines on a page are returned using the ChildObjects property. Lines are



creating using the Page object Add method with an object value of 6 or GPT_LINE. „ Plot lines are returned using the Line property. Collections of Lines can also be



returned using the DropLines property. To return the collection of axis lines, use the Axis object LineAttributes property. These include the axis lines, tick marks, grid lines, and axis break lines. The collection of function lines is returned using the Plot object Functions property. Functions include linear regression and reference lines. Many Line attributes and attribute values can only be returned or set using the GetAttribute and SetAttribute methods. Use the Line Attribute constants to specify these attributes.
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Symbol Object The symbol object controls the symbols used in a plot. Symbols have an ObjectType value of & or GPT_SYMBOL. To use the Symbols Object:



The Symbols object is returned from a Plot object using the Symbols property. The Symbols properties and methods are used to return or modify the individual symbols within the parent plot. Many Symbol attributes and attribute values can only be returned or set using the GetAttribute and SetAttribute methods. Use the Symbol Attribute constants to specify these attributes.



Solid Object A solid object can represent many different graph and page objects, including all drawn shapes, ellipses and rectangles, as well as graph bars and boxes, pie slices, meshes, and any other "filled" object. Solids have an ObjectType value of 8 or GPT_SOLID. To use the Solid Object



Solid objects can be returned from a number of other groups or collections using different properties: „ To access the solid object(s) for a Plot, use the Fill property. „ To access the solid object(s) within a Page or an AutoLegend, use the



ChildObjects property.



Many Solid attributes and attribute values can only be returned or set using the GetAttribute and SetAttribute methods. Use the Solid Attribute constants to specify these attributes.
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Tuple GraphObjects Collection Represents the collection of tuples for a Plot object. A tuple is an individual curve or series representing a plotted column or column set. For example, an XY pair plotted as a scatter plot, a single column plotted as a bar series, or a column plotted as a mean are all tuples. To use the Tuples GraphObjects Collection:



The Tuples collection is returned from a Plot using the ChildObjects property. Use the Tuple collection return specific tuples or add new tuples.



Tuple Object A tuple is an object that represents a plotted column or column pair, displayed as a curve, datapoint, or bar series. A plot always consists of a collection of one or more tuples. Tuples have an ObjectType value of 9 or GPT_TUPLE. To use the Tuple Object:



Tuples are returned from the Tuples GraphObjects collection. Most generic GraphObject properties are not retained by tuples; instead, use the SetAttribute and GetAttribute methods to return or change the tuple properties. Use the Tuple Attribute constants to specify these attributes.



Function GraphObjects Collection The Functions collection consists of all regression, confidence, prediction, and reference lines for a plot. To use the Functions Collection:



The functions collection is basically used to return individual function objects. Return the Functions Collection from a Plot object using the Functions property.
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Function Object A Function object represents one of the various function lines of a Plot object. In addition to Line object properties, functions also have properties and attributes specific to regression and reference lines. Functions have an ObjectType value of 10 or GPT_FUNCTION. To use the Function Object:



The Function object is returned from the Functions collection as follows: Index



1 2 3 4 5 6 7 8 9 10



Constant



SLA_FUNC_REG R SLA_FUNC_CON F1 SLA_FUNC_CON F2 SLA_FUNC_PRE D1 SLA_FUNC_PRE D2 SLA_FUNC_QC1 SLA_FUNC_QC2 SLA_FUNC_QC3 SLA_FUNC_QC4 SLA_FUNC_QC5



Function



Regression Line Upper Confidence Intervals Lower Confidence Interval Upper Prediction Interval Lower Prediction Interval 1st Reference Line (Upper Specification) 2nd Reference Line (Upper Control Line) 3rd Reference Line (Mean) 4th Reference Line (Lower Control Line) 5th Reference Line (Lower Specification)



Most Function attributes and attribute values can only be returned or set using the GetAttribute and SetAttribute methods. Use the Function Attribute constants to specify these attributes. You can return the label for reference lines using the NameObject property, but only if the label is turned on first. Note: Function lines are turned on or off with Plot object attributes.
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DropLines Collection The DropLines object is a special collection of lines that represent the drop lines for a plot. The DropLines object is returned using the Plot object DropLines property. There are three different sets of drop lines that can be retrieved from the DropLines collection: „ XY plane (SLA_FLAG_DROPZ , 3D graphs only) „ Y axis/X direction or yz plane (SLA_FLAG_DROPX) „ X axis/Y direction or zx plane (SLA_FLAG_DROPY)



Note: Drop lines are turned on and off using the Plot object SetAttribute method, using the SLA_PLOTOPTIONS property coupled with the SLA_FLAG_DROPX, SLA_FLAG_DROPY, or SLA_FLAG_DROPZ value, and using the FLAG_SET_BIT to turn on drop lines, or the FLAG_CLEAR_BIT to turn off drop lines. Other drop line properties are set using Line object attributes.



Group Object A group is any grouped collection of objects, generally created with the Format menu Group command. Grouped objects can be treated as a single object. AutoLegends are a special class of Group object. Groups have an ObjectType value of 12 or GPT_BAG. Many Group attributes and attribute values can only be returned or set using the GetAttribute and SetAttribute methods. Use the Group (Bag) Attribute constants to specify these attributes.



AutoLegend Object The AutoLegend object is really a specific Group object consisting of a solid object and text objects. The AutoLegend object is returned from a graph using the AutoLegend property. To use the AutoLegend Object:



Manipulate the AutoLegend object as you would a Group object. Use the ChildObjects property to return the members of the AutoLegend. .ChildObjects(0) always returns the
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Solid rectangle object used as the AutoLegend border/background, and indexes >0 to return the individual Text objects used for the legend keys. Legends can also be manipulated with many Text attributes using the GetAttribute and SetAttribute methods.



GraphObject Object The GraphObject object corresponds to non-SigmaPlot objects residing on a graph page, such as pasted bitmaps or metafiles, or embedded or linked OLE objects.



FitItem Object The FitIItem object corresponds to the a SigmaPlot equation and all the equation code parameters and settings. FitItems are used not only for regressions, but for other nonlinear curve fitting applications, and function plotting and solving. The results of a FitItem are accessed from a FitResults object. To use the FitItem Object:



The FitItem object has the standard notebook item properties and methods. A FitItem is returned from the NotebookItems collection using the Item property or collection index, and created using the NotebookItemsAdd method. The FittItem object has an ItemType property and NotebookItems.Add method value of 6 or LT_FIT. The complete list of FitItem properties and methods also can be found in FitItem and FitResults Properties and Methods.



FitResults Object The FitResults object is used to return the different values computed by the nonlinear regression. These statistics and other results are specifically useful for computing additional statistics that can be derived from these results. The complete list of FitResult properties can also be found in FitItem and FitResults Properties and Methods.
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TransformItem Object Represents either an open transform or opened transform file as an object. You can load transforms, specify the transform code, and replace variables before executing a transform. To use the TransformItem Object:



The TransformItem object has the standard notebook item properties and methods; however transforms cannot be currently saved as notebook objects, only created and opened. If you want to save a transform to a .xfm file, use the Name property to specify a file name and path before using the Save method. When using a TransformItem object, you must first declare a variable as an object and then define it as a newly added transform item. Create a new TransformItem collection using the NotebookItems Add method, using a value of 9. After defining the transform object, open it using the Open method. Specify the transform code using the Text property. To change the value of a transform variable, use the AddVariableExpression method. Run transforms using the Execute method. Note: After executing a transform, it is a good idea to close it, as you are limited to four concurrent transforms that can be open simultaneously.



ReportItem Object A ReportItem represents the RTF (Rich Text Format) documents used for text and regression reports in SigmaPlot. You can use the ReportItem properties to add and remove block of text from a report. To use the ReportItem Object:



The ReportItem object has the standard notebook item properties and methods. A ReportItem is returned from the NotebookItems collection using the Item property or collection index and created using the NotebookItems Add method. SigmaPlot reports have an ItemType property and NotebookItems.Add method value of value of 5, and SigmaStat reports have a value of 4.
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MacroItem Object Represents a SigmaPlot macro. You can use this command to edit and run macros from within macros, or to run macros from outside applications. To use the MacroItem Object:



The MacroItem object has the standard notebook item properties and methods. A MacroItem is returned from the NotebookItems collection using the Item property SigmaPlot Automation Reference or collection index, and created using the NotebookItems Add method. The MacroItem object has an ItemType property and NotebookItems.Add method value of 0.



NotebookItem Object Represents the notebook item in the notebook window. You can use this object to rename the notebook item. The notebook item can always be reference with NotebookItems(0). To use the NotebookItem Object:



The NotebookItem object has most of the standard notebook item properties and methods, and created using the NotebookItems Add method. The NotebookItem object has an ItemType property and NotebookItems.Add method value of 7.



SectionItem Object Represents the section folders within a SigmaPlot notebook. To use the SectionItem Object:



The SectionItem object most of the standard notebook item properties and methods. A SectionItem is returned from the NotebookItems collection using the Item property or collection index, and created using the NotebookItems Add method. The SectionItem object has an ItemType property and NotebookItems.Add method value of 3.
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SigmaPlot Properties A property is a setting or other attribute of an objec. Think of a property as an "adjective." For example, properties of a graph include the size, location, type and style of plot, and the data that is plotted. To change the settings of an object, you change the properties settings. Properties are also used to access the objects that are below the current object in the hierarchy. To change a property setting, type the object reference followed with a period, then type the property name, an equal sign (=), and the property value. For more information, refer to SigmaPlot Automation Help from the SigmaPlot Help menu.



Application Property Used without an object qualifier, this property returns an Application object that represents the SigmaPlot application. Used with an object qualifier, this property returns an Application object that represents the creator of the specified object (you can use this property with an Automation object to return that object’s application). Note: Use the CreateObject and GetObject functions give you access to an Automation object.



Author Property A standard property of notebook files and all NotebookItems objects. Returns or sets the Author field in the Summary Information for all notebook items, or the Author field under the Summary tab of the Windows 98/2000 file Properties dialog box.



Autolegend Property Returns the Autolegend Group object for the specified Graph object. Autolegends have all standard group properties. The first ChildObject of a legends is always a solid; the successive objects are text objects with legend symbols.
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Axes Property The Axes property is used to return the collection of Axis objects for the specified graph object. Individual axis objects have a number of line and text objects that are returned with Axis object properties.



AxisTitles Property The AxisTitle property is used to return the collection of axis title Text objects for the specified Axis. Use the following index values to return the different titles. Note the specific title returned depends on the current axis dimension/direction selected. 0



Bottom/Left axis title



1



Right/Top axis title



2



Sub axis title (shown for radial and ternary axes)



3



Sub axis title (shown for radial and ternary axes)



Cell Property Returns or sets the value of a cell with the specified column and row coordinates for the current DataTable object.



ChildObjects Property Used by all page objects that contain different sub-objects to return the collection of those objects. The ChildObjects property returns different type of objects depending on the object type: Object Returns Page Graph Plot Tuples Group (including Autolegends)



ChildObjects GraphObjects Page Plots All group objects
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Color Property SigmaPlot Properties Gets or sets the color for all drawn page objects. Use the different color constants for the standard RGB color set. For more information, refer to SigmaPlot Automation from the SigmaPlot Help menu. Note: Some objects have more than one color property. The Color property will change to the "main" color.



Comments Property Syntax: Notebook/NotebookItems object.Comments A standard property of notebook files and all NotebookItems objects. Returns or sets the Description field in the Summary Information for all notebook items, or the Comments section under the Summary tab of the Windows 98/2000 file Properties dialog box for notebook files.



Count Property A property available to all collection objects that returns the number of objects within that collection.



CurrentDataItem Property The CurrentDataItem property returns the current worksheet window in focus as an object. The "current" worksheet either the worksheet in focus or the worksheet associated with the window in focus. You must still use the ActiveDocument property to specify the currently active notebook. Note: If a worksheet is not in focus an error is returned.



CurrentItem Property This property returns whatever notebook item currently has focus as an object. You must still use the ActiveDocument property to specify the currently active notebook.
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CurrentPageItem Property Returns the current graph page window as a GraphItem object. You must still use the ActiveDocument property to specify the currently active notebook. If there is no current Pate item, an error is returned.



DataTable Property Returns the DataTable object for the specified worksheet object title. DefaultPath Property Sets or returns the default path used by the Application object to save and retrieve files. Files are opened using the Notebooks collection Open method and saved using the Notebook object Save or SaveAs methods.



DropLines Property Returns the DropLines line collection for a Plot object. Line objects within the DropLines collection have standard line properties. Use an index to return a specific set of drop lines from the DropLines collection: 1. XYplane (SLA_FLAG_DROPZ , 3D graphs only) 2. Y axis/X direction or YZ plane (SLA_FLAG_DROPX) 3. X axis/Y direction or ZX plane (SLA_FLAG_DROPY) Some drop line properties are controlled from the Plot object; for example, use the SetAttribute(SLA_PLOTOPTIONS,SLA_FLAG_DROPX Or FLAG_SET_BIT) plot object method to turn on y axis drop lines. Other drop line properties are set using Line object attributes.



Expanded Property A property of notebook window notebooks and sections, which opens or closes the tree for that notebook section, or returns a true or false value for the current view.
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Fill Property The Fill property is used to return the Solid object for the specified Plot object. Solid objects for plots include bars and boxes.



FullName Property Returns the filename and path for either the application or the current notebook object. If the notebook object has not yet been saved to a file, an empty string is returned.



Functions Property The Functions property is used to return the collection of Function objects for the specified Plot object. Plot functions include regression and confidence lines, and all reference (QC) lines. The individual function lines are specified using an index:: Index



1 2 3 4 5 6 7 8 9 10



Constant



SLA_FUNC_REG R SLA_FUNC_CON F1 SLA_FUNC_CON F2 SLA_FUNC_PRE D1 SLA_FUNC_PRE D2 SLA_FUNC_QC1 SLA_FUNC_QC2 SLA_FUNC_QC3 SLA_FUNC_QC4 SLA_FUNC_QC5



Function



Regression Line Upper Confidence Intervals Lower Confidence Interval Upper Prediction Interval Lower Prediction Interval 1st Reference Line (Upper Specification) 2nd Reference Line (Upper Control Line) 3rd Reference Line (Mean) 4th Reference Line (Lower Control Line) 5th Reference Line (Lower Specification)



Note: Most regression and reference lines options are controlled with different plot and line attributes. For example, to turn on a regression line, use Plot.SetAttribute(SLA_REGROPTIONS,SLA_REGR_FORPLOT Or FLAG_SET_BIT), and to turn on the third reference line, use
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Plot.SetAttribute(SLA_QCOPTIONS,SLA_QCOPTS_SHOWQC3 Or FLAG_SET_BIT)



Graphs Property Returns the collection of graphs for the specified Page object. Use the index to select a specific Graph object. Graphs are used in turn to return the different graph items: Plots, Axes, the graph title, and the graph legend.



GraphPages Property Returns the GraphPages collection of Page objects for a GraphItem object. However, since there is currently only one graph page for any given graph item, you can always use GraphPages(0). However, in order to access items within a GraphItem, you must always specify the GraphPage.



Height Property Sets or returns the height of the application window or specified notebook document window in pixels, or the size of pages and page objects in 1000ths of an inch.



InsertionMode Property Sets or returns a Boolean indicating whether or not Insert mode is on in the current worksheet..



Interactive Property Sets or returns a Boolean indicating whether or not the user is allowed to interact with the running notebook window or application. Do not set the Application property to False from within SigmaPlot or you will lose access to the application.
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IsCurrentBrowser Entry Property Returns whether or not the specified item is the currently selected item in the notebook tree. This is particularly useful when adding new objects to a notebook in s specific notebook location. IsCurrentItem Property Returns whether or not the specified item is the currently selected item. This property is particularly useful when used in conjunction with the CurrentItem property.



IsOpen Property A property common to all NotebookItems objects. Returns a Boolean indicating whether or not the specified document or section is open. Open and close notebook items using the Open and Close methods.



ItemType Property A property common to all NotebookItems objects. Returns an integer denoting the item/object type. 1 2 3 4 5 6 7 8 9 10



CT_WORKSHEET CT_GRAPHICPAGE CT_FOLDER CT_STATTEST CT_REPORT CT_FIT CT_NOTEBOOK CT_EXCELWORKSHEE T CT_TRANSFORM CT_MACRO



NativeWorksheetItem GraphItem SectionItem ReportItem (SigmaStat) ReportItem (SigmaPlot) FitItem NotebookItem ExcelItem TransformItem MacroItem



Keywords Property A standard property of notebook files and all NotebookItems objects. Sets the Keywords field under the Summary tab of the Windows98/2000 file Properties dialog box. Note that the keywords for notebook items are not currently displayed or used. The default keywords used by SigmaPlot notebooks are "SigmaPlot" and "SigmaStat."



 532 Chapter 14



Left Property Sets or returns the left coordinate of the application window or specified notebook document window in pixels, or the size of pages and page objects in 1000ths of an inch.



Line Property Returns the Line object for the specified Plot object. Lines are available in both line plots and line and scatter plots.



LineAttributes Property Returns the collection of axis Line objects for the specified Axis object. Use the collection index to return a specific line object: Index



Line



1 2 3 4 5 6



Axis Lines Major Ticks Minor Ticks Major Grid Minor Grid Axis Break



Note: Many axis line attributes are set with the different Axis object attributes, using the Axis object SetAttribute method.



Name Property A standard property of almost all SigmaPlot objects. Returns or sets the Title name and field in the Summary Information for all notebook items, the filename for a notebook file, and the object name or title for page objects. Note: If you attempt to set the name of a document to the existing name, you will receive an error message and the macro will halt.



 533 SigmaPlot Automation Reference



NamedRanges Property Returns the collection of NamedRanges from a DataTable object. Use the NamedDataRanges collection to return a specific NamedDataRange object.



NameObject Property Returns the Text object that corresponds to the name of the specified object.



NameOfRange Property Sets or returns the name for a NamedDataRange object. Useful for returning lists of column and row titles, which are named ranges.



NotebookItems Property A Notebook object property that returns the collection of notebook items. Use the NotebookItems collection to access individual notebook items. Worksheets, pages, equations, reports, macros, and section and notebook folders are all notebook items and can be returned as objects.



Notebooks Property An Application object property that returns the Notebooks collection object. Use the Notebooks collection to return individual Notebook objects and create new notebooks.



NumberFormat Property Sets or returns the format used by the currently selected cells in the DataTable of the NativeWorksheetItem or ExcelItem object. If there is no selection, the format for the entire worksheet is assumed. If there are mixed formats, a NULL value is returned. Both Number and Date and Time formats are set or returned using the standard number and date and time format designations.
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ObjectType Property Returns the type value for the specified object. The values returned and corresponding object types are: Value



Constant



Object



1 2 3 4 5 6 7 8 9 10 11 12 13



GPT_PAGE GPT_GRAPH GPT_PLOT GPT_AXIS GPT_TEXT GPT_LINE GPT_SYMBOL GPT_SOLID GPT_TUPLE GPT_FUNCTION GPT_EXTERNAL GPT_BAG GPT_DATATABLE



Page Graph Plot Axis Text Line Symbol Solid Tuple Function External Group DataTable



OwnerGraphObject Property Returns the object that the current object is contained within. This applies to the different graph page object hierarchies, where the Parent property is not supported.



Parent Property Returns the object or collection immediately "above" the current object. For graph page items, use the OwnerGraphObject property instead.



Path Property Returns the path for the SigmaPlot application, or the path of the specified notebook file. For notebooks, you can use the Name property to return the file name without the path, or use the FullName property to return the file name and the path together.
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Plots Property Returns the collection of plots for the specified Graph object. Use an index to return the individual Plot objects for the graph.



Saved Property Returns a True or False value for whether of not the document has been saved since the last changes. Note that notebook items that are closed from within SigmaPlot are automatically saved to the notebook, but that the notebook file is only saved using a Save or Save As command or method.



SelectedText Property Returns the text of the current selection from a ReportItem. You can set or return a text selection using the SelectionExtent property.



SelectionExtent Property Returns the array of current selection extents from a ReportItem or ExcelItem. The start and stop indices for each selection are listed as individual members of the array, e.g., .SelectionExtent(0) is the start of the first selection, and SelectionExtent(1) is the end of the first selection.



ShowStatsWorksheet Property If this Boolean property is set to True, SigmaPlot opens up a statistics window that displays statistics about the specified NativeWorksheetItem. Statistics include: mean, standard deviation, standard error, half-widths for 95% and 99% confidence intervals, sample size, total, minimum, maximum, smallest positive value, and number of missing values. If this property is set to False, the statistics window is closed if open. This property returns True if the statistics worksheet window is open or False if the worksheet window is not open or the specified NativeWorksheet is not open. If the specified NativeWorksheet object is not open, setting this property has no effect.
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StatsWorksheetData Table Property Returns the Column Statistics worksheet as a DataTable object. Returns an object expression representing the read-only data table belonging to the NativeWorksheetItemÐ¦s statistics worksheet. If the worksheet has not been opened using the ShowStatsWorksheet property, this property returns nothing.



StatusBar Property Sets or returns the SigmaPlot application window status bar text. Note that when a macro is running within SigmaPlot, it will also issue status messages that will overwrite messages set with the StatusBar property. A macro running in VB or VBA outside SigmaPlot will not create its own status bar messages other than those set with StatusBar.



StockScheme Property Returns the property scheme value for a variable, which can then be assigned to a graph object. STOCKSCHEME_COLOR_BW STOCKSCHEME_COLOR_GRAYS STOCKSCHEME_COLOR_EARTH STOCKSCHEME_COLOR_FOREST STOCKSCHEME_COLOR_OCEAN STOCKSCHEME_COLOR_RAINBOW STOCKSCHEME_COLOR_OLDINCREMENT STOCKSCHEME_SYMBOL_DOUBLE STOCKSCHEME_SYMBOL_MONOCHROME STOCKSCHEME_SYMBOL_DOTTEDDOUBLE STOCKSCHEME_SYMBOL_OLDINCREMENT STOCKSCHEME_LINE_MONOCHROME STOCKSCHEME_LINE_OLDINCREMENT STOCKSCHEME_PATTERN_MONOCHROME STOCKSCHEME_PATTERN_OLDINCREMENT



&H00020001 &H00010001 &H00030001 &H00040001 &H00050001 &H00060001 &H00070001 &H00010002 &H00020002 &H00030002 &H00040002 &H00010003 &H00020003 &H00010004 &H00020004
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Subject Property A standard property of notebook files and all NotebookItems objects. Sets the Subject field under the Summary tab of the Windows 98/2000 file Properties dialog box. Note that the Subject for notebook items is not currently displayed or used.



Symbols Property Returns the Symbol object for the specified Plot object.



Template Property Returns the Notebook object used as the template source file. The template is used for new page creation. To create a graph page using a template file, use the ApplyPageTemplate method.



Text Property Specifies the text for the report, transform or macro code. The text is unformatted, plain text. Note: Use the vbCrLf string data constant to insert a carriage-return and linefeed string. Transforms: To change the value of a transform variable, use the



AddVariableExpression method. Run transforms using the Execute method.



TickLabelAttributes Property Returns the tick label Text objects for the specified Axis object.



Title Property A Notebook object property. Sets the Name of the NotebookItem object of the Notebook file, and the Title field under the Summary tab of the Windows 98/2000 file
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Properties dialog box. Does not affect the file name; to change the file name, use either the Name or FullName property.



Top Property Sets or returns the top coordinate of the application window or specified notebook document window. User Path. Returns the default path for the current user.



Visible Property A property common to the Application, Notebook, and NotebookItems document objects. Sets or returns a Boolean indicating whether or not the application or specified document window is visible. Do not set the Application property to False from within SigmaPlot or you will lose access to the application. Note: Hidden document windows will still appear in the notebook window tree. Setting Visible=False for a notebook object hides all document windows for the notebook as well.



Width Property Sets or returns the width of the application window or specified notebook document window.



SigmaPlot Methods Methods are an action that can be performed on or by an object-think of methods as verbs. For example, the WorksheetEditItem object has Copy and Clear methods. Methods can have parameters that specify the action (adverbs). For more information, refer to SigmaPlot Automation Help from the SigmaPlot Help menu.
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Activate Method Makes the specified notebook the object specified by the ActiveDocument property.



Add Method The Add method is used in collections to add a new item to the collection. The parameters depend on the collection type: Collection



Value



Notebooks NotebookItems



Parameters



None 1



CT_WORKSHEET



2



CT_GRAPHICPAGE



2



CT_FOLDER



4



CT_STATTEST



5



CT_REPORT



6



CT_FIT



7



CT_NOTEBOOK



8



CT_EXCELWORKSHEET



9



CT_TRANSFORMTransformItem



10 Graph Objects



NamedRanges



2



GPT_GRAPH, more...



3



GPT_PLOT, more...



4



GPT_AXIS, more...



5



GPT_TEXT, more...



6



GPT_LINE, more...



7



GPT_SYMBOL, more...



8



GPT_SOLID, more...



9



GPT_TUPLE, more...



10



GPT_FUNCTION, more...



11



GPT_EXTERNAL, more...



12



GPT_BAG, more... Name string, Left long, Top long, Width long, Height long, NamedRange



 540 Chapter 14



The GraphItem object uses the CreateGraphFromTemplate and CreateWizardGraph methods to create new GraphObject objects.



AddVariable Expression Method Allows the substitution of any transform variable with a value.



ApplyPageTemplate Method Overwrites the current GraphItem using a new page template specified by the template name. Optionally, you can specify the notebook file to use as the source of the template page. If no template file is specified, the default template notebook is used, as returned by the Template property.



AddWizardAxis Method Adds an additional axis to the current graph and plot on the specified GraphItem object, using the AddWizardAxis options. If there is only one plot for the current graph, SigmaPlot will return an error. Use the following parameters to specify the type of scale, the dimension, and the position for the new axis: Scale TYPE



SAA_TYPE_LINEAR SAA_TYPE_COMMON (Base 10) SAA_TYPE_LOG (Base e) SAA_TYPE_PROBABILITY SAA_TYPE_PROBIT SAA_TYPE_LOGIT Dimension



DIM_X



1



The X dimension



DIM_Y



2



The Y dimension



DIM_Z



3



The Z dimension (if applicable)
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Position



AxisPosRightNormal



0



AxisPosRightOffset



1



AxisPosTopNormal



2



AxisPosTopOffset



3



AxisPosLeftNormal



4



AxisPosLeftOffset



5



AxisPosBottomNormal



6



AxisPosBottomOffset



7



AddWizardPlot Method Method Adds another plot to the current graph on the specified GraphItem object using the following parameters to define the plot:: Parameter



Values



Optional



graph type



any valid type name



no



graph style



any valid style name



no



data format



any valid data format name



no



column array



any column number/title array no



columns per plot array array of columns in each plot



yes



error bar source



any valid source name



error bar plots only



error bar computation



any valid computation name



error bar plots only



angular axis units



any valid angle unit name



polar plots only



lower range bound



any valid degree value



polar plots only



upper range bound



any valid degree value



polar plots only



ternary units



upper range of ternary axis scale



ternary plots only



Clear Method Clears the selection in items that support this.
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Close Method The Close method is used to close notebooks and notebook items. The parameters for each object type depend on the object: „ Notebook. Save before closing Boolean, filename string „ NotebookItems. Save before closing Boolean Specifying a Save before closing



value of False closes the notebook or notebook item without saving changes made to the object. Note that for NotebookItems and SectionItems, a Close corresponds to an Expanded = False.



Copy Method Copies the currently selected item within the specified notebook item. If no item is selected, then an error is returned.



CreateGraphFromTemplate Method Creates a graph for a GraphItem from the Graph Style Gallery.



CreateWizardGraph Method Creates a graph in the specified GraphItem object using the Graph Wizard options. These options are expressed using the following parameters: Parameter



Values



Optional



graph type



any valid type name



no



graph style



any valid style name



no



data format



any valid data format name



no



columns plotted



any column number/title array no



columns per plot



array of columns in each plot



yes



error bar source



any valid source name



error bar plots only



error bar computation



any valid computation name



error bar plots only
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Parameter



Values



Optional



angular axis units



any valid angle unit name



polar plots only



lower range bound



any valid degree value



polar plots only



upper range bound



any valid degree value



polar plots only



ternary units



upper range of ternary axis scale



ternary plots only



Cut Method Removes the current selection from the specified object, placing the contents on the clipboard. This method is equivalent to using the Copy method, followed by the Clear method. However, whereas Copy places OLE link formats on the clipboard for GraphItem objects, Cut does not.



Delete Method Deletes a notebook item from a NotebookItems collection, as specified using an index number or name. If the item does not exist, an error is returned.



DeleteCells Method Deletes the specified cells from the worksheet. The remaining cells can be moved in two different directions to fill in the deleted region: „ Shift Cells Up „ Shift Cells Left



To delete an entire column or row, simply set the column bottom or row right value to the system maximum: „ Rows: 32,000,000 „ Columns: 32,000
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Execute Method Used to execute the specified TransformItem.



Export Method SigmaPlot Automation supports export of NativeWorksheetItem objects, GraphItem objects, and NotebookItem objects of type CT_NOTEBOOK. „ If applied to a NativeWorksheetItem object, this method exports either the data in



the worksheet to the specified data format or the entire notebook to a previous SPW file format. „ If applied to a GraphItem object, this method exports either the graphic data on the



page to the specified graphic format or the entire notebook to a previous SPW file format. „ If applied to the first NotebookItem in the NotebookItemList, this method exports



the entire notebook to a previous SPW file format.



GetAttribute Method The GetAttribute method is used by all graph page objects to retrieve current attribute settings. Attributes are numeric values that also have constants assigned to them. . Message Forwarding: If you use the GetAttribute method to retrieve an attribute that



does not exist for the specified object, the message is automatically routed to a child object that does have this attribute using a message forwarding table. To use the Object Browser to view Constants:



You can view alternate values for attributes and constants by selecting the current attribute value, then clicking the Object Browser button. All valid alternate values will be listedÐŠto use a different value, select the value and click Paste.
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GetData Method Returns the data within the specified range from a DataTable object as a variant. This variant is always returned as a one dimensional array. If a 2D array is specified, the data is stacked as a linear array. To ensure that GetData retrieves all data in a row or column, specify the worksheet maximum as the right of bottom parameter.



GetMaxLegalSize Method Returns an array containing the maximum legal row and column values.



GetMaxUsedSize Method Returns an array containing the maximum used worksheet column and row values.



Goto Method Moves worksheet cursor position to the specified cell coordinate for the current NativeWorksheetItem or ExcelItem object.



Help Method Opens an on-line Windows help file to a specific topic context map ID number (as a long) or search index keyword (K-word). You can use either the ID number or an index keyword. If any of the parameters are left empty, the SigmaPlot help file defaults are used.



Import Method Imports a data file with the specified file name into an existing NativeWorksheetItem. You can specify both the import starting location in the SigmaPlot worksheet, as well as the range of data imported. InsertCells Method Inserts the specified block of cells into the worksheet. The existing cells can be moved in two different directions to accommodate the inserted region:
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„ Shift Cells Up „ Shift Cells



To insert an entire column or row, simply set the column bottom or row right value to the system maximum: „ Rows: 32,000,000 „ Columns: 32,000



Mesh Method Converts unsorted xyz triplet data to evenly incremented mesh data, as required by mesh and contour plots. The optional parameters control the results columns, mesh range and increment, and original datapoint weighting. Note: The output columns must be specified if the data is to be returned to the worksheet.



Item Method Returns an object from the collection as specified by the object index number or name. Note that the index begins with 0 by default. The Item method is equivalent to specifying an object from the collection object using an index. If the item does not exist, an error is returned.



ModifyWizardPlot Method Modifies the current plot on the specified GraphItem object using the following parameters:: Parameter



Values



Optional



graph type



any valid type name



no



graph style



any valid style name



no



data format



any valid data format name



no



column array



any column number/title array no



columns per plot array array of columns in each plot



yes
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Parameter



Values



Optional



error bar source



any valid source name



error bar plots only



error bar computation



any valid computation name



error bar plots only



angular axis units



any valid angle unit name



polar plots only



lower range bound



any valid degree value



polar plots only



upper range bound



any valid degree value



polar plots only



ternary units



upper range of ternary axis scale



ternary plots only



NormalizeTernary Data Method Normalize three columns of raw data to 100 or 1 for a ternary plot.



Open Method Opens the notebook specified within the Notebooks collection, or the specified notebook item. The parameter depends upon whether you are opening a notebook or a notebook item. Note: For NotebookItems and SectionItems, an Open corresponds to an Expanded = True.



Paste Method Place the contents of the Windows Clipboard into the selected notebook item document, at the current position, if applicable. The format specified is an available clipboard format, as displayed by the Edit menu Paste Special command.



Print Method Prints the selected item, including any items within specified NotebookItems and SectionItems. Specifying the Notebook prints all items in the notebook.
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PrintStatsWorksheet Method Prints the NativeWorksheetItemÐ¦s statistics worksheet. If the worksheet has not been opened using the ShowStatsWorksheet property, this method fails.



PutData Method Places the specified variant into the worksheet starting at the specified location. The data can be a 2D array.



Quit Method Ends SigmaPlot. If SigmaPlot is in use, then this method is ignored.



Redo Method Redoes the last undone action for the specified object. If redo has been disabled in SigmaPlot for either the worksheet or page, this method has no effect.



Remove Method Deletes the specified object. The index can be a number or a name. If the specified index does not exist, an error is returned.



Run Method Runs a FitItem or Macro without closing the object.



SaveAs Method Save a notebook file for the first time, or to a new file name and path. Note that you need to provide the file extension. Recognized SigmaPlot notebook file extensions are .JNB, .JNT, and .JFL Save Method Saves a Notebook object to disk using the current FullName , or a notebook item to the notebook (without saving the notebook file to
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disk). If no FullName exists for a notebook, an error occurs. To save a notebook that has not yet been saved, you must use the SaveAs method. Note: Transform text can be saved to an .xfm file by naming the transform first with the full file name, extension, and path.



Select Method Selects all of the items within the specified selection region. In addition, if Top equals Bottom and Right equals Left, the resulting selection includes the object that the specified point lies within. If AddToSelection is False then the previous selection list is replaced by the new list. If True, then the newly selected items are added to the existing selection list.



SelectAll Method Selects the entire contents of the item.



SelectObject Method Clears the current GraphItem selection list and selects the specified graph object so that it can be altered using the SetSelectedObjectsAttribute method. Line and Solid objects can only be selected if they are top level drawing objects (not child objects of other objects).



SetAttribute Method The SetAttribute method is used by all graph page objects to change current attribute settings. Attributes are numeric values that also have constants assigned to them. For a list of all these attributes and constants, see SigmaPlot Constants. Message Forwarding: If you use the SetAttribute method to change an attribute that



does not exist for the current object, the message is automatically routed to an object that has this attribute using the message forwarding table. Using the Object Browser to view Constants You can view alternate values for attributes and constants by selecting
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the current attribute value, then clicking the Object Browser button. All valid alternate values will be listed. To use a different value, select the value and click Paste.



SetCurrentObject Attribute Method Changes the attribute specified by Attribute, of the current object on the graphics page. Use one of the following three techniques to set the current object on the graphics page: „ Click the object using the mouse. SigmaPlot Automation Reference „ Use the SigmaPlot menus (e.g. Select Graph). „ Use the SetObjectCurrent method.



If the specified GraphItem is not open or there is no current object of the appropriate type on the page, the method will fail.



SetObjectCurrent Method Sets the specified object to the current object for the purpose of the SetCurrentObjectAttribute command. It the specified GraphItem is not open, the method will fail.



SetSelectedObjects Attribute Method „ Changes the attribute specified by Attribute for all the selected objects on the



graphics page. Select graphics page objects using one of the following two techniques: „ Click the object with the mouse. „ Use the SelectObject method.



TransposePaste Method Pastes the data in the clipboard into the worksheet, transposing the row and column indices of the data such that rows and columns are swapped. If there is nothing in the clipboard or the data is not of the right type, nothing will happen. Undo Method Undoes the last performed action for the specified object. If undo has been disabled in SigmaPlot for either the worksheet or page, this method has no effect.
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15 Creating and Using SigmaPlot Transforms Transform Basics This chapter covers: „ Sorting data (see page 551). „ Performing quick transforms (see page 552). „ Smoothing 2D and 3D data (see page 555). „ Normalizing ternary data (see page 554). „ Creating user-defined transforms (see page 565). „ Transform operators (see page 575).



Sorting Data Sort selected blocks of data in ascending or descending order according to the order in a key column. Note: Because the sort command sorts data in place, if you want the original data to remain intact, copy the data to a new location and sort the copied data. To sort selected data: E Use the mouse or keyboard to select the data you want to sort. Only the selected



columns and rows are sorted; unselected values within a column are ignored. E On the Transforms menu, click Sort Selection. The Sort Selection dialog box



appears.
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Figure 15-1 The Sort Selection Dialog Box



E Select the key column by choosing the appropriate column title or column number



from the Key Column drop-down list, or by typing the column title or column number in the Key Column box. E Select either Ascending or Descending to sort your data in order of increasing or



decreasing values. E Click OK to sort the data in place and close the Sort Selection dialog box.



Performing Quick Transforms Use the Quick Transform dialog box to enter and execute simple, one-line mathematical functions to modify one or more columns of data. The Functions palette which appears directly below the Quick Transforms dialog box provides immediate access to frequently used transforms. No knowledge of complex programming is required. Note that you cannot run transforms on date and time columns. To use date and time data, you must first convert the data to numeric data, run the transform, and then convert the column back to date and time data. For more information, see “Switching Between Date and Time and Numeric Display” in Chapter 3.
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To perform a Quick Transform: E With the worksheet in view, on the Transforms menu, click Quick Transform.



The Quick Transform dialog box appears with two Equation drop-down lists. The Functions palette also appears directly below it, and contains many of the most commonly used functions. You can either manually type the equation into the Quick Transform dialog box, or use the Functions palette. E Click the col or cell button in the Function palette. The Equation group box left drop-



down list displays either col[?], or cell[?,?]. E Click the cell or column in the worksheet to replace the question mark in the Equation



group box left drop-down list. E Under Equation, place the cursor in the right drop-down list. E Click a function button on the Functions palette.



The function appears under Equation in the right drop-down list of the Quick Transform dialog box. E Click the specific column, cell, or row in the worksheet to replace the question mark



in the function argument with worksheet coordinates. E To set trigonometric units, click Options. The Options dialog box appears. Figure 15-2 Options: Trig Units Dialog Box



Select the appropriate trig units if calculating trig functions.
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E To use the transform as the title of the column, select Use transform as the title of the



output column. For example: „ Using a Quick Transform of col(3) = col(1)+col(2), results in the column title for



column 3 of: col(1)+col(2). „ Using a Quick Transform of col(4) = col(2)+col(3), results in the column title for



column 4 of: col(2)+col(3). E Click OK. E Click Run.



Normalizing Ternary Data To create a ternary graph using data whose sum is not 100% or 1, first convert the raw XYZ data into normalized ternary triplet data by using the Normalize Ternary Data transform. To normalize ternary data: E On the Transforms menu, click Normalize Ternary Data. The Normalize Ternary



Data Column Picker dialog box appears. Figure 15-3 Selecting the Data Columns to Normalize from the Normalize Ternary Data Column Picker Dialog Box



E Select the column with the original X data from the worksheet or the Data Source list.



The selected column is assigned as the X Source in the Selected Columns list.
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E Select the Y data source. E Select the columns from the worksheet data. E Select the X, Y, and Z data destination columns in the worksheet. E Click Next. E Select the type of scale from the Scale Type drop-down list. Figure 15-4 Selecting the Scale Type from the Normalize Ternary Data Column Picker Dialog Box



E Click Finish.



Smoothing 2D and 3D Data SigmaPlot smoothers are algorithms for smoothing sharp variations in dependent variable values within 2D and 3D data sets. You can also use smoothers to resample data to a rectangular grid of independent variable values. You control the locations of the computed smoothed values. You can choose the raw data values of the independent variable(s) as the smoothing locations. You can also specify uniformly-spaced smoothing locations over the extent of the independent variable data. Each smoothing method weights the data contained in a window surrounding the smoothing location. The radius of this window is called the bandwidth radius. A linear or non-linear technique is then applied to the weighted data to compute each smoothed value.
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The weight assigned to each data value in the window is determined by its normalized distance (u) from the smoothing location. Choose one of the following smoothing methods.



3 3 „ Loess. Applies the tricube weight function ( 1 – u ) to weight the data. The smoother is



polynomial of degree 1, 2, or 3. Use with 2D or 3D data. „ Running Average. Computes the average of the dependent values. Use with 2D or 3D data. „ Running Median. Computes the median of the dependent variable. Use with 2D



or 3D data. „ Negative Exponential. Applies a Gaussian weight function



e



–u



2



to weight the data



and a quadratic fit. Use with 2D or 3D data.



2 2 „ Bisquare. Applies a bisquare weight function ( 1 – u ) . Use with 2D or 3D data. „ Inverse Square. Applies a Cauchy weight function „ Inverse Distance. Applies the weight function



data only.



1----p u



1 -------------2 1+u .



Use with 2D or 3D data..



to the (x,y) data. Use with 3D



You can find smoother method guidelines in the 2D and 3D Smoothers sections of Samples.jnb. For more information, see “Where Files Go” in Chapter 1.



Smoothing 2D Data Use the Smooth 2D Data dialog box to remove undesired high-frequency data components, such as data contamination. Figure 15-5 An example of noisy data and then its conversion. Note that the original noisy data points appear on the graph.
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To select the data source: E Select the worksheet columns by dragging the pointer over your data. E On the Transforms menu, click Smooth 2D Data. The Smoother 2D - Select Data



dialog box appears. Figure 15-6 Selecting the Data Columns to Smooth from the Smoother 2D Dialog Box



E Click Next.



To select columns for results: E Select Predicted: First Empty from the Results list to compute a smoothed value for



each data point. Figure 15-7 Selecting the Results Columns for the Smoothed Data
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E Select Residuals: First Empty to differentiate between the smoothed value and the



original Y value. E Accept First NextEmpty as the standard default column in the Columns



drop-down list. E Select Plot Results to create a grid of the computed smoothed values on the worksheet. E Click .



To select columns to graph: E Accept First Empty as the default in the Curve Data Column list. Figure 15-8 Selecting columns to display a grid of smoothed data on the worksheet.



E Select Create a new graph to create a line plot using the grid of data which appears



on the worksheet. E To create another plot type and style, clear Create new graph, and create the plot



manually. For more information, see “Creating 2D Plots ” in Chapter 6. E Click Finish. The Smooth 2D Data dialog box appears.
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Figure 15-9 Selecting Smoothers from the Smooth 3D Data drop-down list



To define smoothing parameters: E Select a smoother type from the Smoothers drop-down list. E Set the Sampling Proportion to determine a fraction of the total number of data points



used to compute each smoothed value. Note: The interpretation of the Sampling Proportion depends on the Bandwidth Method. E Set the polynomial degree from the Polynomial Degree list, if applicable. E Select Reject Outliers to reduce the effects of outlier points on the smoothed values.



To set smoothing options: E Click Options. The Smoothed Curve Options dialog box appears.
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Figure 15-10 The Smooth Curve Options Dialog Box



E Change the Minimum and Maximum for the X values to new beginning and ending



values for the X ranges. For 2D smoothing, the Y values are the smoothed values, and therefore unavailable in the Smoothed Curve Options dialog box. E Set the bandwidth method to either Fixed or Nearest Neighbors. „ Fixed: Sets the same bandwidth radius the same at every smoothing location. The



radius is computed by multiplying the Sampling Proportion value times half of the difference between the set Minimum and Maximum independent variables (X values). Select Fixed if the density of the observed data is relatively constant over the extent of its defined region. „ Nearest Neighbors: Here the bandwidth radius depends on the smoothing location.



The radius is equal to the maximum distance between the smoothing location and its nearest neighbors, as determined by the Sampling Proportion value. Select Nearest Neighbors for data that is clustered in some areas and sparse in others. For example, if there are 100 data points, enter .1 as the Sampling Proportion value to choose ten data points nearest the smoothing location. E Click OK.
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To preview and create the graph: E Click Preview to see a preview of the graph.



If the preview is not satisfactory, adjust the Smoother settings and options and click Preview again. Each time you preview, the settings are stored for subsequent review by clicking the right and left arrows. E Click OK to accept the preview.



The graph appears with a line graph representing the smoothed data points. The original noisy data points also remain. The worksheet now contains the results of all selected computations. Click the Stop button at the bottom of the Smooth 2D Data dialog box to stop the process.



Smoothing 3D Data Use the Smoother 3D dialog box to smooth variations in 3D data or to re-sample 3D data to rectangular grid locations that are necessary for creating mesh plots and 3D contour plots. To select the data source: E Select the worksheet columns by dragging the pointer over your data. E On the Transforms menu, click Smooth 3D Data. The Smoother 3D - Select Data



dialog box appears.
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Figure 15-11 Selecting the Data Columns to Smooth from the Smoother 3D Dialog Box



E Click Next. Figure 15-12 Selecting the Data Columns to Smooth from the Smoother 3D Dialog Box



To select worksheet columns for your results: E Select Predicted: First Empty from the Results list to compute a smoothed value at



each data point. E Select Residuals: First Empty to differentiate between the smoothed value and the



original Y value. E Accept First Empty as the standard default column in the Columns drop-down list. E Select Plot Results to create a grid of the computed data on the worksheet.
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E Click Next.



To select columns to graph: E Accept First Empty as the default in the Columns drop-down list. Figure 15-13 Selecting columns to display the grid of smoothed data



E Select Create a new graph to create a mesh plot using the grid of data which appears



on the worksheet. If you are creating a contour plot, clear Create new graph, and create the contour plot manually. For more information, see “Creating Contour Plots ” in Chapter 7. E Select a smoother type from the Smoother drop-down list. Figure 15-14 Selecting Smoothers from the Smooth 3D Data drop-down list
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E Set the Sampling Proportion, a fraction of a total number of data points used to



compute each smoothed value. Note: The Sampling Proportion depends on the Bandwidth Method. E Set the Polynomial Degree from the Polynomial Degree list, if applicable. E Select Reject Outliers to reduce the effects of outlier points on the smoothed values.



To set smoothing options: E Click Options. The Smoothed Curve Options dialog box appears. Figure 15-15 The Smooth Curve Options Dialog Box



E Change the Minimum and Maximum for the X and Y values to new beginning and



ending values for the X and Y ranges. E Set the bandwidth method to either Fixed or Nearest Neighbors. „ Fixed: The bandwidth radius is the same at every smoothing location. The radius is



computed by multiplying the Sampling Proportion value times half of the difference between the set Minimum and Maximum independent variables (X and Y values). Select Fixed if the density of the observed data is relatively constant over the extent of its defined region.
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„ Nearest Neighbors: Here the bandwidth radius depends on the smoothing location.



The radius is equal to the maximum distance between the smoothing location and its nearest neighbors, as determined by the Sampling Proportion value. Select Nearest Neighbors for data that is clustered in some areas and sparse in others. E Click OK.



To preview and then create the graph: E Click Preview to see a preview of the graph.



If the preview is not satisfactory, adjust the Smoother settings and options, and click Preview again. Each time you preview, the settings are stored for subsequent review by



clicking the right and left arrows. E Click OK to accept the preview.



The graph appears, and the worksheet now contains the results of all selected computations. Note: You can click the red Stop button at the bottom of the Smooth 3D Data dialog box to stop the process.



Creating User-Defined Transforms Modify and manipulate worksheet data by entering SigmaPlot’s extensive mathematical transformation language into the User-Defined Transform dialog box. Use transforms to create new data by performing functions on existing data, or generate calculated or random data, which can then be placed in worksheet columns. For more information, see “Transform Operators” on page 575. The first step to transform worksheet data is to enter the desired equations in the edit box. If no previously entered transform equations exist, the edit box is empty: otherwise, the last transform entered appears. Select the edit box to begin entering transform instructions. As you enter text into the transform edit box, the box scrolls down to accommodate additional lines. You can enter up to 100 lines of equations, either on separate lines or on the same line.
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To create a user-defined transform: E View the worksheet. E On the Transforms menu, click User-Defined. The User-Defined Transform dialog



box appears. Figure 15-16 User-Defined Transform Dialog Box



E Type transform instructions into the Edit Transform field. You can enter up to 32,000



characters. E Click Run.



You can save the contents of the transform window to a file. Since this is a text file, you can view or print these files using any word processor. You can open previously saved transforms in the transform window for execution or modification. All transform files have the extension of .jnb in the Transforms folder. To view these files, click the Open button in the User-Defined Transforms dialog box and open a transform file. A library of transform results is named Xfms.jnb in the Transform folder. These transform examples also include a sample SigmaPlot graph file displaying the results of the transform. For more information, see “Where Files Go” in Chapter 1.
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Transform Syntax and Structure Use standard syntax and equations when defining user-defined transforms in SigmaPlot or SigmaStat. This section discusses the basics and the details for entering transform equations.



Transform Syntax Enter transforms as equations with the results placed to the left of the equal sign (=) and the calculation placed to the right of the equal sign. Results can be defined as either variables (which can be used in other equations), or as the worksheet column or cells where results are to be placed.



Entering Transforms To type an equation in the transform edit box, click in the edit box and begin typing. When you complete a line, press Enter to move the cursor to the first position on the next line. You can leave spaces between equation elements: x = a+b is the same as x = a + b. However, you may find it necessary to conserve space by omitting spaces. Blank lines are ignored so that you can use them to separate or group equations for easier reading.
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Figure 15-17 Typing Equations into the Edit Window



If the equation requires more than one line, you may want to begin the second and any subsequent lines indented a couple of spaces (press the space bar before typing the line). Although this is not necessary, indenting helps distinguish a continuing equation from a new one. Note: You can resize the transform dialog box to enlarge the edit box. You can press Ctrl+X, Ctrl+C, and Ctrl+V to cut, copy, and paste text in the edit window. Transforms are limited to a maximum of 100 lines. Note that you can enter more than one transform statement on a line; however, this is only recommended if space is a premium. Note: Use only parentheses to enclose expressions. Curly brackets and square brackets are reserved for other uses.



Commenting on Equations To enter a comment, type an apostrophe (’) or a semicolon (;), then type the comment to the right of the apostrophe or semicolon. If the comment requires more than one line, repeat the apostrophe or semicolon on each line before continuing the comment.
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Sequence of Expression SigmaPlot and SigmaStat generally solve equations regardless of their sequence in the transform edit box. However, the col function (which returns the values in a worksheet column) depends on the sequence of the equations, as shown in the following example. Example



The sequence of the equations: col(1)=col(4)^alpha col(2)=col(1)*theta



must occur as shown. The second equation depends on the data produced by the first. Reversing the order produces different results. To avoid this sequence problem, assign variables to the results of the computation, then equate the variables to columns: x=col(4) y=x^alpha z=y*theta col(1)=y col(2)=z



The sequence of the equations is now unimportant.



Transform Components Transform equations consist of variables and functions. Operators are used to define variables or apply functions to scalars and ranges. A scalar is a single worksheet cell, number, missing value, or text string. A range is a worksheet column or group of scalars.
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Figure 15-18 Examples of the Transform Equation Elements Typed into the Transform Window



Variables You can define variables for use in other equations within a transform. Variable definition uses the following form: variable = expression



Variable names must begin with a letter. After that, they can include any letter or number, or the underscore character ( _ ). Variable names are case sensitive—an "A" is not the equivalent of an "a." Once a variable has been defined by means of an expression, that variable cannot be redefined within the same transform.



Functions A function is similar to a variable, except that it refers to a general expression, not a specific one, and thus requires arguments. The syntax for a function declaration is function(argument 1,argument 2,...) = expression
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where function is the name of the function, and one or more argument names are enclosed in parentheses. Function and argument names must follow the same rules as variable names. User-Defined Functions. Frequently used functions can be copied to the Clipboard and pasted into the transform window.



Constructs Transform constructs are special structures that allow more complex procedures than functions. Constructs begin with an opening condition statement, followed by one or more transform equations, and end with a closing statement. The available constructs are for loops and if...then...else statements.



Operators A complete set of arithmetic, relational, and logic operators are provided. Arithmetic operators perform simple math between numbers. Relational operators define limits and conditions between numbers, variables, and equations. Logic operators set simple conditions for if statements. For more information, see “Transform Operators” on page 575.



Numbers You can enter numbers as integers, in floating point style, or in scientific notation. All numbers are stored with 15 figures of significance. Use a minus sign in front of the number to signify a negative value. Missing values, represented in the worksheet as a pair of dashes, are considered non-numeric. All arithmetic operations which include a missing value result in another missing value. To generate a missing value, divide zero by zero.
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Example



If you define: missing = 0/0



the operation: size({1,2,3,missing})



returns a value of 4.0. (The size function returns the number of elements in a range, including labels and missing values.) The transform language does not recognize two successive dashes; for example, the string {1,2,3,--} is not recognized as a valid range. Dashes are used to represent missing values in the worksheet only. Strings, such as text labels placed in worksheet cells, are also non-numeric information. To define a text string in a transform, enclose it with double quotation marks. As with missing values, strings may not be operated upon, but are propagated through an operation. The exception is for relational operators, which make a lexical comparison of the strings, and return true or false results accordingly.



Scalars and Ranges The transform language recognizes two kinds of elements: scalars and ranges. A scalar is any single number, string, or missing value. Anything that can be placed in a single worksheet cell is a scalar. A range (sometimes called a vector or list) is a one-dimensional array of one or more scalars. Columns in the worksheet are considered ranges. Ranges can also be defined using curly bracket ({}) notation. The range elements are listed in sequence inside the brackets, separated by commas. Most functions which accept scalars also accept ranges, unless specifically restricted. Typically, whatever a function does with a scalar, it does repeatedly for each entry in a range. A single function can operate on either a cell or an entire column.
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Example 1



The entry: {1,2,3,4,5}



produces a range of five values, from 1 through 5. Example 2



The operation: {col(1), col(2)}



concatenates columns 1 and 2 into a single range. Note that elements constituting a range need not be of the same type, i.e., numbers, labels and missing values. Example 3



The entry: {x,col(4)*3,1,sin(col(3))}



also produces a range.



Array References Individual scalars can be accessed within a range by means of the square bracket ([ ]) constructor notation. If the bracket notation encloses a range, each entry in the enclosed range is used to access a scalar, resulting in a new range with the elements rearranged. Example



For the range: x = {1.4,3.7,3.3,4.8}
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the notation: x[3]



returns 3.3, the third element in the range. The notation: x[{4,1,2}]



produces the range {4.8,1.4,3.7}. The constructor notation is not restricted to variables: any expression that produces a range can use this notation. Example



The operation: col(3)[2]



produces the same result as col(3,2,2), or cell(3,2). The notation: {2,4,6,8}[3]



produces 6. If the value enclosed in the square brackets is also a range, a range consisting of the specified values is produced. Example



The operation: col(1)[{1,3,5}]



produces the first, third, and fifth elements of column 1.
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Figure 15-19 Range and Array Reference Operations Typed into the User Defined Transform Window



Transform Operators Transforms use operators to define variables and apply functions. A complete set of arithmetic, relational, and logical operators are provided.



Order of Operation The order of precedence is consistent with P.E.M.A. (Parentheses, Exponentiation, Multiplication, and Addition) and proceeds as follows, except that parentheses override any other rule: „ Exponentiation, associating from right to left. „ Unary minus. „ Multiplication and division, associating from left to right. „ Addition and subtraction, associating from left to right. „ Relational operators. „ Logical negation. „ Logical and, associating from left to right. „ Logical or, associating from left to right.
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This list permits complicated expressions to be written without requiring too many parentheses. Figure 15-20 Examples of Transform Operators



Example



The statement: a


groups to (a
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Operations on Ranges The standard arithmetic operators—addition, subtraction, multiplication, division, and exponentiation—follow basic rules when used with scalars. For operations involving two ranges corresponding entries are added, subtracted, etc., resulting in a range representing the sums, differences, etc., of the two ranges. If one range is shorter than the other, the operation continues to the length of the longer range, and missing value symbols are used where the shorter range ends. For operations involving a range and a scalar, the scalar is used against each entry in the range. Example: The operation: col(4)*2



produces a range of values, with each entry twice the value of the corresponding value in column 4.



Arithmetic Operators Arithmetic operators perform arithmetic between a scalar or range and return the result. + * / ^ or **



Add Subtract (also signifies unary minus) Multiply Divide Exponentiate



Multiplication must be explicitly noted with the asterisk. Adjacent parenthetical terms such as (a+b) (c-4) are not automatically multiplied.
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Figure 15-21 Examples of arithmetic operators



Relational Operators Relational operators specify the relation between variables and scalars, ranges or equations, or between user-defined functions and equations, establishing definitions, limits and/or conditions. = or .EQ. > or .GT. >= or .GE. < or .LT. , !=, #, or .NE.



Equal to Greater than Greater than or equal to Less than Less than or equal to Not equal to



The alphabetic characters can be entered in upper or lower case.
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Figure 15-22 Examples of rational and logical operators.



Logical Operators Logical operators are used to set the conditions for if function statements. and, & or, not, ~



Intersection Union Negation
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16 Transform Examples Many mathematical transform examples, along with appropriate graphs and worksheets are included with SigmaPlot. This chapter is describes the data transform examples and the graphing transform examples provided. Each description contains the text of the transform and, where applicable, a graph displaying the possible results of the transform. You can find these sample transforms in the Transforms folder. For more information, see “Where Files Go” in Chapter 1.



Data Transform Examples The data transform examples are provided to show you how transform equations can manipulate and calculate data.



One Way Analysis of Variance (ANOVA) A One Way Analysis of Variance (ANOVA) table can be created from the results of a regression or nonlinear regression. The original Y values, the Y data from the fitted curve, and the parameters are used to generate the table. The transform assumes you have placed the original Y data in column 2, the fitted Y data in column 3, and the regression coefficients or function parameters in column 4. You can either place this data in these columns, or change the column numbers used by the transform. The One Way ANOVA transform contains examples of the following transform functions: „ Count „ If „ Total „ Mean
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„ {...} (constructor notation)



To use the One Way ANOVA transform: E Make sure your original Y data is in column 2. Perform the desired regression using



the Regression Wizard, and save your Predicted values (fitted Y data) in column 3, and Parameters (the regression coefficients) in column 4. For more information, see “Regression Overview” in Chapter 18. E Press F10 to open the User-Defined Transform dialog box, then click the Open button



and open the ANOVA.XFM transform file in the XFMS directory. The ANOVA transform appears in the edit window. E Click Run. The ANOVA results are placed in columns 5 through 9, or beginning at the



column specified with the anova variable.



Area Beneath a Curve Using Trapezoidal Rule This transform computes the area beneath a curve from X and Y data columns using the trapezoidal rule for unequally spaced X values. The algorithm applies equally well to equally spaced X values. This transform uses an example of the diff function. To use the Area Under Curve transform: E Place your X data in column 1 and your Y data in column 2. If your data has been



placed in other columns, you can specify these columns after you open the AREA.XFM file. You can use an existing or new worksheet. E Press F10 to open the User-Defined Transform dialog box, then click the Open button



and open the AREA.XFM transform file in the XFMS directory. The Area transform appears in the edit window. E Click Run. The area is placed in column 3 or in the column specified with the res



variable. Bivariate Statistics
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This transform takes two data columns of equal length and computes their means, standard deviations, covariance, and correlation coefficient. The columns must be of equal length. The Bivariate transform uses examples of these transform functions „ mean „ stddev „ total



To use the Bivariate transform: E Place your X data in column 1 and your Y data in column 2. If your data has been



placed in other columns, you can specify these columns after you open the BIVARIAT.XFM transform file. You can enter data into an existing worksheet or a new worksheet. E Press F10 to open the User-Defined Transform dialog box, then click the Open button,



and open the BIVARIAT.XFM transform file in the XFMS directory. The Bivariate Statistics transform appears in the edit window. E Click Run. The results are placed in columns 3 and 4, or beginning in the column



specified with the res variable. Differential Equation Solving This transform can be used to solve user-defined differential equations. You can define up to four first order equations, named fp1(x1,y1,y2,y3,y4) through fp4(x1,y1,y2,y3,y4). Set any unused equations = 0. To solve a first order differential equation: E Begin a new worksheet by choosing the File menu New command, then choosing



Worksheet; this transform requires a clean worksheet to work correctly. E Open the User-Defined Transforms dialog box by selecting the Transforms menu User



Defined command, then clicking the Open button, and opening the DIFFEQN.XFM transform file in the XFMS directory. The Differential Equation Solving transform appears in the edit window. E Scroll to the Number of Equations section and enter a value for the neqn variable. This



is the number of equations you want to solve, up to four.
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E Scroll down to the Differential Equations section, and set the fp1 through fp4 functions



to the desired functions. Set any unused equations = 0. If only one first order differential equation is used, then only the fp1 transform equation is used and fp2, fp3, and fp4 are set to 0. For example, if you only wanted to solve the differential equation:



dy-1 = – ay -------1 dt you would enter: fp1(x,y1,y2,y3,y4) = -a*y1 fp2(x,y1,y2,y3,y4) = 0 fp3(x,y1,y2,y3,y4) = 0 fp4(x,y1,y2,y3,y4) = 0 E Scroll down to the Initial Values heading and set the nstep variable to the number of



integration (X variable) steps you want to use. The more steps you set, the longer the transform takes. E Set the initial X value x0, final X value x1, and the Y1 through Y4 values (placed in



cells (2,1) through (5,1)). If you are not using a y1 value, set that value to zero (0). For example, for the single equation example above, you could enter: x0 = 0 ;initial x x1 = 1 ;final x cell(2,1) = 1 ;y1 initial value cell(3,1) = 0 ;y2 initial value cell(4,1) = 0 ;y3 initial value cell(5,1) = 0 ;y4 initial value E Click Run. The results output is placed in columns 1 through neqn+1. E To graph your results, create a Line Plot graphing column 1 as your X data and



columns 2 through 5 as your Y data.
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Figure 16-1 Differential Equation Graph
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F-test to Determine Statistical Improvement in Regressions This transform compares two equations from the same family to determine if the higher order provides a statistical improvement in fit. Often it is unclear whether a higher order model fits the data better than a lower order. Equations where higher orders may produce better fits include: simple polynomials of different order, the sums of exponentials for transient response data, and the sums of hyperbolic functions for saturation ligand binding data. F_TEST.XFM uses the residuals from two regressions to compute the sums of squares of the residuals, then creates the F statistic and computes an approximate P value for the significance level.
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You can try this transform out on the provided sample graph, or run it on the residuals produced by your own regression sessions. Residuals are saved to the worksheet by the Regression Wizard. E To use the provided sample data and graph, open the F-test worksheet and graph in the



XFMS.JNB notebook. The worksheet contains raw data in columns 1 and 2, and curve fit results for the two competitive binding models in columns 3-5 and 6-8. The graph plots the raw data and the two curve fits. E To use your own data, enter the XY data to be curve fit in columns 1 and 2, respectively.



Select the first curve fit equation and use it to fit the data, place the parameters, fit results and residuals in the first empty columns (3-5). Run the second curve fit and place the results in columns 6-8 (the default). If desired, create graphs of these results using the wizard. E Press F10 to open the User-Defined Transform dialog box, then open the



F_TEST.XFM transform file. Specify n1 and n2, the number of parameters in the lower and higher order functions. In the example provided, these are 3 and 5, respectively. If necessary, specify cs1 and cs2, the column locations for the residuals of each curve fit, and cres, the first column for the two column output. E Click Run. The F-test value and corresponding P value are placed into the worksheet.



If P < 0.05, you can predict that the higher order equation provides a statistically better fit.
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Figure 16-2 Comparing Two Curve Fits
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You can use this transform to compute the coefficient of determination (R2) for the results of a nonlinear regression. The original Y values and the Y data from the fitted curve are used to calculate R2. To save the fitted Y values of the nonlinear regression to the worksheet, use the Regression Wizard to save the Function results to the appropriate column (for this transform, column 3). E Place your original Y data in column 2 of the worksheet and the fitted Y data in column



3. If your data has been placed in other columns, you can specify these columns after you open the R2.XFM transform file. You can enter data into an existing or a new worksheet. E Press F10 to open the User-Defined Transform dialog box, then click the Open button



and open the R2.XFM transform file in the XFMS directory. The R2 transform appears in the edit window. E Click Run. The R2 value is placed in column 4 of the worksheet, or in the column



specified with the res variable. Standard Deviation of Linear Regression Parameters
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This transform computes linear 1st-order regression parameter values (slope and intercept) and their standard deviations using X and Y data sets of equal length. To calculate 1st-order regression parameters and their standard deviations for XY data points: E Place the X data in column 1 of the worksheet and the Y data in column 2. If your data



is in other columns, you can specify these columns after you open the STDV_REG.XFM transform file. You can enter data into an existing worksheet or a new worksheet. E Press F10 to open the User-Defined Transform dialog box, then click the Open button,



and open the STDV_REG.XFM transform file in the XFMS directory. If necessary, change the x_col, y_col, and res variables to the correct column numbers. E Click Run. The results are placed in columns 3 and 4, or in the columns specified by



the res variable.



Graphing Transform Examples The graph transform examples are provided to show you how transform equations can manipulate and calculate data to create complex graphs. Each of the following descriptions provide instructions on how to use SigmaPlot to create graphs. Most of these graphs, however, are already set up as sample graphs. If you use the provided worksheet and graphs with the corresponding transform files, SigmaPlot will automatically create the graphs after you run the transform.



Control Chart for Fractional Defectives with Unequal Sample Sizes This example computes the fraction of defectives p for a set of unequally sized samples using their corresponding numbers of defects, the control limits for p, and data for the upper and lower control lines. This transform contains examples of the following transform functions: „ stddev „ sqrt
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To calculate and graph the fraction of defectives and control lines for given sample sizes and number of defects per sample, you can either use the provided sample data and graph or begin a new notebook, enter your own data and create your own graph using the data. E To use the provided sample data and graph, open the Control Chart worksheet and



graph in the Control Chart section of the Transform Examples notebook. The worksheet appears with data in columns 1, 2, and 3. The graph page appears with an empty graph. E To use your own data, place the sample sizes in column 1 and the corresponding



number of defects data in column 2 of a new worksheet. If your data is in other columns, you can specify these columns after you open the CONTCHRT.XFM transform file. You can enter your data in an existing or a new worksheet. E Press F10 to open the User-Defined Transform dialog box, then click the Open button



and open the CONTCHRT.XFM transform file in the XFMS directory. The Control Chart transform appears in the edit window. E Click Run. The results are placed in columns 4 through 5 of the worksheet. E If you opened the Control Chart graph, view the graph page. The graph plots the



fraction of defectives using a Line and Scatter plot with a Simple Straight Line style graphing column 3 as Y data versus the row numbers. The control lines are plotted as a Simple Horizontal Step Plot using columns 4 and 5 versus their row numbers. The mean line for the fractional defectives is drawn with a reference line. E To create your own graph, create a Line and Scatter Plot, with a Simple Line style, then



plot column 3 as Y data against the row numbers. Add an additional Line Plot using the Multiple Horizontal Step Plot style, plotting columns 4 and 5 versus their two numbers, then add a reference line to plot the mean line for the fractional device.
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Figure 16-3 Control Chart Graph
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Cubic Spline Interpolation and Computation of First and Second Derivatives This example takes data with irregularly spaced X values and generates a cubic spline interpolant. The CBESPLN1.XFM transform takes X data which may be irregularly spaced and generates the coefficients for a cubic spline interpolant. The CBESPLN2.XFM transform takes the coefficients and generates the spline interpolant and its two derivatives. The values for the interpolant start at a specified minimum X which may be less than, equal to, or greater than the X value of the original first data point. The interpolant has equally spaced X values that end at a specified maximum which may be less than, equal to, or greater than the largest X value of the original data. Note that this is not the same algorithm that SigmaPlot uses; this algorithm does not handle multiple valued functions, whereas SigmaPlot does. To use the transform to generate and graph a cubic spline interpolant, you can either use the provided sample data and graph, or begin a new notebook, enter your own data and create your own graph using the data.
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E To use the provided sample data and graph, open the Cubic Spline worksheet and graph



by double-clicking the graph page icon in the Cubic Spline section of the Transform Examples notebook. The worksheet appears with data in columns 1 and 2 and the graph page appears with two graphs. The first graph plots the original XY data as a scatter plot. The second graph appears empty. E To use your own data, enter the irregularly spaced XY data into the worksheet. The X



values must be sorted in strictly increasing values. The default X and Y data columns used by the transform are columns 1 and 2, respectively. E Press F10 to open the User-Defined Transform dialog box, then click the Open button,



and open the CBESPLN1.XFM transform file in the XFMS directory. The first Cubic Spline transform appears in the edit window. E Move to the Input Variables heading. Set the X data column variable cx, the Y data



column cy, the beginning interpolated X value xbegin, the ending interpolated X value xend, and the X increments for the interpolated points xstep. A larger X step results in a smoother curve but takes longer to compute. Enter the end condition setting iend for the interpolation. E Enter the end condition setting iend for the interpolation.



You can use first, second, or third order conditions. If you have only a few data points, you should try different orders to see which one you like the most. See the example for the effect of too low an order on the first and second derivatives. 1 end spline segments approach straight lines asymptotically 2 end spline segments approach parabolas asymptotically 3 end spline segments approach cubics asymptotically E Move to the RESULTS heading and enter the first column number for the results cr.



This column for the beginning of the results block is specified in both transforms. E Click Run to run the transform. When it finishes, press F10 then open the



CBESPLN2.XFM transform file in the XFMS directory. Make sure that the cr variable is identical to the previous value, then click Run.
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E If you opened the Cubic Spline graph, view the page. The first graph plots the original



XY data as a scatter plot and the interpolated data as a second line plot by picking the cr column as the X column and cr+1 as the Y column. The second graph plots the derivatives as line plots using the cr column versus the cr+2 column and the cr column versus the cr+3 column. E To create your own graphs using SigmaPlot, create a Scatter Plot using a Simple



Scatter style which plots the original data in columns 1 and 2 as XY pairs. Add an additional Line Plot using a Simple Spline Curve, then plot the cr column as the X column against the cr+1 column as the Y column. First and Second Derivatives
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Fast Fourier Transform The Fast Fourier Transform converts data from the time domain to the frequency domain. It can be used to remove noise from, or smooth data using frequency-based filtering. Use the fft function to find the frequency domain representation of your data, then edit the results to remove any frequency which may adversely affect the original data. The Fast Fourier Transform uses the following transform functions: „ fft „ invfft
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„ real „ img „ complex „ mulcpx „ invcpx



The Fast Fourier Transform operates on a range of real values or a block of complex values. For complex values there are two columns of data. The first column contains the real values and the second column represents the imaginary values. The worksheet format of a block of complex numbers is: r1



i1



r2



i2



....



....



rn



in



where r values are real elements, and i values are imaginary elements. In transform language syntax, the two columns {{r1, r2, ... rn},{i1, i2, ... in}} are written as: block({r1, r2, ... rn},{i1, i2, ... in}) This function works on data sizes of size 2n numbers. If your data set is not 2n in length, the fft function pads 0 at the beginning and end of the data range to make the length 2n. For more information, see “Smoothing with a Low Pass Filter” on page 598. The fft function returns a range of complex numbers. The Fast Fourier Transform is usually graphed with respect to frequency. To produce a frequency scale, use the relationship: f=fs*(data(0,n/2)-1)/n



where fs is the sampling frequency. The example transform POWSPEC.XFM. includes the automatic generation of a frequency scale. The Fast Fourier Transform operates on data which is assumed to be periodic over the interval being analyzed. If the data is not periodic, then unwanted high frequency components are introduced. To prevent these high frequency components from occurring, windows can be applied to the data before using the fft transform. The Hanning window is a cosine function that drops to zero at each end of the data. The example transform POWSPEC.XFM includes the option to implement the Hanning
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window. For more information, see “Computing Power Spectral Density” on page 594.



Using the Block Function To return the full fft data to the worksheet: E First assign the data you want to filter to column 1 of the worksheet. You can generate



the data using a transform, or use your own measurements. E Press F10 to open the User-Defined Transforms dialog box, then click the New button



to start a new transform. E Type the following transform in the edit window:



x=col(1) ’real data tx=fft(x) ’compute the fft block(2)=tx ’place real fft data back in col(2) ’place imaginary fft data in col(3) E Click Run. The results are placed starting one column over from the original data.



Computing Power Spectral Density The example transform POWSPEC.XFM uses the Fast Fourier Transform function, then computes the power spectral density, a frequency axis, and makes optional use of a Hanning window. To calculate and graph the power spectral density of a set of data, you can either use the provided sample data and graph, or begin a new notebook, enter your own data and create your own graph using the data. E To use the sample worksheet and graph, open the Power Spectral Density worksheet



and graph by double-clicking the graph page icon in the Power Spectral Density section of the Transform Examples notebook. Data appears in column 1 of the worksheet, and two graphs appear on the graph page. The top graph shows data
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generated by the sum of two sine waves plus Gaussian random noise. The data is represented by: f(t)=sin(2*pi*f1*t)+0.3*sin(2*pi*f2*t)+g(t)



where f1=10 cycles/sec (cps), f2=100cps, and the Gaussian random noise has mean 0 and standard deviation of 0.2. The lower graph is empty. E To use your own data, place your data in column 1. If your data is in a different column,



specify the new column after you open the POWSPEC.XFM transform file. E Press F10 to open the User-Defined Transform dialog box, then click the Open button,



and open POWSPEC.XFM transform file in the XFMS directory. The Power Spectral Density transform appears in the edit window. Note: To use this transform, the Trigonometric Units must be set to Radians. E Click Run. Since the frequency sampling value (fs) is nonzero, a frequency axis is



generated in column 2 and the power spectral density data in column 3. E If you opened the Power Spectral Density graph, view the graph page. Two graphs



appear on the page. The top graph plots the data generated by the sum of two sine waves plus Gaussian random noise using a Line Plot with Simple Straight Line style graphing column 1 versus row numbers. The lower graph plots the power spectral density using a Line Plot with a Simple Straight Line style, graphing column 2 as the X data (frequency), and column 3 as the Y data. E To plot your own data using SigmaPlot, choose the Graph menu Create Graph



command, or select the Graph Wizard from the toolbar. Create a Line Plot with a Simple Straight Line style plotting your original data versus row numbers by choosing Single Y data format. If you set the frequency sampling value (fs) to nonzero, create a Line Plot with a Simple Straight Line style, graphing columns 2 and 3 using XY Pair data format. Otherwise, create a Line Plot with a Simple Straight Line style plotting column 3 (power spectral density) versus row numbers by choosing Single Y data format. The power spectral density plot of the signal f(t) shows two major peaks at the two frequencies of the sine waves (10cps and 100cps), and a more or less constant noise level in between.
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For more information, see “Creating and Modifying Graphs” in Chapter 4. Figure 16-4 Power Spectral Density Example Graph 2
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Kernel Smoothing The example transform SMOOTH.XFM smooths data by convolving the Fast Fourier Transform of a triangular smoothing kernel together with the fft of the data. Smoothing data using this transform is computationally very fast; the number of operations is greatly reduced over traditional methods, and the results are comparable. To increase the smoothing, increase the width of the triangular smoothing kernel. To calculate and graph the smoothed data, you can either use the provided sample data and graph, or begin a new notebook, enter your own data, and create your own graph using the data. E To use the sample worksheet and graph, open the Kernel Smoothing worksheet and



graph by double-clicking the graph page icon in the Kernel Smoothing section of the
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Transform Examples notebook. Data appears in columns 1 through 4, 6, and 7 of the worksheet, and two graphs appear on the graph page. The first graph has two plots, the signal, and the signal with noise distortion. Column 1 contains the X data, column 2 contains the Y data for the signal, and column 3 contains the Y data for the signal and the noise distortion. The lower graph is empty. E To use your own data, place your data in columns 1 through 2. If your data is in other



columns, specify the new columns after you open the SMOOTH.XFM transform file. If necessary, specify a new column for the results. E Press F10 to open the User-Defined Transform dialog box, then click the Open button,



and open SMOOTH.XFM transform file in the XFMS directory. The Kernel Smoothing transform appears in the edit window. Note: To use this transform, make sure the Insert mode is turned off. E Click Run. The results are placed in column 5 unless you specified a different column



in the transform. E If you opened the Kernel Smoothing graph, view the graph page. Two graphs appear



on the page. The first graph has two plots, the signal, and the signal with noise distortion. The Line Plot with a Multiple Straight Line style graphs column 1 as the X data, column 2 as the Y data for the signal, and column 3 as the Y data for the signal and the noise distortion. The lower Line Plot with a Simple Straight Line style plots column 1 as the X data, and column 5 as the Y data using XY Pairs data format. E To plot your own data using SigmaPlot, choose the Graph menu Create Graph



command, or select the Graph Wizard from the toolbar. Create a Line Plot with a Multiple Straight Line style using X Many Y data format, plotting column 1 as the X data, column 2 as the Y data for the signal, and column 3 as the Y data for the signal and the noise distortion. Create a second Line Plot graph with a Simple Straight Line style using the data in columns 1 and 5, graphing column 1 as the X data and column 5 as the Y data using XY Pairs data format.
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For more information, see “Creating and Modifying Graphs” in Chapter 4. Figure 16-5 Kernel Smoothing Graph
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Smoothing with a Low Pass Filter The Low Pass Filter transform smooths data by eliminating high frequencies. Use this transform in contrast to the Kernel Smoothing transform which smooths data by augmenting some frequencies while minimizing others. The transform statements describing how the low pass filter works are: x=col(1) ‘the data to smooth f=5 ‘number of channels to eliminate tx=fft(x) ‘fft of data r=data(1,size(tx)/2) ‘total number of channels mp=size(tx)/4 ‘get the midpoint
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‘remove the frequencies td=if( rmp+1+f,tx,0) sd=invfft( td ) ‘convert back to time domain col(2)=real(sd) ‘save smoothed data to worksheet



The LOWPASS.XFM transform expresses f as a percentage for ease of use. As the value of f increases, more high frequency channels are removed. Note that this is a digital transform which cuts data at a discrete boundary. In addition, this transform does not alter the phase of the data, which makes it more accurate than analog filtering. A high pass or band pass filter can be constructed in the same manner. To calculate and graph the smoothing of a set of data using a low pass filter, you can either use the provided sample data and graph, or begin a new notebook, enter your own data, and create your own graph using the data. E To use the sample worksheet and graph, open the Low Pass Smoothing worksheet and



graph by double-clicking the graph page icon in the Low Pass Smoothing section of the Transform Examples notebook. Data appears in columns 1 through 4 of the worksheet, and two graphs showing plots appear on the graph page. Column 1 contains the X data, column 2 contains the Y data for the signal and the noise distortion, column 3 contains the X data, and column 4 contains the Y data for the original signal. The top graph plots the signal plus the noise distortion; the bottom graph plots the signal. E To use your own data, place your data in columns 1 through 2. If your data is in other



columns, specify the new columns after you open the LOWPASS.XFM transform file. If necessary, specify a new column for the results. E Press F10 to open the User-Defined Transform dialog box, then click the Open button,



and open LOWPASS.XFM transform file in the XFMS directory. The Low Pass Filter transform appears in the edit window. Note: To use this transform, make sure Insert mode is turned off. E Click Run. The results are placed starting in column 5, unless you specified a different



column in the transform. E If you opened the Low Pass Smoothing graph, view the graph page. Two graphs



appear. The top graph plots the signal plus the noise distortion, using a Line Plot with a Simple Straight Line style and XY Pairs data format graphing column 1 as the X data, column 2 as the Y data for the signal and the noise distortion. The bottom graph
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displays two plots. A Scatter Plot with a Simple Scatter Style and XY Pairs data format, plots column 3 as the X data, and column 4 as the Y data for the original signal. A second Line Plot with a Simple Straight Line style using data in columns 1 and 5, plots column 1 as the X data and column 5 as the Y data using XY Pairs data format. E To plot your own data using SigmaPlot, choose the Graph menu Create Graph



command, or select the Graph Wizard from the toolbar. Create two graphs. Graph the signal plus the noise distortion, using a Line Plot with a Simple Straight Line style and XY Pairs data format graphing column 1 as the X data, column 2 as the Y data for the signal and the noise distortion. Create a second graph with two plots. Plot the original signal using a Scatter Plot with a Simple Scatter Style and XY Pairs data format, plotting column 3 as the X data, and column 4 as the Y data for the original signal. Add a second Line Plot with a Simple Straight Line style using data in columns 1 and 5, plotting column 1 as the X data and column 5 as the Y data using XY Pairs data format.
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Figure 16-6 Low Pass Filter Smoothing Graph
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Gain Filter Smoothing The GAINFILT.XFM transform example demonstrates gain filter smoothing. This method eliminates all frequencies with power spectral density levels below a specified threshold. The transform statements describing how gain filter smoothing works are: P=4000 x=col(1)



‘psd threshold ‘data



tx=fft(x) ‘compute fft of data md=real(tx)^2+img(tx)^2 ‘compute sd kc=if(md>P,1,0) ‘remove frequencies with ‘psd
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sd=mulcpx(complex(kc),tx) ‘remove frequency ‘components from x td=real( invfft(sd) ) ‘convert back to time domain col(2)=td ‘place results in worksheet



To calculate and graph the smoothing of a set of data using a gain filter, you can either use the provided sample data and graph, or begin a new notebook, enter your own data, and create your own graph using the data. E To use the sample worksheet and graph, open the Gain Filter Smoothing worksheet and



graph by double-clicking the graph page icon in the Gain Filter Smoothing section of the Transform Examples notebook. Data appears in columns 1 through 3 of the worksheet, and two graphs showing plots, and one blank graph appear on the graph page. Column 1 contains the Y data for the signal plus noise, column 2 contains the X data and column 3 contains the Y data for the power spectral density graph. The top graph plots the signal plus the noise distortion; the middle graph plots the power spectral density. E To use your own data, place your data in column 1. If your data is in a different column,



specify the new column after you open the GAINFILT.XFM transform file. If necessary, specify a new column for the results. E Press F10 to open the User-Defined Transform dialog box, then click the Open button,



and open GAINFILT.XFM transform file in the XFMS directory. The Gain Filter transform appears in the edit window. Note: To use this transform, make sure Insert mode is turned off. For more information, see “Insertion and Overwrite Modes” in Chapter 3. E Click Run. The results are placed in column 5 unless you specified a different column



in the transform. E If you opened the Gain Filter Smoothing graph, view the graph page. Three graphs



appear. The top graph plots the signal plus the noise distortion using a Line Plot with a Simple Straight line style and Single Y data format, plotting column 1 as the Y data for the signal plus noise. The middle graph plots the power spectral density using a Line Plot with a Simple Straight Line style and XY Pairs data format, plotting column 2 as the X data and column 3 as the Y data for the power spectral density graph. The
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lower graph is a plot of the gain filtered signal, using a Line Plot with a Simple Straight Line style, and single Y data format from column 5. E To plot your own data using SigmaPlot, choose the Graph menu Create Graph



command, or select the Graph Wizard from the toolbar. Create two graphs. Plot the signal plus the noise distortion using a Line Plot with a Simple Straight line style and Single Y data format, plotting column 1 as the Y data for the signal plus noise. Plot the gain filtered signal using a Line Plot with a Simple Straight Line style, and single Y data format from column 5.
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Figure 16-7 Gain Filter Smoothing Graph 5 Signal plus noise
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Frequency Plot This transform example creates a frequency plot showing the frequency of the occurrence of data in the Y direction. Data is grouped in specified intervals, then horizontally plotted for a specific Y value. Parameters can be set to display symbols that are displaced a specific distance from each other or that touch or overlap. You can also plot the mean value of each data interval. This transform example shows overlapping symbols which give the impression of data mass. To calculate and graph the frequency of the occurrence of a set of data, you can either use the provided sample data and graph, or begin a new notebook, enter your own data and create your own graph using the data. E To use the sample worksheet and graph, open the Frequency Plot worksheet and graph



by double-clicking the graph page icon in the Frequency Plot section of the Transform Examples notebook. Data appears in columns 1 through 3 of the worksheet, and an empty graph appears on the graph page. E To use your own data, place your data in columns 1 through 3. You can put data in as



many or as few columns as desired, but if you use the sample transform you must change the X locations of the Y values in the second line under the Input heading in the transform file to reflect the number of data columns you are using. If your data is in other columns or more than three columns, specify the new columns after you open the FREQPLOT.XFM transform file. Enter the tick labels for the X axis in a separate column, and specify tick labels from a column using the Tick Labels Type drop-down list in the Tick Labels panel in Graph Properties Axis tab. E Press F10 to open the User-Defined Transform dialog box, then click the Open button,



and open the FREQPLOT.XFM transform file in the XFMS directory. The Frequency Plot transform appears in the edit window. E Click Run. The results are placed starting one column over from the original data. E If you opened the sample Frequency Plot graph, view the graph page. A Scatter Plot



appears plotting columns 5 and 6, 7 and 8, and 9 and 10 as three separate XY Pair plots. The lines passing through each data interval is a fourth Line Plot with a Simple Straight Line style plotting columns 11 and 12 as an XY pair, representing the mean value of
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each data interval. The X axis tick marks are generated by the transform. The axis labels are taken from column 13. Figure 16-8 Frequency Plot Graph Frequency Plot 100 90 80
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E To create your own graph using SigmaPlot, make a graph with three Scatter Plots with



Simple Scatter styles. Plot each consecutive result column pair as XY pair scatter plots. If the mean line option is active in the transform, plot the last consecutive result column pair as a XY pair Line Plot with Simple Straight Line style. Use labels typed into a worksheet column as the X axis tick labels.



Gaussian Cumulative Distribution from the Error Function Rational approximations can be used to compute many special functions. This transform demonstrates a polynomial approximation for the error function. The error function is then used to generate the Gaussian cumulative distribution function. The absolute maximum error for the error function approximation is less than 2.5 x 10-5 (M. Abramowitz and L.A. Stegun, Handbook of Mathematical Functions, p. 299).



 607 Transform Examples



To calculate and graph the Gaussian cumulative distribution for given X values, you can either use the provided sample data and graph or begin a new notebook, enter your own data and create your own graph using the data. E To use the sample worksheet and graph, open the Gaussian worksheet and graph by



double-clicking the graph page icon in the Gaussian section of the Transform Examples notebook. Data appears in column 1 of the worksheet and two empty graphs appear on the graph page. E To use your own data, place the X data in column 1. If your data has been placed in



another column, you can specify the column after you open the GAUSDIST.XFM transform file. E Press F10 to open the User-Defined Transform dialog box, then click the Open button,



and open the GAUSDIST.XFM transform file in the XFMS directory. The Gaussian Cumulative transform appears in the edit window. E Click Run. The results are placed in column 2, or in the column specified by



the res variable. E If you opened the sample Gaussian graph, view the graph page. A Line Plot appears



with a spline curve in the first graph with column 1 as the X data versus column 2 as the distribution (Y) data. E To create your own graph using SigmaPlot, make a Line Plot graph with a Simple



Spline Curve. The spline curve plots column 1 as the X data versus column 2 as the distribution (Y) data.



Gaussian Cumulative Distribution on a Probability Scale The probability scale is the inverse of the Gaussian cumulative distribution function. When a Gaussian cumulative distribution function is graphed using the probability scale, the result is a straight line. E If you opened the sample Gaussian graph, view the graph page. A straight line plot



appears in the second graph plotting the distribution data in column 3 along a probability scale.
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E To create your own graph using SigmaPlot, create a Line Plot with a Simple Straight



Line using column 1 as your X data and column 3 as your Y data, and set the Y axis scale to Probability. Figure 16-9 Gaussian Cumulative Distribution Graphs Gaussian Cumulative Distribution Function Probability Scale
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Histogram with Gaussian Distribution This transform calculates histogram data for a normally distributed sample, then uses the sample mean and standard deviation of the histogram to compute and graph a Gaussian distribution for the histogram data. The Histogram Gaussian transform uses examples of the following functions: „ gaussian „ histogram „ size „ [...] (array reference)



To calculate and graph a histogram and Gaussian curve for a normally distributed sample, you can either use the provided sample data and graph or begin a new notebook, enter your own data, and create your own graph using the data.
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To use the sample worksheet and graph: E Open the Histogram Gaussian worksheet and graph by double-clicking the graph page



icon in the Histogram Gaussian section of the Transform Examples notebook. The Histogram worksheet with data in column 1 and an empty graph page appears. The data in the Histogram Gaussian worksheet was generated using the transform: col(1) = gaussian(100,0,325,2)



To use your own data: E Place the sample in column 1 of the worksheet. If your data has been placed in another



column, you can specify this column after you open the HISTGAUS.XFM transform file. You can enter the data into an existing or new worksheet. E Press F10 to open the User-Defined Transform dialog box, then click the Open button,



and open the HISTGAUS.XFM transform file in the XFMS directory. The Histogram with Gaussian Distribution transform appears in the edit window. E Click Run. The results are placed in columns 2 through 5 of the worksheet, or in the



columns specified by the res variable. E If you opened the Histogram Gaussian graph, view the graph page. A histogram



appears using column 2 as X data versus column 3 as the Y data. The curve plots the Gaussian distribution using column 4 as X data versus column 5 as the Y data. E To create your own graph using SigmaPlot, create a simple vertical bar chart and set



the bar widths as wide as possible. Add the Gaussian curve to the graph by creating another plot using the data in column 4 as the X data and the data in column 5 as the Y data.
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Figure 16-10 The Histogram Gaussian Graph Gaussian Distribution Using the Sample Mean and Standard Deviation 25
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Linear Regression with Confidence and Prediction Intervals This transform computes the linear regression and upper and lower confidence and prediction limits for X and Y columns of equal length. A rational polynomial approximation is used to compute the t values used for these confidence limits. The figure below displays the sample Linear Regression graph with the results of the LINREGR.XFM transform plotted. The LINREGR.XFM transform contains examples of these two functions: „ min „ max



To calculate and graph a linear regression and confidence and prediction limits for XY data points, you can either use the provided sample data and graph or begin a new notebook, enter your own data, and create your own graph using the data. E To use the provided sample data and graph, open the Linear Regression worksheet and



graph by double-clicking the graph page icon in the Linear Regression section of the
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Transform Examples notebook. The worksheet appears with data in columns 1 and 2. The graph page appears with a scatter graph plotting the original data in columns 1 and 2. E To use your own data, place the X data in column 1 and the Y data in column 2. If your



data has been placed in other columns, you can specify these columns after you open the LINREGR.XFM transform file. You can enter data into an existing or a new worksheet. E Press F10 to open the User-Defined Transform dialog box, then click the Open button,



and open the LINREGR.XFM transform in the XFMS directory. The Linear Regression transform appears in the edit window. If necessary, change the x_col, y_col, and res variables to the correct column numbers (this is not necessary for the example Linear Regression worksheet data). E Change the Z variable to reflect the desired confidence level (this is not necessary for



the example Linear Regression worksheet data). E Click Run. The results are placed in columns 3 through 8, or in the columns specified



by the res variable. E If you opened the Linear Regression graph, view the graph page. The original data in



columns 1 and 2 is plotted as a scatter plot. The regression is plotted as a solid line plot using column 3 as the X data versus column 4 as the Y data, the confidence limits are plotted as dashed lines using column 3 as a single X column versus columns 7 and 8 as many Y columns, and the prediction limits are plotted as dotted lines using column 3 as a single X column versus columns 7 and 8 as many Y columns.
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E To create your own graph in SigmaPlot, create a Scatter Plot with a Simple Regression,



plotting column 1 against column 2 as the symbols and using column 3 plotted against column 4 as the regression. Add confidence and prediction intervals using column 3 as the X column and columns 7 and 8 as the Y columns. Figure 16-11 Linear Regression Graph
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Low Pass Filter This transform is a smoothing filter which produces a data sequence with reduced high frequency components. The resulting data can be graphed using the original X data. To calculate and graph a data sequence with reduced high frequency components, you can either use the provided sample data and graph or begin a new notebook, enter your own data, and create your own graph using the data. E To use the provided sample data and graph, double-click the Low Pass Filter graph



page icon in the Low Pass Filter section of the Transform Examples notebook. The worksheet appears with data in columns 1 and 2. The graph page appears with two graphs. The first is a line graph plotting the raw data in columns 1 and 2. The second graph is empty.
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E To use your own data, place your Y data (amplitude) in column 2 of the worksheet, and



the X data (time) in column 1. If your data is in other columns, you can specify these columns after you open the LOWPFILT.XFM file. You can enter your data in an existing or new worksheet. E Press F10 to open the User-Defined Transform dialog box, then click the Open button,



and open the LOWPFILT.XFM transform file in the XFMS directory. The Low Pass Filter transform appears in the edit window. E Set the sampling interval dt (the time interval between data points) and the half power



point fc values. The half power point is the frequency at which the squared magnitude of the frequency response is reduced by half of its magnitude at zero frequency. E If necessary, change the cy1 source column value and cy2 filtered data results to the



correct column numbers. E Click Run to run the transform. Filtered data appears in column 3 in the worksheet, or



in the worksheet column you specified in the transform. E If you opened the Low Pass Filter graph, view the graph page. The second graph



appears as a line graph plotting the smoothed data in columns 1 and 3. E To create your own graphs in SigmaPlot, create the first graph as a Line Plot with a



Simple Spline Curve using the raw data in columns 1 and 2 as the X and Y data. Make the second Line Plot graph with a Simple Spline Curve using the data in column1 as the X data and the smoothed data in column 3 as the Y data.
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Figure 16-12 Low Pass Filter Graph Plotting Raw Data and Filtered Data
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Lowess Smoothing Smoothing is used to elicit trends from noisy data. Lowess smoothing produces smooth curves under a variety of conditions. "Lowess" means locally weighted regression. Each point along the smooth curve is obtained from a regression of data points close to the curve point with the closest points more heavily weighted. The y value of the data point is replaced by the y value on the regression line. The amount of smoothing, which affects the number of points in the regression, is specified by the user with the parameter f. This parameter is the fraction of the total number of points that is used in each regression. If there are 50 points along the smooth curve with f = 0.2 then 50 weighted regressions are performed and each regression is performed using 10 points. An example of the use of lowess smoothing for the U.S. wheat production from 1872 to 1958 is shown in the figures below. The smoothing parameter f was chosen to be 0.2 since this produced a good tradeoff between noisy undersmoothing and oversmoothing which misses some of the peak-and-valley details in the data.
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E To use the provided sample data and graph, open the Lowess Smoothing worksheet



and graph in the Lowess Smoothing section of the Transform Examples notebook. The worksheet appears with data in columns 1, 2, and 3. E To use your own data, enter the XY data for your curve in columns 1 and 2,



respectively. If your data has been placed in other columns, you can specify these columns after you open the LOWESS.XFM transform file. Enter data into an existing or a new worksheet. E Press F10 to open the User-Defined Transform dialog box, then click the Open button,



and open the LOWESS.XFM transform file in the Transforms directory. The Lowess transform appears in the edit window. E Click Run. The results are placed in column 3 of the worksheet, or in the column



specified by the ouput variable. E If you opened the Lowess Smoothing graph, view the graph page. The smoothed curve



is plotted on the second graph and both the original and smoothed data are plotted on the third.
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Figure 16-13 U.S. Wheat data and the lowess smoothed curve (f = 0.2). Notice the definite decreased production during World War II.
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If you want to plot your own results, create a line plot of column 1 versus column 3.



 617 Transform Examples



Normalized Histogram This simple transform creates a histogram normalized to unit area. The resulting data can be graphed as a bar chart. Histogram bar locations are shifted to be placed over the histogram box locations. The resulting bar chart is an approximation to a probability density function. To calculate and graph a normalized histogram sample, you can either use the provided sample data and graph or begin a new notebook, enter your own data, and create your own graph using the data. E To use the provided sample data and graph, open the Normalized Histogram worksheet



and graph in the Normalized Histogram and Graph section of the Transform Examples notebook. The worksheet appears with data in column 1. The data is made up of exponentially distributed random numbers generated with the transform: x = random(200,1,1.e-10,1)col(1) = -ln(x)



The graph page appears with an empty graph. E To use your own data, place your data in column 1 of the worksheet. If your data has



been placed in another column, you can specify this column after you open the NORMHIST.XFM transform file. You can enter data into an existing or new worksheet. E Press F10 to open the User-Defined Transform dialog box, then click the Open button,



and open the NORMHIST.XFM transform file in the XFMS directory. The Normalized Histogram transform appears in the edit window. E Click Run. The results are placed in columns 2 and 3 of the worksheet, or in the



columns specified by the res variable. E If you opened the Normalized Histogram graph, view the graph page. A histogram



appears using column 2 as X data versus column 3 as the Y data. E To create your own graph in SigmaPlot, create a Vertical Bar chart with simple bars,



then set the bar widths as wide as possible.
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Figure 16-14 Normalized Histogram Graph Normalized Histogram of Exponential Random Numbers n=200
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Smooth Color Transition Transform This transform example creates a smooth color transition corresponding to the changes across a range of values. The transform places color cells in a worksheet column that change from a specified start color to a specified end color, each color cell incrementing an equivalent shade for each data value in the range. This transform example shows how the color transform can be set to display a "cool" (blue) color that corresponds to small residuals, and a "hot" (red) color that corresponds to large residuals resulting from a nonlinear regression. Since residuals vary positively and negatively about zero, the absolute values for the residuals are used in the transform. Note: It is unnecessary to sort the data before executing the smooth color transition transform. To calculate and graph the smooth color transition of a set of data, you can either use the provided sample data and graph, or begin a new notebook, enter your own data, and create your own graph using the data. E To use the sample worksheet and graph, open the Smooth Color Transition worksheet



and graph by double-clicking the graph page icon in the Smooth Color Transition
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section of the Transform Examples notebook. Data appears in columns 1 and 2 of the worksheet, and a scatter graph appears on the graph page. E To use your own data, place your data in columns 1 and 2. For the residuals example,



column 2 is the absolute value of the residuals in column 1. To obtain absolute values of your data, use the abs transform function. For example, to obtain the absolute values of the data set in column 1, type the following transform in the User-Defined Transform dialog box: col(2)=abs(col(1))



If your data is in a different column, specify the new column after you open the RGBCOLOR.XFM transform file. E If your data is in a different column, specify the new column after you open the



RGBCOLOR.XFM transform file. E Click Run. The results are placed starting one column over from the original data, or



in the column you specified in the transform. E If you opened the sample Smooth Color Transition graph, view the graph page. A



Scatter Plot appears plotting column 2 as a Simple Scatter plot style using Single Y data format. The symbol colors are obtained by specifying column 3 in the Symbols, Fill Color drop-down list in the Plots panel of the Graph Properties dialog box. The Smooth Color Transition transform applies gradually changing colors to each of the data points. The smaller residual values are colored blue, which gradually changes to red for the larger residuals. E To create your own graph using SigmaPlot, make a Scatter Plot graph with a Scatter



Plot with Simple Scatter style. Plot the data as Single Y data format. Use the color cells produced by the transform by selecting the corresponding worksheet column from the Symbol Fill Color drop-down list.
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Survival (Kaplan-Meier) Curves with Censored Data This transform creates Kaplan-Meier survival curves with or without censored data. The survival curve may be graphed alone or with the data. To use the transform, you can either use the provided sample data and graph or begin a new notebook, enter your own data, and create your own graph using the data. E To use the sample worksheet and graph, double-click the graph page icon in the



Survival section of the Transforms Examples notebook. The Survival worksheet appears with data in columns 1 and 2. The graph page appears with an empty graph. If you open the sample worksheet and graph, skip to step 7. E To use your own data, enter survival times in column 1 of the worksheet. Ties



(identical survival times) are allowed. You can enter data into an existing or a new worksheet. E Enter the censoring identifier in column 2. This identifier should be 1 if the



corresponding data point in column 1 is a true response, and 0 if the data is censored. E If desired, save the unsorted data by copying the data to two other columns. E Select columns 1 and 2, then choose the Transforms menu Sort Selection command.



Specify the key column in the Sort Selection dialog box as column 1, and the sort order option as Ascending. E Check for any ties between true response and censored data. If any exist, make sure



that within the tied data, the censored data follows the true response data. E Click Run to run the file. The sorted time, cumulative survival probability, and the



standard error are placed in columns res, res+1, and res+2, respectively. For graphical purposes a zero, one, and zero have been placed in the first rows of the sorted time, cumulative survival curve probability and standard error columns. E If you opened the sample Survival graph, view the page. The Simple Horizontal Step



Plot graphs the survival curve data from columns res as the X data versus column res+1 as the Y data and a Scatter Plot graphs the data from the same columns. The first data point of the Scatter Plot at (0,1) is not displayed by selecting rows 2 to end in the Portions of Columns Plotted area of the Data section in the Plots tab of the Graph
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Properties dialog box. As shown in Figure 6‚Äì19, a tied censored data point has been incorrectly placed; it should follow uncensored data. E To graph a survival curve using SigmaPlot, create a Line graph with a Simple



Horizontal Step Plot graphing column res as the X data versus column res+1 as the Y data. If desired, create an additional Scatter plot, superimposing the survival data using the same columns for X data and Y data. To turn off the symbol drawn at x = 0 and y = 1, select Plot 2 and set Only rows = 2 to end by 1 in the Plots tab and Data sections of the Graph Properties dialog box. Figure 16-15 The Survival Graph
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User-Defined Axis Scale The USERAXIS.XFM transform is a specific example how to transform data to fit the user-defined axis scale. This transform: „ Transforms the data using the new axis scale „ Creates Y interval data for the new scale



To use this transform to graph data along a (log(log(100/Y)) Y axis, you can either use the provided sample data and graph, or begin a new notebook, enter your own data, and create your own graph using the data. E To use the sample worksheet and graph, double-click the graph page icon in the User



Defined Axis Scale section of the Transforms Examples notebook. The User Defined Axis Scale worksheet appears with data in columns 1 through 3. The graph page appears with an empty graph with gridlines. E To use your own data, place your original X data in column 1, Y data in column 2, and



the Y axis tick interval values in column 3. If your data has been placed in other columns, you can specify these columns after you open the USERAXIS.XFM file. E Press F10 to open the User-Defined Transform dialog box, then open the



USERAXIS.XFM transform. If necessary, change the y_col, tick_col, and res variables to the correct column numbers. E Click Run. The results are placed in columns 4 and 5, or the columns specified



by the res variable. E If you opened the User Defined Axis Scale graph, view the page. The graph is already



set up to plot the data and grid lines. E To plot the transformed Y data using SigmaPlot, plot column 1 as the X values versus



column 4 as the Y values. To plot the Y axis tick marks, open the Ticks panel under the Axes tab of the Graph Properties dialog box. Select Column 5 from the Major Tick Intervals drop-down list.
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To draw the tick labels, use the Y tick interval data as the tick label source by selecting Column 3 from the Tick Label Type drop-down list in the Tick Labels panel under the Axes tab of the Graph Properties dialog box. Figure 16-16 User-Defined Axis Scale Graph PLATELET DEPOSITION - 5 µ TEFLON
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Vector Plot The VECTOR.XFM transform creates a field of vectors (lines with arrow heads) from data which specifies the X and Y position, length, and angle of each vector. The data is entered into four columns. Executing the transform produces six columns of three XY pairs, which describe the arrow body and the upper and lower components of the arrow head. Other settings are: „ The length of the arrow head. „ The angle in degrees between the arrow head and the arrow body. „ The length of the vector (if you want to specify it as a constant).
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To generate a vector plot, you can either use the provided sample data and graph or begin a new notebook, enter your own data, and create your own graph using the data. E To use the sample worksheet and graph, double-click the graph page icon in the Vector



section of the Transform Examples notebook. The Vector worksheet appears with data in columns 1 through 4. The graph page appears with an empty graph. E To use your own data, enter the vector information into the worksheet. Data must be



entered in four column format, with the XY position of the vector starting in the first column, the length of the vectors (which correspond to the axis units), and the angle of the vector, in degrees. The default starting column for this block is column one. E Press F10 to open the User-Defined Transforms dialog box, then click the Open button



to open the VECTOR.XFM file in the XFMS directory. E If necessary, change the starting worksheet column for your vector data block xc. E If desired, change the default arrowhead length L (in axis units) and the Angle used by



the arrowhead lines. This is the angle between the main line and each arrowhead line. E If you want to use vectors of constant length, set the l value to the desired length, then



uncomment the remaining two lines under the Constant Vector Length heading. E Make sure that Radians are selected as the Trigonometric Units (they should be by



default. E Click Run to run the transform. The transform produces six columns of three XY pairs,



which describe the arrow body and the upper and lower components of the arrow head. E If you opened the Vector graph, view the page. The Line Plot with Multiple Straight



Line appears plotting columns 5 through 10 as XY pairs. E To plot the vector data using SigmaPlot, create a Line Plot with Multiple Straight Line



graph that plots columns 5 through 10 as three vector XY column pairs.
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Figure 16-17 The Vector Graph



Z Plane Design Curves The ZPLANE.XFM transform is a specific example of the use of transforms to generate data for a unit circle and curves of constant damping ratio and natural frequency. The root locus technique analyzes performance of a digital controller in the z plane using the unit circle as the stability boundary and the curves of constant damping ratio and frequency for a second order system to evaluate controller performance. Root locus data is loaded from an external source and plotted in Cartesian coordinates along with the design curves in order to determine performance. Refer to Digital Control of Dynamic Systems, Gene. F. Franklin and J. David Powell, Addison-Wesley, pp. 32 and 104 for the equations and graph. To calculate the data for the design curves, you can either use the provided sample data and graph, or begin a new notebook, enter your own data, and create your own graph using the data.
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E To use the sample worksheet and graph, double-click the graph page icon in the Z



Plane section of the Transform Examples notebook. The Z Plane worksheet appears with data in columns 1 through 10. The Z Plane graph page appears with the design curve data plotted over some sample root locus data. This plot uses columns 1 and 2 as the first curve and columns 3 and 4 as the second curve. E To use your own data, place your root locus, zero, and pole data in columns 1 through



10. If your locus data has been placed in other columns, you can change the location of the results columns after you open the ZPLANE.XFM file. E To plot the design curves of your data, create a Line Plot with Multiple Spline Curves,



then plot column 1 as the X data against column 2 as the Y data for the first curve and column 3 as the X data against column 4 as the Y data as the second curve. E Press F10 to open the User-Defined Transform dialog box, then click the Open button,



and open the ZPLANE.XFM transform in the XFMS directory. If necessary, change the res variable to the correct column number. E Click Run. The results are placed in columns 11 through 20, or the columns specified



by the res variable. E If you opened the Z Plane graph, view the page. The circle, frequency trajectory, and



damping trajectory data is automatically plotted with the design data. E To plot the circle data using SigmaPlot, create Multiple Line Plots with Simple Spline



Curves. For the first plot use column 11 as the X values versus column 12 as the Y values. E To plot the frequency trajectory data (zeta) plot column 13 versus column 14 and



column 15 versus column 16 as the XY pairs. E To plot the damping trajectory data (omega) plot column 17 versus column 18 and



column 19 versus column 20 as the XY pairs.
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Figure 16-18 Z Plane Graph Root Locus for Compensated Antenna Design 1.2
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17 Transform Function Reference SigmaPlot provides many predefined functions, including arithmetic, statistical, trigonometric, and number-generating functions. In addition, you can define functions of your own.



Function Arguments Function arguments are placed in parentheses following the function name, separated by commas. Arguments must be typed in the sequence shown for each function. You must provide the required arguments for each function first, followed by any optional arguments desired. Any omitted optional arguments are set to the default value. Optional arguments are always omitted from right to left. If only one argument is omitted, it will be the last argument. If two are omitted, the last two arguments are set to the default value. You can use a missing value (i.e., 0/0) as a placeholder to omit an argument. Example



The col function has three arguments: column, top, and bottom. Therefore, the syntax for the col function is: col(column,top,bottom) The column number argument is required, but the first (top) and last (bottom) rows are optional, defaulting to row 1 as the first row and the last row with data for the last row. col(2) returns the entirety of column 2. col(2,5) returns column 2 from row 5 to the end of the column. col(2,5,100) returns column 2 from row 5 to row 100. col(2,0/0,50) returns column 2 from row 1 to the 50th row in the column.



 630 Chapter 17



User-Defined Functions You can create any user-defined function, consisting of any expression in the transform language, and then refer to it by name. For example, the following transform defines the function dist2pts, which returns the distance between two points dist2pts(x1,y1,x2,y2) = sqrt((x2-x1)^2+(y2-y1)^2). You can then use this custom-defined function, instead of the expression to the right of the equal sign, in subsequent equations. For example, to plot the distances between two sets of XY coordinates, with the first points stored in columns 1 and 2, and the second in columns 3 and 4, enter: col(5) = dist2pts(col(1),col(2),col(3),col(4))



The resulting distances are placed in column 5.



Transform Function Descriptions The following list groups transforms by function type. It is followed by an alphabetical reference containing complete descriptions of all transform functions and their syntax, with examples.



Worksheet Functions These worksheet functions are used to specify cells and columns from the worksheet, either to read data from the worksheet for transformation, or to specify a destination for transform results. „ block. The block function returns a specified block of cells from the worksheet. „ blockheight, blockwidth. The blockheight and blockwidth functions return a specified



block of cells or block dimension from the worksheet. „ cell. The cell function returns a specific cell from the worksheet. „ col. The col function returns a worksheet column or a portion of a column. „ put into. The put into function places variable or equation results in a worksheet



column. „ subblock. The put into function places variable or equation results in a worksheet



column.
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Data Manipulation Functions The data manipulation functions are used to generate non-random data, and to sample, select, and sort data. „ data. The data function generates serial data. For more information, see “data” on



page 647. „ if. The if function conditionally selects between two data sets. For more



information, see “if” on page 656. „ nth. The nth function returns an incremental sampling of data. For more



information, see “nth” on page 671. „ sort. The sort function rearranges data in ascending order. For more information,



see “sort” on page 680.



Trigonometric Functions SigmaPlot and SigmaStat provide a complete set of trigonometric functions. „ arccos. This functions returns the arccosine, of the specified argument. For more



information, see “arccos” on page 639. „ arcsin. This functions returns the arcsine of the specified argument. For more



information, see “arcsin” on page 639. „ arctan. This functions returns the arctangent of the specified argument. For more



information, see “arctan” on page 640. „ cos. This function returns the cosine of the specified argument. For more



information, see “cos” on page 646. „ sin. This function returns the sine of the specified argument. For more information,



see “sin” on page 678. „ tan. This function returns the tangent of the specified argument. For more



information, see “tan” on page 684. „ cosh. This function returns the hyperbolic cosine of the specified argument. For



more information, see “cosh” on page 646. „ sinh. This function returns the hyperbolic sine of the specified argument. For more



information, see “sinh” on page 679. „ tanh. This function returns the hyperbolic tangent of the specified argument. For



more information, see “tanh” on page 685.
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Numeric Functions The numeric functions perform a specific type of calculation on a number or range of numbers and returns the appropriate results. „ abs. The abs function returns the absolute value. For more information, see “abs”



on page 637. „ exp. The exp function returns the values for e raised to the specified numbers. For



more information, see “exp” on page 649. „ factorial. The factorial function returns the factorial for each specified number. For



more information, see “factorial” on page 650. „ mod. The mod function returns the modulus, or remainder of division, for specified



numerators and divisors. For more information, see “mod” on page 670. „ ln. The ln function returns the natural logarithm for the specified numbers. For



more information, see “ln” on page 662. „ log. The log function returns the base 10 logarithm for the specified numbers. For



more information, see “log” on page 663. „ sqrt. The sqrt function returns the square root for the specified numbers. For more



information, see “sqrt” on page 681.



Range Functions The following functions give information on ranges. „ count. The count function returns the number of numeric values in a range. For



more information, see “count” on page 647. „ missing. The missing function returns the number of missing values and text strings



in a range. For more information, see “missing” on page 669. „ size. The size function returns the number of data points in a range, including all



numbers, missing values, and text strings.



Accumulation Functions The accumulation functions return values equal to the accumulated operation of the function.
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„ diff. The diff function returns the differences of the numbers in a range. For more



information, see “diff” on page 648. „ sum. The sum function returns the cumulative sum of a range of numbers. For more



information, see “sum” on page 684. „ total. The total function returns the value of the total sum of a range. For more



information, see “total” on page 685.



Random Generation Functions The two ""random" number generating functions can be used to create a series of normally or uniformly distributed numbers. „ gaussian. The Gaussian function is used to generate a series of normally (Gaussian



or "bell" shaped) distributed numbers with a specified mean and standard deviation. For more information, see “gaussian” on page 654. „ random. The random function is used to generate a series of uniformly distributed



numbers within a specified range. For more information, see “random” on page 674.



Precision Functions The precision functions are used to convert numbers to whole numbers or to round off numbers. „ int. The int function converts numbers to integers. For more information, see “int”



on page 658. „ prec. The prec function rounds numbers off to a specified number of significant



digits. For more information, see “prec” on page 673. „ round. The round function rounds numbers off to a specified number of decimal



places. For more information, see “round” on page 677.



Statistical Functions The statistical functions perform statistical calculations on a range or ranges of numbers.
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„ avg. The avg function calculates the averages of corresponding numbers across



ranges. It can be used to calculate the average across rows for worksheet columns. For more information, see “avg” on page 641. „ max. The max function returns the largest value in a range. For more information,



see “max” on page 668. „ min. The min function returns the smallest value in a range. For more information,



see “min” on page 669. „ mean. The mean function calculates the mean of a range. For more information, see



“mean” on page 668. „ runavg. The runavg function produces a range of running averages. For more



information, see “runavg” on page 677. „ stddev. The stddev function returns the standard deviation of a range. stderr The



stderr function calculates the standard error of a range. For more information, see “stddev” on page 682.



Area and Distance Functions These functions can be used to calculate the areas and distances specified by X,Y coordinates. Units are based on the units used for X and Y. „ area. The area function finds the area of a polygon described in X,Y coordinates.



For more information, see “area” on page 641. „ distance. The distance function calculates the distance of a line whose segments are



described in X,Y coordinates. „ partdist. The partdist function calculates the distances from an initial X,Y



coordinate to successive X,Y coordinates in a cumulative fashion. For more information, see “partdist” on page 671.



Curve Fitting Functions These functions are designed to be used in conjunction with SigmaPlot’s nonlinear curve fitter, to allow automatic determination of initial equation parameter estimates from the source data. You can use these functions to develop your own parameter determination function by using the functions provided with the Standard Regression Equations library provided with SigmaPlot.
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„ ape. This function is used for the polynomials, rational polynomials and other



functions which can be expressed as linear functions of the parameters. A linear least squares estimation procedure is used to obtain the parameter estimates. For more information, see “ape” on page 637. „ dsinp. This function returns an estimate of the phase in radians of damped sine



functions. For more information, see “dsinp” on page 649. „ fwhm. This function returns the x width of a peak at half the peak’s maximum value



for peak shaped functions. For more information, see “fwhm” on page 653. „ inv. The inv function generates the inverse matrix of an invertible square matrix



provided as a block. For more information, see “inv” on page 660. „ lowess. The lowess algorithm is used to smooth noisy data. "Lowess" means



locally weighted regression. Each point along the smooth curve is obtained from a regression of data points close to the curve point with the closest points more heavily weighted. For more information, see “lowess” on page 666. „ lowpass. The lowpass function returns smoothed y values from ranges of x and y



variables, using an optional user-defined smoothing factor that uses FFT and IFFT. For more information, see “lowpass” on page 667. „ sinp. This function returns an estimate of the phase in radians of sinusoidal



functions. For more information, see “sinp” on page 679. „ x25. This function returns the x value for the y value 25% of the distance from the



minimum to the maximum of smoothed data for sigmoidal shaped functions. For more information, see “x25” on page 686. „ x50. This function returns the x value for the y value 50% of the distance from the



minimum to the maximum of smoothed data for sigmoidal shaped functions. For more information, see “x50” on page 687. „ x75. This function returns the x value for the y value 75% of the distance from the



minimum to the maximum of smoothed data for sigmoidal shaped functions. For more information, see “x75” on page 687. „ xatymax. This function returns the x value for the maximum y in the range of y



coordinates for peak shaped functions. For more information, see “xatymax” on page 688. „ xwtr. This function returns x75-x25 for sigmoidal shaped functions. For more



information, see “xwtr” on page 689.
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Miscellaneous Functions These functions are specialized functions which perform a variety of operations. „ choose. The choose function is the mathematical "n choose r" function. For more



information, see “choose” on page 644. „ histogram. The histogram function generates a histogram from a range or column



of data. For more information, see “histogram” on page 654. „ interpolate. The interpolate function performs linear interpolation between X,Y



coordinates. For more information, see “interpolate” on page 659. „ polynomial. The polynomial function returns results for specified independent



variables for a specified polynomial equation. For more information, see “polynomial” on page 672. „ rgbcolor. The rgbcolor(r,g,b) color function takes arguments r,g, and b between 0



and 255 and returns color to cells in the worksheet. For more information, see “rgbcolor” on page 676.



Special Constructs Transform constructs are special structures that allow more complex procedures than functions. „ for. The for statement is a looping construct used for iterative processing. For more



information, see “for” on page 651. „ if...then...else. The if...then...else construct proceeds along one of two possible



series of procedures based on the results of a specified condition. For more information, see “if...then...else” on page 657.



Fast Fourier Transform Functions These functions are used to remove noise from and smooth data using frequency-based filtering. „ fft. The fft function finds the frequency domain representation of your data. For



more information, see “fft” on page 651. „ inv. fftThe invfft function takes the inverse fft of the data produced by the fft to



restore the data to its new filtered form. For more information, see “invfft” below.
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„ real. The real function strips the real numbers out of a range of complex numbers.



For more information, see “real” on page 675. „ img. The img function strips the imaginary numbers out of a range of complex



numbers. „ complex. The complex function converts a block of real and/or imaginary numbers



into a range of complex numbers. For more information, see “complex” on page 645. „ mulcpx. The mulcpx function multiplies two ranges of complex numbers together. „ invcpx. The invcpx takes the reciprocal of a range of complex numbers. For more



information, see “invcpx” on page 661.



abs The abs function returns the absolute value for each number in the specified range. Syntax abs(numbers)



The numbers argument can be a scalar or range of numbers. Any missing value or text string contained within a range is ignored and returned as the string or missing value. Example



The operation col(2) = abs(col(1)) places the absolute values of the data in column 1 in column 2.



ape The ape function is used for the polynomials, rational polynomials and other functions which can be expressed as linear functions of the parameters. A linear least squares estimation procedure is used to obtain the parameter estimates. The ape function is used to automatically generate the initial parameter estimates for SigmaPlot’s nonlinear curve fitter from the equation provided.
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Syntax ape(x range,y range,n,m,s,f)



The x range and y range arguments specify the independent and dependent variables, or functions of them (e.g., ln(x)). Any missing value or text string contained within one of the ranges is ignored and will not be treated as a data point. x range and y range must be the same size. The n argument specifies the order of the numerator of the equation. The m argument specifies the order of the denominator of the equation. n and m must be greater than or equal to 0 (n, m, ≥ 0). If m is greater than 0 then n must be less than or equal to m (if m > 0, n ≤ m). The s argument specifies whether or not a constant is used. s=0 specifies no constant term y0 in the numerator, s=1 specifies a constant term y0 in the numerator. s must be either 0 or 1. If n = 0, s cannot be 0 (there must be a constant). The number of valid data points must be greater than or equal to n = m = s. The optional f argument defines the amount of Lowess smoothing, and corresponds to the fraction of data points used for each regression. f must be greater than or equal to 0 and less than or equal to 1. 0 ≤ f ≤ 1. If f is omitted, no smoothing is used. Example



For x = {0,1,2}, y={0,1,4}, the operation col(1)=ape(x,y,1,1,1,0.5] ) places the 3 parameter estimates for the equation



a + bx f ( x ) = --------------1 + cx as the values {5.32907052e-15, 0.66666667, -0.33333333} in column 1.



 639 Transform Function Reference



arccos This function returns the inverse of the corresponding trigonometric function. Syntax arccos(numbers)



The numbers argument can be a scalar or range. You can also use the abbreviated function name acos. The values for the numbers argument must be within -1 and 1, inclusive. Results are returned in degrees, radians, or grads, depending on the Trigonometric Units selected in the User-Defined Transform dialog box. Any missing value or text string contained within a range is ignored and returned as the string or missing value. The function range (in radians) is:



arccos



0to π



Example



The operation col(2) = acos(col(1)) places the arccosine of all column 1 data points in column 2.



arcsin This function returns the inverse of the corresponding trigonometric function. Syntax arcsin(numbers)



The numbers argument can be a scalar or range. You can also use the abbreviated function name asin.
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The values for the numbers argument must be within -1 and 1, inclusive. Results are returned in degrees, radians, or grads, depending on the Trigonometric Units selected in the User-Defined Transform dialog box. Any missing value or text string contained within a range is ignored and returned as the string or missing value. The function range (in radians) is:



π–π --- to -2 2



arcsin



Example



The operation col(2) = asin(col(1)) places the arcsine of all column 1 data points in column 2.



arctan This function returns the inverse of the corresponding trigonometric function. Syntax arctan(numbers)



The numbers argument can be a scalar or range. You can also use the abbreviated function name atan. The numbers argument can be any value. Results are returned in degrees, radians, or grads, depending on the Trigonometric Units selected in the User-Defined Transform dialog box. The function range (in radians) is:



arctan



π–π --- to -2 2
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Example



The operation col(2) = atan(col(1)) places the arctangent of all column 1 data points in column 2. Note: A convenient way of obtaining the value of ∈ is ∈ = 4 + atan(1).



area The area function returns the area of a simple polygon. The outline of the polygon is formed by the xy pairs specified in an x range and a y range. The list of points does not need to be closed. If the last xy pair does not equal the first xy pair, the polygon is closed from the last xy pair to the first. The area function only works with simple nonoverlapping polygons. If line segments in the polygon cross, the overlapping portion is considered a negative area, and results are unpredictable. Syntax area(x range,y range)



The x range argument contains the x coordinates, and the y range argument contains the y coordinates. Corresponding values in these ranges form xy pairs. If the ranges are uneven in size, excess x or y points are ignored. Example



For the ranges x = {0,1,1,0} and y = {0,0,1,1}, the operation area (x,y) returns a value of 1. The x and y coordinates provided describe a square of 1 unit.



avg The avg function averages the numbers across corresponding ranges, instead of within ranges. The resulting range is the row-wise average of the range arguments. Unlike the mean function, avg returns a range, not a scalar.
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The avg function calculates the arithmetic mean, defined as: n



x = 1--n-



∑x



i



i=1



The avg function can be used to calculate averages of worksheet data across rows rather than within columns. Syntax



avg({x1,x2...},{y1,y2...},{z1,z2...}) The x1, y1, and z1 are corresponding numbers within ranges. Any missing value or text string contained within a range returns the string or missing value as the result. Example



The operation avg({1,2,3},{3,4,5}) returns {2,3,4}. 1 from the first range is averaged with 3 from the second range, 2 is averaged with 4, and 3 is averaged with 5. The result is returned as a range.



block The block function returns a block of cells from the worksheet, using a range specified by the upper left and lower right cell row and column coordinates. Syntax block(column 1,row 1,column 2,row 2)



The column 1 and row 1 arguments are the coordinates for the upper left cell of the block; the column 2 and row 2 arguments are the coordinates for the lower right cell of the block. All values within this range are returned. Operations performed on a block always return a block.
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If column 2 and row 2 are omitted, then the last row and/or column is assumed to be the last row and column of the data in the worksheet. If you are equating a block to another block, then the last row and/or column is assumed to be the last row and column of the equated block (see the following example). All column and row arguments must be scalar (not ranges). To use a column title for the column argument, enclose the column title in quotes; block uses the column in the worksheet whose title matches the string. Example



The command block(5,1) = -block(1,1,3,24) reverses the sign for the values in the range from cell (1,1) to cell (3,24) and places them in a block beginning in cell (5,1).



blockheight, blockwidth The blockheight and blockwidth functions return the number of rows or columns, respectively, of a defined block of cells from the worksheet. Syntax blockheight(block) blockwidth(block)



The block argument can be a variable defined as a block, or a block function statement. Example



For the statement x = block(2,1,12,10) The operation cell(1,1) = blockheight(x) places the number 10 in column 1, row 1 of the worksheet. The operation cell(1,2) = blockwidth(x) places the number 11 in column 1, row 2 of the worksheet.
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cell The cell function returns the contents of a cell in the worksheet, and can specify a cell destination for transform results. Syntax cell (column,row)



Both column and row arguments must be scalar (not ranges). To use a column title for the column argument, enclose the column title in quotes; cell uses the column in the worksheet whose title matches the string. Data placed in a cell inserts or overwrites according to the current insert mode.



choose The choose function determines the number of ways of choosing r objects from n distinct objects without regard to order. Syntax choose(n,r)



For the arguments n and r, r < n and "n choose r" is defined as: n!  n = --------------------- r r! ( n – r )!



Example



To create a function for the binomial distribution, enter the equation: binomial(p,n,r) = choose(n,r) * (p^r) * (1-p) ^ (n-r)
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col The col function returns all or a portion of a worksheet column, and can specify a column destination for transform results. Syntax col (column,top,bottom)



The column argument is the column number or title. To use a column title for the column argument, enclose the title in quotation marks. The top and bottom arguments specify the first and last row numbers, and can be omitted. The default row numbers are 1 and the end of the column, respectively; if both are omitted, the entire column is used. All parameters must be scalar. Data placed in a column inserts or overwrites according to the current insert mode.



complex Converts a block of real and imaginary numbers into a range of complex numbers. Syntax complex (range,range)



The first range contains the real values, the second range contains the imaginary values and is optional. If you do not specify the second range, the complex transform returns zeros for the imaginary numbers. If you do specify an imaginary range, it must contain the same number of values as the real value range. Example



If x = {1,2,3,4,5,6,7,8,9,10}, the operation complex(x) returns {{1,2,3,4,....,9,10}, {0,0,0,0,....,0,0}}. If x = {1.0,-0.75,3.1} and y = {1.2,2.1,-1.1}, the operation complex(x,y) returns {{1.0,0.75,3.1}, {1.2,2.1,-1.1}}.



 646 Chapter 17



cos This function returns ranges consisting of the cosine of each value in the argument given. This and other trigonometric functions can take values in radians, degrees, or grads. This is determined by the Trigonometric Units selected in the User-Defined Transform dialog box. Syntax cos(numbers)



The numbers argument can be a scalar or range. If you regularly use values outside of the usual -2π to 2π (or equivalent) range, use the mod function to prevent loss of precision. Any missing value or text string contained within a range is ignored and returned as the string or missing value. Example



If you choose Degrees as your Trigonometric Units in the User-Defined Transform dialog box, the operation cos({0,60,90,120,180}) returns values of {1,0.5,0,-0.5,-1}.



cosh This function returns the hyperbolic cosine of the specified argument. Syntax cosh(numbers)



The numbers argument can be a scalar or range. Any missing value or text string contained within a range is ignored and returned as the string or missing value.
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Example



The operation x = cosh(col(2)) sets the variable x to be the hyperbolic cosine of all data in column 2.



count The count function returns the value or range of values equal to the number of nonmissing numeric values in a range. Missing values and text strings are not counted. Syntax count(range)



The range argument must be a single range (indicated with the {} brackets) or a worksheet column.



data The data function generates a range of numbers from a starting number to an end number, in specified increments. Syntax data(start,stop,step)



All arguments must be scalar. The start argument specifies the beginning number and the end argument sets the last number. If the step parameter is omitted, it defaults to 1. The start parameter can be more than or less than the stop parameter. In either case, data steps in the correct direction. Remainders are ignored. Example



The operation data(1,5) returns the range of values {1,2,3,4,5}.
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The operation data(10,1,2) returns the values {10,8,6,4,2}. Note: If start and stop are equal, this function produces a number of copies of start equal to step. For example, the operation data(1,1,4) returns {1,1,1,1}.



diff The diff function returns a range or ranges of numbers which are the differences between a given number in a range and the preceding number. The value of the preceding number is subtracted from the value of the following number. Because there is no preceding number for the first number in a range, the value of the first number in the result is always the same as the first number in the argument range. Syntax diff(range)



The range argument must be a single range (indicated with the {} brackets) or a worksheet column. Any missing value or text string contained within the range is returned as the string or missing value. Example



For x = {9,16,7}, the operation diff(x) returns a value of {9,7,-9}. For y = {4,-6,12}, the operation diff(y) returns a value of {4,-10,18}.



dist The dist function returns a scalar representing the distance along a line. The line is described in segments defined by the X,Y pairs specified in an x range and a y range.
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Syntax dist(x range,y range)



The x range argument contains the X coordinates, and the y range argument contains the Y coordinates. Corresponding values in these ranges form X,Y pairs. If the ranges are uneven in size, excess X or Y points are ignored. Example



For the ranges x ={0,1,1,0,0} and y = {0,0,1,1,0}, the operation dist(x,y) returns 4.0. The X and Y coordinates provided describe a square of 1 unit x by 1 unit y.



dsinp The dsinp function automatically generates the initial parameter estimates for a damped sinusoidal functions using the FFT method. The four parameter estimates are returned as a vector. Syntax dsinp(x range, y range)



The x range argument specifies the x variable, and the y range argument specifies the y variable. Any missing value or text string contained within one of the ranges is ignored and will not be treated as a data point. x range and y range must be the same size, and the number of valid data points must be greater than or equal to 3. Note: dsinp is especially used to estimate parameters on waveform functions. This is only useful when this function is used in conjunction with nonlinear regression.



exp The exp function returns a range of values consisting of the number e raised to each number in the specified range. This is numerically identical to the expression e^(numbers).
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Syntax exp(numbers)



The numbers argument can be a scalar or range of numbers. Any missing value or text string contained within a range is ignored and returned as the string or missing value. Example



The operation exp(1) returns a value of 2.718281828459045.



factorial The factorial function returns the factorial of a specified range. Syntax factorial({range})



The range argument must be a single range (indicated with the {} brackets) or a worksheet column. Any missing value or text string contained within a range is ignored and returned as the string or missing value. Non-integers are rounded down to the nearest integer or 1, whichever is larger. For factorial(x): x < 0 returns a missing value, 0 ≤ x < 180 returns x!, and x ≥170 returns +∞ Example 1



The operation factorial({1,2,3,4,5}) returns {1,2,6,24,120}.
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Example 2



To create a transform equation function for the Poisson distribution, you can type: Poisson(m,x)=(m^x)*exp(-m)/factorial(x)



fft The fft function finds the frequency domain representation of your data using the Fast Fourier Transform. Syntax fft(range)



The parameter can be a range of real values or a block of complex values. For complex values there are two columns of data. The first column contains the real values and the second column represents the imaginary values. This function works on data sizes of size 2n numbers. If your data set is not 2n in length, the fft function pads 0 at the beginning and end of the data range to make the length 2n. The fft function returns a range of complex numbers. Example



For x = {1,2,3,4,5,6,7,8,9,10}, the operation fft(x) takes the Fourier transform of the ramp function with real data from 1 to 10 with 3 zeros padded on the front and back and returns a 2 by 16 block of complex numbers.



for The for statement is a looping construct used for iterative processing.
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Syntax for loop variable = initial value to end value step increment do equation equation . . . end for



Transform equation statements are evaluated iteratively within the for loop. When a for statement is encountered, all functions within the loop are evaluated separately from the rest of the transform. The loop variable can be any previously undeclared variable name. The initial value for the loop is the beginning value to be used in the loop statements. The end value for the loop variable specifies the last value to be processed by the for statement. After the end value is processed, the loop is terminated. In addition, you can specify a loop variable step increment, which is used to "skip" values when proceeding from the initial value to end value. If no increment is specified, an increment of 1 is assumed. Note: You must separate for, to, step, do, end for, and all condition statement operators, variables and values with spaces. The for loop statement is followed by a series of one or more transform equations which process the loop variable values. Inside for loops, you can: „ Indent equations. „ Nest for loops.



Note that these conditions are allowed only within for loops. You cannot redefine variable names within for loops. Example 1



The operation: for i = 1 to size(col(1)) do cell(2,i) = cell(1,i)*i end for
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multiplies all the values in column 1 by their row number and places them in column 2. Example 2



The operation: for j = cell(1,1) to cell (1,64) step 2 do col(10) = col(9)^j end for



takes the value from cell (1,1) and increments by 2 until the value in cell (1,64) is reached, raises the data in column 9 to that power, and places the results in column 10.



fwhm The fwhm function returns value of the x width at half-maxima in the ranges of coordinates provided, with optional Lowess smoothing. Syntax fwhm(x range, y range,f)



The x range argument specifies the x variable, and the y range argument specifies the y variable. Any missing value or text string contained within one of the ranges is ignored and will not be treated as a data point. x range and y range must have the same size, and the number of valid data points must be greater than or equal to 3. The optional f argument defines the amount of Lowess smoothing, and corresponds to the fraction of data points used for each regression. f must be greater than or equal to 0 and less than or equal to 1. 0 ≤ f ≤ 1. If f is omitted, no smoothing is used. Example



For x = {0,1,2}, y={0,1,4}, the operation col(1)=fwhm(x,y)
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places the x width at half-maxima 1.00 into column 1.



gaussian This function generates a specified number of normally (Gaussian or "bell" shaped) distributed numbers from a seed number, using a supplied mean and standard deviation. Syntax gaussian(number,seed,mean,stddev)



The number argument specifies how many random numbers to generate. The seed argument is the random number generation seed to be used by the function. If you want to generate a different random number sequence each time the function is used, enter 0/0 for the seed. Enter the same number to generate an identical random number sequence. If the seed argument is omitted, a randomly selected seed is used. The mean and stddev arguments are the mean and standard deviation of the normal distribution curve, respectively. If mean and stddev are omitted, they default to 0 and 1. Note that function arguments are omitted from right to left. If you want to specify a stddev, you must either specify the mean argument or omit it by using 0/0. Example



The operation gaussian(100) uses a seed of 0 to produce 100 normally distributed random numbers, with a mean of 0.0 and a standard deviation of 1.0.



histogram The histogram function produces a histogram of the values range in a specified range, using a defined interval set.
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Syntax histogram(range,buckets)



The range argument must be a single range (indicated with the {} brackets) or a worksheet column. Any missing value or text string contained within a range is ignored. The buckets argument is used to specify either the number of evenly incremented histogram intervals, or both the number and ranges of the intervals. This value can be scalar or a range. In both versions, missing values and strings are ignored. If the buckets parameter is a scalar, it must be a positive integer. A scalar buckets argument generates a number of intervals equal to the buckets value. The histogram intervals are evenly sized; the range is the minimum value to the maximum value of the specified range. If the buckets argument is specified as a range, each number in the range becomes the upper bound (inclusive) of an interval. Values from -∞ to ≤ the first bucket fall in the first histogram interval, values from > first bucket to ≤ second bucket fall in the second interval, etc. The buckets range must be strictly increasing in value. An additional interval is defined to catch any value which does not fall into the defined ranges. The number of values occurring in this extra interval (including 0, or no values outside the range) becomes the last entry of the range produced by histogram function. Example 1



For col(1) = {1,20,30,35,40,50,60}, the operation col(2) = histogram(col(1),3) places the range {2,3,2} in column 2. The bucket intervals are automatically set to 20, 40, and 60, so that two of the values in column 1 fall under 20, three fall under 40, and two fall under 60. Example 2



For buckets = {25,50,75}, the operation col(3) = histogram(col(1),buckets)places {2,4,1,0} in col(3). Two of the values in column 1 fall under 25, four fall under 50, one under 75, and no values fall outside the range.
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if The if function either selects one of two values based on a specified condition, or proceeds along a series of calculations bases on a specified condition. Syntax if(condition,true value,false value)



The true value and false value arguments can be any scalar or range. For a true condition, the true value is returned; for a false condition, the false value is returned. If the false value argument is omitted, a false condition returns a missing value. If the condition argument is scalar, then the entire true value or false value argument is returned. If the condition argument contains a range, the result is a new range. For each true entry in the condition range, the corresponding entry in the true value argument is returned. For a false entry in the condition range, the corresponding entry in false value is returned. If the false value is omitted and the condition entry is false, the corresponding entry in the true value range is omitted. This can be used to conditionally extract data from a range. Example 1



The operation col(2) = if(col(1)< 75,"FAIL","PASS") reads in the values from column 1, and places the word "FAIL" in column 2 if the column 1 value is less than 75, and the word "PASS" if the value is 75 or greater. Example 2



For the operation y = if(x < 2 or x > 4,99,x), an x value less than 2 or greater than 4 returns a y value of 99, and all other x values return a y value equal to the corresponding x value.
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If you set x = {1,2,3,4,5}, then y is returned as {99,2,3,4,99}. The condition was true for the first and last x range entries, so 99 was returned. The condition was false for x = 2, 3, and 4, so the x value was returned for the second, third, and fourth x values.



if...then...else The if...then...else function proceeds along one of two possible series of calculations based on a specified condition. Syntax if condition then statement statement... else statement statement... end if



To use the if...then...else construct, follow the if condition then statement by one or more transform equation statements, then specify the else statement(s). When an if...then...else statement is encountered, all functions within the statement are evaluated separately from the rest of the transform. Note: You must separate if, then, and all condition statement operators, variables, and values with spaces. Inside if...then...else constructs, you can: „ Type more than one equation on a line „ Indent equations. „ Nest additional if constructs.



Note that these conditions are allowed only within if...else statements. You cannot redefine variable names within an if...then...else construct.
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Example



The operations: i = cell(1,1) j = cell(1,2 If i < 1 and j > 1 then x = col(3) else x = col(4) end if



sets x equal to column 3 if i is less than 1 and j is greater than 1; otherwise, x is equal to column 4.



imaginary (img) The imaginary function strips the imaginary values out of a range of complex numbers. Syntax img(block)



The range is made up of complex numbers. Example



If x = {{1,2,3,4,5,6,7,8,9,10}, {0,0,0,....0,0}}, the operation img(x) returns {0,0,0,0,0,0,0,0,0,0}. If x = {{1.0,-0.75, 3.1}, {1.2,2.1,-1.1}}, the operation img(x) returns {1.2,2.1,-1.1}.



int The int function returns a number or range of numbers equal to the largest integer less than or equal to each corresponding number in the specified range. All numbers are rounded down to the nearest integer.
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Syntax int(numbers)



The numbers argument can be a scalar or range of numbers. Any missing value or text string contained within a range is ignored and returned as the string or missing value. Example



The operation int({.9,1.2,2.2,-3.8}) returns a range of {0.0,1.0,2.0,-4.0}.



interpolate The interpolate function performs linear interpolation on a set of X,Y pairs defined by an x range and a y range. The function returns a range of interpolated y values from a range of values between the minimum and maximum of the x range. Syntax interpolate(x range,y range,range)



Values in the x range argument must be strictly increasing or strictly decreasing. The range argument must be a single range (indicated with the {} brackets) or a worksheet column. Missing values and text strings are not allowed in the x range and y range. Text strings in range are replaced by missing values. Extrapolation is not possible; missing value symbols are returned for range argument values less than the lowest x range value or greater than the highest x range value. Example



For x = {0,1,2}, y = {0,1,4}, and range = data(0,2,.5) (this data operation returns numbers from 0 to 2 at increments of 0.5), the operation col(1) = interpolate(x,y,range) places the range {0.0,0.5,1.0,2.5,4.0} into column 1.
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If range had included values outside the range for x, missing values would have been returned for those out-of-range values.



inv The inv function generates the inverse matrix of an invertible square matrix provided as a block. Syntax inv(block)



The block argument is a block of numbers with real values in the form of a square matrix. The number of rows must equal the number of columns. The function returns a block of numbers with real values in the form of the inverse of the square matrix provided. Example



For the matrix: : 1.00



3.00



4.00



2.00



1.00



3.00



3.00



4.00



2.00



in block(2,3,4,5) the operation block(2,7)=inv(block(2,3,4,5)) generates the inverse matrix: -0.40



0.40



0.20



0.20



-0.40



0.20



0.20



0.20



-0.20



in block (2,7,4,9).
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invcpx This function takes the reciprocal of a range of complex numbers. Syntax invcp(block)



The input and output are blocks of complex numbers. The invcpx function returns the range 1/c for each complex number in the input block. Example



If x = complex ({3,0,1}, {0,1,1}), the operation invcpx(x) returns {{0.33333, 0.0, 0.5}, {0.0,-1.0,-0.5}}.



invfft The inverse fft function (invfft) takes the inverse Fast Fourier Transform (fft) of the data produced by the fft to restore the data to its new filtered form. Syntax invfft(block)



The parameter is a complex block of spectral numbers with the real values in the first column and the imaginary values in the second column. This data is usually generated from the fft function. The invfft function works on data sizes of size 2n numbers. If your data set is not 2n in length, the invfft function pads 0 at the beginning and end of the data range to make the length 2n. The function returns a complex block of numbers.
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Example



If x = {{1,2,3,...,9,10}, {0,0,0,...,0,0}}, the operation invfft(fft(x)) returns {{0,0,0,1,2,3,...,9,10,0,0,0}, {0,0,0,...0,0}.



ln The ln function returns a value or range of values consisting of the natural logarithm (base e) of each number in the specified range. Syntax ln(numbers)



The numbers argument can be a scalar or range of numbers. Any missing value or text string contained within a range is ignored and returned as the string or missing value. For ln(x): x < 0 returns an error message, and x = 0 returns -∞



The largest value allowed is approximately x < 10309. Example



The operation ln(2.71828) returns a value ≈ 1.0.
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log The log function returns a value or range of values consisting of the base 10 logarithm of each number in the specified range. Syntax log(numbers)



The numbers argument can be a scalar or range of numbers. Any missing value or text string contained within a range is ignored and returned as the string or missing value. For log(x): x < 0 returns an error message, x = 0 returns -∞



The largest value allowed is approximately x < 10309. Example



The operation log(100) returns a value of 2.



lookup The lookup function compares values with a specified table of boundaries and returns either a corresponding index from a one-dimensional table, or a corresponding value from a two-dimensional table. Syntax lookup(numbers,x table,y table)



The numbers argument is the range of values looked up in the specified x table. The x table argument consists of the upper bounds (inclusive) of the x intervals within the
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table and must be ascending in value. The lower bounds are the values of the previous numbers in the table (-∞for the first interval). You must specify numbers and an x table. If only the numbers and x table arguments are specified, the lookup function returns an index number corresponding to the x table interval; the interval from -∞to the first boundary corresponds to an index of 1, the second to 2, etc. If a number value is larger than the last entry in x table, lookup will return a missing value as the index. You can avoid missing value results by specifying 1/0 (infinity) as the last value in x table. The optional y table argument is used to assign y values to the x index numbers. The y table argument must be the same size as the x table argument, but the elements do not need to be in any particular order. If y table is specified, lookup returns the y table value corresponding to the x table index value, i.e., the first y table value for an index of 1, the second y table value for an index of 2, etc. Note: The x table and y table ranges correspond to what is normally called a "lookup table." Example 1



For n={-4,11,31} and x={1,10,30}, col(1)=lookup(n,x)places the index values of 1, 3, and -- (missing value) in column 1.



index #



1



2



3



x table



1



10



30



-4 11 31 —— (missing value)



-4 falls beneath 1, or the first x boundary; 11 falls beyond 10 but below 30, and 31 lies beyond 30.
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Example 2



To generate triplet values for the range {9,6,5}, you can use the expression lookup(data(1/3,3,1/3),data(1,3),{9,6,5}) to return {9,9,9,6,6,6,5,5,5}. This looks up the numbers 1/3, 2/3, 1, 1 1/3, 1 2/3, 2, 2 1/3, 2 2/3, and 3 using x table boundaries 1, 2, and 3 and corresponding y table values 9, 6, and 5. y table



9



6



5



x table



1



2



3



1/3 2/3



1 1 1/3 1 2/3 2 2 1/3 2 2/3 3
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lowess The lowess function returns smoothed y values as a range from the ranges of x and y variables provided, using a user-defined smoothing factor. "Lowess" means locally weighted regression. Each point along the smooth curve is obtained from a regression of data points close to the curve point with the closest points more heavily weighted. Syntax lowess(x range, y range, f )



The x range argument specifies the x variable, and the y range argument specifies the y variable. Any missing value or text string contained within one of the ranges is ignored and will not be treated as a data point. x range and y range must be the same size, and the number of valid data points must be greater than or equal to 3. The f argument defines the amount of Lowess smoothing, and corresponds to the fraction of data points used for each regression. f must be greater than or equal to 0 and less than or equal to 1. 0 ≤ f ≤ 1. Note that unlike lowpass, lowess requires an f argument. Example



For x = {1,2,3,4}, y={0.13, 0.17, 0.50, 0.60}, the operation col(1)=lowess(x,y,1)
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places the smoothed y data 0.10, 0.25, 0.43, 0.63 into column 1.



lowpass The lowpass function returns smoothed y values from ranges of x and y variables, using an optional user-defined smoothing factor that uses FFT and IFFT. Syntax lowpass(x range, y range, f )



The x range argument specifies the x variable, and the y range argument specifies the y variable. Any missing value or text string contained within one of the ranges is ignored and will not be treated as a data point. x range and y range must be the same size, and the number of valid data points must be greater than or equal to 3. The optional f argument defines whether FFT and IFFT are used. f must be greater than or equal to 0 and less than or equal to 100 ( 0 ≤ f ≤ 100 ). If f is omitted, no Fourier transformation is used. Note: lowpass is especially designed to perform smoothing on waveform functions as a part of nonlinear regression. Example



For x = {0,1,2}, y={0,1,4}, the operation col(1)=lowpass(x,y,88)



places the newly smoothed data 0.25, 1.50, 2.25 into column 1.
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max The max function returns the largest number found in the range specified. Syntax max(range)



The range argument must be a single range (indicated with the { } brackets) or a worksheet column. Any missing value or text string contained within a range is ignored. Example



For x = {7,4,-4,5}, the operation max(x) returns a value of 7, and the operation min(x) returns a value of -4.



mean The mean function returns the average of the range specified. Use this function to calculate column averages (as opposed to using the avg function to calculate row averages). The mean function calculates the arithmetic mean, defined as: n



x = --n1-



∑x



i



i=1



Syntax mean(range)



The range argument must be a single range (indicated with the { } brackets) or a worksheet column. Any missing value or text string contained within a range is ignored.
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Example



The operation mean({1,2,3,4}) returns a value of 2.5.



min The min function returns the smallest number in the range specified. Syntax min(range)



The range argument must be a single range (indicated with the { } brackets) or a worksheet column. Any missing value or text string contained within a range is ignored. Example



For x = {7,4,-4,5}, the operation max(x) returns a value of 7, and the operation min(x)returns a value of -4.



missing The missing function returns a value or range of values equal to the number of missing values and text strings in the specified range. Syntax missing(range)



The range argument must be a single range (indicated with the { } brackets) or a worksheet column.
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mod The mod function returns the modulus (the remainder from division) for corresponding numbers in numerator and divisor arguments. This is the real (not integral) modulus, so both ranges may be nonintegral values. Syntax mod(numerator,divisor)



The numerator and divisor arguments can be scalars or ranges. Any missing value or text string contained within a range is returned as the string or missing value.



-----------------For any divisor ≠ 0, the mod function returns the remainder of numerator divisor



For mod(x,0), that is, for divisor = 0, x > 0 returns + ∞ x = 0 returns + ∞ x < 0 returns - ∞



Example



The operation mod({4,5,4,5},{2,2,3,3}) returns the range {0,1,1,2}. These are the remainders for 4÷ 2, 5÷ 2, 4÷ 3, and 5÷ 3.



mulcpx The mulcpx function multiplies two blocks of complex numbers together. Syntax mulcpx(block, block)
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Both input blocks should be the same length. The mulcpx function returns a block that contains the complex multiplication of the two ranges. Example



If u = {{1,1,0},{0,1,1}}, the operation mulcpx(u,u) returns {{1,0,-1}, {0,2,0}}.



nth The nth function returns a sampling of a provided range, with the frequency indicated by a scalar number. The result always begins with the first entry in the specified range. Syntax nth(range,increment)



The range argument is either a specified range (indicated with the {} brackets) or a worksheet column. The increment argument must be a positive integer. Example



The operation col(1)=nth({1,2,3,4,5,6,7,8,9,10},3) places the range {1,4,7,10} in column 1. Every third value of the range is returned, beginning with 1.



partdist The partdist function returns a range representing the distance from the first X,Y pair to each other successive pair. The line segment X,Y pairs are specified by an x range and a y range. The last value in this range is numerically the same as that returned by dist, assuming the same x and y ranges. Syntax partdist(x range,y range)
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The x range argument specifies the x coordinates, and the y range argument specifies the y coordinates. Corresponding values in these ranges form xy pairs. If the ranges are uneven in size, excess x or y points are ignored. Example



For the ranges x = {0,1,1,0,0} and y = {0,0,1,1,0}, the operation partdist(x,y) returns a range of {0,1,2,3,4}. The X and Y coordinates provided describe a square of 1 unit x by 1 unit y.



polynomial The polynomial function returns the results for independent variable values in polynomials. Given the coefficients, this function produces a range of y values for the corresponding x values in range. The function takes one of two forms. The first form has two arguments, both of which are ranges. Values in the first range are the independent variable values. The second range represents the coefficients of the polynomial, with the constant coefficient listed first, and the highest order coefficient listed last. The second form accepts two or more arguments. The first argument is a range consisting of the independent variable values. All successive arguments are scalar and represent the coefficients of a polynomial, with the constant coefficient listed first and the highest order coefficient listed last. Syntax polynomial(range,coefficents) or polynomial(range,a0,a1,...,an)



The range argument must be a single range (indicated with the { } brackets) or a worksheet column. Text strings contained within a range are returned as a missing value.
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The coefficients argument is a range consisting of the polynomial coefficient values, from lowest to highest. Alternately, the coefficients can be listed individually as scalars. Example



To evaluate the polynomial y = x2 + x + 1 for x values of 0, 1, and 2, type the equation polynomial({0,1,2},1,1,1). Alternately, you could set x ={1,1,1}, then enter polynomial({0,1,2},x). Both operations return a range of {1,3,7}.



prec The prec function rounds a number or range of numbers to the specified number of significant digits, or places of significance. Values are rounded to the nearest integer; values of exactly 0.5 are rounded up. Syntax prec(numbers,digits)



The numbers argument can be a scalar or range of numbers. Any missing value or text string contained within a range is ignored and returned as the string or missing value. If the digits argument is a scalar, all numbers in the range have the same number of places of significance. If the digits argument is a range, the number of places of significance vary according to the corresponding range values. If the size of the digits range is smaller than the numbers range, the function returns missing values for all numbers with no corresponding digits. Example



For x = {13570,3.141,.0155,999,1.92}, the operation prec(x,2) returns {14000,3.100,.0160,1000,1.90}.
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For y = {123.5,123.5,123.5,123.5}, the operation prec(y,{1,2,3,4}) returns {100.0, 120.0,124.0,123.5}.



put into The put into function places calculation results in a designated column on the worksheet. It operates faster than the equivalent equality relationship. Syntax put results into col(column)



The results argument can be either the result of an equation, function or variable. The column argument is either the column number of the destination column, or the column title, enclosed in quotes. Data put into columns inserts or overwrites according to the current insert mode. Example



To place the results of the equation y = data(1,100) in column 1, you can type col(1) = y. However, entering put y into col(1) runs faster.



random This function generates a specified number of uniformly distributed numbers within the range. Rand and rnd are synonyms for the random function. Syntax random(number,seed,low,high)



The number argument specifies how many random numbers to generate.
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The seed argument is the random number generation seed to be used by the function. If you want to generate a different random number sequence each time the function is used, enter 0/0 for the seed. If the seed argument is omitted, a randomly selected seed is used. The low and high arguments specify the beginning and end of the random number distribution range. The low boundary is included in the range. If low and high are omitted, they default to 0 and 1, respectively. Note: Function arguments are omitted from right to left. If you want to specify a high boundary, you must specify the low boundary argument first. Example



The operation random(50,0/0,1,7) produces 50 uniformly distributed random numbers between 1 and 7. The sequence is different each time this random function is used.



real The real function strips the real values from a complex block of numbers. Syntax real (range)



The range argument consists of complex numbers. Example



If x = complex ({1,2,3,...,9,10}, {0,0,...,0}), the operation real(x)returns {1,2,3,4,5,6,7,8,9,10}, leaving the imaginary values out.
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rgbcolor The transform function rgbcolor takes arguments r, g, and b between 0 and 255 and returns the corresponding color to cells in the worksheet. This function can be used to apply custom colors to any element of a graph or plot that can use colors chosen from a worksheet column. Syntax rgbcolor(r,g,b)



The r,g,b arguments define the red, green, and blue intensity portions of the color. These values must be scalars between 0 and 255. Numbers for the arguments less than 0 or greater than 255 are truncated to these values. Example



The operation rgbcolor(255,0,0) returns red. The operation rgbcolor(0,255,0) returns green. The operation rgbcolor(0,0,255) returns blue. The following statements place the secondary colors yellow, magenta, and cyan into rows 1, 2, and 3 into column 1: cell(1,1)=rgbcolor(255,255,0) cell(1,2)=rgbcolor(255,0,255) cell(1,3)=rgbcolor(0,255,255)



Shades of gray are generated using equal arguments. To place black, gray, and white in the first three rows of column 1: cell(1,1)=rgbcolor(0,0,0) cell(1,3)=rgbcolor(255,255,255)cell(1,2)=rgbcolor(127,127,127)
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round The round function rounds a number or range of numbers to the specified decimal places of accuracy. Values are rounded up or down to the nearest integer; values of exactly 0.5 are rounded up. Syntax round(numbers,places)



The numbers argument can be a scalar or range of numbers. Any missing value or text string contained within a range is ignored and returned as the string or missing value. If the places argument is negative, rounding occurs to the left of the decimal point. To round to the nearest whole number, use a places argument of 0. Example



The operation round(92.1541,2) returns a value of 92.15. The operation round(0.19112,1) returns a value of 0.2. The operation round(92.1541,-2) returns a value of 100.0.



runavg The runavg function produces a range of running averages, using a window of a specified size as the size of the range to be averaged. The resulting range is the same length as the argument range. Syntax runavg(range,window)



The range argument must be a single range (indicated with the {} brackets) or a worksheet column. Any missing value or text string contained within a range is replaced with 0.
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If the window argument is even, the next highest number is used. The tails of the ( w i n dodd ow – 1 ) - additional initial and final running average are computed by appending ----------------------2 values to their respective ends of range. Example



The operation runavg({1,2,3,4,5},3) returns {1.33,2,3,4,4.67}. The value of the window argument is 3, so the first result value is calculated as: (3 – 1) ---------------- + 1 + 2 2 ----------------------------------3 The second value is calculated as:



1+2+3 --------------------3



sin This function returns ranges consisting of the sine of each value in the argument given. This and other trigonometric functions can take values in radians, degrees, or grads. This is determined by the Trigonometric Units selected in the User-Defined Transform dialog box. Syntax sin(numbers)



The numbers argument can be a scalar or range. If you regularly use values outside of the usual -2π to 2π (or equivalent) range, use the mod function to prevent loss of precision. Any missing value or text string contained within a range is ignored and returned as the string or missing value.
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Example



If you choose Degrees as your Trigonometric Units in the Transform dialog box, the operation sin({0,30,90,180,270}) returns values of {0,0.5,1,0,-1}.



sinh This function returns the hyperbolic sine of the specified argument. Syntax sinh(numbers)



The numbers argument can be a scalar or range. Like the circular trig functions, this function also accepts numbers in degrees, radians, or grads, depending on the units selected in the User-Defined Transform dialog box. Example



The operation x = sinh(col(3)) sets the variable x to be the hyperbolic sine of all data in column 3.



sinp The sinp function automatically generates the initial parameter estimates for a sinusoidal functions using the FFT method. The three parameter estimates are returned as a vector. Syntax sinp(x range, y range)



The x range argument specifies the x variable, and the y range argument specifies the y variable. Any missing value or text string contained within one of the ranges is
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ignored and will not be treated as a data point. x range and y range must be the same size, and the number of valid data points must be greater than or equal to 3. Tip: sinp is especially used to perform smoothing on waveform functions, used in determination of initial parameter estimates for nonlinear regression.



size The size function returns a value equal to the total number of elements in the specified range, including all numbers, missing values, and text strings. Note that size (X) 1/2 count (X) + missing (X). Syntax size(range)



The range argument must be a single range (indicated with the { } brackets) or a worksheet column. the operation size(col(1)) returns a value of 6, the operation size(col(2)) returns a value of 6, and the operation size(col(3)) returns a value of 4



sort This function can be used to sort a range of numbers in ascending order, or a range of numbers in ascending order together with a block of data. Syntax sort(block,range)
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The range argument can be either a specified range (indicated with the { } brackets) or a worksheet column. If the block argument is omitted, the data in range is sorted in ascending order. Example 1



The operation col(2) = sort(col(1)) returns the contents of column 1 arranged in ascending order and places it in column 2. To reverse the order of the sort, you can create a custom function: reverse(x) = x[data(size(x),1)]



then apply it to the results of the sort. For example, reverse(sort(x)) sorts range x in descending order. Example 2



The operation: block(3,1) = sort(block(1,1,2,size(col(2)),col(2))



sorts data in columns 1 and 2 using column 2 as the key column and places the sorted data in columns 3 and 4.



sqrt The sqrt function returns a value or range of values consisting of the square root of each value in the specified range. Numerically, this is the same as {numbers}^0.5, but uses a faster algorithm. Syntax sqrt(numbers)



The numbers argument can be a scalar or range of numbers. Any missing value or text string contained within a range is ignored and returned as the string or missing value. For numbers < 0, sqrt generates a missing value.
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Example



The operation sqrt({-1,0,1,2}) returns the range {--,0,1,1.414}.



stddev The stddev function returns the standard deviation of the specified range, as defined by: n



1 s = ---------n–1



∑ (x – x)



2



--12



i



i=1



Syntax stddev(range)



The range argument must be a single range (indicated with the {} brackets) or a worksheet column. Any missing value or text string contained within a range is ignored. Example



For the range x = {1,2}, the operation stddev(x) returns a value of .70711.



stderr The stderr function returns the standard error of the mean of the specified range, as defined by:



s ------n where s is the standard deviation.
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Syntax stderr(range)



The range argument must be a single range (indicated with the { } brackets) or a worksheet column. Any missing value or text string contained within a range is ignored. Example



For the range x = {1,2}, the operation stderr(x) returns a value of 0.5.



subblock The subblock function returns a block of cells from within another previously defined block of cells from the worksheet. The subblock is defined using the upper left and lower right cells of the subblock, relative to the range defined by the source block. Syntax subblock (block, column 1, row 1, column 2, row 2)



The block argument can be a variable defined as a block, or a block function statement. The column 1 and row 1 arguments are the relative coordinates for the upper left cell of the subblock with respect to the source block. The column 2 and row 2 arguments are the relative coordinates for the lower right cell of the subblock. All values within this range are returned. Operations performed on a block always return a block. If column 2 and row 2 are omitted, then the last row and/or column is assumed to be the last row and column of the source block. All column and row arguments must be scalar (not ranges). Example



For x = block (3,1,20,42) the operation subblock (x,1,1,1,1) returns cell (3,1) and the operation subblock (x,5,5) returns the block from cell (7, 5) to cell (20, 42).
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sum The function sum returns a range of numbers representing the accumulated sums along the list. The value of the number is added to the value of the preceding cumulative sum. Because there is no preceding number for the first number in a range, the value of the first number in the result is always the same as the first number in the argument range. Syntax sum(range)



The range argument must be a single range (indicated with the { } brackets) or a worksheet column. Any text string or missing value contained within the range is returned as the string or missing value. Example



For x = {2,6,7}, the operation sum(x) returns a value of {2,8,15}. For y = {4,12,-6}, the operation sum(y) returns a value of {4,16,10}.



tan This function returns ranges consisting of the tangent of each value in the argument given. This and other trigonometric functions can take values in radians, degrees, or grads. This is determined by the Trigonometric Units selected in the User-Defined Transform dialog box. Syntax tan(numbers)



The numbers argument can be a scalar or range.
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If you regularly use values outside of the usual -2π to 2π (or equivalent) range, use the mod function to prevent loss of precision. Any missing value or text string contained within a range is ignored and returned as the string or missing value. Example



If you choose Degrees as your Trigonometric Units in the transform dialog box, the operation tan({0,45,135,180}) returns values of {0,1,-1,0}.



tanh This function returns the hyperbolic tangent of the specified argument. Syntax tanh(numbers)



The numbers argument can be a scalar or range. Example



The operation x = tanh(col(3)) sets the variable x to be the hyperbolic tangent of all data in column 3.



total The function total returns a single value equal to the total sum of all numbers in a specified range. Numerically, this is the same as the last number returned by the sum function. Syntax total(range)
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The range argument must be a single range (indicated with the { } brackets) or a worksheet column. Missing values and text strings contained within the range are ignored. Example



For x = {9,16,7}, the operation total(x) returns a value of 32. For y = {4,12,-6}, the operation total(y) returns a value of 10.



x25 r rang The x25 function returns an interpolated value of the x data at min + --------- in the ranges 4 of coordinates provided, with optional Lowess smoothing. This is typically used to return the x value for the y value at 25% of the distance from the minimum to the maximum of smoothed data for sigmoidal shaped functions. Syntax x25(x range, y range, f )



The x range argument specifies the x variable, and the y range argument specifies the y variable. Any missing value or text string contained within one of the ranges is ignored and will not be treated as a data point. x range and y range must have the same size, and the number of valid data points must be greater than or equal to 3. The optional f argument defines the amount of Lowess smoothing, and corresponds to the fraction of data points used for each regression. f must be greater than or equal to 0 and less than or equal to 1. 0 ≤ f ≤ 1. If f is omitted, no smoothing is used. Example



For x = {0,1,2}, y={0,1,4}, the operation col(1)=x25(x,y)



r rang places the x at min + --------- as 1.00 into column 1. 4
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x50 r rang The x50 function returns an interpolated value of the x data at min + --------- in the ranges 2 of coordinates provided, with optional Lowess smoothing. This is typically used to return the x value for the y value at 50% of the distance from the minimum to the maximum of smoothed data for sigmoidal shaped functions. Syntax x50(x range, y range, f )



The x range argument specifies the x variable, and the y range argument specifies the y variable. Any missing value or text string contained within one of the ranges is ignored and will not be treated as a data point. x range and y range must have the same size, and the number of valid data points must be greater than or equal to 3. The optional f argument defines the amount of Lowess smoothing, and corresponds to the fraction of data points used for each regression. f must be greater than or equal to 0 and less than or equal to 1.0 ≤ f ≤ 1 . If f is omitted, no smoothing is used. Example



For x = {0,1,2}, y={0,1,4}, the operation col(1)=x50(x,y)



r rang places the x at min + --------- as 1.00 into column 1. 2



x75 rang The x75 function returns an interpolated value of the x data at min + 3r -----------in the ranges 4 of coordinates provided, with optional Lowess smoothing. This is typically used to return the x value for the y value at 75% of the distance from the minimum to the maximum of smoothed data for sigmoidal shaped functions.
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Syntax x75(x range, y range, f )



The x range argument specifies the x variable, and the y range argument specifies the y variable. Any missing value or text string contained within one of the ranges is ignored and will not be treated as a data point. x range and y range must have the same size, and the number of valid data points must be greater than or equal to 3. The optional f argument defines the amount of Lowess smoothing, and corresponds to the fraction of data points used for each regression. f must be greater than or equal to 0 and less than or equal to 1. 0 ≤ f ≤ 1. If f is omitted, no smoothing is used. Example



For x = {0,1,2}, y={0,1,4}, the operation col(1)=x75(x,y)



3r rangas 2.00 into column 1. places the x at min + -----------4



xatymax The xatymax function returns the interpolated x value at the maximum y value found, with optional Lowess smoothing. Syntax xatymax(x range, y range, f )



The x range argument specifies the x variable, and the y range argument specifies the y variable. Any missing value or text string contained within one of the ranges is ignored and will not be treated as a data point. x range and y range must have the same size, and the number of valid data points must be greater than or equal to 3. The optional f argument defines the amount of Lowess smoothing, and corresponds to the fraction of data points used for each regression. f must be greater than or equal to 0 and less than or equal to 1. 0 ≤ f ≤ 1. If f is not defined, no smoothing is used.
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Note: If duplicate y maximums are found xatymax will return the average value of all the x at y maximums. Example



For x = {0,1,2}, y={0,1,4}, the operation col(1)=xatymax(x,y)



places the x at the y maximum as 2.00 into column 1.



xwtr The xwtr function returns value of x75-x25 in the ranges of coordinates provided, with optional Lowess smoothing. Syntax xwtr(x range, y range, f )



The x range argument specifies the x variable, and the y range argument specifies the y variable. Any missing value or text string contained within one of the ranges is ignored and will not be treated as a data point.x range and y range must have the same size, and the number of valid data points must be greater than or equal to 3. The optional f argument defines the amount of Lowess smoothing, and corresponds to the fraction of data points used for each regression. f must be greater than or equal to 0 and less than or equal to 1. 0 ≤ f ≤ 1. If f is omitted, no smoothing is used. Example



For x = {0,1,2}, y={0,1,4}, the operation col(1)=xwtr(x,y)



places the x75-x25 as double 1.00 into column 1.
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 691 Using the Regression Wizard



18 Using the Regression Wizard Regression is most often used by scientists and engineers to visualize and plot the curve that best describes the shape and behavior of their data. Regression procedures find an association between independent and dependent variables that, when graphed on a Cartesian coordinate system, produces a straight line, plane or curve. This is also commonly known as curve fitting. The independent variables are the known, or predictor, variables. These are most often your X-axis values. When the independent variables are varied, they result in corresponding values for the dependent, or response, variables, most often assigned to the Y-axis. Regression finds the equation that most closely describes, or fits, the actual data, using the values of one or more independent variables to predict the value of a dependent variable. The resulting equation can then be plotted over the original data to produce a curve that fits the data.



About the Regression Wizard SigmaPlot uses the Regression Wizard to perform regression and curve fitting. The Regression Wizard provides a step-by step guide through the procedures that let you fit the curve of a known function to your data, and then automatically plot the curve and produce statistical results. The Regression Wizard simplifies curve fitting. There is no need to be familiar with programming or higher mathematics. The large library of built-in equations are graphically presented and organized by different categories, making selection of your models straightforward. Built-in shortcuts let you bypass all but the simplest procedures; fitting a curve to your data can be as simple as picking the equation to use, then clicking a button. Use the Regression Wizard to: „ Select the function describing the shape of your data. SigmaPlot provides over 100



built-in equations. You can also create your own custom regression equations. For more information, see “Regression Equation Library” in Chapter 20.
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„ Select the variables to fit to the function. You can select your variables from either



a graph or a worksheet. „ Evaluate and save your results. Resulting curves can be plotted automatically on a



graph, and statistical results saved to the worksheet and text reports. The Regression Wizard is also compatible with older .FIT files. For more information, see “Opening .FIT Files” on page 693. Figure 18-1 Selecting an Equation from the Regression Wizard



About SigmaPlot’s Curve Fitter The SigmaPlot curve fitter works by varying the parameters (coefficients) of an equation, and finds the parameters which cause the equation to most closely fit your data. Both the equation and initial parameter values must be provided. All built-in equations have the curve equation and initial parameters predefined. The curve fitter accepts up to 25 equation parameters and ten independent equation variables. You can also specify up to 25 parameter constraints, which limit the search area of the curve fitter when checking for parameter values. The regression curve fitter can also use weighted least squares for greater accuracy.



Curve-fitting Algorithm The SigmaPlot curve fitter uses the Marquardt-Levenberg algorithm to find the coefficients (parameters) of the independent variable(s) that give the best fit between the equation and the data.
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This algorithm seeks the values of the parameters that minimize the sum of the squared differences between the values of the observed and predicted values of the dependent variable n



SS =



∑ w (y – y ) i



i



2



i



i=1



where yi is the observed and yˆi is the predicted value of the dependent variable. This process is iterative—the curve fitter begins with a guess at the parameters, checks to see how well the equation fits, then continues to make better guesses until the differences between the residual sum of squares no longer decreases significantly. This condition is known as convergence. For more information, see “References for the Marquardt-Levenberg Algorithm ” on page 693.



References for the Marquardt-Levenberg Algorithm Press, W. H., Flannery, B. P., Teukolsky, S. A., and Vetterling, W. T. (1986). Numerical Recipes. Cambridge: Cambridge University Press. Marquardt, D.W. (1963). An Algorithm for Least Squares Estimation of Parameters. Journal of the Society of Industrial and Applied Mathematics, 11, 431-441. Nash, J.C. (1979). Compact Numerical Methods for Computers: Linear Algebra and Function Minimization. New York: John Wiley & Sons, Inc. Shrager, R.I. (1970). Regression with Linear Constraints: An Extension of the Magnified Diagonal Method. Journal of the Association for Computing Machinery, 17, 446-452. Shrager, R.I. (1972). Quadratic Programming for N. Communications of the ACM, 15, 41-45.



Opening .FIT Files Use the File menu Open command to open old curve fit (.FIT) files, selecting SigmaPlot Curve Fit as the file type. .FIT files are opened as a single equation in a notebook.
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.FIT files can also be opened from the library panel of the Regression Wizard.



Adding .FIT Files to a Library or Notebook You can add these equations to other notebooks by copying and pasting. To add them to your regression library, open the library notebook (Standard.jfl for SigmaPlot’s built-in library), then copy the equation and paste it into the desired section of the library notebook. For more information, see “Where Files Go” in Chapter 1. You can also create your own library by simply combining all your old .fit files into a single notebook, then setting this notebook to be your default equation library. For more information, see “Using a Different Library for the Regression Wizard ” on page 731. Note: Sections appear as categories in the library, so create a new section to create a new equation category. Figure 18-2 Opening a .FIT file as a notebook using the File menu Open command



.FIT files as well as new equations do not have graphic previews of the equation.
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Using the Regression Wizard Selecting the Data Source E View the page or worksheet with the data you want to fit.



If you select a graph, right-click the curve you want fitted, and on the shortcut menu,



click Fit Curve. Note: If you are running a regression from the graph page, make sure you select the plot itself, not the graph, or Fit Curve will not appear on the shortcut menu. If you are using a worksheet, select the variables in the worksheet you want to fit, then on the Statistics menu , click Regression Wizard.



The Regression Wizard appears. Figure 18-3 Selecting an Equation Category and Equation Name



Selecting the Equation to Use E Select an equation from the Equation Category and Equation Name drop-down lists.



You can view different equations by selecting different categories and names. The equation’s mathematical expression and shape appear to the left. For more information, see “Regression Equation Library” in Chapter 20. If the equation you want to use isn’t on this list, you can create a new equation. For more information, see “Editing Code” in Chapter 19. You can also browse other notebooks and regression equation libraries for other equations.
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Note: SigmaPlot remembers the equation for the next time you open the Regression Wizard. If the Finish button is available, click it to complete your regression. If it is not available, or if you want to further specify your results, click Next. Selecting the Variables to Fit E Clicking Next opens the variables panel. From here, you can select or re-select your



variables. To select a variable, click a curve on a graph, click a column in a worksheet, or select it from the Variable Columns drop-down list. The equation picture to the left prompts you for which variable to select. Figure 18-4 Selecting a plot as the data source for the Regression Wizard.



You can also modify other equation settings and options from this panel by clicking Options, which opens the Equations Options dialog box. These options include changing initial parameter estimates, parameter constraints, weighting, and other related settings. For more information, see “Equation Options” on page 703. If you pick variables from a worksheet column, you can also set the data format. For more information, see “Variable Options” on page 702.
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Viewing Initial Results E When you have selected your variables, you can either click Finish, or click Next.



Clicking Next executes the regression equation and displays the initial results. These results are also displayed if you receive a warning or error message about your fit. Figure 18-5 The Initial Results for a Regression



For more information, see “Interpreting Initial Results” on page 711. E If you wish to modify the remainder of the results that are automatically saved, click



Next. Otherwise, click Finish.



The subsequent panels provide options for the output data. Setting Results Options



The first results panel lists: „ Which results are saved to the worksheet. „ Whether or not a text report of the regression is to be generated. „ Whether or not a copy of the regression equation is saved to the section that



contains the data that was fitted.
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Figure 18-6 Selecting the results to save.



E Select which results you want to keep from the Results list. These settings are



remembered between regression sessions. E Click Next to set the graph options.



Setting Graph Options E If you selected your variables from a graph, select Add curve to to automatically add



the equation curve to that graph. You can also plot the equation on any other graph on that page by selecting one from the drop-down list. Select Create new graph to create a new graph of the original data and fitted curve. Figure 18-7 Selecting the results to graph. These settings are retained between sessions.



Select Extend fit to axes to extend the equation curve to intersect the Y-axis.
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E Select Add equation to graph page to insert the equation of the curve fit under the title



of the graph. E After selecting the graphed results you want, click Finish.



Click Next only if you want to select the specific columns used to contain the data for the fitted curve (see below). Selecting Columns for Graph Data E To select the specific columns to use for the plotted results, click the columns in the



worksheet where you want the results to always appear. Tip: Remember, these settings are reused each time you perform a regression and overwrite data if it exists in these columns in subsequent worksheets. To avoid overwriting data, use First Empty to place the fitted curve results in empty columns. Figure 18-8 Selecting the graph results columns. These settings are retained between sessions.



Finishing the Regression



When you click Finish, all your results are displayed in the worksheet, report, and graph. The initial defaults are to save parameter and computed dependent variable values to the worksheet, to create a statistical report, and to graph the results. E To change the results that are saved, click Next to go through the entire wizard,



changing your settings as desired.
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Running a Regression From a Notebook Because regression equations can be treated like any other notebook item, you can select and open regression equations directly from a notebook. This is particularly convenient if you have created or stored equations along with the rest of your graphs and data. E In the Notebook Manager, view the notebook with the equation you want to use, and



double-click the equation. The Regression Wizard appears with the equation selected. E Select the variables as prompted by clicking a curve or worksheet columns. Note that



at this point you can open and view any notebook, worksheet or page you would like, and pick your variables from that source. E Click Finish to complete the regression, or click Next if you want to view initial results



or change your results options.



Creating New Regression Equations You can create new equations by using the Function dialog box. Here you can set the equations, variables, initial parameters, constraints and other options. You can create new regression equations two different ways: „ On the Regression Wizard, click New or Edit Code, or „ Right-click in a notebook section, and on the shortcut menu, click Equation .



When you create a new equation, the Function dialog box appears with blank headings. For more information, see “Editing Code” in Chapter 19.



Viewing and Editing Code To view the code for the current equation document, in the Regression Wizard, click the Edit Code button. For more information, see “Editing Code” in Chapter 19. You can click the Edit Code button from the equation or variables panels. The Edit Code button opens the Function dialog box. All settings for the equation are displayed.
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Figure 18-9 Viewing the code for a built-in equation in the Function dialog box.



Note: You cannot edit the Equations, Parameters, and Variables for built-in SigmaPlot equations. However, you can edit and save built-in equations as new equations. Click Add As, add the equation to the desired section, and then edit the Equations, Variables and Parameters as desired. You can also copy and paste equations from notebook to notebook like any other notebook item. You can also edit pasted built-in equations. For more information, see “Editing Code” in Chapter 19.



Saving Regression Equation Changes When you edit an equation using the Equation Options or Function dialog boxes, or when you add an equation, all changes are updated to the equation in the library or notebook. However, just like other notebook items, these changes are not saved to the file until the notebook is saved. Changes made to regression libraries are automatically saved when the Regression Wizard is closed. You can also save changes to regression libraries using the Save or Save As buttons in the Regression Wizard. This saves the current regression library notebook to disk. Save As allows you to save the regression library to a new file. If you have a regression library open as a notebook, you can also save changes by saving the notebook. To save the notebook, on the File menu, click Save or Save As.
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Variable Options Data Format Options



If you use data columns from the worksheet, you can specify the data format to use in the variables panel of the Regression Wizard. By default, the data format when assigning columns from the worksheet is XY Pair. Figure 18-10 Variable data format options



The data format options are: „ XY pair. Select an x and a y variable. „ Y only. Select only a y variable column. „ XY column means. Pick one x column, then multiple y columns; the y columns will



be graphed as means. „ Y column means only. Pick multiple y columns; the columns will be graphed as



means. „ From Code. Uses the current settings as shown when editing code. „ XY Replicate. Select and X and multiple Y columns. Rows of the Y columns are



replicate measurements. „ Y Replicates. Select multiple Y columns. Rows of the Y column are replicate



measurements. When you use an existing graph as your data source, the Regression Wizard displays a format reflecting the data format of the graph. You cannot change this format unless
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you switch to using the worksheet as your data source, or run the regression directly from editing the code. Multiple Independent Variables



Although the Standard Regression Library only supports up to two independent variables, the curve fitter can accept up to ten. To use models that have more than two independent variables, simply create or open a model with the desired equation and variables. The Regression Wizard will prompt you to select columns for each defined variable Figure 18-11 Variable data format options for a 3D function



Equation Options If the curve fitter fails to find a good fit for the curve, you can try changing the equation options to see if you can improve the fit. To set options for a regression, click the Options button in the Variables panel of the Regression Wizard. The Equation Options dialog box appears. Note: If you want to edit the settings in the equation document manually, click the Edit Code button. For more information, see “Editing Code” in Chapter 19. Use the Equation Options dialog box to: „ Change initial parameter values.
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„ Add or change constraints. „ Change constant values. „ Use weighted fitting, if it is available. „ Change convergence options.



Parameters The default setting for the initial parameter value is shown Automatic. The Automatic setting available with the built-in SigmaPlot equations uses algorithms that analyze your data to predict initial parameter estimates. These do not work in all cases, so you may need to enter a different value. Just click the parameter you want to change, and make the change in the edit box. The values that appear in the Initial Parameters drop-down list were previously entered as parameter values. Any parameter values you enter will also be retained between sessions. Figure 18-12 Selecting Numeric Initial Parameters in the Equation Options dialog box.



Parameters can be either a numeric value or a function. The value of the parameter should approximate the final result, in order to help the curve fitter reach a valid result, but this depends on the complexity and number of parameters of the equation. Often an initial parameter nowhere near the final result will still work. However, a good initial estimate helps guarantee better and faster results.



 705 Using the Regression Wizard



Constraints Constraints are used to set limits and conditions for parameter values, restricting the regression search range and improving curve fitter speed and accuracy. Constraints are often unnecessary, but should always be used whenever appropriate for your model. Constraints are also useful to prevent the curve fitter from testing unrealistic parameter values. For example, if you know that a parameter should always be negative, you can enter a constraint defining the parameter to be always less than 0. You can also use constraints if the regression produces parameter values that you know are inaccurate. Simply click Back from the initial results panel, click the Options button, and enter constraint(s) that prevent the wrong parameter results. Note that a parameter equals a constraint value at the completion of the fit, the constraint is called active. You can view these constraints from the initial results panel by clicking View Constraints. For more information, see “Checking Use of Constraints ” on page 713.



Entering Parameter Constraints To enter constraints, click the Constraints edit box, and type the desired constraint(s), using the transform language operators. A constraint must be a linear equation of the equation parameters, using an equal (=) or inequality (< or >) sign. For example, you could enter the following constraints for the parameters a, b, c, d, and e: a2 d-e=15 a>b+c+d+e



However, the constraint a*x


is illegal, since x is a variable, not a parameter, and the constraints b+ c^2> 4 d*e=1
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are illegal because they are nonlinear. Inconsistent and conflicting constraints are automatically rejected by the curve fitter. Figure 18-13 Entering parameter constraints



Defining Constants Constants that appear in the Constants edit window have been previously defined as a constant, rather than a parameter to be determined by the regression. To edit a constant value, or define new constant values, click Edit Code on the Regression Wizard dialog box. Constants are defined when an equation is created. Currently, you can only define new constants by editing the regression equation code. However, you can redefine any existing constants. Change only the value of the constant. Do not add new constant values; constant variables must exist in the equation and not be defined already under variables or parameters, so they can only be defined within the code of an equation.
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Fit with Weight You can select from any of the weights listed. Some built-in equations have some predefined values, although most do not. If no weighting options are available for your equation, only the None option will be available. Weighting options appear in the Fit with Weight drop-down list. By default, the weighting applied to the fit is (none). To apply a different weighting setting, select a weighting option from the drop-down list. Figure 18-14 Selecting a Predefined Weight Variable



Weight variables must be defined by editing the regression code.



Iterations The Iterations option sets the maximum number of repeated fit attempts before failure. Each iteration of the curve fitter is an attempt to find the parameters that best fit the model. With each iteration, the curve fitter varies the parameter values incrementally, and tests the fit of that model to your data. When the improvement in the fit from one iteration to the next is smaller than the setting determined by the Tolerance option, the curve fitter stops and displays the results.
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Figure 18-15 Changing iterations



Change the number of iterations to speed up or improve the regression process, especially if a complex fit requires more than the default of 100 iterations. You can also reduce the number of iterations if you want to end a fit to check on its interim progress before it takes too many iterations. You can also set Iterations to 0 to develop ape functions. To change the maximum number of iterations, enter the number of iterations to use, or select a previously used number of iterations from the drop down list. When the maximum number of iterations is reached, the regression stops and the current results are displayed in the initial parameters panel. If you want to continue with more iterations, you can click More Iterations on the Regression Wizard.
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Step Size Step size, or the limit of the initial change in parameter values used by the curve fitter as it tries, or iterates, different parameter values, is a setting that can be changed to speed up or improve the regression process. Figure 18-16 Changing Step Size



A large step size can cause the curve fitter to wander too far away from the best parameter values, whereas a step size that is too small will result in slow convergence to the best parameters. For most functions, the default step size value is 1. To change the Step Size value, type the desired step size in the Step Size edit box, or select a previously defined value from the drop-down list.



Tolerance The Tolerance option controls the condition that must be met in order to end the regression process. When the absolute value of the difference between the norm of the residuals (square root of the sum of squares of the residuals), from one iteration to the next, is less than the tolerance value, the iteration stops. The norm for each iteration is displayed in the progress dialog box, and the final norm is displayed in the initial results panel. When the tolerance condition has been met, a minimum of the sum of squares has usually been found, which indicates a correct solution. However, local minimums in the sum of squares can also cause the curve fitter to find an incorrect solution.
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Decreasing the value of the tolerance makes the requirement for finding an acceptable solution more strict; increasing the tolerance relaxes this requirement. Figure 18-17 ChangingTolerance



The default tolerance setting is1e-10. To change the tolerance value, type the desired value in the Tolerance edit box, or select a previously defined value from the drop-down list.



Watching The Fit Progress During the regression process, the Regression fit progress dialog box displays the number of iterations completed, the norm value for each iteration, and a progress bar indicating the percent complete of the maximum iterations. Figure 18-18 The Regression Fit Progress Dialog Box
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Cancelling a Regression To stop a regression while it is running, click Cancel. The initial results appear, displaying the most recent parameter values, and the norm value. You can continue the regression process by clicking More Iterations on the Regression Wizard.



Interpreting Initial Results When you click Next from the variables panel, the regression process completes by either converging, reaching the maximum number of iterations, or encountering an error. When any of these conditions are met, or whenever there is an error or warning, the initial results panel is displayed. Figure 18-19 Initial Regression Results



Completion Status Messages A message displaying the condition under which the regression completed is displayed in the upper left corner of the Regression Wizard. If the regression completed with convergence, the message: Converged, tolerance satisfied



is displayed. Otherwise, another status or error message is displayed. For more information, see “Regression Results Messages ” on page 737.
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Rsqr R2 is the coefficient of determination, the most common measure of how well a regression model describes the data. The closer R2 is to one, the better the independent variables predict the dependent variable. R2 equals 0 when the values of the independent variable does not allow any prediction of the dependent variables, and equals 1 when you can perfectly predict the dependent variables from the independent variables.



Initial Results The initial results are displayed in the results window, in five columns. „ Parameter. The parameter names are shown in the first column. These parameters



are derived from the original equation. „ Value. The calculated parameter values are shown in the second column. „ StdErr. The asymptotic standard errors of the parameters are displayed in column



three. The standard errors and coefficients of variation can be used as a gauge of the fitted curve’s accuracy. „ CV(%). The parameter coefficients of variation, expressed as a percentage, are



displayed in column four. This is the normalized version of the standard errors: CV% = standard error × 100 § parameter value



The coefficient of variation values and standard errors can be used as a gauge of the accuracy of the fitted curve. Dependency. The last column shows the parameter dependencies. The dependence of a parameter is defined to be: ( variance of the parameter, other parameters constant ) dependence = 1 – --------------------------------------------------------------------------------------------------------------------------------------( variance of the parameter, other parameters changing )



Parameters with dependencies near 1 are strongly dependent on one another. This may indicate that the equation(s) used are too complicated and over-parameterized—too many parameters are being used, and using a model with fewer parameters may be better.
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Changing the Regression Equation or Variables To go back to any of the previous panels, click Back. This is especially useful if you need to change the model (equation) used, or if you need to modify any of the equation options and try the curve fit again.



More Iterations If the maximum number of iterations was reached before convergence, or if you canceled the regression, the More Iterations button is available. Click More Iterations to continue for as many iterations as specified by the Iterations option, or until completion of the regression.



Checking Use of Constraints If you used parameter constraints, you can determine if the regression results involved any constraints by clicking View Constraints. This button is dimmed if no constraints were entered. Figure 18-20 The Constraints Dialog Box



The Constraints dialog box displays all constraints, and flags the ones encountered with the word (active). A constraint is flagged as active when the parameter values lie on the constraint boundary. For example, the constraint: a+b


is active when the parameters satisfy the condition a+b=1, but if a+b
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Quitting the Regression If the regression results are unsatisfactory, you can click Back and change the equation or other options, or you can select Cancel to close the wizard. If you want to keep your results, click Finish. You can also click Next to specify which results you want to keep.



Saving Regression Results Regression reports and other data results are saved using the Regression Wizard results options panel, which appears after the initial results panel. Settings made here are retained from session to session. The type of data results that can be saved to the current notebook for each regression procedure are: „ The function results, saved to the worksheet. „ A statistical report. „ A copy of the regression equation.



Saving the Results using Default Settings To save the regression results using the default save setting, click Finish at any point the Finish button is active. If you want to see or modify the results that are produced, you can use the Next button to advance to the results options panel.



Saving Results to the Worksheet Function results can be saved to the current worksheet. These are: „ Equation parameter values. „ Predicted values of the dependent variable for each independent variable value. „ Residuals, or the difference between the predicted and observed dependent



variable values.
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To place any of these values in a column in the worksheet, simply check the results you want to keep. If you want to set a specific column in which to always place these values, you can click a column on a worksheet for each result. Figure 18-21 Generating and Saving a Report from the Regression Wizard



Saving a Report Regression reports are saved to the current section selecting Report in the Regression Wizard. For more information, see “Interpreting Regression Reports” on page 717.



Adding the Equation to the Notebook To add the current regression equation to the current notebook, select Add Equation to Notebook. If this option is selected, a copy of the equation is added to the current section of your notebook.



Graphing Regression Equations SigmaPlot can graph the results of a regression as a fitted curve. A curve or graph is created by default. If you want to disable graphed results, you can change the options in the Regression Wizard graph panel. Note that these settings are retained from session to session. From the graph panel, you can choose to plot the results either by: „ Adding a plot to an existing graph. This option is only available if the fitted



variables were assigned by selecting them from a graph.
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„ Creating a new graph of the original data and fitted curve.



To add a plot to an existing graph, select the Add Curve to check box option, then select the graph to which you want to add a plot from the drop-down list. The drop-down list includes all the graphs on the current page. If there is no existing graph, this option is dimmed. If you want to specify the columns used to plot the fitted curve, click Next. Otherwise, the data is placed in the first available columns. Figure 18-22 A Fitted Curve Added to the Graph



To create a new graph, select Create New Graph. Click Finish to create a new notebook section containing a worksheet of the plotted data and graph page.



Data Plotted for Regression Curves You can specify the worksheet columns used to add a fitted curve to an existing graph, or to create a new graph, by clicking Next from the graph panel.
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Figure 18-23 The Regression Wizard Pick Output Dialog Box



From this panel you can select worksheet columns for X, Y, (and Z data for 3D graphs) by clicking worksheet columns. The default of First Empty places the results in the first available column after the last filled cell.



Interpreting Regression Reports Reports can be automatically generated by the Regression Wizard for each curve fitting session. The statistical results are displayed to four decimal places of precision by default. Reports are displayed using the SigmaPlot report editor. For more information, see “Using the Report Editor” in Chapter 11.



Equation Code This is a printout of the code used to generate the regression results. For more information, see “Editing Code” in Chapter 19.
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Figure 18-24 Regression Report



R and R Squared The multiple correlation coefficient, and R2, the coefficient of determination, are both measures of how well the regression model describes the data. R values near 1 indicate that the equation is a good description of the relation between the independent and dependent variables. R equals 0 when the values of the independent variable does not allow any prediction of the dependent variables, and equals 1 when you can perfectly predict the dependent variables from the independent variables.



Adjusted R Squared The adjusted R2, R2adj, is also a measure of how well the regression model describes the data, but takes into account the number of independent variables, which reflects the degrees of freedom. Larger R2adj values (nearer to 1) indicate that the equation is a good description of the relation between the independent and dependent variables.
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Standard Error of the Estimate The standard error of the estimate Sy|x a measure of regression plane of the the actual variability about the regression plane of the underlying population. The underlying population generally falls within about two standard errors of the observed sample.



Statistical Summary Table The standard error, t and P values are approximations computed at the final iteration of the regression. Estimate



The value for the constant and coefficients of the independent variables for the regression model are listed. Standard Error



The standard errors are estimates of the uncertainties in the estimates of the regression coefficients (analogous to the standard error of the mean). The true regression coefficients of the underlying population are generally within about two standard errors of the observed sample coefficients. Large standard errors may indicate multicollinearity. The default procedure for computing standard errors is based on whether or not the regression problem is weighted. In an unweighted problem, the standard error for each parameter includes a factor that estimates the standard deviation of the observed data. In this case, it is assumed that the errors for all data points have the same variance. In a weighted problem, this factor is ignored because the weights themselves provide the error information for the data.
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t statistic



The t statistic tests the null hypothesis that the coefficient of the independent variable is zero, that is, the independent variable does not contribute to predicting the dependent variable. t is the ratio of the regression coefficient to its standard error, or



regression coefficient t = ----------------------------------------------------------------------------------------------standard error of regression coefficient You can conclude from large t values that the independent variable can be used to predict the dependent variable (for example., that the coefficient is not zero). P value



P is the P value calculated for t. The P value is the probability of being wrong in concluding that the coefficient is not zero (i.e., the probability of falsely rejecting the null hypothesis, or committing a Type I error, based on t). The smaller the P value, the greater the probability that the coefficient is not zero. Traditionally, you can conclude that the independent variable can be used to predict the dependent variable when P < 0.05.



Analysis of Variance (ANOVA) Table The ANOVA (analysis of variance) table lists the ANOVA statistics for the regression and the corresponding F value for each step. SS (Sum of Squares)



The sum of squares are measures of variability of the dependent variable. „ The sum of squares due to regression measures the difference of the regression



plane from the mean of the dependent variable. „ The residual sum of squares is a measure of the size of the residuals, which are the



differences between the observed values of the dependent variable and the values predicted by the regression model.
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DF (Degrees of Freedom)



Degrees of freedom represent the number of observations and variables in the regression equation. „ The regression degrees of freedom is a measure of the number of independent



variables. „ The residual degrees of freedom is a measure of the number of observations less



the number of parameters in the equation. MS (Mean Square)



The mean square provides two estimates of the population variances. Comparing these variance estimates is the basis of analysis of variance. The mean square regression is a measure of the variation of the regression from the mean of the dependent variable, or



SS reg sum of squares due to regression ------------------------------------------------------------------------------- = ------------ = MS reg regression degrees of freedom DF reg The residual mean square is a measure of the variation of the residuals about the regression plane, or



SS res residual sum of squares - = ----------------------------------------------------------------------------- = MSres residual degrees of freedom DF res 2



The residual mean square is also equal to S y x
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F statistic



The F test statistic gauges the contribution of the independent variables in predicting the dependent variable. It is the ratio



MS reg regression variation from the dependent variable mean ------------------------------------------------------------------------------------------------------------------------------------ = ------------ = F MS res residual variation about the regression



If F is a large number, you can conclude that the independent variables contribute to the prediction of the dependent variable (i.e., at least one of the coefficients is different from zero, and the unexplained variability is smaller than what is expected from random sampling variability of the dependent variable about its mean). If the F ratio is around 1, you can conclude that there is no association between the variables (i.e., the data is consistent with the null hypothesis that all the samples are just randomly distributed). P value



The P value is the probability of being wrong in concluding that there is an association between the dependent and independent variables (i.e., the probability of falsely rejecting the null hypothesis, or committing a Type I error, based on F ). The smaller the P value, the greater the probability that there is an association. Traditionally, you can conclude that the independent variable can be used to predict the dependent variable when P < 0.05.



PRESS Statistic PRESS, the Predicted Residual Error Sum of Squares, is a gauge of how well a regression model predicts new data. The smaller the PRESS statistic, the better the predictive ability of the model. The PRESS statistic is computed by summing the squares of the prediction errors (the differences between predicted and observed values) for each observation, with that point deleted from the computation of the regression equation.
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Durbin-Watson Statistic The Durbin-Watson statistic is a measure of correlation between the residuals. If the residuals are not correlated, the Durbin-Watson statistic will be 2; the more this value differs from 2, the greater the likelihood that the residuals are correlated. Regression assumes that the residuals are independent of each other; the DurbinWatson test is used to check this assumption. If the Durbin-Watson value deviates from 2 by more than 0.50, a warning appears in the report, i.e., if the Durbin-Watson statistic is below 1.50 or above 2.50.



Normality Test The normality test results display whether the data passed or failed the test of the assumption that the source population is normally distributed around the regression, and the P value calculated by the test. All regressions assume a source population to be normally distributed about the regression line. If the normality test fails, a warning appears in the report. Failure of the normality test can indicate the presence of outlying influential points or an incorrect regression model. Figure 18-25 Regression Report Showing Normality Test Results
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Constant Variance Test The constant variance test results displays whether or not the data passed or failed the test of the assumption that the variance of the dependent variable in the source population is constant regardless of the value of the independent variable, and the P value calculated by the test. When the constant variance test fails, a warning appears in the report. If the constant variance test fails, you should consider trying a different model (for example, one that more closely follows the pattern of the data) using a weighted regression, or transforming the independent variable to stabilize the variance and obtain more accurate estimates of the parameters in the regression equation. If you perform a weighted regression, the normality and equal variance tests use the weighted residuals w i ( y i – yˆ i ) instead of the raw residuals y i – yˆ i



Power The power, or sensitivity, of a regression is the probability that the model correctly describes the relationship of the variables, if there is a relationship. Regression power is affected by the number of observations, the chance of erroneously reporting a difference α (alpha), and the slope of the regression. Alpha



Alpha (α) is the acceptable probability of incorrectly concluding that the model is correct. An α error is also called a Type I error (a Type I error is when you reject the hypothesis of no association when this hypothesis is true). Smaller values of α result in stricter requirements before concluding the model is correct, but a greater possibility of concluding the model is incorrect when it is really correct (a Type II error). Larger values of α make it easier to conclude that the model is correct, but also increase the risk of accepting an incorrect model (a Type I error).
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Regression Diagnostics The regression diagnostic results display the values for the predicted values, residuals, and other diagnostic results. Row



This is the row number of the observation. Predicted Values



This is the value for the dependent variable predicted by the regression model for each observation. Residuals



These are the unweighted raw residuals, the difference between the observed and predicted values for the dependent variables. Standardized Residuals



The standardized residual is the raw residual divided by the standard error of the estimate S y x . If the residuals are normally distributed about the regression, about 66% of the standardized residuals have values between -1 and +1, and about 95% of the standardized residuals have values between -2 and +2. A larger standardized residual indicates that the point is far from the regression. Values less than -2.5 or larger than 2.5 may indicate outlying cases. Studentized Residuals



The Studentized residual is a standardized residual that also takes into account the greater confidence of the predicted values of the dependent variable in the middle of the data set. By weighting the values of the residuals of the extreme data points (those with the lowest and highest independent variable values), the Studentized residual is more sensitive than the standardized residual in detecting outliers. This residual is also
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known as the internally Studentized residual, because the standard error of the estimate is computed using all data. Studentized Deleted Residuals



The Studentized deleted residual, or externally Studentized residual, is a Studentized residual which uses the standard error of the estimate Sy|x( -i), computed after deleting the data point associated with the residual. This reflects the greater effect of outlying points by deleting the data point from the variance computation. The Studentized deleted residual is more sensitive than the Studentized residual in detecting outliers, since the Studentized deleted residual results in much larger values for outliers than the Studentized residual. Figure 18-26 Regression Report Showing the Influence Diagnostics
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Influence Diagnostics Row



This is the row number of the observation. Cook’s Distance



Cook’s distance is a measure of how great an effect each point has on the estimates of the parameters in the regression equation. It is a measure of how much the values of the regression coefficients would change if that point is deleted from the analysis. Values above 1 indicate that a point is possibly influential. Cook’s distances exceeding 4 indicate that the point has a major effect on the values of the parameter estimates. Leverage



Leverage values identify potentially influential points. Observations with leverages two times greater than the expected leverages are potentially influential points. p The expected leverage of a data point is --- where there are p parameters and n data n points. Because leverage is calculated using only the dependent variable, high leverage points tend to be at the extremes of the independent variables (large and small values), where small changes in the independent variables can have large effects on the predicted values of the dependent variable.
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Figure 18-27 Regression Report



DFFITS



The DFFITSi statistic is a measure of the influence of a data point on regression prediction. It is the number of estimated standard errors the predicted value for a data point changes when the observed value is removed from the data set before computing the regression coefficients. Predicted values that change by more than 2.0 standard errors when the data point is removed are potentially influential.



95% Confidence Intervals If the confidence interval does not include zero, you can conclude that the coefficient is not zero with the level of confidence specified. This can also be described as P < α (alpha), where α is the acceptable probability of incorrectly concluding that the coefficient is different than zero, and the confidence interval is 100(1 - α). The confidence level for both intervals is fixed at 95% (α=0.05). Row



This is the row number of the observation.



 729 Using the Regression Wizard



Predicted Values



This is the value for the dependent variable predicted by the regression model for each observation. Regression



The confidence interval for the regression gives the range of variable values computed for the region containing the true relationship between the dependent and independent variables, for the specified level of confidence. The 5% values are lower limits and the 95% values are the upper limits. Population



The confidence interval for the population gives the range of variable values computed for the region containing the population from which the observations were drawn, for the specified level of confidence. The 5% values are lower limits and the 95% values are the upper limits.



Regression Equation Libraries and Notebooks Regression equations are stored in notebook files just as other SigmaPlot documents. Notebooks that are used to organize and contain only regression equations are referred to as libraries, and distinguished from ordinary notebooks with a file extension of .sfl. These library notebooks can be opened and modified like any other notebook file. You can also use ordinary SigmaPlot notebooks (.jnb) as equation libraries, as well as save any notebook as a .jfl file. Regression equations within notebooks are indicated with a to the equation name.



icon that appears next



The equations that appear in the Regression Wizard are read from a default regression library. The way the equations are named and organized in the equations panel is by using the section name as the category name, and the entry name as the equation name.
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Figure 18-28 The Standard Regression Equation Library



For example, the standard.jfl regression library supplied with SigmaPlot has twelve categories of built-in equations: „ Polynomial „ Peak „ Sigmoidal „ Exponential Decay „ Exponential Rise to Maximum „ Exponential Growth „ Hyperbola „ Waveform „ Power „ Rational
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„ Logarithm „ 3D „ Standard Curves „ Ligand Binding



These categories correspond to the section names within the Standard.jflnotebook. For more information, see “Regression Equation Library” in Chapter 20. To see the library currently in use, click Back in the Regression Wizard equation panel. Previously selected libraries and open notebooks can be selected from the Library drop-down list.



Opening an Equation Library You can open, view, and modify a regression equation library as you would any ordinary notebook. To open a regression library: E Click the Open toolbar button, select *.jfl as the file type from the File Type drop-



down list, then select the library to open, or E Click the Open button in the Regression Wizard library panel to open the current



library. You can reach the library panel by clicking Back on the Equations panel. You can copy, paste, rename and delete regression equations as any other notebook item. Opening a regression equation directly from a notebook automatically launches the Regression Wizard with the variables panel selected.



Using a Different Library for the Regression Wizard You can also select another notebook or library as the source for the equations in the Regression Wizard. Selecting a different equation library changes the categories and equations listed in the Regression Wizard equations panel.
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Figure 18-29 Selecting the Regression Equation Library



To change the library: E Start the Regression Wizard by pressing F5 or clicking Regression Wizard on the



Statistics menu. E Click Back to view the library panel. To change the library used, enter the new library



path and name, or click Browse. The File Open dialog box appears. E Change the path and select the file to use as your regression library. When you start the



Regression Wizard next, it will continue to use the equation library selected in the library panel. Note: Opening a regression equation directly from a notebook does not reset the equation library.
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Curve Fitting Date And Time Data You can run the Regression wizard on data plotted versus calendar times and dates. Dates within and near the twentieth century are stored internally as very large numbers. However, you can convert these dates to relatively small numbers by setting Day Zero to the first date of your data, then converting the date data to numbers. After curve fitting the data, you can switch the numbers back to dates. For more information, see “Setting Day Zero” in Chapter 3. Figure 18-30 You can curve fit dates, but you must convert the dates to numbers first. Time only data (as shown in column 1) does not require a conversion.



Note: If you have entered clock times only, then you can directly curve fit those time without having to convert these to numbers. Time only entries assume the internal start date of 4713 B.C. (the start of the Julian calendar). However, if you have entered times using a more recent calendar date, you must convert these times to numbers as well.
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Converting Dates to Numbers E On the Tools menu, click Options. The Options dialog box appears. Figure 18-31 Setting Day Zero



E Click the Worksheet tab. E From theSettings for list, select Date and Time. E Set Day Zero to be the first date of your data, or to begin very close to the starting date



of your data. You must include the year as well as month and day. E Click OK, then view the worksheet and select your data column. E On the Format menu click Cells, and then click Numeric. Your dates are converted to



numbers.
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These numbers should be relatively small numbers. If the numbers are large, you did not select a Day Zero near your data starting date. E If the axis range of you graph is manual, convert it back to automatic. Select the axis,



then open the Graph Properties dialog box and change the range to Automatic. For more information, see “Changing Axis Range” in Chapter 9. E Click you curve and run your regression. When you are finished, you must convert the



original and fitted curve x variable columns back to dates.



Converting Numbers Back to Dates E Select each column, then on the Format menu, click Cells. The Format Cells dialog



box appears. E Click the Data tab. E Under Types, select Date and Time. E On the Date drop-down list, click a date format. E Click OK.
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Figure 18-32 Converting Numeric Data back to Date and Time Data



When the columns are converted back to dates, the graph re-scales and you have completed your date and time curve fit. Figure 18-33 The Data and Fitted Curve X Variables Converted Back to Dates and Graphed
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Regression Results Messages When the initial results of a regression are displayed, a message about the completion status appears. Explanations of the different messages are found below.



Completion Status Messages Converged, tolerance satisfied. This message appears when the convergence criterion,



which compares the relative change in the norm to the specified tolerance, is satisfied. Note that this result may still be false, caused by a local minimum in the sum of squares. Converged, zero parameter changes. The changes in all parameters between the last two



iterations are less than the computer’s precision. Did not converge, exceeded maximum number of iterations. More iterations were required to satisfy the convergence criteria. Select More Iterations to continue for the same number of iterations or increase the number of iterations specified in the Options dialog box and rerun the regression. Did not converge, inner loop failure. There are two nested iterative loops in the Marquardt algorithm. This diagnostic occurs after 50 sequential iterations in the inner loop. The use of constraints may cause this to happen due to a lack of convergence. In some cases, the parameter values obtained with constraints are still valid, in the sense that they result in good estimates of the regression parameters. Terminated by user. You pressed Esc, or selected the Cancel button and terminated the



regression process. Function overflow using initial parameter values. The regression iteration process could



not get started since the first function evaluation resulted in a math error. For example, if you used f = sqrt(-a*x), and the initial a value and all x values are positive, a math error occurs. Examine your equation, parameter values and independent variable values, and make the appropriate changes. Parameters may not be valid. Array ill conditioned on final iteration. During the



regression iteration process the inverse of an array (the product of the transpose of the Jacobian matrix with itself) is required. Sometimes this array is nearly singular (has a nearly zero determinant) for which very poor parameter estimates would be obtained.
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SigmaPlot uses an estimate of the "condition" of the array (ill conditioned means nearly singular) to generate this message (see Dongarra, J.J., Bunch, J.R., Moler, C.B., and Stewart, G.W., Linpack User’s Guide, SIAM, Philadelphia, 1979 for the computation of condition numbers). Usually this message should be taken seriously, as something is usually very wrong. For example, if an exponential underflow has occurred for all x values, part of the equation is essentially eliminated. SigmaPlot still tries to estimate the parameters associated with this phantom part of the equation, which can result in invalid parameter estimates. A minority of the time the "correct," though poorly conditioned, parameters are obtained. This situation may occur, for example, when fitting polynomial or other linear equations. Parameters may not be valid. Array numerically singular on final iteration. This is a



variant of the above condition. Instead of using the condition number the inverted array is multiplied by the original array and the resulting array elements are tested (the off diagonal elements are compared to 0.0 and the diagonal elements compared to 1.0). If the absolute value of any off diagonal element or difference of the diagonal element from 1.0 is greater than a specified tolerance, then the original array is considered to be singular. Parameters may not be valid. Overflow in partial derivatives. The partial derivatives of



the function to be fit, with respect to the parameters, are computed numerically using first order differences. Math errors from various sources can cause errors in this computation. For example if your model contains exponentials and the parameters and independent variable values cause exponential underflows, then the numerical computation of the partial derivative will be independent of the parameter(s). SigmaPlot checks for this independence. Check the parameter values in the results screen, the range of the independent variable(s) and your equation to determine the problem. There may be inconsistent constraints. Check constraint equations. This occurs if you



have defined constraints like a>0 and a
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Error Status Messages Bad constraint. The regression cannot proceed because a constraint you defined either was not linear or contained syntax errors. Invalid or missing ’fit to’ statement. The regression lacks a fit to statement, or the fit to



statement contains one or more syntax errors. No observations to fit. The regression cannot proceed unless at least one x,y data pair (observation) is included. Check to be sure that the data columns referenced in the regression specifications contain data. No parameters to fit. The regression specifications do not include any parameter



definitions. To add parameter definitions, return to the Equation Options dialog box and type the parameter definitions in the Parameters edit window. No weight statement. The regression specifications include a fit to statement with an



unknown weight variable. Check the Variables edit window to see if a weight variable has been defined and that this corresponds to the variable in the regression statement. Not enough or bad number of observations. In regression, the x and y data sets must be of the same size. The data sets (x and y columns) you specified contain unequal numbers of values. Problem loading the file [Filename]. File too long; truncated. The fit file you tried to load



is too long. Regression files can be up to 50 characters wide and 80 lines long. Any additional characters or lines were truncated when the file was loaded into the Edit Window. Section has already been submitted. This regression section has already been defined. Symbol [Variable or Function] has not been defined. The fit to statement in the regression definition contains an observed variable which is undefined, or the fit to statement in the regression definition contains an undefined function. Examine the regression specifications you have defined and be sure that the dependent variable listed in the regression statement exists and corresponds to the variable defined in the Variables edit window and that the function listed in the regression statement exists and corresponds to the function you defined in the Equations edit window. Unreferenced variable. The regression specifications define a parameter that is not



referenced in any other statements. Either delete the parameter definition, or reference it in another statement.
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19 Editing Code You can edit a regression equation by clicking the Edit Code button in the Regression Wizard. This opens the Functions dialog box. Regression equations can be selected from within the wizard, or opened from a notebook directly. You can also create new regression equations. Creating a new equation requires entry of all the code necessary to perform a regression. This chapter covers: „ Selecting an equation for editing (see page 742). „ Entering equation code (see page 746). „ Defining constants (see page 747). „ Entering variables (see page 747). „ Entering code for parameter constraints and other options (see page 750). „ Entering parameters code (see page 757).



About Regression Equations Equations contain not only the regression model function, but other information needed by SigmaPlot to run a regression. All regression equations contain code defining the equations, parameter settings, variables, constraints, and other options used. To edit the code for an equation, you need to either open and edit an existing equation, or create a new equation.



Protected Code for Built-in Equations All built-in equations provided in standard.jfl have protected portions of code which can be viewed and copied but not edited. However, you may use Add As to create a duplicate entry that can be edited, and you can also copy a built-in equation from the library to another notebook or section and edit it.
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Opening an Existing Equation You can open an equation by: „ Double-clicking an equation icon in a notebook window, or selecting the equation



then clicking Open. „ Starting the Regression Wizard, then selecting the equation by category and name. Figure 19-1 Opening an equation from the Notebook Manager



You can also double-click an equation in a notebook while the Regression Wizard is open to switch to that equation. Once an equation is opened, you can edit it by clicking the Edit Code button.
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Creating a New Equation If you require an equation that does not appear in the standard equation library, you can create a new equation using the Functions dialog box. Figure 19-2 You can create equations of your own in the Function dialog box.



You can open the Functions dialog box by: „ Clicking the New button in the Regression Wizard. „ Choosing File menu New command , and selecting Regression Equation. „ Right-clicking in the Notebook Manager, and choosing New, Regression



Equation from the shortcut menu.



A new equation document has no default settings for the equations, parameters, variables, constraints, or other options. To create a new equation from within the Regression Wizard: E On the Statistics menu click Regression Wizard. E Click New to create a new equation. The Function dialog box appears.
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To create an equation from the Notebook Manager: E Right-click the section where you want the equation to go. If you want the equation to



be created in a new section, right-click the notebook icon. E On the shortcut menu, click New from the shortcut menu, and then click Equation. The



Function dialog box appears.



Copying Equations You can copy an existing equation from any notebook view to another, and modify it as desired.



Adding Equations as New Entries To edit equations from within the Regression Wizard, and add them as new equations to the current library, click Add As button in the Function dialog box. The Add As dialog box appears, in which you can enter the equation name.



Entering Regression Equation Settings To enter the settings for new equations, click the desired edit window in the Function dialog box and enter your settings. Note: Open the Function dialog box by clicking New or Edit Code on the Regression Wizard. For more information, see “Viewing and Editing Code ” in Chapter 18.
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Figure 19-3 The Function dialog box.



This section covers the minimum steps required to enter the code for a regression equation. For more information on entering the code for each section, see: „ Equations. For more information, see “Equations” on page 751. „ Variables. For more information, see “Variables” on page 753. „ Weight Variables. For more information, see “Weight Variables” on page 755. „ Initial Parameters. For more information, see “Initial Parameters” on page 757. „ Constraints. For more information, see “Constraints” on page 759. „ Other Options. For more information, see “Other Options ” on page 760.



Adding Comments Place comments in the edit box by preceding them with an apostrophe (’), or a semicolon (;). You can also use apostrophes or semicolons to comment out equations instead of deleting them.
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Entering Equations To enter the code for the Equation section: E Click in the Equation window and type the regression equation model, using the



transform language operators and functions. The equation should contain all of the variables you plan to use as independent variables, as well as the name for the predicted dependent variable (which is not your y variable). You can use any valid variable name for your equation variables and parameters, but short, single letter names are recommended for the sake of simplicity. Omit the observed dependent variable name from the regression model. The observed dependent variable (typically your y variable) is used in the fit statement. E Press the Enter key when finished with the regression equation model, then type the fit



statement. The simplest form of the fit statement is: fit f to y Where f is the predicted dependent variable from the regression model, and y is the variable that will be defined as the observed dependent variable (typically the variable plotted as y in the worksheet). You can also define whether or not weighting is used. For more information, see “Weight Variables” on page 755.
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Figure 19-4 Entering the regression equation and the regression statement.



Example: The code f=m*x+b fit f to y can be used as the model for the function , and also defines y as the observed dependent variable. In this example, x is the independent variable, and m and b the equation parameters.



Defining Constants Constants that appear in the equations can also be defined under the equations heading. If you decide that an equation parameter should be a constant rather than a parameter to be determined by the regression, define the value for that constant here, then make sure you don’t enter this value in the parameters section. Constants defined here appear under the Constants option in Equation Options dialog box. For more information, see “Equation Options” in Chapter 18.



Entering Variables Independent, dependent, and weighting variables are defined in the Variables section. One of the variables defined must be the observed values of the dependent variable: that is, the "unknown" variable to be solved for. The rest are the independent variables (predictor, or known variables) and an optional weighting variable.
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To define your variables: E Click in the Variables section and type the character or string you used for the first



variable in your regression equation. E Type an equal sign (=), then enter a range for the variable. Ranges can be any transform



language function that produces a range, but typically is simply a worksheet column. Note: The variable values used by the Regression Wizard depend entirely on what are selected from the graph or worksheet; the values entered here are only used if the From Code data format is selected, or if the regression is run directly from the Function dialog box. Repeat these steps for each variable in your equation. Up to ten independent variables can be defined, but you must define at least one variable for a regression equation to function. The curve fitter checks the variable definitions for errors and for consistency with the regression equation. Figure 19-5 Entering the variable definitions



Example: To define x and y as the variables for the equation code f=m*x+b, fit f to y you could enter the code x=col(1), y=col(2) which defines an x variable as column 1 and a y variable as column 2, using these columns whenever the regression is run directly from the code.
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Automatic Initial Parameter Estimation Functions Any user-defined functions you plan on using to compute initial parameter estimates must be entered into the Variables section. For more information, see “Automatic Determination of Initial Parameters ” on page 758.



Entering Initial Parameters Parameters are the equation coefficients and offset constants that you are trying to estimate in your equation model. The definitions or functions entered into the Parameters sections determine which variables are used as parameters in your equation model, and also their initial values for the curve fitter. The curve fitter checks the parameter equations for errors and for consistency with the regression equations. To enter initial parameter values: E Click in the Initial Parameters section and type the name of the first parameter as it



appears in your equation model, followed by an equals (=) sign. E Enter the initial parameter value used by the curve fitter. Ideally, this should be as close



to the real value as possible. This value can be numeric, or a function that computes a good guess for the parameter. Using a function for the initial parameter value is called automatic para meter estimation. For more information, see “Automatic Determination of Initial Parameters” on page 758. Example: If your data for the equation code f=m*x+b, fit f to y appear to rise to the right and run through the origin, you could define your initial parameter as m=0.5, b=0. These are good initial guesses, since the m coefficient is the slope and the b constant is the y-intercept of a straight line.
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Parameter Constraints Parameter Constraints are completely optional. Use them to limit the parameter ranges to meaningful values for your particular problem. For more information, see “Parameter Constraints” on page 750.



Options The Iterations, Step Size and Tolerance options sometimes can be used to improve or limit your curve fit. The default settings work for the large majority of cases, so you do not need to change these setting unless truly required. For more information, see “Other Options ” on page 760.



Saving Equations Once you are satisfied with the settings you have entered into the Function dialog box, you can save the equation. Clicking OK automatically updates the equation entry in the current notebook or regression library. If you created a new equation, you are prompted to name it before it is added to your notebook. If you are editing an existing equation, you can click Add As to add the code as a new equation to the current library or notebook. In order to save your changes to disk, you must also save the notebook or library. Changes to your current regression library are automatically saved when you close the wizard. You can also save changes before you close the wizard by clicking Save. Click Save As to save the regression library to a new file. If your equation is part of a visible notebook, you can save changes by saving the notebook using the Save button or the File menu Save or Save As commands. Note that when an equation is edited using the Equation Options dialog box, all the changes are also automatically updated and saved.



Saving Equation Copies with Results You can save equations along with the targeted page or worksheet while saving your regression results. Just check the Add Equation to Notebook option in the results panel, and a copy of the equation used is added to the same section as reports and other results.
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Equations The Equation section of the Function dialog box defines the model used to perform the regression as well as the names of the variables and parameters used. The regression equation code is defined using the transform language operators and functions. The equation must contain all of the variables you wish to use. These include all independent variables, the predicted dependent variable, and observed dependent variable. All parameters and constants used are also defined here. The Equation code consists of two required components: „ The equation model describing the function(s) to be fit to the data. „ The fit statement, which defines the predicted dependent variable and, optionally,



the name of a weighting variable. The independent variable and parameters are defined within the equation function. Also, any constants that are used must also be defined under the Equations section.



Defining the Equation Model The equation model sets the predicted variable (called f in all built-in functions) to be a function of one or more independent variables (called x in the built-in twodimensional Cartesian functions) and various unknown coefficients, called parameters. The model may be described by more than one function. For example, the following three equations define a dependent variable f, which is a constant for x < 1 and a straight line for x ≥ 1. f = if (x < 1, constant (x), line (x)) constant (x) = c line (x) = a + b * x



Number of Parameters You can enter and define up to 25 parameters, but a large number of parameters will slow down the regression process. You can determine if you are using too many parameters by examining the parameter dependencies of your regression results. Dependencies near 1.0 (0.999 for example) indicate that the equation is overparameterized, and that you can probably remove one or more dependent parameters. For more information, see “Interpreting Initial Results” in Chapter 18.
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Defining the Fit Statement The most general form of the fit statement is: fit f to y with weight w



f identifies the predicted dependent variable to be fit to the data in the set of equations, as defined by the model. y is the observed dependent variable, later defined in the Variables section, whose value is generally determined from a worksheet column. w is the optional weight variable, also defined in the Variables section. Any valid variable name can be used in place of f, y, and w. If the optional weighting variable is not used, the fit statement has the form: fit f to y



Defining Constants Define constants by setting one of the parameters of the equation model to a value, using the form constant=value



For example, one commonly used constant is pi, defined as pi=3.14159265359



Defining Alternate Fit Statements You can create alternate fit statements that call different weight variables. These statements appear as fit statements preceeded by two single quotes (’’, not a double quote). For each weight variable you define, you can create a weighting option by adding commented fit statements to the equation window.
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For example, an Equation window that reads: f=a*exp(-b*x)+c*exp(-d*x)+g*exp(-h*x) fit f to y with Weight Reciprocal ’’fit f to y



with weight Reciprocal would display the option Reciprocal in the Regressions Options dialog box Fit With Weight list.



Variables Independent, dependent, and weighting variables are defined in the Variables edit window of the Function dialog box. One of the variables defined must be the observed values of the dependent variable: that is, the unknown variable to be solved for. The rest are the independent variables (predictor, or known variables) and any optional weighting variables. Up to ten independent variables can be defined. To define your variables, select the Variables edit window, then type the variable definitions. You generally need to define at least two variables—one for the dependent variable data, and at least one for the independent variable data.



Variable Definitions Variable definitions use the form: variable = range You can use any valid variable name, but short, single letter names are recommended for the sake of simplicity (for example, x and y). The range can either be the column number for the data associated with each variable, or a manually entered range. Most typically, the range is data read from a worksheet. The curve fitter uses SigmaPlot’s transform language, so the notation for a column of data is: col(column,top,bottom)



The column argument determines the column number or title. To use a column title for the column argument, enclose the column title in quotation marks. The top and bottom arguments specify the first and last row numbers and can be omitted. The default row
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numbers are 1 and the end of the column, respectively. If both are omitted, the entire column is used. For example, to define the variable x to be column 1, enter: x = col(1)



Data may also be entered directly in the variables section. For example, you can define y and z variables by entering: y = {1,2,4,8,16,32,64} z = data(1,100)



This method can have some advantages. For example, in the example above the data function was used to automatically generate z values of 1 through 100, which is simpler than typing the numbers into the worksheet. Note: The Regression Wizard generally ignores the default variable settings, although it requires valid variable definitions in order to evaluate an equation. Variables are redefined when the variables are selected from within the wizard. However, you can force the use of the hard-coded variable definitions, either by selecting From Code as the data source, or running the regression directly from the Function dialog box.



Transform Language Operations You can use any transform language operator or function when defining a variable. For example: x = 10^data(-2, log(10.8),0.5) y = ((col(2)-col(2)*(.277*col(1))^0.8))*1.0e-12 z = 1/sqrt(abs(col(3)))



are all valid variable names.



User-Defined Functions Any user-defined functions that are used later in the regression code must be defined in the Variables section.
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Concatenating Columns Constructor notation can be used to concatenate data sets. For example, you may want to fit an equation simultaneously to multiple y columns paired with one x column. If the x data is in column 1 and the y data is in columns 2 through 6, you can enter the following variable statements: x = {col (1), col (1), col (1), col (1), col (1)} y = {col (2), col (3), col (4), col (5), col (6)}



The variable x is then column 1 concatenated with itself four times, and variable y is the concatenation of columns 2 through 6. If the function to be fit is f, then the fit statement fit f to y



fits f to the dependent variable values in columns 2 through 6 for the independent variable values in column 1.



Weight Variables Variables used to perform weighted regressions are known as weight variables. All weight variables must be defined along with other variables in the Variables window.



Specifying the Weight Variable to Use The use of weighting is specified by the Equation section code, which can call weight variables defined under Variables. Weight variables are selected from the fit statement, using the syntax: fit f to y with weight w



where w is the weight variable defined under Variables. For more information, see “Equations” on page 751. Generally, a weight variable is defined as the reciprocal of either the observed dependent variable or its square. For example, if y=col(2) is the observed dependent variable, the weighting variable can defined as 1/col(2) or as
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1/col(2)^2. For more information, see “Example 2: Weighted Regression ” in Chapter 21.



Defining Optional Weight Variables You can define more than one possible weight variable, and select the one to use from the Equation Options dialog box. Simply create multiple weight variables, then create alternate fit statement entries selecting the different weight variables in the Equations window. For more information, see “Defining Alternate Fit Statements” on page 752.



When to Use Weighting Least squares regressions assumes that the errors at all data points are equal. When the error variance is not homogeneous, weighting should be used. If variability increases with the dependent variable value, larger dependent variable values will have larger residuals. Large residuals will cause the squared residuals for large dependent variable values to overwhelm the small dependent variable value residuals. The total sum of squares will be sensitive only to the large dependent variable values, leading to an incorrect regression. You may also need to weight the regression when there is a requirement for the curve to pass through some point. For example, the (0,0) data point can be heavily weighted to force the curve through the origin. Note: If you use weighted least squares, the regression values are valid, but the statistical values produced for the curve are not.



The Weighting Process: Norm and Residuals Changes The weight values are proportional to the reciprocals of the variances of the dependent variable. Weighting multiplies the corresponding squared term in the sum of squares, dividing the absolute value of the residual by its standard error. This causes all terms of the sum of squares to have a similar contribution, resulting in an improved regression. For weighted least squares, the weights w are included in the sum of squares to be minimized.
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When weighting is used, the norm that is computed and displayed in the Progress dialog box and initial results is SS , and includes the effect of weighting. The residuals computed are the weighted residuals .



Initial Parameters The code under the Initial Parameters section of the Function dialog box specify which equation coefficients and constants to vary and also set the initial parameter values for the regression. To enter parameters, select the Initial Parameters window, then type the parameters definitions using the form: parameter=initial value All parameters must appear in the equation model. All equation unknowns not defined as variables or constants must be defined in Initial Parameters.



Initial Parameter Values For the initial values, a "best guess" may speed up the regression process. If your equation is relatively simple (only two or three parameters), the initial parameter values may not be important. For more complex equations, however, good initial parameter values can be critical for a successful convergence to a solution.



Automatic Parameter Estimation All built-in equations use a technique called automatic parameter estimation, which computes an approximation of the function parameters by analyzing the raw data. You can indicate the parameter value you wish to appear as the Automatic setting by typing two single quotes followed by the string Auto after the parameter setting. For example, entering the parameter line a=max(y) ’’Auto tells the Equation Options dialog box to use max(y) as the Automatic parameter value for a. For more information, see “Automatic Determination of Initial Parameters ”on page 758.
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Automatic Determination of Initial Parameters SigmaPlot automatically obtains estimates of the initial parameter values for all builtin equations found in Standard.jfl (For more information, see “Where Files Go” in Chapter 1.). When automatic parameter estimation is used, you no longer have to enter static values for parameters yourself—the parameters determine their own values by analyzing the data. Note: It is only important that the initial parameter values are robust among varying data sets, i.e., that in most cases the curve fitter converges to the correct solution. The estimated parameters only have to be a "best guess" (somewhere in the same ballpark as the real values, but not right next to them). You can create your own methods of parameter determination using the new transform function provided just for this purpose. The general procedure is to smooth the data, if required, and then use functions specific to each equation to obtain the initial parameter estimates. Consider the logistic function as an example. This function has the stretched s shape that changes gradually from a low value to a high value or vice versa. The three parameters for this function determine the high value (a), the x value at which the function is 50% of range of the function’s amplitude (x0) and the width of the transition (b). As expressed in the transform language, the function is entered into the Equation window as f=a/(1+exp(-(x-x0)/b)) fit f to y. Noise in the data can lead to significant errors in the estimates of x0 and b. Therefore, a smoothing algorithm is used to reduce the noise in the data and three functions are then used on the smoothed data to obtain the parameter estimates. To estimate the parameter a the maximum use the y value. Use the x value at 50% of the amplitude to estimate x0, and the difference between the x values at 75% and 25% of the amplitude is used to estimate b. As entered into the Initial Parameters window, these are: a=max(y) ’’Auto b=xwtr(x,y,.5)/4 ’’Auto x0=x50(x,y,.5) ’’Auto Both the fwhm and xwtr transform functions have been specifically designed to aid the estimation of function parameters. For more information, see “Example 1: Curve Fitting Pitfalls” in Chapter 21.
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The ’’Auto comment that follows each parameter is used to identify that parameter value as the Automatic setting from within the Equation Options dialog box. Note that these values may not at all reflect the final values, but they are approximate enough to prevent the curve fitter from finding false or invalid results.



Alternate Parameter Values You can insert alternate parameter values that appear in the Equation Options dialog box Initial Parameter Values drop-down lists. To add an alternate, insert a new line after the default value, then type two single quotes, followed by the alternate parameter setting. For example, the two lines d=-F(0)[2] ’’Auto, ’’d=0.01 cause an alternate value of 0.01 to appear in the Equation Options dialog box Initial Parameter Values dropdown list for d. Alternate parameter values are automatically inserted when different parameter values are entered into the Equation Options dialog box.



Constraints Linear parameter constraints are defined under the Constraints section. A maximum of 25 constraints can be entered. Use of constraints is optional. Constraints are used to set limits and conditions for parameter values, restricting the regression search range and improving regression speed and accuracy. Liberal use of constraints in problems which have a relatively large number of parameters is a convenient way to guide the regression and avoid searching in unrealistic regions of parameter space.



Valid Constraints A constraint must be a linear equation of the parameters using an equality (=) or inequality (< or >). For example, the following constraints for the parameters a, b, c, d, and e are valid: a 2 d-e = 15 a>b+c+d+e
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whereas a*x


is illegal since x is not a constant, and b+c^2>4 d*e=1



are illegal because they are nonlinear. Tip: Although the curve fitter checks the constraints for consistency, you should still examine your constraint definitions before executing the regression. For example, the two constraints: a2



are inconsistent. The parameter a cannot be both less than 1 and greater than 2. If you execute a regression with inconsistent constraints, a message appears in the Results dialog box warning you to check your constraint equations.



Other Options You can use several special options to influence regression operation. The different options can be used to speed up or improve the regression process, but their use is optional. The three options are: „ Iterations, the maximum number of repeated regression attempts. „ Step Size, the limit of the initial change in parameter values used by the regression



as it tries different parameter values. „ Tolerance, one of the conditions that must be met to end the regression process.



When the absolute value of the difference between the norm of the residuals from one iteration to the next is less than the tolerance, this condition is satisfied and the regression considered to be complete. Options are entered in the Options section edit boxes. The default values are displayed for new equations. These settings will work for most cases, but can be changed to overcome any problems encountered with the regression, or to perform other tasks, such as evaluating parameter estimation.
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Iterations Setting the number of iterations, or the maximum number of repeated regression attempts, is useful if you do not want to regression to proceed beyond a certain number of iterations, or if the regression exceeds the default number of iterations. The default iteration value is 1.00. To change the number of iterations, simply enter the maximum number of iterations in the Iterations edit box.



Evaluating Parameter Values Using 0 Iterations Iterations must be non-negative. However, setting Iterations to 0 causes no iterations occur; instead, the regression evaluates the function at all values of the independent variables using the parameter values entered under the Initial Parameters section and returns the results. If you are trying to evaluate the effectiveness of automatic parameter estimation function, setting Iterations to 0 allows you to view what initial parameter values were computed by your algorithms. Using zero iterations can be very useful for evaluating the effect of changes in parameter values. For example, once you have determined the parameters using the regression, you can enter these values plus or minus a percentage, run the regression with zero iterations, then graph the function results to view the effect of the parameter changes.



Step Size The initial step size used by the Marquardt-Levenberg algorithm is controlled by the Step Size option. The value of the Step Size option is only indirectly related to changes in the parameters, so only relative changes to the step size value are important. The default step size value is 100. To change the step size value, type a new value into the edit box. The step size number equals the largest step size allowed when changing parameter values. Changing the step size to a much smaller number can be used to prevent the curve fitter from taking large initial steps when searching around suspected minima. For more information, see “Example 1: Curve Fitting Pitfalls” in Chapter 21. If you are familiar with this algorithm, step size is the inverse of the Marquardt parameter.
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Tolerance The Tolerance option controls the conditions that must be met in order to end the regression process. When the absolute value of the difference between the norm of the residuals from one iteration to the next is less than the tolerance, the regression is considered to be complete. The curve fitter uses two stopping criteria: „ When the absolute value of the difference between the norm of the residuals



(square root of the sum of squares of the residuals), from one iteration to the next, is less than the tolerance value, the iteration stops. „ When all parameter values stop changing in all significant places, the regression



stops. When the tolerance condition has been met, a minimum has usually been found. The default value for tolerance is 1.0e-10. To change the tolerance value, type the required value in the Tolerance edit box. The tolerance number sets the value that must be met to end the iterations. More precise parameter values can be obtained by decreasing the tolerance value. If there is a sharp sum of squares response surface near the minimum, then decreasing the tolerance from the default value will have little effect. However, if the response surface is shallow about the minimum (indicating a large variability for one or more of the parameters), then decreasing tolerance can result in large changes to parameter values. For more information, see “Example 1: Curve Fitting Pitfalls” in Chapter 21.
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20 Regression Equation Library This appendix lists the equations found in the Regression Equation Library. Polynomial Linear



Quadratic



Cubic
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Inverse First Order



Inverse Second Order



Inverse Third Order Peak



Four Parameter Gaussian



Five Parameter Gaussian



Three Parameter Modified Gaussian



Four Parameter Modified Gaussian
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Three Parameter Lorentzian



Four Parameter Lorentzian



Four Parameter Pseudo-Voigt



Five Parameter Pseudo-Voigt



Three Parameter Log Normal



Four Parameter Log Normal



Four Parameter Weibull
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Five Parameter Weibull Sigmoidal



Three Parameter Sigmoid



Four Parameter Sigmoid



Five Parameter Sigmoid



Three Parameter Logistic



Four Parameter Logistic



Four Parameter Weibull
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Five Parameter Weibull



Three Parameter Gompertz Growth Model



Four Parameter Gompertz Growth Model



Three Parameter Hill Function



Four Parameter Hill Function



Three Parameter Chapman Model



Four Parameter Chapman Model Exponential Decay
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Two Parameter Single Exponential Decay



Three Parameter Single Exponential Decay



Four Parameter Double Exponential Decay



Five Parameter Double Exponential Decay



Six Parameter Triple Exponential Decay



Seven Parameter Triple Exponential Decay



Modified Three Parameter Single Exponential Decay
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Exponential Linear Combination Exponential Rise to Maximum



Two Parameter Single Exponential Rise to Maximum



Three Parameter Single Exponential Rise to Maximum



Four Parameter Double Exponential Rise to Maximum



Five Parameter Double Exponential Rise to Maximum



Two Parameter Simple Exponent Rise to Maximum



Three Parameter Simple Exponent Rise to Maximum Exponential Growth



One Parameter Single Exponential Growth
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Two Parameter Single Exponential Growth



Three Parameter Single Exponential Growth



Four Parameter Double Exponential Growth



Five Parameter Double Exponential Growth



Modified One Parameter Single Exponential Growth



Modified Two Parameter Single Exponential Growth



Stirling Model
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Two Parameter Simple Exponent



Three Parameter Simple Exponent



Modified Two Parameter Simple Exponent Hyperbola Library



Two Parameter Rectangular Hyperbola



Three Parameter Rectangular Hyperbola I



Three Parameter Rectangular Hyperbola II



Four Parameter Double Rectangular Hyperbola
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Five Parameter Double Rectangular Hyperbola



Two Parameter Hyperbolic Decay



Three Parameter Hyperbolic Decay



Modified Hyperbola I



Modified Hyperbola II



Modified Hyperbola III Waveform



Three Parameter Sine
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Four Parameter Sine



Three Parameter Sine Squared



Four Parameter Sine Squared



Four Parameter Damped Sine



Five Parameter Damped Sine



Modified Sin



Modified Sine Squared
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Modified Damped Sine Power



Two Parameter



Three Parameter



Pareto Function



Three Parameter Symmetric



Four Parameter Symmetric



Modified Two Parameter I
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Modified Two Parameter II



Modified Pareto Rational



One Parameter Rational I



One Parameter Rational II



Two Parameter Rational I



Two Parameter Rational II



Three Parameter Rational I
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Three Parameter Rational II



Three Parameter Rational III



Three Parameter Rational IV



Four Parameter Rational



Five Parameter Rational



Six Parameter Rational



Seven Parameter Rational
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Eight Parameter Rational



Nine Parameter Rational



Ten Parameter Rational



Eleven Parameter Rational Logarithm



Two Parameter I



Two Parameter II



Two Parameter III
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Second Order



Third Order 3 Dimensional



Plane



Paraboloid



Gaussian



Lorentzian
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Standard Curves Linear Curve



Four Parameter Logistic Curve



Ligand Binding One Site Saturation



Two Site Saturation



One Site Saturation + Nonspecific
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Two Site Saturation + Nonspecific



Sigmoidal Dose Response



Sigmoidal Dose Response (Variable Slope)



One Site Competition



Two Site Competition



Four-Parameter Logistic Function



Four-Parameter Logistic Function (Linear)
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One Site Competition, Max = 100



One Site Competition, Min = 0, Max = 100
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21 Advanced Regression Examples Example 1: Curve Fitting Pitfalls This example demonstrates some of the problems that can be encountered during nonlinear regression fits. Peaks in chromatograph data are sometimes fit with sums of Gaussian or Lorentzian distributions. A simplified form of the Lorentzian distribution is:



where x0 is the location of the peak value. E Open the Pitfalls worksheet and graph by double-clicking the Pitfalls Graph in the



Nonlin.jnb notebook. Note the positions of data points on the curve. E Open the Simplified Lorentzian regression equation by double-clicking it in the



Regression Examples notebook. The Regression Wizard opens and displays the



variables panel. E Click one of the symbols on the graph so that the selected Variables are Columns 1



and 2. The object is to determine the peak location x0 for the data. Since this data was generated from the Lorentzian function above using x0 = 0, the regression should always find the parameter value x0 = 0.
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How the Curve Fitter Finds XO



To find x0, the curve fitter computes the sum of squares function: 3



∑



f ( xi ) – yi



2



i=1



as a function of the parameter x0. The curve fitter then searches this parameter space for any x0 value where a relative minimum exists. The sum of squares for x0 has two minima—an absolute minimum at x0 = 0 and a relative minimum at x0 = 4.03—and a maximum at 2.5. As the curve fitter searches for a minimum, it may stumble upon the local minimum and return an incorrect result. If you start exactly at a maximum, the curve fitter may also remain there. Figure 21-1 The plot of the sum of squares for the location of the peak value of a Simplified Lorentzian Distribution



E False convergence caused by a small step size. Click Options. Note that the value of x0



is set to 1000, and the Step Size option is set to 0.000001.
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Figure 21-2 The Equation Options dialog box showing step size set to 0.00001



E Click OK, then click Next.



Using the large initial value of x0 and a small step size, the curve fitter takes one small step, finds that there is no change in the sum of squares using the default value for tolerance (0.0001), and declares the tolerance condition is satisfied. The very low slope in the sum of squares at this large x0 value causes the regression to stop. Figure 21-3 The results using a step size of 0.00001



E False convergence caused by a large step size and tolerance. Click Back, then click



Options. Open the Step Size list and select 100; this is the default step size value.



 786 Chapter 21



Figure 21-4 Selecting a step size of 100



E Click OK, then click Next. The curve fitter takes a large step, reaches negative x0



values, and finds a value x0 = -546 for which the tolerance is satisfied. Figure 21-5 The results using a step size of 100



The sum of squares function asymptotically approaches the same value for both large positive and negative values of x, so the difference of the sum of squares for x0 = 1000 and x0 = -546 is within the default value for the tolerance. E Reducing tolerance for a successful convergence. Click Back, then click Options again.



Change the Tolerance value to 0.000001, then click OK.
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Figure 21-6 Changing the tolerance to 0.0001



E Click Next. The regression continues beyond x0 = -546 and successfully finds the



absolute minimum at x0 = 0. Summary



When you used a poor initial parameter value, you needed to use a large initial step size to get the regression started, and you had to decrease the tolerance to keep the regression from stopping prematurely. Poor initial parameters can arise also when using the Automatic method of determining initial parameters as well as when constant values are used. You will now use initial parameter values which result in convergence to a local minimum and a local maximum. E Finding a local minimum Click Back, then click the Options button.
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Figure 21-7 The results of using a step size of 100 and tolerance of 0.000001



E Change the initial value of x0 to 10 using the drop down Parameter Values list. Figure 21-8 Changing the initial parameter value to 10 and the tolerance to 0.0001



E In the Tolerance drop-down list, change the tolerance back to the default value of



0.0001, then click OK. E Click Next. The regression converges to x0 = 4.03, which corresponds to the local



minimum.
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Figure 21-9 Nonlinear regression results



In this example, you know that a local minimum was found by viewing the sum of squares function for the single parameter x0. However, when there are many parameters, it is usually not obvious whether an absolute minimum or a local minimum has been found. Figure 21-10 Nonlinear regression results



E Finding a local maximum Click Back, then click Options. Change the initial parameter



value of x0 to 2.5, then click OK. E Click Next. Because this initial parameter value happens to correspond to the



maximum of the sum of squares function, the regression stops immediately. The slope is zero within the default tolerance, so the curve fitter falsely determines that a minimum has been found. Finding the absolute minimum Click Back, then click Options. Change the initial value



of x0 to 2.0.
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E Click OK to close the Options dialog box, then click Next to execute the regression.



The initial parameter value is reasonably close to the optimum value, so the regression converges to the correct value x0 = 0.0. Figure 21-11 Nonlinear regression results



These last examples demonstrate how the curve fitter can find a local minimum and even a local maximum using poorly chosen initial parameter values.



Example 2: Weighted Regression The data obtained from the lung washout of intravenously injected dissolved Xenon 133 is graphed in the Weighted Graph in the Weighted Regression section of the Nonlin.jnb notebook. E Open the Weighted worksheet and graph by double-clicking the graph page icon in the



Weighted section of the Nonlin.jnb notebook. The data in the graph displays the compartmental behavior of Xenon in the body. Three behaviors are seen: the wash-in from the blood (rapid rise), the washout from the lung (rapid decrease), and the recirculation of Xenon shunted past the lung (slow decrease).
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Figure 21-12 The weighted graph



The sum of three exponentials (a triple exponential) is used as a compartmental model: Figure 21-13



Least squares curve fitting assumes that the standard deviations of all data points are equal. However, the standard deviation for radioactive decay data increases with the count rate. Radioactive decay data is characterized by a Poisson random process, for which the mean and the variance are equal. Weighting must be used to account for the non-uniform variability in the data. These weights are the reciprocal of the variance of the data. For a Poisson process, the variance equals the mean. You can use the inverse of the measurements as an estimate of the weights. The initial weighting variable only needs to be proportional to the inverse variance. E Double-click the Weighted Triple Exponential equation in the Weighted Regression



section.
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Figure 21-14 The weighted triple exponential equation



Click Edit Code, and examine the Variable value: w = 1/(col)2 This sets w to equal the reciprocal of the data in column 2. Click Cancel to close the dialog box. E Click the datapoints to select your variables. To use the w variable as the weighting



variable, click Options, and select w as the Fit With Weight value. Figure 21-15 Selecting a weight variable



Click OK to close the dialog box.
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E Click Next to run the regression. The curve fitter finds a solution quickly. E Click Finish to complete the regression. E What would be the result without weighting? Press F5, then click Next and click



Options. Change the weighting to (none), then click OK. E Click Finish. The curve fitter goes through many more iterations. When it is



completed, view the Weighted graph page. The graph shows the nonlinear regression results with and without weighting. The weighted results fit the very small recirculation data (represented by the third exponential) quite well. However, when weighting is not used, the curve fitter ignored the relatively small values in the recirculation portion of the data, resulting in a poor fit. Figure 21-16 Comparing the function results of weighted and unweighted nonlinear regression fits
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Example 3: Piecewise Continuous Function The data obtained from the wash-in of a volatile liquid into a mixing chamber is modeled by three separate equations, representing three line segments joined at their endpoints:



x2 ( t – t1 ) f 1 ( t ) = x 1 ( T 1 – t ) + -------------------( T1 – t1 ) x3 ( t – T1 ) f 2 ( t ) = x 2 ( T 2 – t ) + ---------------------( T2 – T1 ) x4 ( t – T4 ) f 3 ( t ) = x 3 ( t 4 – t ) + ---------------------( t4 – T2 ) where:



 f 1 ( t ) if t 1 < t < T 1  f =  f 2 ( t ) if T 1 < t < T 2   f 3 ( t ) if T 2 < t < t 4 E Open the Piecewise Continuous worksheet and graph by double-clicking the graph



page icon in the Piecewise Continuous section of the nonlin.jnb notebook. The data appears to be described by three lines, representing the three regions: before wash-in, during wash-in, and following wash-in. E View the notebook, and double-click the Piecewise Continuous Regression



Equation.
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Figure 21-17 The weighted triple exponential equation



E Click the datapoints to select the data, then click Next to run the regression. The model,



with parameters x1, x2, x3, x4, T1, and T2, is fit to the data. E Click Finish. When the fit is complete, view the graph page. A continuous curve fits



the three segments of the data. Figure 21-18 The data in the piecewise continuous graph fitted with the equations for three lines
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Example 4: Using Dependencies This example demonstrates the use of dependencies to determine when the data has been "over-parameterized." Too many parameters result in dependencies very near 1.0. If a mathematical model contains too many parameters, a less complex model may be found that adequately describes the data. Sums of exponentials are commonly used to characterize the dynamic behavior of compartmental models. In this example you model data generated from the sum of two exponentials with one, two, and three exponential models, and you examine the parameter dependencies in each case. Dependencies Over a Restricted Range



The first fit is made to data over a restricted range, which does not reveal the true nature of the data. E Open the Dependencies worksheet and graph by double-clicking the graph page icon



in the Dependencies section of the Regression Examples notebook. The data generated from the sum of two exponentials:



f ( t ) = 0.9e –t + 0.1e –0.2t is graphed on a semi-logarithmic scale over the range 0 to 3. Figure 21-19 The dependencies graph showing the data for the sum of two exponentials
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Although the data is slightly curved, the "break" associated with the two distinct exponentials is not obvious. E Right-click the curve on the shortcut menu click Fit Curve to open the Regression



Wizard. E Select the Exponential Decay category and the Single, 2 Parameter exponential



decay equation, then click Next twice. Figure 21-20 Selecting the 2 parameter single exponential decay equation



The results show that the dependencies are not near 1.0, indicating that the single exponential parameters, a1 and b1, are not dependent on one another. Figure 21-21 The results of fitting the data to a single exponential



E Click Back twice, and change the equation to the Double, 4 parameter exponential



decay equation. Click Next twice.
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Figure 21-22 Selecting the 4 parameter double exponential decay equation



The results show that the parameter dependencies for the double exponential are acceptable, indicating that they are unlikely to be dependent, and that using a double exponential produces a better fit (the curve fitter in fact finds the exact parameter values used to generate the data, producing a perfect fit with an R2 of 1). Figure 21-23 The results of fitting the data to the sum of two exponentials



Dependencies Over an Extended Range E Click Back twice, and change the equation to a Triple, 6 Parameter exponential decay



equation. Click Next twice.
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Figure 21-24 Selecting the 6 parameter triple exponential decay equation



The results show that the parameter dependencies for a, b, c, and d are 1.00, suggesting that the three exponential model is too complex and that one exponential may be eliminated. Click Cancel when finished. Figure 21-25 The results of fitting the data to the sum of three exponentials



Example 5: Solving Nonlinear Equations You can use the nonlinear regression to solve nonlinear equations. For example, given a y value in a nonlinear equation, you can use the nonlinear regression to solve for the x value by making the x value an unknown parameter. Consider the problem of finding the LD50 of a dose response experiment. The LD50 is the function of the four parameter logistic equation:



a1 - + d f ( x ) = -------------------b(x – c) 1+e
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where x is the dose and f(x ) is the response, then using nonlinear regression, you can find the value for x where:



a1 - + d 50 = -------------------b(x – c) 1+e E Open the Solving Nonlinear Equations worksheet and graph file by double-clicking



the graph page icon in the Solving Nonlinear Equations section of the Nonlin.jnb notebook. Note that the value for x at y = 50 appears to be approximately 150. Figure 21-26 The Solving Nonlinear Equations Graph, a four parameter logistic curve



E Double-click the Solving Nonlinear Equation and click Edit Code.
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Figure 21-27 The Solving Nonlinear Equations statements used to solve four parameter logistic equation with known parameters



E Examine the regression statements. Note that x is a parameter, y = 0, and the fit



equation is modified: f = p1/(1 + exp(p2*(x -p3))) + p4 - 50



Since you are fitting f to y = 0, these statements effectively solve the original problem for x when y = 50. The values for parameters a, b, c, and d were obtained by fitting the four parameter logistic equation to a given set of dose response data. E Click Run to execute the regression. The parameter solution is the unknown x. For this



example, x is approximately 149.5.
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Figure 21-28 The results of the Solving Nonlinear Equations example



Example 6: Multiple Function Nonlinear Regression You can use the Regression Wizard to fit more than one function at a time. This process involves combining your data into additional columns, then creating a third column which identifies the original data sets. This example fits three separate equations to three data sets. n



n



n



x x x T  ----T  ----T  ---- E 1  E 2  E 1 f 1 ( x ) = -----------------------n , f 2 ( x ) = -----------------------n , f 3 ( x ) = -----------------------n x x x 1 +  ----1 +  ----1 +  ---- E 1  E 2  E 3 E Open the Multiple Function worksheet and graph by double-clicking the graph page



icon in the Multiple Function section of the Nonlin.jnb notebook. The data points are for three dose responses. Columns 1 and 2 hold the combined data for the three curves. Column 3 is used to identify the three different data sets. A 0 corresponds to the first dataset, 1 to the second, and 2 to the third.
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Figure 21-29 The multiple function graph with three curves



E Double-click the Multiple Functions Equation. The Regression Wizard opens with the



variables panel displayed. Click Edit Code. Figure 21-30 The multiple function statements
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E Examine the fit statements. The fit equation is an if statement which uses different



equations depending on the value of d, which is the data set identifier variable. If d = 0, the data is fit to f1: if d = 1, the data is fit to f2; and if d = 2, the data is fit to f3. The functions share the T and n parameters, but have individual E parameters of E1, E2, and E3. E Click Run to execute the regression. The fit proceeds slowly but fits each data set to



the separate equation. Click Next to ensure that the Predicted function results are saved to the worksheet, then Next again and make sure no graph is being created. Click Finish to end the fit. E To graph the results, you need to create a plot of the predicted results. View the page



and select the graph, then create a straight line plot of rows 1-12 of column 1 versus rows 1-12 of the predicted results column. Figure 21-31 Creating a plot of a restricted data range



E Create two more line plots of rows 13-23 and 24-34. The results plots appear as three



separate curves.
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Figure 21-32 A graph of the predicted results of the multiple function equation



Example 7: Advanced Nonlinear Regression Consider the function:



f = 1–e



-dx ( b + cx )------------------------------x+a



When fitted to the data in columns 1 and 2 in the Advanced Techniques worksheet, this equation presents several problems: „ Parameter identifiability. „ Very large x values. „ Very large y error value range.



These problems are outlined and solved below. If you want to view the regression functions for this equation, open the Advanced Techniques worksheet and graph in the Advanced Techniques section of the Nonlin.jnb notebook. Double-click the Advanced Techniques Equation to open the Regression Wizard. If you want to run the equation, use the graph of the transformed data.
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Overparameterized Equations



The equation has four parameters, a, b, c, and d. The numerator in the exponential: -dx(b+cx) can have identical values for an infinite number of possible parameter combinations. For example, the parameter values: b = c = 1 and d = 2 and the values: b = c = 2 and d = 1 result in identical numerator terms. The curve fitter cannot find a unique set of parameters. The parameters are not uniquely identifiable, as indicated by the large values for variance inflation factor (VIF), and dependency values near 1.0. The solution to this problem is to multiply the d parameter with the other terms to create the equation:



f = 1–e



– x ( db + dcx ) --------------------------------x+a



then treat the db and dc terms as single parameters. This reduces the number of parameters to three. Scaling Large Variable Values



The data used for the fit has enormous x values, around a value of 1 × 1024 (see column 1 in the worksheet above). These x values appear in the argument of an exponential which is limited to about ±700, which is much smaller than 1024. However, when the curve fitter tries to find the parameter values which are multiplied with x, it does not try to keep the argument value within ±700. Instead, when the curve fitter varies the
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parameters, it overflows and underflows the argument range, and does not change the parameter values. The solution to this problem is to scale the x variable and redefine some of the parameters. Multiply and divide each x value by 1 × 1024 to get: – 24  – 24 10 x- db + dc10 – --------------------------------------x  – – 24  10 24  10 -------------------------------------------------------------– 24



f = 1–e



10 x- + a ---------------– 24 10



If you let X = x(10-24), then the equation becomes: 24



f = 1–e



– X ( db + dc10 X ) ----------------------------------------------– 24 X + 10 a



If you let CD = 1024dc and A = 10-24a, the resulting scaled equation is simplified to:



f = 1–e



– X ( db + CDX ) -------------------------------------X+A



The exponent argument now does not cause underflows and overflows. The graph of the transformed x data is displayed below the original data.
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Figure 21-33



Small Independent Variable Values: Weighting for Non-Uniform Errors



The y values for the data range from very small values to very large values. However, for this problem, we know that the y values do not have the same errors—smaller y values have smaller errors. The curve fitter fits the data by minimizing the sum of the squares of the residuals. Because the squares of the residuals extend over an even larger range than the data, small residual squared numbers are essentially ignored. The solution to this non-uniform error problem is to use weighting, so that all residual squared terms are approximately the same size. Fitting with a weighting variable of 1/y2 (the inverse of y squared), which is proportional to the inverse of the variance of the y data, produces a better fit for low y value data.
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Figure 21-34



To see the results of the regression without weighting, open the Options dialog box and change the weighting to (none) before finishing. Figure 21-35 The graph showing the results of weighted and unweighted nonlinear regressions
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